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Welcome to This Guide

This guide explains how to configure and work with an IT model that
enables you to build a topology of your system. You populate the model
with configuration items and their relationships, and then use the model to
measure and manage critical business processes.

This chapter includes:

» How This Guide Is Organized on page 13

» Who Should Read This Guide on page 14

» How Do I Find the Information That [ Need? on page 14

» Additional Online Resources on page 17

» Documentation Updates on page 18

How This Guide Is Organized

Part |

The guide contains the following chapters:

Introduction to RTSM

Introduces the RTSM and provides general information about Topology
Query Lanaguage, the CI Selector, and Topology Map.

13
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Partll Modeling

Describes how to model your business environment by defining views
and by building TQL queries that retrieve the required information from
the RTSM; describes how to view and modify the definitions of
configuration item types (CITs) defined in the RTSM and the relationships
that define the connections between them.

Part Il RTSM Data Model

Includes documents that explain and quantify the BTO Data Model
(BDM) version 1.1.1 and the CMS data model.

Part IV Reference Information

Contains general reference information.

Who Should Read This Guide

This guide is intended for the following users:

» Business Service Management administrators

» Business Service Management platform administrators

» Business Service Management application administrators
» Business Service Management data collector administrators

Readers of this guide should be knowledgeable about enterprise system
administration, have familiarity with ITIL concepts, and be knowledgeable
about Business Service Management in general and the Operational
Database technology specifically.

How Do | Find the Information That | Need?

14

This guide is part of the HP Business Service Management Documentation
Library. This Documentation Library provides a single-point of access for all
Business Service Management documentation.

You can access the Documentation Library by doing the following:
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> In Business Service Management, select Help > Documentation Library.

» From a Business Service Management Gateway Server machine, select
Start > Programs > HP Business Service Management > Documentation.

Topic Types

Within this guide, each subject area is organized into topics. A topic
contains a distinct module of information for a subject. The topics are
generally classified according to the type of information they contain.

This structure is designed to create easier access to specific information by
dividing the documentation into the different types of information you
may need at different times.

Three main topic types are in use: Concepts, Tasks, and Reference. The topic
types are differentiated visually using icons.

Topic Type Description Usage
Concepts Background, descriptive, or Learn general information
(% conceptual information. about what a feature does.

15
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Topic Type

Description

Usage

Tasks

A

Instructional Tasks. Step-by-
step guidance to help you
work with the application and
accomplish your goals. Some
task steps include examples,
using sample data.

Task steps can be with or
without numbering:

» Numbered steps. Tasks that
are performed by following
each step in consecutive
order.

» Non-numbered steps. A list
of self-contained operations
that you can perform in any
order.

» Learn about the overall
workflow of a task.

» Follow the steps listed in
a numbered task to
complete a task.

» Perform independent
operations by
completing steps in a
non-numbered task.

Use-case Scenario Tasks.
Examples of how to perform a
task for a specific situation.

Learn how a task could be
performed in a realistic
scenario.
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Topic Type

Description

Usage

Reference

®

General Reference. Detailed
lists and explanations of
reference-oriented material.

Look up a specific piece of
reference information
relevant to a particular
context.

User Interface Reference.
Specialized reference topics
that describe a particular user
interface in detail. Selecting
Help on this page from the
Help menu in the product
generally open the user
interface topics.

Look up specific
information about what to
enter or how to use one or
more specific user interface
elements, such as a
window, dialog box, or
wizard.

Q,

Troubleshooting
and Limitations

Troubleshooting and
Limitations. Specialized
reference topics that describe
commonly encountered
problems and their solutions,
and list limitations of a feature
or product area.

Increase your awareness of
important issues before
working with a feature, or
if you encounter usability
problems in the software.

Additional Online Resources

Troubleshooting & Knowledge Base accesses the Troubleshooting page on
the HP Software Support Web site where you can search the Self-solve
knowledge base. Choose Help > Troubleshooting & Knowledge Base. The
URL for this Web site is http://h20230.www2.hp.com/troubleshooting.jsp.

HP Software Support accesses the HP Software Support Web site. This site
enables you to browse the Self-solve knowledge base. You can also post to
and search user discussion forums, submit support requests, download

patches and updated documentation, and more. Choose Help > HP Software
Support. The URL for this Web site is www.hp.com/go/hpsoftwaresupport.

Most of the support areas require that you register as an HP Passport user
and sign in. Many also require a support contract.

17
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To find more information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp

To register for an HP Passport user ID, go to:

http://h20229.www2.hp.com/passport-registration.html

HP Software Web site accesses the HP Software Web site. This site provides
you with the most up-to-date information on HP Software products. This
includes new software releases, seminars and trade shows, customer support,
and more. Choose Help > HP Software Web site. The URL for this Web site
is www.hp.com/go/software.

Documentation Updates

18

HP Software is continually updating its product documentation with new
information.

To check for recent updates, or to verify that you are using the most recent
edition of a document, go to the HP Software Product Manuals Web site
(http://h20230.www2.hp.com/selfsolve/manuals).
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Topology Query Language

This chapter includes:

Concepts

» Topology Query Language (TQL) Overview on page 22
» Creating TQL Queries in the RTSM Managers on page 23
» Viewing TQL Query Results on page 24

» Compound Relationship on page 26

» Join Relationship on page 26

» Subgraph Definition on page 28

» The ALLOW_VOLATILITY Qualifier on page 28

Tasks

» Define a TQL Query on page 30

» Add Query Nodes and Relationships to a TQL Query on page 32
» Define a Compound Relationship — Scenario on page 33
» Define a Join Relationship — Scenario on page 36

» Create a Subgraph Definition — Scenario on page 38
Reference

» Shortcut Menu Options on page 40

» Attribute Operator Definitions on page 45

> TQL Logs on page 47

» Topology Query Language User Interface on page 53

Troubleshooting and Limitations on page 103

21
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Concepts

& Topology Query Language (TQL) Overview

22

Topology Query Language (TQL) is a language and tool for discovering,
organizing, and managing IT infrastructure data. It enables you to create
TQL queries that retrieve business service data from the RTSM. TQL queries
also help you display the data in a visual representation that facilitates data
monitoring and managing.

This section includes the following topics:
» "Topology Query Language" on page 22
» "The Roles of TQL" on page 23

Topology Query Language

TQL extends the standard SQL language by adding two important
capabilities:

» TQL enables you to draw conceptual relationships between configuration
items (CIs), which represent their actual interdependencies. Using
predefined operators, the different types of interconnections
(relationships) that exist between Cls can be established, and
consequently the infrastructure design and performance are more
accurately represented. This representation serves as a basis and a model
for the discovery, arrangement, query, and management of complex
infrastructures.

» TQL includes a graphical aspect, consisting of visual symbols and syntax,
that represents the resources and their interconnections. This
visualization of an IT infrastructure simplifies the understanding,
monitoring, and managing of the IT business operations.
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The Roles of TQL
TQL plays several roles:

» Builds a business service model that defines and delineates the
interconnection between IT assets that function together as business
services. The business service model guides the discovery and
identification of these business services, from the ever-increasing number
and complexity of infrastructure resources. After the resources that
comprise the business services are discovered, the business service model
structures the way they are organized and managed in the RTSM.

» Constantly searches the RTSM for changes that occur in the state of
managed resources. When such changes are detected, the relevant
subsystems are informed and updated.

» Creates queries that retrieve business service data from the RTSM, and
displays the data in a visual representation that facilitates data
monitoring and managing.

& Creating TQL Queries in the RTSM Managers

The following managers enable you to create TQL queries that retrieve
specific data from the RTSM and to display that data:

> Impact Analysis Manager. An Impact rule simulates how infrastructure
changes can impact your system and enables you to determine the true
origin of a problem and its business impact. During rule creation, you
define the base TQL query type, which can be a new query or an existing
query. For details, see "Impact Analysis Manager" on page 449.

» Enrichment Manager. An Enrichment rule enables enlarging the RTSM,
deleting CI instances from the RTSM, or updating the attributes of a CI
that already exists in the RTSM. During rule creation, you define the base
TQL query type, which can be a new query or an existing query. For
details, see "Enrichment Manager" on page 519.

23
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> Modeling Studio. You can build a new TQL query using the TQL Query
Editor or you can build a new query while defining a new view, template,
or perspective using the Pattern View Editor. You can also define the
topology report settings for any view in the Pattern View Editor. For
details, see "Modeling Studio" on page 33S5.

& Viewing TQL Query Results

24

You view the resulting data in a visual representation in IT Universe
Manager. The queries define the structure of the resulting topology map.
The view displays only those Cls and relationships that meet the query
definition. You can also view the results of a query by clicking the Preview
button in the toolbar to open a preview display identical to IT Universe
Manager. For more details about IT Universe Manager, see "IT Universe
Manager" on page 227.

TQL Query Types and Priorities

When you define a TQL query, you define the type of the TQL query in the
Type field of the Query Definition Properties dialog box. The following
query types are available:

» View. TQL queries used as the basis for pattern views.

> Integration. TQL queries used for integrations.

» Discovery. TQL queries used as the basis for DFM patterns.
» Template. TQL queries used as the basis for templates.

> Perspective. TQL queries used as the basis for perspectives.

> Impact Analysis. TQL queries used as the basis for Impact rules. This is the
default type for queries created in Impact Analysis Manager.

» Enrichment. TQL queries used as the basis for Enrichment rules. This is
the default type for queries created in Enrichment Manager.

You cannot change the type of an existing TQL query if it has dependencies
(such as views, templates, and so on).
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If a query imported though an integration is not assigned a type, it is
considered a hidden query and does not appear in the query list in the
Modeling Studio. To display hidden queries in the query list, change the
setting for hidden queries under General in the User Preferences dialog box.
For details, see "User Preferences Dialog Box" on page 102.

You can also set the priority level of a TQL query, which determines how
often the query is rerun automatically to include updated information. The
following priorities are available:

» Low. The TQL query is refreshed every 2 minutes.

» Medium. The TQL query is refreshed every 30 seconds.
» High. The TQL query is refreshed every 10 seconds.

» Express. The TQL query is refreshed continuously.

» Not Active. The TQL query is inactive.

Note: The above refresh times are average values.

If you set the priority of a TQL query to Not Active, the query becomes
inactive and is not run automatically, however it can be used for manually
building a view.

Base Queries

You can select a base query for a TQL query in the Query Definition
Properties dialog box. In this case, the base query is first applied to the entire
IT Universe, generating results. The new query is then applied to that subset
of the universe, further refining the results. Selecting a base query enables
you to filter the query results more finely and generate results more quickly
in certain cases.

The base query you select must be both active and persistent for your new
query to be active. If the base query is not active and persistent, the new
query is automatically assigned a priority of Not Active.

25
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& Compound Relationship

A compound relationship represents a path in the topological graph. You use
a compound relationship to define the allowed steps in the path between
the source and the target Cls.

Each row represents one of the allowed steps in the path leading from the
source CI to the target CI in the topology map.

Source | Relationship | Target
IpSubnet Membership % MNode
% Mode Containment @ IpAddress

For an example of a compound definition, see "Define a Compound
Relationship — Scenario" on page 33. For details on defining compound
relationships, see "Add/Edit Compound Relationship Dialog Box" on
page 56.

& Join Relationship

26

A join relationship is a logical connection that represents the relationship
between two Cls (and which appears only in the topology map containing
the TQL query results). It does not exist in the RTSM. A join relationship is
created by defining an attribute for each query node, whose values are used
for comparison.

The TQL results retrieve all CIs whose attribute values meet the conditions
defined in the join definition.

For example, you can create a join definition that links all node ClIs
connected to IP Address CIs whose Created By attribute values are equal (see
the example below).

Hode | Operator | IpAddress

Created By Egjual Created By

Each join definition represents one condition defined for the join
relationship.
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Note: You can define multiple conditions.

For an example of a join definition, see "Define a Join Relationship -
Scenario" on page 36. For details on defining join relationships, see
"Add/Edit Join Relationship Dialog Box" on page 60.
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& Subgraph Definition

A subgraph definition enables you to create a graph that represents
additional TQL query data related to a specific CI. The DFM job searches for
the results from both the TQL query and the subgraph definitions. The
query recursively retrieves all related Cls for a defined depth matching the
definition of the subgraph. For details on defining subgraph definitions, see
"Subgraph Definition Dialog Box" on page 100.

In the graph, you can define the relationship that is connected to a specific
query node. For example, if one of the query nodes is of type node, you can
specify different relationships for Windows, router, and IP Address. You can
also define attribute conditions for query nodes. For details, see "Subgraph
Condition Definition Dialog Box" on page 98.

DFM jobs retrieve data that meets the criteria defined in the subgraph.

For an example of a subgraph definition, see "Create a Subgraph Definition —
Scenario" on page 38.

& The ALLOW_VOLATILITY Qualifier

28

This qualifier is used to mark attributes that enable minor deviations to their
value. For example, there is probably no need to report a small disk size
change (from 8.00008 to 8.00009 GB).

When updating an attribute that is marked with this qualifier, HP Business
Service Management checks the new value against the old value. This check
is performed on the server as part of the record update. If the difference
between the two values is lower that the allowed deviation, an update is not
performed (the action is considered a false update).
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This qualifier must contain one of the following data items that hold the
allowed deviation:

> ALLOWED_DEVIATION_FIX. The type of deviation is the same as the
attribute type for numeric attributes, and the integer type for date
attributes. Deviation is measured by a fixed value, of the same unit as the
attribute value. (For date attributes, the deviation is measured in seconds.)

> ALLOWED_DEVIATION_PERCENT. Deviation is measured by percentage.
For date values, the percentage is checked against the millisecond date
representation. This data item type is always integer, and the value range
is 0 to 100.

To deactivate the qualifier:

Access the Infrastructure Settings Manager (Admin > Platform > Setup and
Maintenance > Infrastructure Settings). Locate the Allow Volatility option.
Change the value to False.

29
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Tasks

P Define a TQL Query

30

This task describes how to create a TQL query in the Modeling Studio.

Note: You can also create a TQL query during the procedure for creating
Impact rules, Enrichment rules, Views, Templates, and Perspectives.

This task includes the following steps:

» "Create a TQL Query" on page 30
> "Add Query Nodes and Relationships to the Query" on page 30
> "Set the Query Properties" on page 31

1 Create a TQL Query

In the Modeling Studio, select New > Query to open the TQL Query
Editor. For details, see "TQL Query Editor" on page 440.

2 Add Query Nodes and Relationships to the Query

Add the TQL query nodes and relationships that define the query. The
TQL query nodes represent the CITs, as defined in the CI Type Manager,
and the relationships represent the connections between them.
Relationships are defined one at a time for each pair of TQL query nodes
in the query. For details, see "Add Query Nodes and Relationships to a
TQL Query" on page 32.

Note: You can also define a self-relationship from a query node to itself.
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3 Set the Query Properties

! Click the Query Definition Properties button to open the Query
Definition Properties dialog box. Set the query type, scope, priority, and
other properties. For details, see "Query/View Definition Properties Dialog
Box" on page 426.

Example of a TQL Query Definition:

The direction of the relationship indicates which query node is
dependent on the other. The following example displays two nodes, an IP
Service Endpoint, and a Client Port, which are linked to one another via a
client/server connection. The TQL query results must comply with the
direction of the arrows.

Windomis

| A

. |
,} IpAddress !
e | IpAddress_1
(] ClientServer ¥
IpSericeEndpaint _'7-13
Client Port

Note: A TQL query is subject to certain validation restrictions. For details,
see "Troubleshooting and Limitations" on page 103.
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T Add Query Nodes and Relationships to a TQL Query

This section explains how to add query nodes and relationships to a TQL
query. It is relevant for Impact Analysis Manager, Enrichment Manager, and
the Modeling Studio.

32

I

Note: For TQL queries to be valid, they must comply with certain
restrictions. For details, see "Troubleshooting and Limitations" on page 103.

To add query nodes and relationships to a TQL query:

1

In Impact Analysis Manager or Enrichment manager, select the required
query from the tree in the left pane or click the New button to create one.

In the Modeling Studio, select the Resources tab in the left pane, select
Queries as the Resource type, and select the required query from the tree
or click New > Query to create a new one.

In Impact Analysis Manager or Enrichment manager, click and drag one
or more required TQL query nodes from the tree displayed in the CI Type
Selector, onto the editing pane. In the Modeling Studio, select the CI
Types tab in the left pane and drag the required TQL query nodes from
the tree onto the editing pane. These are the TQL query nodes that are
included in the query.

To add a relationship between two query nodes:

» Select the required TQL query nodes by holding down CTRL and
clicking the TQL query nodes, right-click and select Add Relationship.
The Add Relationship dialog box opens. Select the required
relationship. For details, see "Add/Edit Relationship Dialog Box" on
page 63.

or

» Click the Create Relationship icon and draw a line between the
required query nodes. The Select Relationship Type dialog box opens.
Select the required relationship type. For details, see "Select
Relationship Type Dialog Box" on page 97.



T Define

Chapter 1 ¢ Topology Query Language

4 Click OK. The selected query nodes are linked by the relationship you
have selected.

a Compound Relationship - Scenario

This section describes how to define the allowed steps that form a
compound relationship between a IP Subnet CI and an IP Address CI.

Note: To reach the required result, you must implement each one of the
following steps.

To define a compound relationship between a IP Subnet Cl and an IP
Address Cl:

1 Create a TQL query of type view and drag the following query nodes onto
the editing pane:

» IP Subnet
» IP Address

2 Right-click the IP Subnet and IP Address query nodes and select Add
Compound Relationship to open the Add Compound Relationship dialog
box.

3 Click the Add button. In Enrichment Manager and Impact Analysis
Manager, the Add Triplet dialog box opens. In the Modeling Studio, a row
is added to the table. Make the following selections:

» From the Source list, select IP Subnet.

» From the Target list, select Node.

» From the Relationship list, select Membership.
» Select the required Relationship direction.

In Enrichment Manager and Impact Analysis Manager, click OK to save
your changes.
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& 4 Click the Add button again and make the following selections:
» From the Source list, select Node.
» From the Target list, select IP Address.
» From the Relationship list, select Containment.
> Select the required Relationship direction.
In Enrichment Manager and Impact Analysis Managet, click OK to save
your changes.

The following shows an example of compound definitions following the

changes:
Source | Relationship | Target
IpSubnet Membership % Mode
% Mode Containment @ IpAddress

5 Click OK to save your changes.
The TQL query in the editing pane now looks like this:

@{Vir’[ual - Compaund ‘@

IpAddress IpSubnet

6 Create a view based on your TQL query and save it.
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7 Go to the required view in IT Universe Manager to view the results. If you

did not select the Show full path between source and target Cls option,
then the results display the names of the relationships that link the CIs as
Virtual-Compound rather than the actual names of the relationships. See
the illustration below:

Wirtual - Compao
und
Campo

192.168.01 16B.59.68.183 19216816381

You can double-click the Virtual - Compound relationship in IT Universe
Manager to open the Link Map, which displays the CIs and relationships
that comprise the allowed steps used to link the IP Subnet and IP Address
Cls.

192165.1658.0

Membershig

Y
%

labimd corml 5

Containment

¥
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In the example above, the 192.168.168.0 (IP Subnet) CI is linked to the
192.168.0.1 (IP Address) CI through the labm1ccm15 (Node) CI.

If you selected the Show full path between source and target Cls option,
then the results in IT Universe Manager display the actual names of the
relationships that link the Cls and the full path between the source and
target Cls. See the illustration below:

192.168.168.0

Membership

Contain

..

TR
1648

i
192.168.1

62.1 165968183 192163.01

T Define a Join Relationship - Scenario

This section explains how to define a join relationship that links Node ClIs
to IP Address CIs whose Created by attribute values are equal.

Note: To reach the required result, you must implement each one of the
following steps.
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To define a join relationship that links all IP Address and Node Cls whose
Created by attribute values are equal:

ge

1 Create a TQL query and drag the following query nodes from the CI Type

Selector onto the editing pane:
» Node
> 1P Address

2 Select the Node and IP Address query nodes and right-click to open the
Add Join Relationship dialog box.

3 Click the Add button to add a row to the table and do the following:
> In the Node Attribute box, select Created by.
» In the Operator box, select Equal.
> In the IP Address Attribute box, select Created by.
In Enrichment Manager and Impact Analysis Manager, you make these
selections in the Join Relationship Condition dialog box.

The Join Definition area now looks like this.

Hode | Operator IpAddress

Created By Equal Created By

4 Click OK to save your changes.
The TQL query in the editing pane now looks like this:

(I

MHode

Yirual - Jaoin

il

IpAddress
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T Create a Subgraph Definition - Scenario

38

This section describes how to create a subgraph definition. In this example,
the TQL query results retrieve all CIs that are connected to a Business Service
CI by a Containment relationship up to a depth of 3.

Note: To reach the required result, you must implement each one of the
following steps.

To create this sample subgraph definition:

1 Create a TQL query and drag a query node of type Business Service onto
the editing pane.

2 Right-click the Business Service query node and select Subgraph
Definition to open the Subgraph Definition dialog box.

3 Click the Add button. In Enrichment Manager and Impact Analysis
Manager, the Add Triplet dialog box opens. In the Modeling Studio, a row
is added to the table. Make the following selections:

» From the Source drop-down list, select Managed Obiject.

» From the Target drop-down list, select Managed Object.

» From the Relationship drop-down list, select Containment.

> Set the direction of the relationship as left to right.

In Enrichment Manager and Impact Analysis Manager, click OK to save
your changes.

The Subgraph Definition dialog box now looks like this.

Source Relaticnship Target Relaticnship Direction
Managed Object Cortainmert Managed Object =

4 Set the Depth setting to 3.

5 Click OK in the Subgraph Definition dialog box.
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Go to the required view in IT Universe Manager to view the results.

P

&

aaa

Containment

Containment

Containynent

(A2 3
13444881120 ge-smelesh
efaultDarmain

The results show the Business Service CI aaa and all of the CIs linked to it

in succession by Containment relationships down to three levels.
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Reference

@ Shortcut Menu Options

This section includes a list of TQL query shortcut menu options (listed

40

alphabetically):

Ul Element (A-Z)

Description

Add Calculated
Relationship

Enables you to create a calculated relationship.
» For details on how to create a calculated relationship,
see "Triplets Page" on page 503.

» For details about Impact Modeling, see "Impact
Modeling" on page 109.

Add Compound
Relationship

Enables you to define the connection between two query
nodes using a compound relationship.

For details, see "Add/Edit Compound Relationship Dialog
Box" on page 56.

Add Join Relationship

Enables you to define join relationships. You create them
by defining an attribute for each query node. These query
node values are used for comparison during federation.

For details, see "Add/Edit Join Relationship Dialog Box"
on page 60.

Add Related Query
Node Wizard

Displays the Add Related Query Node Wizard which
enables you to build a TQL query. For details, see "Add
Related Query Node Wizard" on page 65.
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Ul Element (A-Z)

Description

Add Relationship

Enables you to create a relationship for your query nodes
by selecting it from a predefined list. Displays the Add
Relationship dialog box.

For details, see "Add/Edit Relationship Dialog Box" on
page 63.

Note: In Enrichment Manager, this option adds an
Enrichment relationship to the rule when working in
Enrichment mode. Applicable for regular and Enrichment
query nodes. For details, see "Enrichment Manager" on
page 519. Added relationships are denoted by an added
|T| indicator.

Add to Hierarchy

Adds the selected query node to the hierarchy as a
separate query node.

Note: Only relevant for the Modeling Studio.

Add to Model Output

Designates the selected query node as output for the
pattern-based model.

Note: Only relevant for pattern-based models in the
Modeling Studio.

Change Query
Node/Relationship

Type

Displays the Change Query Node Type dialog box.
Enables you to change the CI type of the query node after
you have created it. For details, see "Change Query
Node/Relationship Type Dialog Box" on page 381.

Note: Only relevant for the Modeling Studio.

Clear

Available by right-clicking a query node or relationship
when working in Enrichment mode in the Enrichment
Manager. Clears the query node/relationship’s
Enrichment rule definition. For details, see "Enrichment
Manager" on page 519.

Appears only if you have updated or deleted a query
node/relationship using an Enrichment rule.

Note: Only relevant for Enrichment Manager.

41




Chapter 1 » Topology Query Language
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Ul Element (A-Z)

Description

Copy/Paste

Copy/paste an existing TQL query node/relationship in
the same query or into another TQL query.

The copied TQL query node/relationship includes all TQL
definitions.

You can copy and paste relationships provided that the
TQL query nodes to which the relationships are
connected are also selected. A relationship on its own
cannot be copied without its connecting TQL query
nodes.

You can select multiple TQL query nodes/relationships as
well.

Note: The Copy and Paste options are only available in
the Modeling Studio. The Paste option is available only
after using the Copy option to copy an existing TQL
query node/relationship.

Define Impacted

Define which query node in the TQL query is the trigger
Impact Analysis query node and which query nodes are
impacted by the changes that occur in the system. For
details, see "Impacted Query Nodes Dialog Box" on

page 466.

Note: Only relevant for Impact Analysis Manager.

Delete Deletes the selected query node/relationship/CI.
Note: This option is not available for calculated
relationships.

Delete Available by right-clicking a query node or relationship

Relationship/Query
Node

when working in Enrichment mode.

Creates a specific Enrichment rule that is designed to
delete Cls/relationships from the RTSM. Applicable to
regular query nodes and relationships only. You can use
this option, for example, for removing unnecessary data
from the RTSM. For details, see "Enrichment Manager" on
page 519.

Deleted query nodes and relationships are denoted by a
removed E| indicator.

Note: Only relevant for Enrichment Manager.
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Ul Element (A-Z)

Description

Edit Relationship

Displays the Refine Relationship Type dialog box. For
details, see "Refine Query Node Type Dialog Box" on
page 96.

Note: Not relevant in the Modeling Studio.

Note: This option appears only when the selected
relationship has descendants.

Query
Node/Relationship
Properties

Displays the Query Node/Relationship Properties dialog
box, enabling you to define the attribute conditions for
the selected TQL query node/relationship. For details, see
"Query Node/Relationship Properties Dialog Box" on
page 85.

Note: This option is not available for calculated
relationships.

Refine Query Node
Type

Displays the Refine Query Node Type dialog box. Enables
you to change the CI type of the query node after you
have created it. For details, see "Refine Query Node Type
Dialog Box" on page 96.

Note: This option only appears if a child of the CI type
exists. Only relevant for Impact Analysis Manager and
Enrichment Manager.

Remove Subgraph

Only appears if you have defined a subgraph definition.
For details, see "Subgraph Definition Dialog Box" on
page 100.

Reset Impacted

Removes the Define Impacted definition applied to that
query node. For details on the Define Impacted
definition, see "Impacted Query Nodes Dialog Box" on
page 466.

Note: Only relevant for Impact Analysis Manager.

Reset Inner
Relationship

Redraws a self-referential relationship in the Topology
map as a square for ease of viewing.

Note: Only relevant for self-referential relationships that
are not square.
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Ul Element (A-Z)

Description

Set As Contact Query
Node

Designates the selected query node as a contact query
node for the perspective.

Note: Only relevant for perspectives in the Modeling
Studio.

Set Data Sources

Opens the Set Data Sources dialog box which enables you
to select the required data sources for a TQL query node.

Note: Only relevant for the Modeling Studio.

Set Element Invisible

When this option is selected, an invisible indicator B
appears to the right of the selected TQL query node in the
editing pane.

Any query results pertaining to that TQL query node are
not displayed in the topology map. This can be useful
when certain relationships or TQL query nodes are
required to build the query but are not needed in the
results. At least one query node must be visible for the
view to be valid.

Note: Only relevant for the Modeling Studio.

Set Element Visible

When this option is selected, the results pertaining to the
TQL query node are displayed in the topology map.

Note: Only relevant for the Modeling Studio.

Show Element

Displays the Element Instances dialog box which displays

instances all the instances found for each query node in a table. For
details, see "Element Instances Dialog Box" on page 77.

Show Node Opens the Template Parameter Values dialog box, which

Parameters enables you to set the values of the query node’s

parameters.

Note: Only relevant for template-based views in the
Modeling Studio.

Subgraph Definition

Displays the Subgraph Definition dialog box, where you
can create a graph that represents additional TQL query
data related to a specific query node. For details, see
"Subgraph Definition Dialog Box" on page 100.
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Ul Element (A-Z)

Description

Update
Relationship/Query
Node

Use an Enrichment rule to update the value of CI
attributes in the RTSM, or to add data to attributes that
currently do not have values. Opens the Query Node
Definition - Attributes dialog box. For details, see "Query
Node/Relationship Definition Dialog Box" on page 544.
This is applicable for both regular and Enrichment query
nodes.

Updated query nodes are denoted by an updated
indicator.

Note: Only relevant for Enrichment Manager.

@ Attribute Operator Definitions

This section contains a list of operators used to define attribute conditions
in various dialog boxes, such as the Subgraph Condition dialog box, Impact
Rules Definition dialog box, or the Query Node/Relationship Properties

dialog box.

Operator

Description

Changed during

(Displayed only when you select an attribute of type
Date.) Displays only the instances that changed
during the period specified in the Value box.

Equal

Checks whether the attribute value is equal to the
value specified in the Value box.

Equal ignore case

Checks whether the attribute value is equal to the
value specified in the Value box regardless of the
case.

Greater

Checks whether the attribute value is greater than
the value specified in the Value box.

Greater than or equal

Checks whether the attribute value is greater than
or equal to the value specified in the Value box.
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Operator Description

In Displays only the instances where this attribute
value equals one of the selected values. For
example, for CIs that have a Change state that
equals Plan and New, select the operator In from the
Operator list and select both Plan and New from
the Value box.

Is null Checks whether the attribute value is null.

Less Checks whether the attribute value is less than the
value specified in the Value box.

Less than or equal Checks whether the attribute value is less than or
equal to the value specified in the Value box.

Like Uses a wildcard (%). Use Like when you are not sure
of the complete name for which you are searching.

Like ignore case Uses a wildcard (%). Use Like ignore case when you
are not sure of the complete name for which you
are searching. The case of the string is ignored.

Not equal Checks whether the attribute value is not equal to
the value specified in the Value box.

Unchanged during (Displayed when you select a date type attribute.)
Displays only the instances that did not change
during the period specified in the Value box.
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Note:

» For the Not equal operator, query results do not include data from the CI

instances that are not assigned a value. For example, a system contains
three nodes: Nodel is assigned the value A, Node2 is assigned the value
B, and Node3 is not assigned a value. If you create a query to retrieve all
nodes that are Not equal to A, the results of your query include Node2
only, because Node3 is not assigned a value.

HP Business Service Management supports both Microsoft SQL Server
and Oracle Server databases. Microsoft SQL Server is not case sensitive by
default (unlike Oracle database which is case sensitive). Consequently, if
you are using Microsoft SQL Server, the Equal operator retrieves the same
query results as the Equal ignore case operator. For example, if you select
the attribute City, the operator Equal, and type NEW YORK in the Value
comparison box, case differences are ignored and query results include
NEW YORK, New York and new york.

@ TQL Logs

This section contains definitions for TQL parameter log files.

This section includes the following topics:

Y Y Y Y Y Y

"Pattern Log" on page 48

"Pattern Statistics Log" on page 50

"Audit Short/Detailed Log (TQL Perspective)" on page 50
"Incremental Statistics Log" on page 51

"Incremental Splitter Log" on page 52

"Incremental Detailed Log" on page 53
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Pattern Log

The log name is cmdb.pattern.log.

Log File Description

Purpose Information about the lifecycle of a TQL query that is handled
and calculated in the RTSM.
Only TQL queries stored in the RTSM are included.
Information about ad hoc TQL queries is not included.

Information Not available.

Level

Error Level

Not available.

Debug Level

Possible actions performed on each TQL query include:

» Status changes. Each TQL query has an internal state during
its lifecycle. For example, all inactive queries are always in
the INACTIVE state. Active queries begin in the NEW state.
When they are first calculated, they move to the IN_CALC
state. When a query is removed, it moves to the
WAIT_FOR_DELETE state until it is removed completely.

» Model changes. Whenever a change occurs in the CMDB
model, the TQL determines if it is relevant to its results. If
s0, it calculates the required change in the query results.
The log displays the number of changes processed by this
TQL.

» Query changes. When the TQL is modified, the log indicates
that the query was modified and displayes its new priority.

Basic
Troubleshooting

Check if a TQL query has the same status for a long time:

> new - the query is in lazy loading

» inactive

» calculation - the calculation may have failed but the
scheduler was not informed

You can also view the number of notifications that a TQL

query received.
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Examples of typical log entries:
The TQL query named TQL1 is added and is in NEW state:

2011-01-25 07:44:48,763 DEBUG - TQL1 [NEW] State change NEW --> NEW

TQL1 is asked to be calculated and is moved to IN CALCULATION state:

2011-01-25 07:44:48,763 DEBUG — TQL1 [NEW] State change NEW --> IN_CALC

The calculation finishes and moves to IDLE state (waits for changes):

2011-01-25 07:44:48,778 DEBUG - TQL1 [IN_CALC] State change IN_CALC -->
IDLE

Changes took place in the model (total of 5 changes):

2011-01-25 07:44:49,544 DEBUG - TQL1 [IDLE] Model Change Recieved 5 model
changes.

Moving to a state that checks whether these change are relevant for this TQL
query:

2011-01-25 07:44:49,544 DEBUG - TQL1 [IDLE]  State change IDLE -->
IN_IMMEDIATE_1

The pattern is changed. The new priority is medium:

2011-01-25 07:45:39,647 DEBUG - TQL1 [IDLE] Pattern change New priority
MED_PRIORITY
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Pattern Statistics Log

The log name is cmdb.pattern.statistics.log.

Log File Description

Purpose General calculation data for each TQL query, updated at
predefined intervals.

Information The following information is given for each TQL query:

Level > name

» average, minimum, and maximum calculation times
» number of calculations

» last calculation time

» result size

Error Level Not available.
Debug Level Not available.
Basic » Verify that a specific TQL query was updated.

Troubleshooting | » Evaluate a TQL query’s calculation time.

» Evaluate a TQL query’s result size.

Audit Short/Detailed Log (TQL Perspective)

The log name is cmdb.audit.short.log.

Log File Description

Purpose RTSM state changes, CI Type changes, and TQL query results.

You can use this log to follow the results of TQL queries.

Information Not available.
Level
Error Level Not available.
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Log File Description

Debug Level » Final calculation for TQL queries is logged.

» If the final TQL query calculation is unchanged from the
previous calculation, this is noted.

» If the final TQL query calculation is changed from the
previous calculation, results of the Cls and relationships are
recorded in the detailed log. The number of CIs and
relationships are recorded in the short log.

Basic » Use this log to verify which notifications are published by

Troubleshooting the TQL query subsystem.

» Check the section at the end of each result. This section
includes added, removed, and updated CIs and
relationships.

» Track the CIT changes and see if the query results also
change. You can thus correlate the CIT changes to the
results of the query calculations.

Incremental Statistics Log

The log name is cmdb.incremental.statistics.log.

Log File Description

Purpose Traces the calculation procedure, full or incremental, of every
query.

Information Not available.

Level

Error Level Not available.
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Log File

Description

Debug Level

» Gives the date, time, query name, and whether an
incremental statistic calculation was performed (yes/no).

» If an incremental statistic calculation was not performed,
states the reason, the number of subcalculations (relevant
for incremental calculations only), and the complete
calculation time.

Basic
Troubleshooting

Monitors the calculation process.

If a specific query calculation takes a long time, check if it is a
full or incremental calculation:
» If full, check whether a full calculation is necessary.

» If incremental, check how many subcalculations have been
performed.

Incremental Splitter Log

The log name is cmdb.incremental.splitter.log.

Log File Description

Purpose Monitors the incremental splitter result made during an
incremental calculation.

Information Not available.

Level

Error Level

Not available.

Debug Level Gives the set of query node numbers of each query graph
created by the incremental splitter.

Basic If the TQL result calculated by the incremental calculator is

Troubleshooting | wrong, verify that the splitter result is correct.
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Incremental Detailed Log

The log name is cmdb.incremental.detailed.log.

Log File Description

Purpose Monitors the incremental calculation process.
Information Not available.

Level

Error Level

Not available.

Debug Level

Each incremental subcalculation entry includes the following:

» the trigger query node
» the number of elements classified to the trigger query node

» whether the subcalculation step is driven by new elements
added to the model or by existing elements

» the calculated query graph

Basic
Troubleshooting

Follows the basic steps of an incremental calculation.

® Topology Query Language User Interface

This section includes (in alphabetical order):

» Add/Edit Calculated Relationship Dialog Box on page 54

» Add/Edit Compound Relationship Dialog Box on page 56

» Add/Edit Join Relationship Dialog Box on page 60

» Add/Edit Relationship Dialog Box on page 63
» Add Related Query Node Wizard on page 65

» Add Triplet Dialog Box on page 73

» Element Instances Dialog Box on page 77

» Filter CI Instances Dialog Box on page 80

» Join Relationship Condition Dialog Box on page 82
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» Layout Settings Dialog Box on page 84

» Query Node/Relationship Properties Dialog Box on page 85
» Refine Query Node Type Dialog Box on page 96

» Select Relationship Type Dialog Box on page 97

» Subgraph Condition Definition Dialog Box on page 98

» Subgraph Definition Dialog Box on page 100

» User Preferences Dialog Box on page 102

@ Add/Edit Calculated Relationship Dialog Box

54

This dialog box enables you to define the connection between two query
nodes using a calculated relationship from the CI Type model.

To access To access in Enrichment Manager, Impact Analysis
Manager, and the Modeling Studio:

Right-click the required query node in the editing pane in
Enrichment Manager, Impact Analysis Manager, or the
Modeling Studio and select Add Calculated Relationship.

Note: If you are using Enrichment Manager, select Query
mode at the top of the editing pane to display the Add
Calculated Relationship option.

To access in Adapter Management in Data Flow

Management (DFM):

1 Select an adapter in the Resources pane.

2 In the Adapter Definition tab, click the Edit Input
Query ¢# button to the right of the Input Query box to
open the Input Query Editor.

3 Right-click the required query node and select Add

Calculated Relationship.
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Relevant tasks

"Define an Impact Rule — Workflow" on page 452
"Define an Enrichment Rule — Scenario" on page 523
"Define a TQL Query" on page 30

YyYVYVvYYy

"Implement a Discovery Adapter" in the RTSM
Developer Reference Guide

"Create a Pattern View" on page 359
"Create a Template" on page 360
"Create a Perspective" on page 362

See also

"Impact Modeling" on page 109

YY| YYVYYy

"CI Type Relationships" on page 478

User interface elements are described below (unlabeled elements are shown

in angle brackets):

Ul Element (A-Z)

Description

B Click Expand All to expand all the folders in the tree.
B Click Collapse All to collapse all the folders in the tree.
@ Tree View Click Tree View to select the display format of the

calculated relationship tree. The following options are
available:

» Display label

» Class name

» Legacy class name

<Calculated
relationship tree>

Select the calculated relationship that defines the
connection between two query nodes.

Relationship
Direction

The direction of the relationship that indicates which
query node is dependent on the other.

Relationship Name

The name of the calculated relationship.
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Ul Element (A-Z)

Description

Relationship
Restrictions

Select an option to define how to handle relationships
between identical query nodes or self relationships in the
query results. A self relationship is a relationship that
leads from a query node to itself.

Note: This list appears only when you select one query
node or two identical query nodes.

» Allow All Relationships. All relationships appear in the
query results.

» Allow Self Relationships Only. Only self-relationships (a
relationship that leads to itself) appear in the query
results.

» Allow Non Self Relationships Only. Self-relationships
do not appear in the query results.

@ Add/Edit Compound Relationship Dialog Box

This dialog box enables you to define the connection between two query
nodes using a compound relationship.

To access

To access in Enrichment Manager, Impact Analysis
Manager, and the Modeling Studio:

Right-click the required query nodes in the editing pane
in Enrichment Manager, Impact Analysis Manager, or the
Modeling Studio and select Add Compound Relationship.

Note: If you are using Enrichment Manager, select Query
mode at the top of the editing pane to display the Add
Compound Relationship option.

To access in Adapter Management in DFM:

1 Select an adapter in the Resources pane.

2 In the Adapter Definition tab, click the Edit Input
Query £# button to the right of the Input Query box to
open the Input Query Editor.

3 Right-click the required query node and select Add
Compound Relationship.
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Important
information

You can create as many compound definitions as
necessary.

Relevant tasks

>
>
>
>

"Define an Impact Rule — Workflow" on page 452
"Define an Enrichment Rule — Scenario" on page 523
"Define a TQL Query" on page 30

"Implement a Discovery Adapter" in the RTSM
Developer Reference Guide

"Create a Pattern View" on page 359

"Create a Template" on page 360

"Create a Perspective" on page 362

See also

YY| YYVYY

"Compound Relationship" on page 26

"Define a Compound Relationship — Scenario" on
page 33

User interface elements are described below:

Ul Element (A-Z)

Description

o

Add a compound definition.

In Impact Analysis Manager and Enrichment Manager, it
opens the Add Triplet dialog box. In the Modeling Studio,
it enters a default compound definition in the table. Click
the Edit buttons to edit the definition components.

Delete the selected compound definition.

Edit the selected compound definition.

In Impact Analysis Manager and Enrichment Manager, it
opens the Add Triplet dialog box. In the Modeling Studio,
it opens the Compound Relationship Condition
Definition dialog box.

Max steps

The longest path allowed between the two ClIs in the
RTSM to be included in the discovery process.

Default is: 5

Min steps

The shortest path allowed between the two ClIs in the
RTSM to be included in the discovery process.

Default is: 1
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Ul Element (A-Z)

Description

Relationship The relationship connecting the two query nodes.
Relationship The direction of the relationship that indicates which
Direction query node is dependent on the other.

Relationship Name

The name of the compound relationship.

Relationship
Restrictions

Select an option to define how to handle relationships
between identical query nodes or self relationships in the
query results. A self relationship is a relationship that
leads from a query node to itself.

Note: This list appears only when you select one query
node or two identical query nodes.

» Allow All Relationships. All relationships appear in the
query results.

» Allow Self Relationships only. Only self-relationships (a
relationship that leads to itself) appear in the query
results.

» Allow Non Self Relationships only. Self-relationships do
not appear in the query results.

Show full path
between source and
target Cls

If you select this option, then the query results display
the actual names of the relationships that link the CIs
and the full path between the source and target CIs.

Source

The required source query node.
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Ul Element (A-Z)

Description

Stop at first
compound level

Select this option if you want the system to stop looking
for TQL query results once it reaches the first target in the
path.

In the following sample compound link definition, Depth
is defined as 10 and Stop at first compound level is
selected.

The TQL query results include the Target 1, Target 3, and
Target 4 because they are all at level 1 (the first CI found
in the path). Target 2 is not included in the TQL results
because it is at level 2 (the second CI found in the path).

Target

The required target query node.

Visible

Select Visible to include query results relating to a join or
compound relationship. By default, Visible is selected.
When Visible is cleared, a box B appears to the left of the
relationship’s name in the editing pane, denoting that
any query results pertaining to the relationship are not
displayed in the topology map.

(

Mode

Virtual - Join

+———£El———¥

E

IpAddress
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@ Add/Edit Join Relationship Dialog Box

This dialog box enables you to define join relationships.

60

To access

To access in Enrichment Manager, Impact Analysis
Manager, and the Modeling Studio:

Right-click the required query nodes in the editing pane
in Enrichment Manager, Impact Analysis Manager, or the
Modeling Studio and select Add Join Relationship.

Note: If you are using Enrichment Manager, select Query
mode at the top of the editing pane to display the Add
Join Relationship option.

To access in Adapter Management in DFM:

1 Select an adapter in the Resources pane.

2 In the Adapter Definition tab, click the Edit Input
Query ¢# button to the right of the Input Query box to
open the Input Query Editor.

3 Right-click the required query node and select Add Join
Relationship.

Important
information

When you access the dialog box from the Modeling
Studio, you select the attributes and operator within the
dialog box itself. When you access the dialog box from
Impact Analysis Manager or Enrichment Manager, you
select the attributes and operator from the Join
Relationship Condition dialog box.

Relevant tasks

» "Define an Impact Rule - Workflow" on page 452
"Define an Enrichment Rule — Scenario" on page 523
"Define a TQL Query" on page 30

Yy vy

"Implement a Discovery Adapter" in the RTSM
Developer Reference Guide

"Create a Pattern View" on page 359
"Create a Template" on page 360
"Create a Perspective" on page 362

See also

"Join Relationship" on page 26

YY| YYVYYy

"Define a Join Relationship - Scenario" on page 36
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User interface elements are described below (unlabeled elements are shown
in angle brackets):

Ul Element (A-Z) Description

4k Define a join definition. In Impact Analysis Manager and
Enrichment Manager, it opens the Join Relationship
Condition dialog box. In the Modeling Studio, it adds the
selected attributes and operator to the list.

3¢ Delete the selected join definition.

& Edit the join definition. Opens the Join Relationship
Condition dialog box.
Note: This option is not relevant in the Modeling Studio.

<Query nodel Select an attribute for the <end_1> query node.

Attribute> box

Note: This option is only available in the Modeling
Studio.

<Query node2
Attribute> box

Select an attribute for the <end_2> query node.

Note: This option is only available in the Modeling
Studio.

<Selected query
nodel> column

A selected query node. The first attribute applies to
<end_1>.

<Selected query
node2> column

A selected query node. The second attribute applies to
<end_2>.

And

All join definitions are linked by the And operator.

Note: This is not relevant in the Modeling Studio.

Operator box

Select an operator. For details on the available operators,
see "Join Relationship Condition Dialog Box" on page 82.

Note: This option is only available in the Modeling
Studio.

Operator column

The operator selected in the Join Relationship Condition
dialog box. For details about operator definitions, see
"Attribute Operator Definitions" on page 45.

Relationship
Direction

The direction of the relationship that indicates which
query node is dependent on the other.
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Ul Element (A-Z)

Description

Relationship Name

The name of the join relationship.

Relationship
Restrictions

Select an option to define how to handle relationships
between identical query nodes or self relationships in the
query results. A self relationship is a relationship that
leads from a query node to itself.

Note: This list appears only when you select one query
node or two identical query nodes.

» Allow All Relationships. All relationships appear in the
query results.

» Allow Self Relationships only. Only self-relationships (a
relationship that leads to itself) appear in the query
results.

» Allow Non Self Relationships only. Self-relationships do
not appear in the query results.

Visible

Select Visible to include query results relating to a join or
compound relationship. By default, Visible is selected.
When Visible is cleared, an invisible box E appears to
the left of the of the relationship’s name in the editing
pane. Any query results pertaining to the relationship are
not displayed in the topology map.

(N

Mode

Wirtual - Jain

E

IpAddress
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@ Add/Edit Relationship Dialog Box

This dialog box enables you to define the connection between two query

nodes in a TQL query.

To access

To access in Enrichment Manager, Impact Analysis

Manager, and the Modeling Studio:

» Right-click the required query node in the editing pane
in Enrichment Manager, Impact Analysis Manager, or
the Modeling Studio and select Add Relationship.

or

» Click the Create Relationship {/» icon and draw a line
between the required query nodes. The Select
Relationship Type dialog box opens. Select Regular
Relationship.

Note: If you are using Enrichment Manager, select Query
mode at the top of the editing pane to display the Add
Relationship option.

To access in Adapter Management in DFM:

1 Select an adapter in the Resources pane.

2 In the Adapter Definition tab, click the Edit Input
Query 7 button to the right of the Input Query box to
open the Input Query Editor.

3 Right-click the required query node and select Add
Relationship.

Important
information

This option does not appear when two selected query
nodes (or a single selected query node) do not have a
valid relationship between them.

Relevant tasks

» "Define an Impact Rule - Workflow" on page 452

» "Define an Enrichment Rule — Scenario" on page 523

» "Define a TQL Query" on page 30

» "Implement a Discovery Adapter" in the RTSM
Developer Reference Guide

» "Create a Pattern View" on page 359

» "Create a Template" on page 360

» "Create a Perspective" on page 362
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User interface elements are described below (unlabeled elements are shown
in angle brackets):

Ul Element (A-Z) Description
B Click Expand All to expand all the folders in the
relationship tree.
B Click Collapse All to collapse all the folders in the
relationship tree.
@ Tree View Click Tree View to select the display format of the

relationship tree. The following options are available:
» Display label

» Class name

» Legacy class name

<Relationship tree>

Select the relationship that defines the connection
between two query nodes.

Relationship
Direction

The direction of the relationship that indicates which
query node is dependent on the other.

Relationship Name

The name of the relationship.

Relationship
Restrictions

Select an option to define how to handle relationships
between identical query nodes or self relationships in the
query results. A self relationship is a relationship that
leads from a query node to itself.

Note: This list appears only when you select one query
node or two identical query nodes.

» Allow All Relationships. All relationships appear in the
query results.

» Allow Self Relationships only. Only self-relationships (a
relationship that leads to itself) appear in the query
results.

» Allow Non Self Relationships only. Self-relationships do
not appear in the query results.
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% Add Related Query Node Wizard

This wizard enables you to build a TQL query.

To access

To access in Enrichment Manager, Impact Analysis
Manager, and the Modeling Studio:

In the editing pane, right-click the required query node
and select Add Related Query Node.

Note: If you are using Enrichment Manager, select Query
mode at the top of the editing pane to display the Add
Related Query Node option.

To access in Discovery Control Panel in DFM:

1 Select a job in the Discovery Modules pane.

2 Select a Trigger Query in the Properties tab. Click the
Open the Query Editor # button to open the Trigger
Query Editor.

3 Right-click the required query node and select Add
Related Query Node Wizard.

To access in Adapter Management in DFM:

1 Select an adapter in the Resources pane.

2 In the Adapter Definition tab, click the Edit Input
Query ¢# button to the right of the Input Query box
to open the Input Query Editor.

3 Right-click the required query node and select Add
Related Query Node Wizard.

Important
information

If the TQL query is empty, drag the required TQL query
nodes on to the editing pane from the tree displayed in
the CI Type Selector or the CI Types tab of the left pane.

Relevant tasks

» "Define an Impact Rule - Workflow" on page 452
"Define an Enrichment Rule — Scenario" on page 523
"Define a TQL Query" on page 30

Yyvyy

"Implement a Discovery Adapter" in the RTSM
Developer Reference Guide

» "Create a Pattern View" on page 359
» "Create a Template" on page 360
» "Create a Perspective" on page 362
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Wizard map The Add Related Query Node Wizard contains:
Related Query Node Type Page > Relationship Type Page >
Related Query Node Properties Page > Related Query
Node Instances Page

See also "Topology Query Language (TQL) Overview" on page 22

®, Related Query Node Type Page
This wizard page enables you to add a query node to the TQL query.

Important
information

If the TQL query is empty, drag the required TQL query
node on to the editing pane from the tree displayed in
the Configuration Item Types pane.

For general information on the Add Related Query Node
Wizard, see "Add Related Query Node Wizard" on
page 65.

Wizard map

The Add Related Query Node Wizard contains:

Related Query Node Type Page > Relationship Type
Page > Related Query Node Properties Page > Related
Query Node Instances Page

User interface elements are described below (unlabeled elements are shown

in angle brackets):

Ul Element (A-Z)

Description

B Click Expand All to expand all the folders in the tree.
B Click Collapse All to collapse all the folders in the tree.
@ Tree View Click Tree View to select the display format of the CI type

tree. The following options are available:
» Display label

» Class name

» Legacy class name

Note: This feature is only available in the Modeling
Studio.




Chapter 1 ¢ Topology Query Language

Ul Element (A-Z)

Description

<query node> is
required

Define the relationship cardinality. For details, see
"Cardinality Tab" on page 89.

» Select the <query node> is required check box for each
query node to include a minimum of one instance of
the query node at the other end of the relationship in
the query results. Selecting the check box gives the
relationship a cardinality value of 1..*.

» Clear the <query node> is required check box to give
the relationship a cardinality value of 0..*.

<TQL Query Node
hierarchy tree>

Select the required query node. The query node you select
appears in the Element name box.

This list only includes the query nodes of the CI type that
have valid relationships to the selected (source) query
node.

To the right of each query node, the number of CI
instances that exist in the RTSM for that CI type is
displayed. The number of instances is only updated after
you close the Add Related Query Node Wizard and open
it again.

Note: The first query node in the hierarchy tree is selected
by default.

Element name

(Optional) Contains the name of the selected query node.
By default, the CI type is assigned as the element’s name.

You can rename a TQL query node in the Element name
box giving it a unique label. This can be helpful when
there is more than one query node of the same CI type in
the TQL query.

Show only CITs with
instances

Select this check box to display only the CITs of which
there are instances in the RTSM. If this box is not
selected, the tree includes all CITs with a valid link to the
source query node.

Note: The Show only CITs with instances check box is
selected by default.
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® Relationship Type Page

This wizard page enables you to add a relationship to a TQL query.

Wizard map

The Add Related Query Node Wizard contains:

Related Query Node Type Page > Relationship Type Page
> Related Query Node Properties Page > Related Query
Node Instances Page

User interface elements are described below (unlabeled elements are shown

in angle brackets):

Ul Element (A-Z)

Description

@ Tree View Click Tree View to select the display format of the
= Relationship tree. The following options are available:
» Display label
» Class name
» Legacy class name
Note: This feature is only available in the Modeling
Studio.
<TQL Query Select the required relationship.
Relationship
hierarchy tree>
Relationship Select the required relationship direction. The direction
Direction indicates which query node is dependent on the other.

Relationship Name

The name of the relationship.

Note: This feature is only available in the Modeling
Studio.

Relationship
Restrictions

Select an option to define how to handle relationships
between identical query nodes or self relationships in the
query results. A self relationship is a relationship that
leads from a query node to itself.

Note: This feature is only available in the Modeling
Studio.
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Ul Element (A-Z) Description

Relationship Type A valid relationship that defines the connection between
the selected query nodes. The box displays the
relationship you selected in the relationship hierarchy
tree.

Note: This feature is only available in Enrichment
Manager and Impact Analysis Manager.

Show only Display only the relationships of which there are
relationships with instances in the RTSM. If this box is not selected, the tree
instances includes all valid relationships between the selected

query nodes.

®, Related Query Node Properties Page

This wizard page enables you to create an expression that restricts the
number of query nodes that appear in the query by adding an attribute
condition to a query node or relationship.

Important When you access the wizard from the Modeling Studio,
information this wizard page has two tabs: Attribute and Qualifier. The
Attribute tab includes the elements described below. For
details on the Qualifier tab, see "Qualifier Tab" on

page 92.

Wizard map The Add Related Query Node Wizard contains:

Related Query Node Type Page > Relationship Type Page >
Related Query Node Properties Page > Related Query
Node Instances Page

User interface elements are described below:

Ul Element (A-Z) Description

% Add an attribute condition.
3¢ Delete an attribute condition.
Y Move a selected row up.
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Ul Element (A-Z)

Description

v

Move a selected row down.

o

View the condition definition.

Advanced layout
settings

Opens the Layout Settings dialog box which enables you
to determine which attributes are used in the calculation
of the TQL query when querying the RTSM using third-
party or custom tools.

Note: This option is only relevant when accessing the
wizard from the Modeling Studio.

And/Or

Click inside the And/Or field and select either And or Or
to link multiple conditions.

Attribute name

Choose an attribute from the list.

() Brackets

Click inside the Brackets box to display a list of brackets
you can use to build more complex, logical statements.

Criteria

Contains the attribute condition definition as defined in
the Flement Instances Dialog Box.

Include subtypes

Display both the selected CI and its children in the
topology map.

NOT

Select NOT if you want the condition statement to do the
opposite of what is defined.

Note: If you select NOT, query results do not include data
from the CI instances that were not assigned a value. For
example, your system contains three nodes: Nodel is
assigned the value A, Node2 is assigned the value B and
Node3 is not assigned a value. You create a query to
retrieve all nodes that are equal to A and select NOT; the
results of your query only include Node2 because Node3
is not assigned a value.

Operator

Select the required operator. For details, see "Attribute
Operator Definitions" on page 45.
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Ul Element (A-Z)

Description

Value Enter or select the value of the attribute. The Value
options vary according to the attribute type you select.
Visible Select Visible to display the selected TQL query node in

the editing pane. When Visible is cleared, an invisible
box @ appears to the right of the selected TQL query
node in the editing pane.

m

Ipaddres,
ontainment

A% | tembership|
—— _ p
o

Windows @
ITETmEt

Any query results pertaining to that TQL query node are
not displayed in the topology map. This can be useful
when certain relationships or TQL query nodes are
required to build the query but are not needed in the
results. For example, Windows are connected to the
network by defining specific IP Addresses, but in any
query results you may want to view the IP Address
elements only and not the Windows elements.
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¥, Related Query Node Instances Page

This wizard page displays all the instances found for the selected TQL query
node in a table.

Important The columns displayed in the report vary according to
information the CI type selected.

By default, only columns corresponding to attributes that
have been defined with the Asset Data, Change
Monitored, and Comparable attribute qualifiers in the CI
Type Manager are displayed as columns in the dialog box.
For details, see "Attributes Page" on page 498.

If required, you can click the Display Hidden Columns
button to display the attributes that are defined as Visible
but not Static. For details on Static attributes, see
"Attributes Page" on page 498.

Note: For information on the elements included in the
Related Query Node Instances page, see "Element
Instances Dialog Box" on page 77.

Wizard map The Add Related Query Node Wizard contains:

Related Query Node Type Page > Relationship Type Page >
Related Query Node Properties Page > Related Query
Node Instances Page
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@ Add Triplet Dialog Box

This dialog box enables you to define the allowed steps in a path in the
topology graph leading from the source CI to the target CI when creating a
subgraph definition, a compound relationship, or a calculated relationship.

To access » In the Add Compound Relationship dialog box, click
the Add # button. For details, see "Add/Edit
Compound Relationship Dialog Box" on page 56.

» In the Subgraph Definition dialog box, click 4 Add.
For details, see "Subgraph Definition Dialog Box" on
page 100.

» In CI Type Manager, select Calculated Relationships
from the drop-down list in the CI Types pane. In the
editing pane, select the Triplets page and then click

&+ Add.
Important Select the query nodes and relationships to be included
information in the topology graph.

Important: The Condition fields are displayed only when
you access the Add Triplet dialog box from the Subgraph
Definition dialog box.

Relevant tasks » "Define an Impact Rule — Workflow" on page 452
"Define an Enrichment Rule — Scenario" on page 523
"Define a TQL Query" on page 30

Yy vy

"Implement a Discovery Adapter" in the RTSM
Developer Reference Guide

"Create a Pattern View" on page 359
"Create a Template" on page 360
"Create a Perspective" on page 362

See also "Compound Relationship" on page 26

YY| YYVYY

"Define a Compound Relationship — Scenario" on
page 33

» "Subgraph Definition" on page 28
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User interface elements are described below:

Ul Element (A-Z)

Description

&

Define attribute conditions for the source and target
query nodes you selected. When the Add Triplet dialog
box is opened from the Subgraph Definition dialog box,
it opens the Subgraph Condition Definition dialog box.
When the Add Triplet dialog box is opened from the Add
Compound Relationship dialog box, it opens the
Compound Relationship Condition Definition dialog
box.

The Condition button is enabled only after you select a
query node from the Source or Target lists.

Note: You cannot define attribute conditions for the
source and target query nodes in the CI Type Manager.

Relationship

Select an available relationship connecting the two query
nodes. The list of available relationships appears only
after defining both query nodes.

Relationship
Direction

Select the required direction. Setting different
relationship directions can achieve different query
results. For an example, see "Setting Different
Relationship Directions for Compound Definitions" on
page 75.

Note: The Relationship list remains empty until you have
selected a source and target.

Source

Select the required source query node.

Target

Select the required target query node.
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Setting Different Relationship Directions for Compound
Definitions

You can achieve different TQL results by setting different relationship
directions. For example, in your business world, as illustrated below, you

want to create a compound relationship that connects between a query
node of the CIT a and a query node of the CIT b. Depth is defined at 5 (for

details, see "Depth" on page 101).

al

ORONO
O © ©

In the Add Triplet dialog box, you can create compound definitions to link
query nodes a and b using different relationship directions.

gz;?npi;)i:;?\d Source Target Relationship RD?::zit?S:‘hip

#1 query node a | query node ¢ | <relationship> | source --> target
#2 query node ¢ | query node b | <relationship> | source --> target
#3 query node ¢ | query node b | <relationship> | source <-- target

» Compound definitions 1 and 2 result in the following query:

Compound definitions 1 and 2
ail o bl
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» Compound definitions 1 and 3 result in the following query:

Compound definitions 1 and 3
ail = b2

» Compound definitions 1, 2, and 3 result in the following query:
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@ Element Instances Dialog Box

This dialog box displays all of the CI instances found for the selected TQL
query node in a table.

To access To access in Enrichment Manager, Impact Analysis
Manager, and the Modeling Studio:

In the editing pane, right-click the required query node
and select Show Element Instances.

Note: If you are using Enrichment Manager, select Query
mode at the top of the editing pane to display the Show
Element Instances option.

To access in Adapter Management in DFM:

1 Select an adapter in the Resources pane.

2 In the Adapter Definition tab, click the Edit Input
Query £# button to the right of the Input Query box to
open the Input Query Editor.

3 Right-click the required query node and select Show
Element’s Instances.

To access in Integration Studio:

Create an integration point based on a discovery jython

adapter. In the Trigger CI Instance menu, choose Select

Existing CI.
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Important
information

The columns in the table display the attributes of the
selected CI type. The attributes displayed vary according
to the CI type selected.

By default, only columns corresponding to attributes that
have been defined with the Asset Data, Change
Monitored, and Comparable attribute qualifiers in the
CIT Manager are displayed as columns in the dialog box.
For details, see "Attributes Page" on page 498.

Relevant tasks

"Define an Impact Rule — Workflow" on page 452
"Define an Enrichment Rule — Scenario" on page 523
"Define a TQL Query" on page 30

"Create a Pattern View" on page 359

"Create a Template" on page 360

"Create a Perspective" on page 362

"How to Work with Population Jobs" in RTSM Data
Flow Management Guide

» "How to Work with Data Push Jobs" in RTSM Data Flow
Management Guide

YYYVYVYYVYY

User interface elements are described below (unlabeled elements are shown

in angle brackets):

Ul Element (A-Z)

Description

Specify the CIT you want displayed in the table. The table

Show Clinstances of. | Network *| also includes the children of the selected CIT.

=

Click to delete the selected CI.

e

Click Show CI Properties to open the Configuration Item
Properties dialog box for the selected CI.

=

Click to refresh the list of CI instances.

g

Filters the CI instances you want to display for the
selected query node. Opens the Filter CI Instances dialog
box.

[%]

Clears the filter definitions you created in the Filter CI
Instances dialog box.
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Ul Element (A-Z)

Description

Iy

Enables you to select the columns to be displayed. For
details, see "Select Columns Dialog Box" on page 570.

Enables you to set the sort order of the CI instances. For

= details, see "Sort Column Content Dialog Box" on
page 572.

Q Click Find to display the Find toolbar.

= Click Send Mail to send the table data in an email.

Choose the export format for the table data. The available
options are:

» Excel. The table data is formatted as an .xls (Excel) file
that can be displayed in a spreadsheet.

» PDF. The table data is exported in PDF format.

Note: When exporting to PDE, select a reasonable
number of columns to display to ensure that the report
is legible.

» CSV. The table data is formatted as a comma-separated
values (CSV) text file that can be displayed in a
spreadsheet.

Note: For the CSV formatted table data to display
correctly, the comma (,) must be defined as the list
separator. In Windows, to verify or modify the list
separator value, open Regional Options from the
Control Panel, and on the Numbers tab ensure that the
comma is defined as the List Separator value.

» XML. The table data is formatted as an XML file that
can be opened in a text or XML editor.
Tip: To extract HTML code from the report:
» Save the file as HTML
» Open the file in an HTML editor
» Copy the relevant table into the target file

Rows per
page

Select the number of rows to be displayed on each page.
You can also manually enter value for the number of rows

per page.
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Ul Element (A-Z)

Description

K Q[ 3of1e528 > P

Click to navigate through the results page by page or to
jump to the first or last page.

<Element Instances>

The CI instances found for the selected TQL query node.

You can double-click an instance to open the
Configuration Item Properties dialog box for that CI.

<Element instances
shortcut menu>

For details, see "IT Universe Manager Shortcut Menu" on
page 283.

Display Label

The name of the CI instance as it appears in the topology
map.

 Filter Cl Instances Dialog Box

This dialog box enables you to reduce the number of CI instances to be
displayed in a list by selecting a condition and a value for a specific CI.

To access

Click the Filter T button in the Element Instances
dialog box.

80




Chapter 1 ¢ Topology Query Language

Important
information

A description of the filter condition you defined appears
above the table columns in the Element Instances dialog
box. For example, the following illustration shows that a
filter condition was created to display only CI instances
whose CI type is Windows.

|Fi|ter: Cl Type[Eqgual nt]; I
Display Label | Cl Type
WNKPUKROT Winclows

Relevant tasks

"Define an Impact Rule — Workflow" on page 452
"Define an Enrichment Rule — Scenario" on page 523
"Define a TQL Query" on page 30

"Implement a Discovery Adapter" in the RTSM
Developer Reference Guide

YYVvYYy

» "Create a Pattern View" on page 359
» "Create a Template" on page 360
» "Create a Perspective" on page 362

User interface elements are described below:

Ul Element (A-Z)

Description

Attribute Displays all the attributes of the CI type to which the CI
belongs.

Condition Select the required operator. For details, see "Attribute
Operator Definitions" on page 45.

NOT Select to filter the results by the negation of a condition
and value.

Value Select or enter the required value.
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@ Join Relationship Condition Dialog Box

This dialog box enables you to define the connection between two query
nodes using a join relationship.

To access In Enrichment Manager or Impact Analysis Manager,
click the Add ™ button in the Add Join Relationship
dialog box.

Relevant tasks » "Define an Impact Rule - Workflow" on page 452

» "Define an Enrichment Rule — Scenario" on page 523

» "Define a TQL Query" on page 30

» "Implement a Discovery Adapter" in the RTSM
Developer Reference Guide.

User interface elements are described below (unlabeled elements are shown
in angle brackets):

Ul Element (A-Z) Description
<Selected query A selected query node. The first attribute applies to
nodel> <end_1>.
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Ul Element (A-Z)

Description

<Selected query
node2>

A selected query node. The second attribute applies to
<end_2>.

Operator

Select one of the following operators:

» Equal. The system checks whether two selected
attributes are equal.

» Not equal. The system checks whether two selected
attributes are not equal.

» Sub string. The system checks whether the value of the
first attribute is a substring of the value of the second
attribute.

» Sub string ignore case. The system checks whether the
value of the first attribute is a substring of the value of
the second attribute regardless of the string’s case.

Important: When using the operator Not equal, ensure

that both sides of the join relationship have a limited

result size. It is recommended to define more specific
conditions so as not to overload the system with large
results.
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@ Layout Settings Dialog Box

84

This dialog box enables you to determine which attributes are used in the
calculation of the TQL query when using the UCMDB API. For details, see
"RTSM (HP Universal CMDB) Web Service API" in the RTSM Developer

Reference Guide.

To access Click Advanced layout settings in the Query
Node/Relationship Properties dialog box.

Important Since this option is only relevant when querying the

information CMDB AP, the query results in the user interface are not

impacted by the attributes you select in this dialog box.

Relevant tasks

» "Define an Impact Rule — Workflow" on page 452

» "Define an Enrichment Rule — Scenario" on page 523

» "Define a TQL Query" on page 30

» "Implement a Discovery Adapter" in the RTSM
Developer Reference Guide

» "Create a Pattern View" on page 359

» "Create a Template" on page 360

» "Create a Perspective" on page 362

User interface elements are described below:

Ul Element (A-Z)

Description

Attribute name

The name of the attribute.

Calculate

Select this check box to include the attribute in the
query’s calculation.
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@ Query Node/Relationship Properties Dialog Box

This dialog box enables you to define the attribute conditions for the
selected TQL query node/relationship.

To access To access in Enrichment Manager, Impact Analysis
Manager, and the Modeling Studio:

In the editing pane, right-click the required query node
and select Query Node/Relationship Properties.

Note: If you are using Enrichment Manager, select Query
mode at the top of the editing pane to display the Query
Node Properties option.

To access in DFM:

1 To access from the Adapter Definition tab, select an
adapter. Click the Edit Input Query ;# button to the
right of the Input Query box to open the Input Query
Editor.

2 Right-click the required query node/relationship and
select Query Node Properties or Relationship
Properties.

Relevant tasks "Define an Impact Rule — Workflow" on page 452
"Define an Enrichment Rule - Scenario" on page 523

"Define a TQL Query" on page 30

YYVYYy

"Implement a Discovery Adapter" in the RTSM
Developer Reference Guide

» "Create a Pattern View" on page 359
» "Create a Template" on page 360
» "Create a Perspective" on page 362
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User interface elements are described below:

Ul Element (A-Z)

Description

Element name

(Optional) The Element name box contains the name of
the selected query node/relationship. By default, the CI
type is assigned as the element’s name. You can rename a
TQL query node in the Element name box giving it a
unique label. This can be helpful when there is more than
one query node of the same CI type in the TQL query.

Include subtypes

Select to display both the selected CI and its children in
the topology map.

Query Result Count

Click Query Result Count to display a topology map of
the TQL query showing the number of instances of each
query node/relationship.

Note: This feature is only available in the Modeling
Studio.

Visible

Select Visible to display the selected TQL query node in
the editing pane. When this option is cleared, an invisible
box B appears to the right of the selected TQL query
node in the editing pane.

m

IpAddres
ontainment

'ﬁ' Membership @
DA
Windows o
IFSTETEet

Any query results pertaining to that TQL query node are
not displayed in the topology map. This can be useful
when certain relationships or TQL query nodes are
required to build the query but are not needed in the
results. For example, Windows are connected to the IP
Subnet by defining specific IP Addresses, but in any query
results you may want to view the IP Address elements
only and not the Windows elements.
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Attribute Tab

This area enables you to create an expression defining conditions that
restrict the number of query nodes that appear in the query. You can add an
attribute condition to a query node or relationship and filter the query
results.

To access Click the Attribute tab in the Query Node/Relationship
Properties dialog box.

Relevant tasks » "Define an Impact Rule - Workflow" on page 452

» "Define an Enrichment Rule — Scenario" on page 523

» "Define a TQL Query" on page 30

» "Implement a Discovery Adapter" in the RTSM
Developer Reference Guide

» "Create a Pattern View" on page 359

» "Create a Template" on page 360

» "Create a Perspective" on page 362

User interface elements are described below:

Ul Element (A-Z) Description
4 Add the attribute condition you have defined.
3¢ Delete an attribute definition.

Move a selected row up.

Move a selected row down.

v
el Display the criteria in a popup dialog box.
Advanced layout Opens the Layout Settings dialog box which enables you
settings to determine which attributes are used in the calculation
of the TQL query when querying the RTSM using third-
party or custom tools.
And/Or Click inside the And/Or field and select either And or Or

to link multiple conditions.
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Ul Element (A-Z)

Description

Attribute name

Select an attribute from the drop-down list.

() Brackets

Click inside the Brackets box to display a list of brackets
you can use to build more complex, logical statements.

Criteria

Contains the attribute condition definition as defined in
the Element Instances dialog box.

Default Value

For parameterized attributes, enter a default value for the
parameter.

Not

Select NOT if you want the condition statement to do the
opposite of what is defined.

Note: If you select NOT, query results do not include data
from the CI instances that were not assigned a value. For
example, your system contains three nodes: Nodel is
assigned the value A, Node2 is assigned the value B and
Node3 is not assigned a value. You create a query to
retrieve all nodes that are equal to A and select NOT; the
results of your query only include Node2 because Node3
is not assigned a value.

Operator

Select the required operator. For details, see "Attribute
Operator Definitions" on page 45.

Parameterized

Select Yes to define a parameterized value for the
attribute. Select No to define a fixed value for the
attribute.

Note: This feature is only available in the Modeling
Studio.

Parameter Name

If you are defining a parameterized value for the
attribute, you must enter the parameter name.

Note: This feature is only available in the Modeling
Studio.

Value

Enter or select the value of the attribute. The Value
options vary according to the attribute type you select.

Note: You can paste a copied value into the window by
pressing CTRL+V on the keyboard.
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In this area, you can define a relationship cardinality, which enables you to
define how many CI instances you expect to have at the end of a
relationship in your query result.

To access Click the Cardinality tab in the Query Node Properties
dialog box.

Important Select the required relationship to which the selected

information query node is attached. Then define the lower and upper

limits for including the query node at the other end of
the relationship in the query results.

You can define relationship conditions that enable the
relationship’s connecting query node to be included in
the TQL query results by creating an expression defining
that condition. For an example, see "Example of a
Relationship Condition" on page 91.

Note: This tab only appears when a query node is
selected.

Relevant tasks

» "Define an Impact Rule — Workflow" on page 452

» "Define an Enrichment Rule — Scenario" on page 523

» "Define a TQL Query" on page 30

» "Implement a Discovery Adapter" in the RTSM
Developer Reference Guide

» "Create a Pattern View" on page 359

» "Create a Template" on page 360

» "Create a Perspective" on page 362

User interface elements are described below:

Ul Element (A-Z)

Description

4

Add the cardinality definition you have defined.

*®

Delete a cardinality definition from the Cardinality area.

Move a selected row up.
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Ul Element (A-Z) Description

Move a selected row down.

Display the criteria in a popup dialog box.

Inserts 1 in the Min box and * in the Max box.

Note: Only relevant for the Modeling Studio.

W

=

—
Inserts 0 in the Min box and * in the Max box.

Note: Only relevant for the Modeling Studio.

And/Or Click inside the And/Or field and select either And or Or
to link multiple conditions.

( ) Brackets Click inside the Brackets box to display a list of brackets
you can use to build more complex, logical statements.

Criteria Contains the cardinality condition definition as defined
in the Element Instances Dialog Box.

Max Enter the value that defines the upper limits for including
the query node at the other end of the relationship in the
query results.

Note: You can use an asterisk (*) in the Max box to
represent an infinite value.

Min Enter the value that defines the lower limits for including
the query node at the other end of the relationship in the
query results.

For example, if <end_1> is IpAddress and <end_2> is
Windows, entering 1 in the Min box and asterisk (*) in
the Max box instructs the system to retrieve only those IP
Addresses that are connected to at least one Windows
operating system. (The asterisk indicates an infinite
value.) Entering 3 in the Min box and asterisk (*) in the
Max box instructs the system to retrieve only those
Windows operating systems that are connected to at least
three IP Addresses.
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Ul Element (A-Z)

Description

Query Node Select the required relationship to which the selected
query node is attached. The list contains all the
relationships that are linked to the selected query node.

Not Select NOT if you want the condition statement to do the

opposite of what is defined.

Note: If you select NOT, query results do not include data
from the CI instances that were not assigned a value. For
example, your system contains three nodes: Nodel is
assigned the value A, Node2 is assigned the value B and
Node3 is not assigned a value. You create a query to
retrieve all nodes that are equal to A and select NOT; the
results of your query only include Node2 because Node3
is not assigned a value.

Example of a Relationship Condition
The example of relationship conditions is based on the following TQL

query:

i

IpAddres,
antainrnent

[L_| Membership @
= =

Mode B
IpSubnet
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In the Relationship Cardinality dialog box, the following relationship
conditions are defined for the query:

» Containment — Min: 2, Max: 4
» Membership - Min: 1, Max: *

Using the OR operator, the definitions appear in the Cardinality section, as
follows:

nor | ( | Criteria | ) | Andior
Containment (Mode, [pAddress) : 2.4 OR
Membership (IpSubnet, Mode) : 1.*

» [Containment (Node, IP Address)] OR [Membership (IP Subnet, Node)]
means that the node must either have between two and four IP Addresses
OR be a member of the IP Subnet.

Using the AND operator, the definitions appear in the Cardinality section, as
tfollows:

wor | ( | Criteria | ) | Angior
Containment (Mode, [pAddress) : 2.4 AND
Membership (IpSubnet, Node) : 1.*

» [Containment (Node, IP Address)] AND [Membership (IP Subnet, Node)]
means that the node must have between two and four IP Addresses AND
also be a member of the IP Subnet.

Qualifier Tab

This area enables you to define qualifier conditions for the selected query
node or relationship. For example, you can use a qualifier to define a CIT as
abstract, meaning you cannot create instances from it.

To access Click the Qualifier tab in the Query Node/Relationship
Properties dialog box.
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Important
information

By default, multiple selection links the conditions with
the OR operator.

Relevant tasks

» "Define an Impact Rule — Workflow" on page 452

» "Define an Enrichment Rule — Scenario" on page 523

» "Define a TQL Query" on page 30

» "Implement a Discovery Adapter" in the RTSM
Developer Reference Guide

» "Create a Pattern View" on page 359
» "Create a Template" on page 360
» "Create a Perspective" on page 362

User interface elements are described below:

Ul Element (A-Z)

Description

ABSTRACT_CLASS

You cannot create instances of this CIT.

ALLOW_VOLATILITY

Used to mark attributes that enable minor deviations
to their value. For example, there is probably no need
to report a small disk size change (from 8.00008 to
8.00009 GB).

By default, ALLOW_VOLATILITY is enabled for the
following numeric or date attributes only:
» CIT: Node
» MemorySize
» SwapMemorySize
These attributes also include comparable and static
qualifiers.
» CIT: Host
» HostLastBootTime
» CIT: CPU
» CpuClockSpeed
» CIT: Filesystem
» Disk_size
For details of this qualifier’s attributes and the

procedure for activating and deactivating this feature,
see "The ALLOW_VOLATILITY Qualifier" on page 28.
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Ul Element (A-Z)

Description

BDM_SCOPE

Indicates that the CI type is part of the BDM scope of
the class model.

BLE_LINK_CLASS

A relationship that has been assigned this qualifier is
loaded by an online BLE engine TQL and becomes
part of the Dashboard status calculations.

CALCULATED_LINK

This qualifier is assigned to calculated relationships

CONTAINER

This qualifier is assigned to relationships that signify a
containment relationship, such as Membership,
Composition, Containment.

HIDDEN_CLASS

Instances of this CIT do not appear anywhere in the
application.

ID_CLASS_NAME_OVER
RIDE

Indicates that the class ID is calculated based on
another class.

ITU_HIDDEN_CLASS

Instances of this CIT do not appear in the topology
map application.

MAJOR_APP

CI types that are assigned this qualifier appear in the
Application Breakdown overview report. For details,
see "Application Breakdown Report" on page 416.

MODELING_ENABLED

Enables a CIT to act as a model in Modeling Studio.
For details, see "Business CI Models" on page 346.

NETWORK_DEVICES

A qualifier common to all the CI types that represent a
network device. It can be used for TQL queries related
to network devices and serves as a replacement for CI
types in a query.

Negate Qualifiers

If this check box is selected, then the element is
included in the query results only if it has no qualifier
in the list of selected qualifiers.

PM_SUSPECT

Used by Problem Isolation to determine which CIs are
to be considered as suspects when isolating a problem.
For details, see "Problem Isolation" in Using Problem
Isolation.
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Ul Element (A-Z) Description

RANDOM_GENERATED_ | Indicates that the RTSM ID of the CIs is randomly
ID_CLASS generated rather than being based on the key
attributes of the class.

READ_ONLY_CLASS This CIT cannot be edited.

RECURSIVE_DELETE Relevant for relationships. When the CI at one end of
a relationship is deleted, the system checks the CI at
the other end of the relationship. If it is not related to
any other ClIs, it is also deleted.

TRACK_LINK_CHANGES | Changes that occur in the specified relationship
appear in Change reports.

Identity Tab

This area enables you to filter the TQL query results according to the
element ID of the instances found for the selected TQL query node.

To access Click the Identity tab in the Query Node Properties dialog
box.

Important Move the required element from the Optional identities

information pane on the left to the Selected identities pane on the

right to define what you want included in the TQL query
results using the left and right arrows.

Note: This tab only appears when a query node is
selected.

Relevant tasks » "Define an Impact Rule — Workflow" on page 452
"Define an Enrichment Rule — Scenario" on page 523
"Define a TQL Query" on page 30

Yy vy

"Implement a Discovery Adapter" in the RTSM
Developer Reference Guide

» "Create a Pattern View" on page 359
» "Create a Template" on page 360

» "Create a Perspective" on page 362
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The following elements are included (unlabeled elements are shown in
angle brackets):

Ul Element (A-Z) Description

<Toolbar> For descriptions of the toolbar buttons, see "Element
Instances Dialog Box" on page 77.

Optional identities Displays all the instances found for the selected TQL
pane query node.

Selected identities Displays the elements that are used to define what should
pane be included in the TQL query results.

® Refine Query Node Type Dialog Box

This dialog box enables you to change the CI type of a TQL query node after
you have created a TQL query.

To access In Impact Analysis Manager or Enrichment Manager, right-
click the required query node and select Refine Query Node

Type.
Note: If you are using Enrichment Manager, select Query

mode at the top of the editing pane to display the Refine
Query Node Type option.

Important You can change the CI type to a type from one of the CI
information type’s children, if one exists. If no such CI type exists, this
option does not appear.

Relevant tasks » "Define an Impact Rule — Workflow" on page 452

» "Define an Enrichment Rule — Scenario" on page 523

» "Define a TQL Query" on page 30

» "Implement a Discovery Adapter" in the RTSM Developer
Reference Guide

» "Create a Pattern View" on page 359

» "Create a Template" on page 360

» "Create a Perspective" on page 362
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User interface elements are described below (unlabeled elements are shown

in angle brackets):

Ul Element (A-Z)

Description

<List of Cl types from
which to choose>

Select the required CI type.

@ Select Relationship Type Dialog Box

This dialog box enables you to select the type of TQL relationship to be

created.

To access In the editing pane of Impact Analysis Manager,
Enrichment Manager, and the Modeling Studio, click the
Create Relationship {x button in the toolbar and draw a
line between two query nodes. The Select Relationship Type
dialog box opens automatically.

Important Select one of the following relationship types:

information

» Regular Relationship. For details, see "Add/Edit
Relationship Dialog Box" on page 63.

» Join Relationship. For details, see "Add/Edit Join
Relationship Dialog Box" on page 60.

» Compound Relationship. For details, see "Add/Edit
Compound Relationship Dialog Box" on page 56.

» Calculated Relationship. For details, see "Add/Edit
Calculated Relationship Dialog Box" on page 54.

Relevant tasks

"Define an Impact Rule — Workflow" on page 452
"Define an Enrichment Rule — Scenario" on page 523
"Define a TQL Query" on page 30

YYVYY

"Implement a Discovery Adapter" in the RTSM Developer
Reference Guide

» "Create a Pattern View" on page 359
» "Create a Template" on page 360
» "Create a Perspective" on page 362
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@ Subgraph Condition Definition Dialog Box

This dialog box enables you to create conditions that restrict the number of
query nodes that appear in the query.

To access In Impact Analysis Manager and Enrichment Manager,
click Condition ¢ in the Add Triplet dialog box.

In the Modeling Studio, click Condition £ in the
Subgraph Definition dialog box.

Important Contains the following tabs:

information » Attribute. Enables you to define attribute conditions

for query nodes and relationships. See a description of
the elements in the Attribute tab in the table below.

» Qualifiers. Enables you to define qualifier conditions
for the selected query node or relationship. For details,
see "Qualifier Tab" on page 92.

Relevant tasks "Define an Impact Rule — Workflow" on page 452
"Define an Enrichment Rule — Scenario" on page 523

"Define a TQL Query" on page 30

YYVYY

"Implement a Discovery Adapter" in the RTSM
Developer Reference Guide

» "Create a Pattern View" on page 359
» "Create a Template" on page 360
» "Create a Perspective" on page 362

User interface elements are described below:

Ul Element (A-Z) Description
s Add the subgraph condition definition.
3¢ Delete the subgraph condition definition.

Move a selected row up.

I Move a selected row down.
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Ul Element (A-Z)

Description

Q

View the subgraph condition definition.

Advanced layout
settings

Opens the Layout Settings dialog box which enables you
to determine which attributes are used in the calculation
when querying the RTSM using third-party or custom
tools.

Note: This option is only relevant when accessing the
dialog box from the Modeling Studio.

And/Or

Click inside the And/Or field and select either And or Or
to link multiple conditions.

Attribute name

Choose an attribute from the list.

() Brackets

Click inside the Brackets box to display a list of brackets
you can use to build more complex, logical statements.

Criteria

Contains the attribute condition definition as defined in
the Element Instances Dialog Box.

Element Name

Contains the CIT selected from the Source and Target
lists.

Not

Select NOT if you want the condition statement to do the
opposite of what is defined.

Note: If you select NOT, query results do not include data
from the CI instances that were not assigned a value. For
example, let us assume that your system contains three
nodes. Nodel is assigned the value A, Node2 is assigned
the value B and Node3 is not assigned a value. If you
create a query in which you want to retrieve all nodes
that are equal to A and you select NOT, the results of your
query only include Node2 because Node3 is not assigned
a value.

Operator

Select the required operator. For details, see "Attribute
Operator Definitions" on page 45.

Value

Enter or select the value of the attribute. The Value
options vary according to the attribute type you select.
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@ Subgraph Definition Dialog Box

This dialog box enables you to create a graph that represents additional TQL
query data related to a specific CI.

To access To access in Enrichment Manager, Impact Analysis
Manager, and the Modeling Studio:

In the editing pane, right-click the required query node
and select Subgraph Definition.

Note: If you are using Enrichment Manager, select Query

mode at the top of the editing pane to display the

Subgraph Definition option.

To access in Adapter Management in DFM:

1 Select an adapter in the Resources pane.

2 In the Adapter Definition tab, click the Edit Input
Query ¢* button to the right of the Input Query box
to open the Input Query Editor.

3 Right-click the required query node and select
Subgraph Definition.

Important The following icon is displayed next to the query node
information for which you define a subgraph:

AL

£

E

Relevant tasks "Define an Impact Rule — Workflow" on page 452
"Define an Enrichment Rule — Scenario" on page 523

"Define a TQL Query" on page 30

YyYvYyYYVvYYy

"Implement a Discovery Adapter" in the RTSM
Developer Reference Guide

"Create a Pattern View" on page 359
"Create a Template" on page 360
"Create a Perspective" on page 362

See also "Subgraph Definition" on page 28

YY|YYVYY

"Create a Subgraph Definition - Scenario" on page 38
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User interface elements are described below:

Ul Element (A-Z)

Description

4

Add a subgraph definition. In Enrichment Manager and
Impact Analysis Manager, click to open the Add Triplet
dialog box. In the Modeling Studio, click to add a row to
the table.

Delete a subgraph definition.

Edit a subgraph definition. In Impact Analysis Manager
and Enrichment Manager, click to open the Edit Triplet
dialog box. In the Modeling Studio, click to open the
Subgraph Condition Definition dialog box.

Depth

A number that represents the longest path (that is, the
maximum connecting query nodes) allowed between two
CIs in the RTSM that should be included in the DFM
process.

Default: 5

Element condition
exists

A green asterisk appears next to either the source,
relationship, or target in the subgraph definition if an
attribute condition has been defined for one of them in
the Subgraph Condition Definition dialog box. For
details, see "Subgraph Condition Definition Dialog Box"
on page 98.

Relationship The relationship selected connecting the source to the
target query node.

Relationship The direction of the relationship selected, indicating

Direction which query node is dependent on the other.

Source The required source query node selected.

Target The required target query node selected.
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@ User Preferences Dialog Box

This dialog box enables you to reset system preferences.

To access Select Tools > User Preferences or click the Configure
User Preferences [5! button in the Status Bar.

Important All the preferences you select (such as whether to display
information certain wizard pages or warning message preferences) are
stored in the system. This dialog box enables you to reset
those preferences.

User interface elements are described below (unlabeled elements are shown
in angle brackets):

Ul Element (A-Z) Description

<Left pane> Select the preferences page to edit. The following options
are available:

» Wizard Preferences. Enables you to define whether to
hide or display certain wizard pages.

» Optional Messages Preferences. Enables you to define
whether to hide or display certain messages.

» Discovery Preferences. Enables you to define:

» Whether to hide or display certain Discovery
warning messages

» The required default external editor (such as
Notepad)

» Whether to use Basic or Advanced Discovery mode
» General. Enables you to define general application

preferences.
<Preferences list> The list of warning messages and their user-selected
preferences.
Filter by Enter a search word to filter the list of options.
Reset All Click to reset all the preferences to their default values.
Reset Page Click to reset the selected preference to its default value.
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Q, Troubleshooting and Limitations

This section describes troubleshooting and limitations for Topology Query
Language.

For TQL queries to be valid, they must comply with certain restrictions.
This section includes the following topics:

» "Understanding Validation Restrictions" on page 103
> "Impact Analysis TQL Query Validation" on page 105
» "Enrichment TQL Query Validation" on page 106

Understanding Validation Restrictions

For Impact Analysis, Discovery, and Enrichment TQL query types to be
valid, they must comply with the following restrictions:

> Unique Names. TQL query elements must have unique names.

> Self Relationships. A TQL query must not contain self relationships, that
is, a relationship must not lead from a query node to itself, as the
following example illustrates:

Route

_ Containment i—4_|
é.—»@

IpAddress
Maode
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» Cyclic Graph. The TQL query structure cannot be a closed circle, as shown
in the following example:

=

ode
Wanaoed Relationship
Containment
i @
IpAddress Conﬂgurationltem
Membership
oute

InAddress_1

> Separate Query Nodes and Groups. All the TQL query nodes must be
linked to one another, that is, the TQL query cannot contain separate
query nodes or groups, as the following example illustrates:

= =

M Huoce
Containment Cump!JSmun
i
¥
e _\U/_
i T_J:J
ATM Port Bridge
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Impact Analysis TQL Query Validation

Impact Analysis TQL queries must also comply with the following
restrictions:

» Number of query nodes. An Impact Analysis TQL query must consist of at
least two query nodes.

» Trigger and affected query nodes must be connected. There must be a
path of relationships from the triggered query node to the affected query
nodes.

> Selecting query nodes to function as Impact Analysis triggers. When
selecting query nodes to function as Impact Analysis triggers, the query
nodes must comply with the following restrictions:

» You can select more than one query node as a trigger. However, you
cannot define a query node both as affected and as a trigger.

» If a query node has a relationship whose minimum limit is O (meaning
that one of its ends does not necessarily have a query node linked to
it), the query node that is linked to its other end cannot be a root cause
query node (because it may or may not exist in the TQL query). For
details about minimum limits, see "Cardinality Tab" on page 89. For
example, Configuration Item cannot be either a root cause or affected
query node because it is connected to the query node with a Min limit

of 0.
Cardinality: Containment (Mocde, [pAddress): 1.* AND
[ | Composttion (Node, Configurationttern) : 0.
o
-7 Node
" il .
.—/ )
Lt tainment
Lo
Coriposition ) )
& A
Configurationitern IpAddrass
Cardinality: Composition (Node, Configurationttem) : 1.4 Cardinality: Containment (Node, [pAddress) 0 1.*
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Note: A query node that is not visible cannot be a root cause or an
affected query node.

» The connection between trigger and affected query nodes. The trigger
query node and affected query nodes you define must be connected by a
path of relationships from the triggered query node to the affected query
nodes.

Enrichment TQL Query Validation

Enrichment TQL queries must comply with the following restriction:

> Required elements. You cannot perform Enrichment on a non-required
query node, that is, a query node that does not necessarily appear in the
TQL query results.

Example 1. In this example, the TQL query results can be either A and B
or A and C. Therefore, you cannot add an Enrichment query node to
query nodes B or C because they are not required elements. You can add
an Enrichment query node to query node A because it always appears in
the TQL query results. For details on how to add Enrichment query nodes
and relationships, see "Add Enrichment Query Nodes and Relationships
to an Enrichment TQL Query" on page 528.

,ténril:hrnent relationship
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Example 2. In this example, both A and B are required elements that
always appear in the TQL query results. Only C is not a required element
because it has a cardinality of 0. Therefore, you cannot add an

Enrichment query node to it.

)
Enrichment relationstip
A
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Impact Modeling

This chapter includes:

Concepts

» Impact Modeling Overview on page 110

» Impact Layer on page 111

» Impact Rules on page 111

» Propagation Reversal on page 113

» Calculated Relationship Types on page 114

» Creating Views Based on the Impact Model on page 115
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Concepts

& Impact Modeling Overview

110

The impact model enables you to determine the direction of the
propagation of the IT infrastructure Cls in your business world. The
direction of the impact is not always the same direction as the physical
relationships taken from the CI Type model.

The impact model uses the impact layer to change the propagation
direction. The impact layer is used in the applications where propagation
occurs. You change the direction of the impact using the impact layer,
regardless of the direction of the physical relationships.

All KPI propagation is affected by the impact model. For details on KPI
propagation in Service Health, see "Propagation Rules" in Using Service
Health. For details on KPI propagation in Service Level Management, see
"Propagation Rules" in Using Service Level Management.
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& Impact Layer

The impact layer changes the direction of the impact. The impact layer
separates the impact direction from the CI Type model, creating an
independent layer on top of the CI Type model. This means that
components affected by the impact model are no longer relying on the
physical relationships as defined in the CI Type model. As a result, the
impact direction is no longer necessarily identical to the direction of the
physical relationships in the CI Type model.

& Impact Rules

The impact layer consists of impact rules. The impact rules are defined in
the CI Type Manager. For details, see "Triplets Page" on page 503.

An impact rule is defined by one or more triplets. Each triplet is defined by
the following components:

» One source CI type
» One target CI type

> A physical relationship type (for example, Containment) that links the
two CI types

» The required impact direction. The direction of the impact can be
identical to or opposite from the direction of the physical relationship
between the source and target Cls.

HP Business Service Management implements the impact layer by creating
calculated relationships that are defined by impact rules. Once one of the
triplets fulfills the impact rule condition, HP Business Service Management
automatically creates the calculated relationship based on the triplet
definition.

Since calculated relationships are defined by physical relationships from
within the class model, their lifetime is determined by the lifetime of the
physical relationships defined in the impact rule. When the physical
relationship in the class model is removed, the corresponding calculated
relationship is removed from all view results as well.

111



Chapter 2 « Impact Modeling

112

Note: If you create a new CI type or relationship in the CI Type Manager,
you need to define the required triplets. For example, to enable the impact
model to properly affect KPI propagation. If the triplets are not defined, the
required KPIs are not included in the Dashboard views and SLA agreements.

You can use calculated relationships to create TQL queries just like any other
relationship in the CI Type model. This enables you to base Enrichment
rules, Impact rules, and views on calculated relationships. Calculated
relationships affect the results of all TQLs that use that calculated
relationships since calculated relationships are part of the class model.

Example of an Impact Rule Definition:

@;a Web Service Link: \'_'-,") Running Software =



Chapter 2 ¢ Impact Modeling

& Propagation Reversal
The following example illustrates a scenario in which propagation is

reversed.

Business
Element 1

i {Calculated relationship -
Caontainment ‘same direction as physical

e

Calculated relationship —

S::,';ﬁz T~ same direction as physical S
Rl Containment
e Calculated
relationship —
. direction opposite
Containment Running 1o physTczal

Software

Monitored By

Based on the impact rules defined in the CI Type Manager, the impact is
propagating from the Business2 CI to Business1, the same direction as the
physical relationship that is connecting the Running Software CI to

Business2.
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According to the direction of the physical relationship between the Running
Software CI and the Node, the Running Software CI should impact the
Node.

But based on the following impact rule, a calculated relationship is
automatically created and HP Business Service Management reverses the
impact of the propagation.

B Node Link {7% PunningSoftware =

The impact is now propagated from the Node to the Running Software.

& Calculated Relationship Types

114

There is one out-of-the-box calculated relationship called Impacted By.
Impacted By contains two subtypes, each one representing a different type
of dependency relationship (complete dependency vs. potential
dependency.)

> Impacted by (Directly). Represents the fact that one CI that is linked to
another CI using an Impacted By (Directly) relationship is part of that CI.
You use an Impacted By (Directly) relationship for those ClIs that you
want to see in your model. The ownership of the two CIs may be the
same, but this is not always the case.

> Impacted By (Potentially). Represents the fact that one CI consumes the
products of another. Cls that are linked by an Impacted By (Potentially)
relationship are not part of that model, but are listed as related CIs. For
details, see "Model Editor" on page 396.
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& Creating Views Based on the Impact Model

As a best practice, you should use Modeling Studio to create a view of
calculated relationships based on a model. Modeling Studio enables you to
create perspective based views that use calculated relationships instead of
physical relationships. For details, see "Modeling Studio" on page 335.

For details on how to create and edit models, see "Model Editor" on
page 396.

Note: For an in-depth description of the Impact Modeling Solution, see
"Best Practices for Modeling" on page 215.
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Create a URL for a Direct Link

This chapter includes:

Concepts

> Generate a Direct Link — Overview on page 118

Tasks

» Generate a Direct Link — Scenario on page 120

» Create a Direct Link to a Template with Parameter Values on page 120

» Encrypt the Password of a Direct Link Using the JMX Console
on page 122

Reference

» Generate a Direct Link User Interface on page 123
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Concepts

& Generate a Direct Link — Overview

Direct Links enables you to create a URL that guides another user to a
specific target view or CI in HP Business Service Management.

You can create a URL that:

» Opens a specific HP Business Service Management view or CI directly
in HP Business Service Management. This enables users to retrieve
information from HP Business Service Management without being
located in the HP Business Service Management context.

Note: To open a specific view or CI directly in HP Business Service
Management, use the Open in context links option. For details, see
"Select Command Page" on page 125.

» Enables integration with HP Business Service Management:

» If you create a URL using the Embedded links option, the URL takes
you first to the HP Business Service Management login page. After
you enter your login name and password, the target page opens in
your browser.

Note: To open the target page in your browser, use the Embedded
links option. For details, see "Select Command Page" on page 125.

When you create a URL, you can:

» Send the URL to an email recipient

» Copy the URL to the clipboard
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» Test the URL to ensure that the target application page can be found

The user to whom you are sending the URL must have an account with
sufficient privileges to open the target page. You must apply the appropriate
viewing and editing permissions to the users and user groups that want to
access the target view. You set permissions in Admin > Platform > Users and
Permissions, select a user or a group and select Permissions. For details, see
"How to Assign Permissions" in Platform Administration.

Note: You can use Link to this Page function to open a target HP Business
Service Management page in your browser. While the Link to this Page
function enables you to access another application page in HP Business
Service Management, it does not enable you to access a specific CI or view.
For details, see "Linking to a Specific Page" in Platform Administration.
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Tasks

T Generate a Direct Link - Scenario

P Create
Values

120

This scenario describes how to generate a direct link to email the URL of a
specific CI to another person.

Jane Harrison is a senior engineer in the ABC Software company. She has
encountered a problematic Cl in a view she has created. She wants to inform
Henry Jones, who is working with the same view through HP ServiceCenter,
about the problematic CI. Since the view Jane has created contains many
hundreds of CIs, she decides to email Henry the URL of the CI so that he
does not have to spend a lot of time searching for that specific CI.

In IT Universe Manager, Jane selects Generate Direct Link from the Edit
menu. In the Select Command page, she selects Open in context links and
then the Show view option, and clicks Next.

In the Direct Link Parameters — Show View page, she selects the view she
created, the problematic CI, and View topology as the mode in which Henry
should open the CI. When the URL is created, she emails Henry the link to
the problematic CI.

For details, see "Generate Direct Link Wizard" on page 124.

a Direct Link to a Template with Parameter

This task describes how to create a direct link to a template by including the
parameter values in the URL.

This task includes the following steps:

» "Create a Direct Link to a Template" on page 121
» "Edit the URL" on page 121
» "Paste the URL into a Browser" on page 122
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1 Create a Direct Link to a Template

In IT Universe Manager, select Edit > Generate Direct Link to run the
Generate Direct Link wizard. On the Select Command page, select
Embedded links. Select Show view topology from the list of options. On
the Direct Link Parameters page, select the required template from the
drop-down list.

2 Edit the URL

When the wizard finishes, click Copy URL and paste the URL into a text
editor such as Notepad.

Append the following text to the end of the URL:

&params=[parameter1=value1,parameter2=value2]

where parameter1 and parameter2 are the parameter names for the
selected template and value1 and value2 are the values you want to enter
for the parameters.

Note: Any special characters must be entered using the URL encoding. In
the above example, the URL encoding for the [ character is %5B, the URL
encoding for the ] character is %5D, and the URL encoding for the comma
is %2C. Thus, the actual text to enter is:

&params=%>5Bparameter1=value1%2Cparameter2=value2%5D

121



Chapter 3 ¢ Create a URL for a Direct Link

3 Paste the URL into a Browser

Paste the URL into a browser. HP Business Service Management opens to
the selected template with the parameters assigned the specified values.

T Encrypt the Password of a Direct Link Using the JMX

Console

122

This task describes how to encrypt the password contained within a direct
link using the JMX console.

To encrypt the password of a direct link using the JMX console:

1 Launch your Web browser and enter the following address:
http://<server_name>:<port number>/jmx-console, where
<server_name> is the name of the machine on which HP Universal
CMDB is installed.

2 Under UCMDB-UI, locate UCMDB Integration.
3 Under encryptString, enter your password in the Value box.

4 Click Invoke to view the encrypted string.
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Reference

® Generate a Direct Link User Interface

This section includes (in alphabetical order):
» Generate Direct Link Dialog Box on page 123
» Generate Direct Link Wizard on page 124

® Generate Direct Link Dialog Box

This dialog box enables you to create a URL to send to users so that they can
access HP Business Service Management.

To access From the Admin > RTSM Administration > Modeling
main menu, select Edit > Generate Direct Link. After you
configure the Direct Link parameters in the "Generate
Direct Link Wizard" on page 124, click Finish in the
Finish page.

Alternatively, click the Generate Direct Link to View ==
button in the CI Selector toolbar in IT Universe Manager.

Relevant tasks "Generate a Direct Link — Scenario" on page 120
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User interface elements are described below:

Ul Element (A-Z) Description

Advanced Enables you to build a direct link and choose specific
elements such as views or CIs, for the end user to access.
For details, see "Generate Direct Link Wizard" on

page 124.

Note: This feature is only relevant when accessing the
Generate Direct Link dialog box from the CI Selector
toolbar in IT Universe Manager.

Copy URL Copies the URL to the clipboard.

Description Describes the parameters that are included in the URL.
For details on selecting the parameters, see "Select
Command Page" on page 125.

Link URL The created URL that accesses the specified HP Business
Service Management function.

Mail URL Opens an email containing the URL of the link.

Test URL Checks the URL to ensure that the specified application

page can be found.

® Generate Direct Link Wizard

This wizard enables you to create a URL that guides another user to a specific
target view or CI in HP Business Service Management.

To access From the Admin > RTSM Administration > Modeling
main menu, select Edit > Generate Direct Link.

Important By default, this wizard is set to display a Welcome page.

information You can choose not to display the Welcome page by

selecting the Do not show this page again check box.
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Relevant tasks

"Generate a Direct Link — Scenario" on page 120

Wizard map

The Generate Direct Link wizard contains:

Select Command Page (<Open in context links options>
and <Embedded links options>) > Finish Page

® select Command Page

This wizard page enables you to select the required parameters that must be

added to the URL.

You can create two types of links:

» Open in context links. Creates a URL that opens a specific view or CI
directly in HP Business Service Management without having to be in the
HP Business Service Management context:

> Embedded links. Creates a URL that enables you to embed an RTSM
applet into external applications.

Important By default, this wizard is set to display a Welcome page.
information You can choose not to display the Welcome page by
selecting the Do not show this page again check box.
Wizard map The Generate Direct Link wizard contains:
Select Command Page (<Open in context links options>
and <Embedded links options>) > Finish Page
See also "Generate Direct Link Wizard" on page 124
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User interface elements are described below (unlabeled elements are shown
in angle brackets):

Ul Element (A-Z) Description
<Left pane> A graphic illustration of the selected command.
Cll Grid Creates a URL that displays all the CI instances found in

the RTSM for a selected CI type and its children. For
details, see "Direct Link Parameters — CII Grid Page" on
page 131.

Note: Available when you select the Embedded links
option.

Cl Selector Creates a URL that embeds the CI Selector displaying the
ClIs of a selected view, into external applications. For
details, see "Direct Link Parameters — CI Selector Page" on

page 129.
Note: Available when you select the Embedded links
option.

Cl Type Selector Creates a URL that embeds the CI type selector into

external applications. For details, see "Direct Link
Parameters — CI Type Selector Page" on page 129.

Note: Available when you select the Embedded links

option.
Description A description of the selected command.
Impact Map Creates a URL that embeds an impact map into an

external application. For details, see "Direct Link
Parameters — Impact Map Page" on page 132.

Note: Available when you select the Embedded links
option.

Model Editor Creates a URL that embeds the Model Editor into an
external application, highlighting the selected ClIs in the
CI Selector in the Model Editor. For details, see "Direct
Link Parameters — Model Editor" on page 133.

Note: Available when you select the Embedded links
option.
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Ul Element (A-Z)

Description

Query Editor

Creates a URL that embeds the Model Editor into an
external application, displaying the selected TQL query.
For details, see "Direct Link Parameters — Query Editor" on
page 134.

Note: Available when you select the Embedded links
option.

Related Cls

Creates a URL that opens a topology map displaying the
selected CI and its immediate neighbors within the
selected view. For details, see "Direct Link Parameters —
Related CIs Page" on page 135.

Note: Available when you select the Embedded links
option.

Report Viewer

Creates a URL that opens a specific report. For details, see
"Direct Link Parameters — Report Viewer Page" on
page 136.

Note: Available when you select the Embedded links
option.

Report Viewer -
Saved Report

Creates a URL that opens a saved topology or custom
report. For details, see "Direct Link Parameters — Report
Viewer — Saved Report Page" on page 136.

Note: Available when you select the Embedded links
option.

Show CI properties

Creates a URL that displays a CI’s properties. For details,
see "Direct Link Parameters — Show CI Properties Page" on
page 137.

Note: Available when you select the Embedded links
option.

Show view

Creates a URL that displays the selected view and
optionally preselects a query node in it. For details, see
"Direct Link Parameters — Show View Page" on page 140.

Note: Available when you select the Open in context links
option.
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Ul Element (A-Z)

Description

Show view topology

Creates a URL that displays the topology map of the
selected view and embeds it in an external application.
For details, see "Direct Link Parameters — Show View
Topology Page" on page 138.

Note: Available when you select the Embedded links
option.

Start in mode

Creates a URL that opens HP Business Service
Management at the selected page. For details, see "Direct
Link Parameters — Start in Mode Page" on page 141.

Note: Available when you select the Open in context links
option.

Steps

The current step in the procedure.

View Editor

Creates a URL that opens a specific view in the Pattern
View Editor in Modeling Studio. For details, see "Direct
Link Parameters — View Editor Page" on page 138.

Note: Available when you select the Embedded links
option.

Views Selector

Creates a URL that embeds the View Selector in an
external application, enabling you to select and display a
view in that application. For details, see "Direct Link
Parameters — Views Selector Page" on page 139.

Note: Available when you select the Embedded links
option.
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. Direct Link Parameters - Cl Selector Page

This wizard page enables you to create a URL that embeds the CI Selector
displaying the ClIs of a selected view, into external applications.

Wizard map Select Command Page (Embedded links > CI Selector) >
Finish Page
Important » For general information about the Generate Direct
information Link wizard, see "Generate Direct Link Wizard" on
page 124.

» Click Finish to close the wizard and create a URL. For
details, see "Generate Direct Link Dialog Box" on
page 123.

User interface elements are described below:

Ul Element (A-Z) Description

Allow multi selection | Allow single or multiple selection of ClIs.

Selected view Select the required view from which you want to select
the required ClIs.

» Click [=2] to open the View Selector dialog box. Select
the view you want to appear in the CI Selector.

» Click 3£ to delete the selected view.

. Direct Link Parameters - Cl Type Selector Page

This wizard page enables you to create a URL to a hierarchical tree or list of
selected CI types, which can be embedded into an external application.

Important » For general information about the Generate Direct
information Link wizard, see "Generate Direct Link Wizard" on
page 124.

» Click Finish to close the wizard and create a URL. For
details, see "Generate Direct Link Dialog Box" on
page 123.

Wizard map Select Command Page (Embedded links > CI Type
selector) > Finish Page
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User interface elements are described below:

Ul Element (A-Z)

Description

Cl type selector
mode

View the selected CI types in either a hierarchical tree or
list.

Invisible CITs (tree
only)

Select the CI types you do not want to appear in the tree.

» Click &” to open the CI Type Selector dialog box.
Select the CI types you want to appear in the tree.

» Click & to delete the selected CI types.

Root CI Type (tree
only)

Select the CI type you want to use as the root CI type in a
hierarchical tree.

» Click " to open the CI Type Selector dialog box.
Select the CI type you want to use as the root CI type
in the tree.

» Click £ to delete the selected CI type. The default is
Configuration Item.

Selection mode

Allow single or multiple selection of CI types.

Unselectable CITs
(tree only)

Select the CI types which cannot be selected in the tree.

» Click &” to open the CI Type Selector dialog box.
Select the CI types which cannot be selected in the
tree.

» Click & to delete the selected CI types.

Visible CITs (list only)

Select the CI types which you want to appear in the CI
type list.

» Click &” to open the CI Type Selector dialog box.
Select the CI types which you want to appear in the CI
type list.

» Click & to delete the selected CI types.

Note: If you choose to view the CITs in a list, then you
are required to select at least one CI type.
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., Direct Link Parameters - Cll Grid Page

This wizard page enables you to display all of the CI instances found in the
RTSM for selected CI type, and its children.

Important » For general information about the Generate Direct
information Link wizard, see "Generate Direct Link Wizard" on
page 124.

» Click Finish to close the wizard and create a URL. For
details, see "Generate Direct Link Dialog Box" on
page 123.

Wizard map Select Command Page (Embedded links > CII Grid) >
Finish Page

See also "Element Instances Dialog Box" on page 77

User interface elements are described below:

Ul Element (A-Z) Description

Class type Select the required CI type.

» Click | ==« to select the required CI type.
» Click 3£ to clear the box.
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. Direct Link Parameters - Impact Map Page

This wizard page enables you to run an Impact Analysis rule defined in
Impact Analysis Manager. The URL you create enables you to embed a
topology map showing a simulation of all the CIs that are affected by the
selected trigger CI for the selected severity and state. For details, see "Run
Impact Analysis Dialog Box" on page 294.

Important » For general information about the Generate Direct
information Link wizard, see "Generate Direct Link Wizard" on
page 124.

» Click Finish to close the wizard and create a URL. For
details, see "Generate Direct Link Dialog Box" on
page 123.

Wizard map Select Command Page (Embedded links > Impact map)
> Finish Page

See also "IT Universe Manager" on page 227

User interface elements are described below:

Ul Element (A-Z) Description

Filter by Cl types Select the CI types you do not want to appear in the
impact analysis results.

» Click [==2] to select the required CI types.
» Click £ to delete the selected CI types.

Rule bundle Enables you to define where you can run Impact Analysis
rules.
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Ul Element (A-Z) Description

Severity Select the required severity from the drop-down list.

Note: The severity list was defined for the state in the
System Type Manager. For details, see "System Type
Manager" on page 479.

For example, you can create an Impact rule in the Impact
Analysis Manager (see the "Impact Rules Definition
Dialog Box" on page 467), that defines the severity of the
trigger query node as other than No Change. If you select
a severity other than No Change, for example, Plan, the
condition is met and the simulated changes in the system
are triggered.

For details, see "Run Impact Analysis Dialog Box" on
page 294.

Trigger Cls » Click =] to select the CIs that are used as the triggers
in an impact map. These CIs represent the simulated
changes to be made to the system. Opens the CI
Selector dialog box. For details on how to use the CI
Selector pane, see "CI Selector" on page 163.

» Click 3£ to delete the selected ClIs.

%& Direct Link Parameters - Model Editor

This wizard page enables you to embed the Model Editor into an external
application, highlighting the selected ClIs in the CI Selector in the Model
Editor.

Important » For general information about the Generate Direct
information Link wizard, see "Generate Direct Link Wizard" on
page 124.

» Click Finish to close the wizard and create a URL. For
details, see "Generate Direct Link Dialog Box" on

page 123.
Wizard map Select Command Page (Embedded links > Model Editor)
> Finish Page
See also "Business CI Models" on page 346

133



Chapter 3 ¢ Create a URL for a Direct Link

User interface elements are described below:

Ul Element (A-Z)

Description

Model name

Select the model you want to display in the Model Editor.

» Click |2 to open the Select Model dialog box. Select
the model you want to appear in the Model Editor.

» Click 3£ to delete the selected model.

Selected Cl in search

Select the Cls you want to appear highlighted in the CI
Selector in the Model Editor.

» Click [=:| to open the CI Selector.
» Click 3£ to delete the selected ClIs.

. Direct Link Parameters - Query Editor

This wizard page enables you to embed the Model Editor into an external
application, displaying the selected TQL query.

Important » For general information about the Generate Direct
information Link wizard, see "Generate Direct Link Wizard" on
page 124.
» Click Finish to close the wizard and create a URL. For
details, see "Generate Direct Link Dialog Box" on
page 123.
Wizard map Select Command Page (Embedded links > Query Editor)
> Finish Page
See also "Business CI Models" on page 346

User interface elements are described below:

Ul Element (A-Z)

Description

Query name

Select the model you want to display in the Model Editor.

» Click [=2| to open the Select Query dialog box. Select
the query you want to appear in the Model Editor.

» Click £ to delete the selected query.
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. Direct Link Parameters — Related Cls Page

This wizard page enables you to embed into an external application, a
topology map that displays a specific CI, and all the CIs that are linked to it
by a distance of no more than one relationship.

Important
information

» For general information about the Generate Direct
Link wizard, see "Generate Direct Link Wizard" on
page 124.

» Click Finish to close the wizard and create a URL. For
details, see "Generate Direct Link Dialog Box" on
page 123.

Wizard map

Select Command Page (Embedded links > Related Cls) >
Finish Page

User interface elements are described below (unlabeled elements are shown

in angle brackets):

Ul Element (A-Z)

Description

Cls

Select the CI type you want to appear in the topology

map.

» Click [===] to select the required CI types. Opens the CI
Selector dialog box.

» Click 3£ to delete the value in the Cls box.

Filter by Cl types

Restrict the results of the topology map to related Cls of
one or more CI types.
» Click [==2] to select the required CI types.

» Click £ to delete the value in the Filter by Cl types
box.

Restrict to view

Restrict the results of the topology map to related Cls
from a specific view.

» Click [=2] to select the required view. Opens the View
Selector dialog box.

» Click 3£ to delete the selected view in the Restrict
results to view box.
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. Direct Link Parameters - Report Viewer Page

This wizard page enables you to create a URL that opens a specific report.

Important » For general information about the Generate Direct
information Link wizard, see "Generate Direct Link Wizard" on
page 124.

» Click Finish to close the wizard and create a URL. For
details, see "Generate Direct Link Dialog Box" on
page 123.

Wizard map Select Command Page (Embedded links > Report
Viewer) > Finish Page

User interface elements are described below:

Ul Element (A-Z) Description

Report type Select the required report type. For information about the
different report types, see "Reports" on page 303.

. Direct Link Parameters - Report Viewer - Saved Report
Page

This wizard page enables you to create a URL that opens a saved topology or
custom report.

Important » For general information about the Generate Direct
information Link wizard, see "Generate Direct Link Wizard" on
page 124.

» Click Finish to close the wizard and create a URL. For
details, see "Generate Direct Link Dialog Box" on
page 123.

Wizard map Select Command Page (Embedded links > Report Viewer
- Saved Report) > Finish Page
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User interface elements are described below:

Ul Element (A-Z)

Description

Report

Select the required saved report.

» Click [=2] to open the Select Report dialog box. Select
the required topology or custom report.

> Click & to delete the selected report.

For information about saved reports, see "Reports" on
page 303.

. Direct Link Parameters - Show Cl Properties Page

This wizard page enables you to view basic information for an existing CI.

Important
information

» For general information about the Generate Direct
Link wizard, see "Generate Direct Link Wizard" on
page 124.

» Click Finish to close the wizard and create a URL. For
details, see "Generate Direct Link Dialog Box" on
page 123.

Wizard map

Select Command Page (Embedded links > Show CI
properties) > Finish Page

See also

"Configuration Item Properties Dialog Box" on page 266

User interface elements are described below:

Ul Element (A-Z)

Description

Source Cl object ID

Select the required CI.

» Click &7 to select the source CI and retrieve its object
ID. Opens the Select Source CI dialog box. For details,
see "CI Selector" on page 163.

» Click @£ to delete the value in the Source Cl object ID
box.
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. Direct Link Parameters — Show View Topology Page

This wizard page enables you to display the topology map of the selected
view and embed it in an external application.

Important
information

» For general information about the Generate Direct
Link wizard, see "Generate Direct Link Wizard" on
page 124.

» Click Finish to close the wizard and create a URL. For
details, see "Generate Direct Link Dialog Box" on
page 123.

Wizard map

Select Command Page (Embedded links > Show view
topology) > Finish Page

User interface elements are described below:

Ul Element (A-Z)

Description

Show topology of
view

» Click | ===/ to select the required view to be opened by
the URL. Opens the View Selector dialog box.

» Click 3£ to delete the selected view in the Show
topology of view box.

. Direct Link Parameters - View Editor Page

This wizard page enables you to create a URL that opens a specific view in
the Pattern View Editor in Modeling Studio.

Important » For general information about the Generate Direct
information Link wizard, see "Generate Direct Link Wizard" on
page 124.
» Click Finish to close the wizard and create a URL. For
details, see "Generate Direct Link Dialog Box" on
page 123.
Wizard map Select Command Page (Embedded links > View Editor) >
Finish Page
See also "Building a Business View" on page 339
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User interface elements are described below:

Ul Element (A-Z) Description

View name » Click [=22] to select the required view to be opened by
the URL. Opens the View Selector dialog box.

» Click 3£ to delete the selected view in the View name
box.

., Direct Link Parameters - Views Selector Page

This wizard page enables you to embed into an external application, the View
Selector, that enables you to select, and display a view in that application.

Important » For general information about the Generate Direct
information Link wizard, see "Generate Direct Link Wizard" on
page 124.

» Click Finish to close the wizard and create a URL. For
details, see "Generate Direct Link Dialog Box" on
page 123.

Wizard map Select Command Page (Embedded links > Views
Selector) > Finish Page

See also "Building a Business View" on page 339
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. Direct Link Parameters — Show View Page

This wizard page enables you to create a URL to a specific view and
optionally select a specific query node in that view. When the view opens,
the CI you chose is selected in the view. The view opens in IT Universe

Manager.
Important » For general information about the Generate Direct
information Link wizard, see "Generate Direct Link Wizard" on
page 124.
» Click Finish to close the wizard and create a URL. For
details, see "Generate Direct Link Dialog Box" on
page 123.
Wizard map Select Command Page (Open in context links > Show
view) > Finish Page

User interface elements are described below:

Ul Element (A-Z) Description

<Left pane> A graphic illustration of the selected option.

Advanced pane Hide or display the Advanced pane in IT Universe

(visibility) Manager.

Select ClI from view (Optional) Click to select a CI and retrieve its object ID.

result When the view opens, the CI you chose is selected in the
view.

» Click &” to choose the CI you want selected in the
target view and retrieve its object ID. Opens the Select
CI dialog box. For details, see "CI Selector" on
page 163.

» Click £ to delete the object ID for the selected CI in
the Select Cl from view result box.
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Ul Element (A-Z)

Description

Selected View

The target view to be opened by the URL.
» Click &7 to select the target view to be opened by the
URL. Opens the Select View dialog box.

» Click 3£ to delete the selected view in the Selected
view box.

View mode

The view options are:

» View Topology. Displays an entire layer within a view.
> Related in View. Displays the selected CI and its
immediate neighbors within the current view.

» Related in CMDB. Displays the selected CI and its
immediate neighbors in the RTSM.

. Direct Link Parameters - Start in Mode Page

This wizard page enables you to start the RTSM application at the selected
page, for example, in the Modeling Studio page.

Important
information

» For general information about the Generate Direct
Link wizard, see "Generate Direct Link Wizard" on
page 124.

» Click Finish to close the wizard and create a URL. For
details, see "Generate Direct Link Dialog Box" on
page 123.

Wizard map

Select Command Page (Open in context links > Start in
mode page) > Finish Page

User interface elements are described below (unlabeled elements are shown

in angle brackets):

Ul Element (A-Z)

Description

<Left pane>

A graphic illustration of the selected mode.

Initial mode

Starts the RTSM application in the selected mode.
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® Finish Page

This is the final page of the Generate Direct Link wizard. Click Finish to close
the wizard and create a URL. Opens the Generate Direct Link dialog box.

Important For general information about the Generate Direct Link

information wizard, see "Generate Direct Link Wizard" on page 124.

Wizard map Select Command Page (<Open in context links options>
and <Embedded links options>) > Finish Page
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Embedding RTSM Applets Using Direct
Links

This chapter includes:

Concepts

» Using the Direct Link Functionality to Embed RTSM Applets on page 144
» RTSM Applet Tag — Overview on page 145

Reference

» Direct Link Operation Flow on page 147

Note: This chapter is relevant to integration developers only.
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Concepts

& Using the Direct Link Functionality to Embed RTSM

Applets

144

You can directly embed RTSM applets into external applications using a
direct link. A direct link is a URL that you create using the Direct Links
wizard. For details, see "Generate Direct Link Wizard" on page 124.

You can embed RTSM applets in the following ways:

» Using the URL itself to display RTSM content in an external application.

For example, you can create a URL in the Direct Links wizard to display
the properties of a certain CI. The login page opens if you are not already
logged into HP Business Service Management or if Lightweight Single
Sign-On Authentication Support (LW-SSO) is not enabled for HP Business
Service Management.

Note: Using the URL to enable the integration requires opening the link
in an IFrame or a new window. This does not allow you to manage the
resulting RTSM applet using Javascript due to cross-site scripting issues.
For example, if you use a URL that displays the properties of a specific CI
using the object ID, you cannot use the same URL to display the
properties of another CI.

Using the RTSM applet tag to embed the RTSM applet in an external
application. This enables integration developers to display a part of the
HP Business Service Management user interface as part of their own
application. In addition, this enables interaction with the embedded
HP Business Service Management user interface using Javascript.
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& RTSM Applet Tag — Overview

The RTSM Applet tag creates the environment needed for the RTSM applet
to run (HTML, Javascript, and server session parameters). The code behind
the tag can log into the HP Business Service Management server in one of

the following cases:

» The login parameters are specified and the user is not already logged in
(or if Lightweight Single Sign-On Authentication Support (LW-SSO) is not
enabled for HP Business Service Management).

» The clear session parameter is true.

Once a user session is established, the tag continues to write the required
applet environment (HTML and Javascript code) to the result of the JSP
processor. The resulting HTML page includes the required Javascript code to
load the RTSM applet from the specified server. On error, the specified error
string is printed to the page. This string can be customized using the
userErrorMessage parameter and may include HTML elements and HTML
wrapped Javascript code to initiate error handling scenarios.

Example of the Usage of an RTSM Applet Tag

<ucmdb:ucmdb_applet
serverConnectionString="http://labm3mam17.devlab.ad:8080"
serverType="UCMDB"
directLinkParameters="initViewName=NetworkTopology"
userName="user-name"

userPassword="password"

customerld="1"

encoded="false"

printDebuglLogs="true"

userErrorMessage="This is your general error"
navigation="false"

clearSessionCookies="false"
command="ShowCISelector"/>
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Caution: You retrieve the directLinkParameters from the URL created in the
Direct Links wizard. Insert the values for each parameter in the tag as
displayed. If the URL contains values for parameters not displayed above,
copy them into the directLinkParameters line of the tag. For details on how
to create a direct link, see "Generate Direct Link Wizard" on page 124.

The RTSM applet tag is located at <HP Business Service
Management>\odb\deploy\ucmdb-ui\WEB-INF\tags\ucmdb_applet.tag
on the Gateway Server machine.

You can copy the RTSM applet tag to an external application server. The
RTSM applet tag requests the login data from the HP Business Service
Management server provided that:

» The external application server can communicate with JSP tags.

» The HP Business Service Management server is accessible to the
external application server and to the browser.
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Reference

® Direct Link Operation Flow

This section describes different scenarios in which direct links are used to
embed RTSM applets into external machines.

This section includes the flow descriptions:

> "Regular Login" on page 148

» "An Embedded RTSM Applet Using a Direct Link URL" on page 150

> "An Embedded RTSM Applet Using an RTSM Applet Tag" on page 152
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Regular Login

This flow describes a regular login to the HP Business Service Management
server. It serves as a base reference for the direct link flows.

HP Business

Service
Management/HP
Universal CMDB
Browser server
|
1
Y
2 -
3

— N —

JVM

7]

'

Y

1 The user enters the direct link URL (into the browser) to log into the
HP Business Service Management server.

2 The browser sends the login request to the HP Business Service
Management server.

3 The server checks the user credentials and creates a user session if
required.

4 The server returns the requested first page of HP Business Service
Management.
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Note: This can be any page. For this flow, we assume that it is the Admin >
RTSM Administration > Modeling page in which the RTSM applet is
loaded.

5 The browser loads the Java virtual machine (JVM) with the code base
location parameter (which instructs the JVM from where to load the
RTSM applet files) as the HP Business Service Management server.

6 RTSM applet files (jars) and data are transferred between the HP Business
Service Management server and the JVM loaded in the browser.

At this point, the RTSM applet is loaded and regards HP Business Service
Management as the server with which it should communicate.
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An Embedded RTSM Applet Using a Direct Link URL

This flow shows how to use the direct link to open an RTSM applet (opened
to a specified context) in a new browser frame.

HP Business
Service
Management/HP
External Universal CMDB
Browser application server
[
1
Y
- 2
|
3
Y
IFrame/New
browser window
4 -
3 .l
B 5 6
¥
- 7
|
8
Y
JVM - 9 ~

1 The external application has a page that needs to show the RTSM applet.

2 The returned page includes a directive to open the direct link in an
IFrame or new browser window.

3 The browser opens a new frame (IFrame or new window) with the direct
link as the frame URL.

4 The new frame sends the direct link to the HP Business Service
Management server.
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5 If the user is not already logged into HP Business Service Management, or
if Lightweight Single Sign-On Authentication Support (LW-§S0) is not
enabled for HP Business Service Management, HP Business Service
Management displays the login page and waits for the user to enter
credentials and click the login button.

6 The user session is created, if required.

7 The HP Business Service Management server returns a page that includes
the directive to load the RTSM applet.

8 The browser processes the page. When the browser encounters the
directive to load the RTSM applet, it starts the JVM. The browser then
passes the needed parameters to the JVM, including the HP Business
Service Management server location as "code base."

9 RTSM applet files (jars) and data are transferred between the HP Business
Service Management server and the JVM loaded in the browser.

Caution: The HP Business Service Management server must be accessible
from the browser machine.
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An Embedded RTSM Applet Using an RTSM Applet Tag

This flow shows how to use the RTSM applet tag in conjunction with direct

links to embed the RTSM applet (opened to a specified context) in an
external application page.

HP Business
Service
Management/HP
Universal CMDB
server

External
Browser application
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JVM
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1 The RTSM applet tag is included in the processed JSP in the external
application.

2 The RTSM applet tag uses the parameters given to it to create an HTTP/

HTTPS connection to the HP Business Service Management server and
requests the applet HTML snippet code.
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3 If the user is not already logged in, the parameters from the RTSM applet
tag are used (see the tag itself for reference information regarding this
step). If login fails, the RTSM applet tag returns an error message, either
the preset one or the one specified in the RTSM applet tag parameters.

4 The HP Business Service Management server returns the HTML snippet
code (with embedded Javascript) that loads the RTSM applet. The external
application can now incorporate this snippet code into the page, and
send the page to the browser.

5 The external application sends the complete page that includes the HTML
snippet code to the browser.

6 The browser processes the page. When the browser encounters the HTML
snippet code that loads the RTSM applet, the JVM is started. The browser
then passes the needed parameters to the JVM, including the HP Business
Service Management server location as "code base".

7 RTSM applet files (jars) and data are transferred between the HP Business
Service Management server and the JVM loaded in the browser.

Caution: The HP Business Service Management server must be accessible
from the browser machine as well as the external application machine.
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Working with the Cl Selector

This chapter includes:

Concepts

» CI Selector Overview on page 156

Tasks

» Display a View in Browse Mode on page 157

» Search for CIs in Search Mode on page 157

» Modity CI Selector Display Options on page 159
Reference

» CI Selector User Interface on page 161

Troubleshooting and Limitations on page 174
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Concepts

& CI Selector Overview

156

Note: The CI Selector was known as View Explorer in earlier versions of HP
Business Service Management.

The CI Selector presents the elements of the IT universe model in HP
Business Service Management through the medium of views. HP Business
Service Management displays the CI Selector in the left pane of IT Universe
Manager and the Modeling Studio.

When you select a view in the CI Selector, the configuration items (Cls)
contained in the view are displayed in a hierarchical tree format according
to the relationships defined between the CIs. A view may be empty if no Cls
were found matching the TQL query. For details on views, see "View
Formats" on page 338.

You can use the CI Selector to select views and to locate CIs. You can select a
view and browse through the list of CIs, or you can search for a specific CI
by name or by CI type. You can also save the search criteria for future use.

For information on the components of the CI Selector, see "CI Selector User
Interface" on page 161.
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Tasks

® Display a View in Browse Mode

When the CI Selector is set to Browse mode, you can display the contents of
a selected view. For details on the CI Selector user interface in Browse mode,
see "Browse Views Mode" on page 163.

1 Prerequisites

In the CI Selector pane, select Browse Views mode.

2 Select a View to Display

Click the ellipsis button to open the View Selector dialog box and select
the view you want to display. The name of the selected view is shown in
the View box. The ClIs in the view appear in the CI tree in the lower part
of the CI Selector pane. The view remains selected when you move to
other applications in HP Business Service Management.

T Search for Cls in Search Mode

The CI Selector search tool enables you to locate a specific CI. The search is
executed on the entire RTSM. For details on the CI Selector search tool user
interface, see "Search CIs Mode" on page 167.

This task includes the following steps:
"Prerequisites" on page 158
"Search by CI Name" on page 158

"Search by Configuration Item Type" on page 158
"Run the Search and Sort the Results" on page 158

Y Y Y VY Y

"Run an Advanced Search" on page 159
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Prerequisites

In the CI Selector pane, select Search Cls mode and select the Simple tab.

Search by CI Name

To search for CIs by name, enter a string in the Cl Name box, representing
the name of the CI, or part of the name. The search returns all CIs that
contain the entered string somewhere in their names (within the
boundaries of the other search criteria that you define).

Note: The search by CI name option is not case sensitive.

Search by Configuration Item Type

You can search for CIs using the Cl Type box. This search returns CIs of the
type specified in the Cl Type box.

Click the ellipsis button and select the required CI type. You cannot
manually enter a CIT in the Cl Type box.

After defining a CI in the Cl Type box, HP Business Service Management
remembers your selection until you move to a different application, or until
you define a different value.

Run the Search and Sort the Results

Run the search. The results appear in the lower part of the CI Selector pane,
showing the CI name and type for each entry. You can sort the search results
by clicking the appropriate heading.

When you select the required CI from the results list, the right pane displays
details for the CI you selected, in the context in which you are working. To
see a Cl in the context of its view, right-click the CI and select Locate Cl in
View. The CI Selector reverts to Browse mode and displays the view that
contains the CI, with the CI selected in the view tree.

When you select a CI in the search results, the CI appears in the topology
map with its related CIs in the RTSM.
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Optionally, save the search criteria by clicking the Save button and entering
a name for the search. For details, see "Save Search Criteria Dialog Box" on
page 173.

Run an Advanced Search

You can select the Advanced tab for other search options. For details on the
CI Conditional search, see "CI Conditional Search Dialog Box" on page 161.
For details on the Running Software search, see "Running Software Search
Dialog Box" on page 172.

T Modify Cl Selector Display Options

You can modify the display options for the CI Selector. These options are
configured in the Infrastructure Settings Manager.

Caution: Modifying certain settings in the Infrastructure Settings Manager
can adversely affect the performance of HP Business Service Management.
Do not modify settings without first consulting HP Software Support or your
HP Professional Services representative.

1 Prerequisites

Access the Infrastructure Settings Manager by selecting Admin >
Platform > Setup and Maintenance > Infrastructure Settings.

2 Modify Selected Settings
The following settings under RTSM - General properties can be modified:

» Immediate Children Count. Number of children immediately
displayed when expanding their parent’s query node in the CI Selector.

» Maximal Children Count. Maximum number of children displayed
under their parent’s query node in the CI Selector.
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» Maximal search results size. Maximum number of CMDB instances
that can be returned in one search operation.

> Recently Used Views List size. Maximal number of recently used views
to store per user.
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Reference

®. I Selector User Interface

This section includes (in alphabetical order):

» CI Conditional Search Dialog Box on page 161

» CI Selector on page 163

» Organize Searches Dialog Box on page 171

» Running Software Search Dialog Box on page 172

» Save Search Criteria Dialog Box on page 173

@ Cl Conditional Search Dialog Box

This dialog box enables you to search for Cls by attribute conditions, by
related ClIs, and by attribute conditions of related Cls.

To access

In the CI Selector, select the Advanced tab in Search
mode and click the ellipsis button next to CI Conditional
Search.

User interface elements are described below:

Ul Element (A-Z)

Description

Click to add an attribute condition.

Click to delete a selected row.

Click to move a selected row up.

<> | ¥

Click to move a selected row down.
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Ul Element (A-Z)

Description

Click to display a preview of the attribute condition list.

Attribute name

Select an attribute from the drop-down list.

Cl Name Enter a CI name for which to search.
Cl Type Enter the CI type for which to search.
Operator Select an operator from the drop-down list.

Related Cl Name

Enter the name of a related CI for the search.

Related CI Type

Click the ellipsis =s«| button to select a CI type from the
tree for a search by related CI.

Relationship Type

Click the ellipsis «:«| button to select a relationship from
the tree for a search by related CI.

Search by Cl
conditions

Select to run a search for CIs with the specified
conditions.

Search by related CI
conditions

Select to run a search for CIs related to CIs with the
specified conditions.

Search by related CI
criteria

Select to run a search for CIs related to the specified Cls
or CI types.

Value

Enter a value for the attribute condition.
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. Cl Selector

This feature enables you to select views and to locate ClIs.

To access Appears in the left pane of the IT Universe Manager page
and the Modeling Studio.

Important The CI Selector consists of two functional formats:
information Browse Views mode and Search CIs mode.

» In Browse Views mode, you can search for and display
a view, and browse through the view to locate a
particular CI. You can also perform operations on the
CI from a shortcut menu.

» In Search CIs mode you can search for one or more
CIs in the RTSM by name or by CI type.

Note: Many of the features of the CI Selector are only
relevant in the RTSM and not in other HP Business
Service Management modules.

Relevant tasks "Display a View in Browse Mode" on page 157

"Search for ClIs in Search Mode" on page 157

Browse Views Mode

User interface elements are described below (unlabeled elements are shown
in angle brackets):

Ul Element (A-Z) Description

|§| Click to refresh the data content of the hierarchical tree
. structure that may have been modified by other users.

& Click Show Template Parameters to open the Template
Parameter Values dialog box, which enables you to edit
the parameters of the selected template.

Note: This button is only active when a template is
selected.

Click Add selected Cls to model/view to add the
selected ClIs to the current model or view.

Note: This button only appears in the Modeling Studio.
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Ul Element (A-Z) Description

i@ Click Add to model as related Cls to add the selected CI
to the model as a related CI.

Note: This button is only active in the Model Editor of
the Modeling Studio.

IS Click Open selected model in a new tab to open the
selected model in the Model Editor.

Note: This button is only active when a model is
selected in the Modeling Studio.

Click Show models containing selected Cl to display a
list of models containing the selected CI.

&

Note: This button only appears in the Modeling Studio.

=i In IT Universe Manager, this represents Show View
Definition, which takes you directly to the view
definition in the Modeling Studio for the current view.

In the Modeling Studio, this represents Open selected
view, which opens the selected view in the Editor pane.

L@ Click Show views containing selected Cl/model to
- display a list of views containing the selected CI or
model.

Note: This button only appears in the Modeling Studio.

7 Click Generate view for selected model to open the
= Creating New View dialog box which enables you to
build a view based on the selected model.

Note: This button is only active when a model is
selected in the Modeling Studio.

Click Show Discovery and Changes Summary to
rediscover all the ClIs in a selected view by manually
starting the DFM jobs that originally discovered them.
For details, see "Show Discovery Status and Changes
Dialog Box" on page 298.

(G

Note: This button only appears in IT Universe Manager.
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Ul Element (A-Z)

Description

Click Generate Direct Link to View to create a direct link
to the view using the Direct Links wizard.

Note: This button only appears in IT Universe Manager.

Choose the export format for the browse results. The
available options are:

» Excel. The table data is formatted as an .xls (Excel) file
that can be displayed in a spreadsheet.

» PDF. The table data is exported in PDF format.
Note: When exporting to PDE, select a reasonable
number of columns to display to ensure that the
report is legible.

» RTF. The table data is exported in Rich Text Format.

» CSV. The table data is formatted as a comma-
separated values (CSV) text file that can be displayed
in a spreadsheet.
Note: For the CSV formatted table data to display
correctly, the comma (,) must be defined as the list
separator. In Windows, to verify or modify the list
separator value, open Regional Options from the
Control Panel, and on the Numbers tab ensure that
the comma is defined as the List Separator value.

» XML. The table data is formatted as an XML file that
can be opened in a text or XML editor.
Tip: To extract HTML code from the report:
» Save the file as HTML
» Open the file in an HTML editor
» Copy the relevant table into the target file
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Ul Element (A-Z) Description

Click the Snapshot button to work with snapshots. The
following options are available:

» Save Snapshot. Select to open the Save Snapshot
dialog box, which enables you to save a snapshot of
the view. For details, see "Save Snapshot Dialog Box"
on page 296.

» Compare Snapshots. Select to run the Compare
Snapshots Report. For details, see "Compare
Snapshots Report" on page 318.

» Schedule Snapshot. Select to open the Schedule Job
dialog box. For details, see "Schedule Snapshot Dialog
Box" on page 327.

» Show Scheduled Snapshot Jobs. Select to open the
Job List dialog box. For details, see "Job List Dialog
Box" on page 325.

Note: This button only appears in IT Universe Manager.

& Click View Based Report to display the topology report
- for the selected view.

Note: This button only appears in IT Universe Manager.

B Click Asset Report to open the Asset report for the
selected view. For details, see "Asset Report" on page 311.

Note: This button only appears in IT Universe Manager.

Click the ellipsis button to the right of the View box, to
open the View Selector dialog box. You can browse
through the folder tree to locate the view you want to

display.
© @ Enables you to m.ove to the n.ext or p.revious result of the
search for the string entered in the Find box.
<Cls> The CIs contained in the currently selected view.
<Tooltip> Hold the cursor over a CI to display a tooltip with the

relevant CI type.
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Ul Element (A-Z)

Description

Find Enter a CI name or a portion of a CI name in the Find
box to locate a Cl in the CI tree.
View The View box displays the currently selected view. To

select a view to display, click the down arrow on the
right side of the View box; this displays an abridged list
of views, containing the most recently accessed views.
Click the arrow at the bottom of the list to scroll
through the entire list. The recently accessed views
appear at the top of the drop-down, above the dividing
line. The complete list of views appears below the line.

Alternatively, place the cursor in the list and begin
typing the view name. HP Business Service Management
completes the view name, if the first few letters that you
type match an existing entry. If the names of several
views begin with those letters, all matching views are
displayed in the list.

Search Cls Mode

User interface elements
in angle brackets):

are described below (unlabeled elements are shown

Ul Element (A-Z)

Description

€% Click Show Search Results in Table to open a separate
= pane with a table of the CIs in the search results.
Note: This button only appears in IT Universe Manager.
> Click Add selected Cls to model/view to add the
selected CIs to the current model or view.
Note: This button only appears in the Modeling Studio.
@ Click Add to model as related Cls to add the selected CI

to the model as a related CI.

Note: This button is only active in the Model Editor of
the Modeling Studio.
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Ul Element (A-Z) Description

& Click Open selected model in a new tab to open the
selected model in the Model Editor.

Note: This button is only active when a model is
selected in the Modeling Studio.

Click Show models containing selected Cl to display a
list of the models containing the selected CI.

&

Note: This button only appears in the Modeling Studio.

g Click Show views containing selected Cl/model to
- display a list of the views containing the selected CI or
model.

Note: This button only appears in the Modeling Studio.

7 Click Generate view for selected model to open the
1} Creating New View dialog box which enables you to
build a view based on the selected model.

Note: This button is only active when a model is
selected in the Modeling Studio.
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Ul Element (A-Z)

Description

8

Choose the export format for the search results. The
available options are:

» Excel. The table data is formatted as an .xls (Excel) file
that can be displayed in a spreadsheet.

» PDF. The table data is exported in PDF format.
Note: When exporting to PDE, select a reasonable
number of columns to display to ensure that the
report is legible.

» RTF. The table data is exported in Rich Text Format.

» CSV. The table data is formatted as a comma-
separated values (CSV) text file that can be displayed
in a spreadsheet.
Note: For the CSV formatted table data to display
correctly, the comma (,) must be defined as the list
separator. In Windows, to verify or modify the list
separator value, open Regional Options from the
Control Panel, and on the Numbers tab ensure that
the comma is defined as the List Separator value.

» XML. The table data is formatted as an XML file that
can be opened in a text or XML editor.
Tip: To extract HTML code from the report:
» Save the file as HTML
» Open the file in an HTML editor
» Copy the relevant table into the target file

Click to open the Organize Searches dialog box, where
you can edit or delete searches from the list of saved
searches.

»

Click to collapse or expand the search criteria area.

Jo)

Click to run the search. The search results are displayed
in the lower part of the CI Selector pane.

m:

Click to save the current search criteria for future use.

@
®

Enables you to move to the next or previous result of the
search for the string entered in the Find field.
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Ul Element (A-Z) Description

<Search results> After you run the search, the results are listed in the
lower part of the CI Selector pane. The results are shown
in two columns:

» Name. Contains the name of the CI.
» Cl Type. Contains the CI type of the CI.
If the CI or view name is abbreviated, hold the pointer

over the entry to see the full name. You can sort the
search results by clicking the appropriate heading.

Advanced tab The following detailed search options are available:

» Cl Conditional Search. Enables you to search for Cls
by attribute conditions, by related CIs, and by
attribute conditions of related Cls.

» Running Software Search. Enables you to search for
hosts by the applications running on them and for
applications by the host on which they are running.

For each of the searches, click the ellipsis | ... button to
open the search dialog box. After running a search, click
the Save button to save the search for future use.

Cl Name To search for a CI by name, enter the name of the CI for
which to search.

Cl Type To search for ClIs by CI type, click the ellipsis button to
select a CI from the Select Configuration Item Type
dialog box.

Find Enter a CI name or a portion of a CI name in the Find

box to locate a CI in the search results.

Searches Select a search from the drop-down list of saved
searches.
Search results count The Search results count below the Find box displays the

total number of CIs found in the search.

Simple tab The Simple tab includes the standard search
functionality. Click the Advanced tab for more detailed
search options.
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Shortcut Menu Options

Menu Item Description

<IT Universe Manager | The regular shortcut menu for the topology map in
shortcut menu IT Universe Manager is also available from the CI
options> Selector. For details on the menu options, see

"IT Universe Manager Shortcut Menu" on page 283.

Add Adds the selected CI to the current model or view.
Note: This feature only appears in the Modeling Studio.

Add to model as Adds the selected CI as a related CI to the current model.
related Cls Note: This feature only appears in the Modeling Studio.
Generate view for Select to create a view based on the current model. The

selected model Creating New View dialog box opens which enables you

to select a perspective to apply.

Note: This feature only appears in the Modeling Studio.

Open selected model | Opens the selected model in a new tab in the Model
in a new tab Editor.

Note: This feature only appears in the Modeling Studio.

Show containing Select Show models containing selected Cl to display a
models list of the models containing the selected CI.

Note: This option only appears in the Modeling Studio.

Show containing Select Show views containing selected Cl/model to
views display a list of the views containing the selected CI or
model.

Note: This option only appears in the Modeling Studio.

@ Organize Searches Dialog Box

This dialog box enables you to edit or delete searches from the list of saved
searches.

To access Click the Manage the list of saved searches 5! button
in the CI Selector.
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User interface elements are described below:

Ul Element (A-Z) Description

& Click to edit the selected search. For simple searches, the
CI Simple Search dialog box opens, which enables you to
edit the name and type of the CI. For CI Conditional
searches, the CI Conditional Search dialog box opens.

% Click to delete the selected search.

o Click to expand the search tree.

B Click to collapse the search tree.
<Searches tree> Displays all the saved searches in tree format.

Find Enter a search name or a portion of a search name in the

Find box to locate it in the list.

Find Next Click to go to the next occurrence of the selected search
phrase in the list.

Find Previous Click to go to the previous occurrence of the selected
search phrase in the list.

® Running Software Search Dialog Box

This dialog box enables you to search for hosts by the applications running
on them and for applications by the host on which they are running.

To access In the CI Selector, select the Advanced tab in Search
mode and click the ellipsis button next to Running
Software Search.
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User interface elements are described below:

Ul Element (A-Z)

Description

Host name

Enter the name of the node for which you are searching.

Running Software

Select a running software CI from the drop-down list.

Note: The drop-down list may not display an accurate list
of available running software CI types (only the option
Any appears). In this event, perform the Host name
search only.

Search for

Select Running Software or Node.

Note: To search for a running software CI running on a
specific node, enter a node name, select the required
running software CI and search for it.

® save Search Criteria Dialog Box

This dialog box enables you to save the current search criteria for future use.

To access

Click the Save button from Search mode in the CI
Selector.

User interface elements are described below:

Ul Element (A-Z)

Description

Existing Queries

Displays a list of existing searches in tree format.

Name Enter a name for the current search.

Find Enter a search name or a portion of a search name in the
Find box to locate it in the list.

Find Next Click to go to the next occurrence of the selected search

phrase in the list.

Find Previous

Click to go to the previous occurrence of the selected
search phrase in the list.
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Q, Troubleshooting and Limitations

174

This section describes troubleshooting and limitations for the CI Selector.

Unavailable Views and Cls

The View list in the CI Selector may not display all views in the RTSM, or it
may not display the contents of a view, for any of the following reasons:

» The View list includes only the views for which you have the necessary
permissions. Similarly, Search mode is only available if you have CI
Search permission. To set permissions, select Admin > Platform > Users
and Permissions, select a user or a group and select Permissions. For more
information, see "How to Assign Permissions" in Platform Administration.

» Views that are currently inactive appear in red in the View list, but they
cannot be selected. In IT Universe Manager, inactive views appear in
faded text.

» Out-of-the-box views for which you do not have a license may appear in
the View list, but these views do not contain ClIs. For information on the
out-of-the-box views, see "Predefined Folders and Views" on page 343.

Note: After deleting one or more query nodes from a TQL query, it can take
time for changes to be updated to the view; meanwhile, the removed Cls
appear in the view. If you select one of these CIs before it is updated, an
error message is displayed. Click the Refresh button to update the view.
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Working with Topology Map

This chapter includes:

Concepts

» Topology Map Overview on page 176
» Handling Large Views on page 177
Reference

» Topology Map User Interface on page 178
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Concepts

& Topology Map Overview

176

-

B
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The Topology Map provides a graphical display of a view. All the Cls in a
given layer of the view are represented by icons and the connecting lines
represent relationships. You can select a CI in the Topology Map or in the CI
Selector in the left pane. You can also drill down in the CI Selector to display
different layers of the view in the Topology Map.

The label of a CI appears under the icon. You can set the maximum number
of characters per line and the maximum number of lines in a CI label in the
User Preferences dialog box under General. For details, see "User Preferences
Dialog Box" on page 102.

If a Cl icon appears with a downward arrow icon in the Topology Map, there
is an additional CI layer beneath it, created by the hierarchy set for the view.
You can click the arrow to display the Cls contained in the sublayer.

The topology map is automatically updated dynamically with changes in
the IT Universe data, such as new Cls discovered by the Data Flow
Management process.

The toolbar and Main Menu above the Topology Map enable you to zoom
in, change the layout of the Topology Map, and print the Topology Map.
Additional functionality is available from the shortcut menu by right-
clicking a CI in the Topology Map or in the CI Selector.
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& Handling Large Views

The Topology Map cannot display a view with more than 900 ClIs in a single
layer. When you select a view which contains a layer with more than this
number of CIs, the Topology Map appears empty. A layer with more than
900 ClIs can be displayed in a table in Text mode.

To display large views in the Topology Map, use one of the following
methods:

» Reduce the TQL query results by redefining the view in the Modeling
Studio. For details, see "Change Query Node/Relationship Type Dialog
Box" on page 381.

» Define a different hierarchy for the view to redistribute the CIs among the
view’s layers. For details on defining hierarchy, see "Setting the View
Hierarchy" on page 340.

» Reset the maximum number of Cls allowed in the configuration
parameters. Select the Max Object Count GUI for TS parameter under
RTSM - Viewing Settings in the Infrastructure Settings Manager. However,
be aware that increasing the maximum number of CIs per layer may
significantly slow down the redrawing of the Topology Map.

To modify the setting, select Admin > Platform > Setup and Maintenance
> Infrastructure Settings > Foundations > RTSM. Locate Max Object
Count GUI for TS and change the value to the required number.
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Reference

@ Topology Map User Interface

This section includes (in alphabetical order):

» Export Map to Image Dialog Box on page 178
» Layout Properties Dialog Box on page 180

» Main Menu on page 197

» Print Dialog Box on page 198

» Print Preview Dialog Box on page 199

» Print Setup Dialog Box on page 199

» Toolbar Options on page 201

» Topology Map Sidebar on page 210

® Export Map to Image Dialog Box

This dialog box enables you to save a topology map to a file.

To access From a topology map, select Operations > Export Map to
Image.
Relevant tasks "Print and Save a Topology Map to File" on page 258
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User interface elements are described below:

Ul Element (A-Z)

Description

Actual Size

Save the view so that the graph node sizes are at
maximum.

Current Zoom Level

Save the view as you see it on the topology map. For
example, if you have used the Interactive Zoom mode to
decrease the view magnification, the graph nodes also
appear smaller in the saved view. For details, see
"Interactive Zoom" on page 204.

Custom Specify the size of the view you want to save in the Width
and Height boxes.
File Name Specify the required file name and location (or click

Browse to search for the file and location).

Fit in Canvas

Expand or shrink the view so that it fits in the pane.

Image Quality

The quality of the printed map. Select High, Medium, or
Low.

Selected Obijects
Only

Saves only the graph nodes/Cls and their relationships
that you selected in the map.

Type

Select the required file format.

Visible Window Only

Saves only the part of the graph that appears in the pane.
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@ Layout Properties Dialog Box

This dialog box enables you to customize the layout of a specific layer in a
view, to achieve the clearest presentation possible and to better understand
and monitor the managed data.

To access Select Layout > Layout Properties.
Important You define the layout of a view’s layers by assigning
information logical positions for the graph’s nodes and relationships

that appear in a layer. You customize the layer layouts by
modifying the default values.

You set layout definitions for a specific layer only. The
definitions cannot be saved for a different layer or a
different view.

Parameter values are in pixels.

Global Tab

This area enables you to define global layout parameters.

To access Click the Global tab in the Layout Properties dialog box.
Important The Global tab enables you to define global settings for
information the layout.

User interface elements are described below:

Ul Element (A-Z) Description

Drawing Fitting Select one of the following options for fitting the layout:

» Fit to Canvas. Fit the layout to the canvas on the
screen.

» Fit for Printing. Fit the layout to a page for printing.

» No Fitting. Do not change the layout.
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Ul Element (A-Z) Description

Labeling Select Perform Labeling to ensure that the labels appear
when the layout is redrawn. If this field is not selected,
labels do not appear in the redrawn layout.

Style Select Apply Style Deeply to apply the layout selected to
all nested layers of the topology map.

All Styles Tab

To access Click the All Styles tab in the Layout Properties dialog
box.

Important The All Styles tab enables you to define general layout

information parameters for disconnected graph nodes and connected
components.

» A disconnected graph node is a node that is not
connected to any other graph node.

» A disconnected component is a component that is not
connected to any other component. It contains a set of
graph nodes that can be connected to each other.

This illustrates a connected component with five graph

nodes:

This illustrates a connected component with two graph
nodes:

O—0

This illustrates four disconnected components, each
made up of a single, disconnected graph node:

OO
OO
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User interface elements are described below:

Ul Element (A-Z) Description

Components The spacing between the components in a disconnected
graph consists of both a constant value and a
proportional value based on the sizes of the components.

Select Detect Components to view the disconnected
components. You can specify that all components be laid
out together or individually, regardless of the other
components. If the grouping for components is selected,
each component is laid out, and the resulting
components are packed together.

When Detect Components is selected, enter values for
the following settings:

» Constant Spacing. Set constant spacing (horizontal
and vertical) around each disconnected component.
Default value: 20

» Proportional Spacing. Set spacing (horizontal and
vertical) that is proportional to the size of the
component around each disconnected component.
Default value: 0.05
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Ul Element (A-Z)

Description

Disconnected Graph
Nodes

The spacing between the graph nodes in a disconnected
graph consists of both a constant value and a
proportional value based on the sizes of the graph nodes.

Select Detect Disconnected Graph Nodes to view the
disconnected graph nodes. You can specify that
disconnected graph nodes be grouped into one
component or laid out individually.

When Detect Disconnected Graph Nodes is selected,
enter values for the following settings:

» Constant Spacing. Set constant spacing (horizontal
and vertical) around each disconnected graph node.
Default value: 20

» Proportional Spacing. Set spacing (horizontal and
vertical) that is proportional to the size of the
component around each disconnected graph node.
Default value: 0.05

Margin Spacing

Enter values for the right, left, top, and bottom margin
spacing for the layout.

Circular Tab

To access To access: Click the Circular tab in the Layout Properties
dialog box.

Important The Circular tab enables you to group a graph’s nodes

information into groups or clusters based on the grouping options you

select. It is particularly suited for visualizing ring and star
network topologies, and for link analysis.
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User interface elements are described below:

Ul Element (A-Z) Description

Clustering Set the values for the following settings:

» Cluster Size Factor. Specifies the ratio between the
average cluster size and the number of clusters. The
size of a cluster is defined as the sum of the weights of
all graph nodes in the cluster. You can assign a weight
value to each graph node.

» Min Number of Clusters. The minimum number of
clusters in a layer.

» Max Number of Clusters. The maximum number of
clusters in a layer.

Cluster Layout Style Displays clusters either in a symmetric or circular layout
style.

Select one of the following options:

» Symmetric. Displays clusters in a symmetric layout

style.

3

[uga) \

R - s St

» Circular. Displays clusters in a circular layout style.
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Ul Element (A-Z)

Description

Layout Quality

Adjusts the quality of the layout produced to fit your
application’s needs. The quality reflects the number of
steps or the method used to produce the layout. For
example, high quality is sharper but takes more time to
set the layout.

Select one of the following options:

» Draft. Produces faster results (faster than Medium and
Proof).

» Medium. Produces a result that is a combination of
Draft and Proof, that is, it produces a more accurate
graph layout than Draft, but not as accurate as Proof.

» Proof. Produces a more refined result but takes more
time.

Note: The differences between the speed and resulting
layout of each quality setting varies depending on the
nature of the graph being laid out. You can try each
option to determine which works best for you.
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Ul Element (A-Z) Description

Spacing Sets the spacing around each graph node within the same
cluster and between clusters.

Enter values for the following settings:

» Between Graph Nodes. Sets the spacing around each
graph node within the same cluster. The larger the
spacing, the more graph nodes there are on the cluster
boundary.

Default value: 50

This illustration shows smaller graph node spacing.

This illustration shows larger graph node spacing.

f-ﬂ-
qtg:?}‘
» Between Clusters. Sets the spacing between clusters.

Default value: 50

This illustration shows smaller cluster spacing.

TP

This illustration shows larger cluster spacing.

o
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To access Click the Hierarchical tab in the Layout Properties dialog
box.

Important The Hierarchical tab shows the precedence relationships

information that can represent organizational or information

management system dependencies, as well as process
models, software call graphs, and work flows. The
hierarchical layout emphasizes dependencies by placing
the graph nodes at different levels.

User interface elements are described below:

Ul Element (A-Z)

Description

Backward Edges

Specifies how backward relationships are displayed in the
hierarchical layout.

Select one of the following options:

» Minimize Backward Edges. Sets the number of
backward relationships displayed in a layer to a
minimum.

» Optimize for Feedback Flow. Sets the number of
backward relationships displayed in a layer to a
maximum. This mode is more appropriate for flow
charts.

Horizontal Spacing

Enables you to set the minimum horizontal distance
between two neighboring graph nodes at each level.

Enter values for the following settings:

» Between Graph Nodes. Sets a horizontal space around
each graph node in the layer.
Default value: 28

» Between Edges. This setting is available only when
you select Routing > Orthogonal. It sets a horizontal
space between edges in the graph.
Default value: 12
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Ul Element (A-Z) Description

Layout Quality Adjusts the quality of the layout produced to fit your
application’s needs. The quality reflects the number of
steps or the method used to produce the layout. For
example, high quality is sharper but takes more time to
set the layout.

Select one of the following options:

» Draft. Produces faster results (faster than Medium and
Proof).

Dratt

» Medium. Produces a result that is a combination of
Draft and Proof, that is, it produces a more accurate
graph layout than Draft, but not as accurate as Proof.

» Proof. Produces a more refined result but takes more
time.

Note: The differences between the speed and resulting
layout of each quality setting varies depending on the
nature of the graph being laid out. You can try each
option to determine which works best for you.
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Ul Element (A-Z)

Description

Level Alignment

Enables you to set the way graph nodes are vertically
aligned.

Select one of the following options:

» Top. This illustration shows that the top of the graph
nodes at the same level of the hierarchy are aligned.

» Center. This illustration shows that the center of the
graph nodes at the same level of the hierarchy are
aligned.

» Bottom. This illustration shows that the bottom of the
graph nodes at the same level of the hierarchy are
aligned.
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Ul Element (A-Z)

Description

Orientation

Enables you to set the orientation of the hierarchy.

Select one of the following options:

» Top to Bottom. The children are located above the
parent.

» Left to Right. The children are located to the left of the
parent.

» Bottom to Top. The children are located below the
parent.

» Right to Left. The children are located to the right of
the parent.

Orthogonal Routing -
Fix Node Sizes

This setting is available only when you select Routing >
Orthogonal. Maintain the size of a graph node. Clear this
option if you want the layout to increase the size of a
graph node, if it is necessary to maintain the specified
relationship spacing, when more than one relationship is
attached to the same side of the graph node.

Polyline Routing -
Spacing Between
Bends

This setting is available only when you select Routing >
Polyline. Polyline routing routes edges (connecting lines)
as one or more straight line segments with arbitrary
angles. Path nodes are added automatically to prevent
the edges (connecting lines) from overlapping.

Default Value: 12

L

Routing

Select the type of routing for the layout. The available
options are:

» Orthogonal
» Polyline
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Ul Element (A-Z)

Description

Undirected Layout

Edge direction is not used to build the levels of the
hierarchical drawing.

Variable Level
Spacing

between the levels.

If the drawing’s edges are orthogonally routed, this

edges (in a top-to-bottom or bottom-to-top layout)
routed between levels.

easier to distinguish among edges in very dense
drawings.

Variable level spacing adjusts the spacing between pairs
of neighboring levels according to the density of edges

ensures the desired vertical spacing between horizontal

If the routing is polyline, variable level spacing makes it

Vertical Spacing

Enables you to set the minimum vertical distance
between two neighboring graph nodes on different
levels.

Enter values for the following settings:

» Between Graph Nodes. Sets a vertical space around
each graph node in the level.
Default value: 28

» Between Edges. This setting is available only when
you select Routing > Orthogonal. It sets a vertical
space between edges in the graph.

Default value: 12

Orthogonal Tab

To access To access: Click the Orthogonal tab in the Layout
Properties dialog box.

Important The Orthogonal tab enables you to set orthogonal layout

information route relationships horizontally and vertically. This

results in relationships bending at 90-degree angles only.
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User interface elements are described below:

Ul Element (A-Z) Description

Fix Node Sizes Maintain the size of a graph node. Clear this option if
you want the layout to increase the size of a graph node
if it is necessary to maintain the specified relationship
spacing when more than one relationship is attached to
the same side of the graph node.

Horizontal Spacing Enables you to set the minimum horizontal distance
between graph nodes.

Select one of the following options:

» Between Graph Nodes. Set a horizontal space around
each graph node in the layer.

Default value: 20

» Between Edges. Set a horizontal space between
elements in the layer.

Default value: 12

Layout Quality Adjusts the quality of the layout produced to fit your
application’s needs. The quality reflects the number of
steps or the method used to produce the layout. For
example, high quality is sharper but takes more time to
set the layout.

Select one of the following options:

» Draft. Set the layout to draft quality.
» Medium. Set the layout to medium quality.
» Proof. Set the layout to proof quality.

Vertical Spacing Enables you to set the minimum vertical distance
between graph nodes.

Select one of the following options:

» Between Graph Nodes. Set a vertical space around
each graph node in the layer.

Default value: 100

> Between Edges. Set a vertical space between elements
in the layer.

Default value: 20
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Symmetric Tab

To access Click the Symmetric tab in the Layout Properties dialog
box.

Important The Symmetric tab displays a clear representation of

information complex networks. The symmetric layout emphasizes the
symmetries that may occur in a graph.

User interface elements are described below:

Ul Element (A-Z) Description

Layout Quality Adjusts the quality of the layout produced to fit your
application’s needs. The quality reflects the number of
steps or the method used to produce the layout. For
example, high quality is sharper but takes more time to
set the layout.

Select one of the following options:

» Draft. Produces faster results (faster than Medium and
Proof).

» Medium. Produces a result that is a combination of
Draft and Proof, that is, it produces a more accurate
graph layout than Draft, but not as accurate as Proof.

» Proof. Produces a more refined result but takes more
time.

Note: The differences between the speed and resulting
layout of each quality setting varies depending on the
nature of the graph being laid out. You can try each
option to determine which works best for you.
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Ul Element (A-Z)

Description

Spacing

Allows you to set constant horizontal and vertical

spacing around each graph node in the layer. The value

you specify is a guideline for the layout, so that it is
possible that the spacing for a particular pair of graph

nodes might be different from the one you specified. The
larger the graph node spacing, the farther apart the graph

nodes are spaced in the final layout.
Default value: 50

The following figure illustrates smaller and larger
spacing.

TN

\

node spacing=75

node spacing=150
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To access Click the Routing tab in the Layout Properties dialog box.
Important The Routing tab enables you to produce drawings that
information leave graph nodes essentially where they are, and reroute

the lines orthogonally.

User interface elements are described below:

Ul Element (A-Z)

Description

Fix Node Positions

Maintain the position of all the graph nodes in the
display. Clear this option for the layout to move the
graph nodes if it is necessary to improve the layout. The
movement is minimal, avoids overlaps, and minimizes
bend points.

Fix Node Sizes

Maintain the size of a graph node. Clear this option if
you want the layout to increase the size of a graph node
if it is necessary to maintain the specified relationship
spacing when more than one relationship is attached to
the same side of the graph node.
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Ul Element (A-Z) Description

Horizontal Spacing Enables you to set the minimum horizontal distance
between graph nodes.

Select one of the following options:

» Between Graph Nodes. Set a horizontal space around
each graph node in the layer.
Default value: 20

» Between Edges. Set a horizontal space between
elements in the layer.
Default value: 12

Vertical Spacing Enables you to set the minimum vertical distance
between graph nodes.

Select one of the following options:

» Between Graph Nodes. Set a vertical space around
each graph node in the layer.
Default value: 20

> Between Edges. Set a vertical space between elements
in the layer.
Default value: 12
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This feature contains the options for working with the topology map.

To access Located in the upper left portion of the screen.
Important The specific options contained within the Main Menu
information drop-downs are detailed in "Toolbar Options" on

page 201.

User interface elements are described below:

Ul Element (A-Z) Description

Edit Contains selection options for the topology map.

Editor Item Contains the topology map shortcut menu options for
the current manager.
Note: This drop-down does not appear in CI Type
Manager.

Layout Contains options for changing the layout of the topology
map.

Operations Contains options for printing or exporting the topology
map.

Resources Contains the left pane shortcut menu options for the
current manager.
Note: This drop-down does not appear in IT Universe
Manager, and in CI Type Manager it is called Cl Types.

Tools Contains the User Preferences, Log Configuration, and
Screen Capture tools.

View Enables you to hide or display the different panes of the
module.
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@ Print Dialog Box

This dialog box enables you to print the contents of the topology map.

To access Select Operations > Print.
Important The results of printing a topology map is similar to a
information screen capture. Therefore, before printing, it is

recommended to:

» Define your print settings and arrange the contents of
the topology map according to your requirements. For
details, see "Print Setup Dialog Box" on page 199.

» Arrange the contents of the topology map for print.
You can use the Layout option and Layout Properties.
For details about the layout options, see "Layout" on
page 2035. For details about layout properties, see
"Layout Properties Dialog Box" on page 180.

Relevant tasks "Print and Save a Topology Map to File" on page 258

User interface elements are described below:

Ul Element (A-Z) Description
Number of copies Enter the number of copies you want to print.
Properties Define document properties as required.
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@ Print Preview Dialog Box

This dialog box enables you to preview the content of the topology map

before printing.

To access Select Operations > Print Preview.

Relevant tasks

"Print and Save a Topology Map to File" on page 258

User interface elements are described below:

Menu ltem

Description

=

Print the map. For details, see "Print Dialog Box" on
page 198.

Zoom out to view the map.

Zoom in to focus on specific details of the map.

Fit the complete view in the pane.

@ Print Setup Dialog Box

This dialog box enables you to define the print settings for a topology map.

To access

Select Operations > Print Setup.

Relevant tasks

"Print and Save a Topology Map to File" on page 258

User interface elements are described below:

Ul Element (A-Z)

Description

Actual Size Print the view as it really is.
Color Set the text color.
Font Set the required font.
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Ul Element (A-Z)

Description

Page Setup Set the printer settings.

Pages Divide the map into rows and columns and print each
section separately. Enter the number of columns and rows
in the Page Columns and Page Rows boxes.

Position Select the position of the caption from the Position list.

Print Background

Print the background behind the view.

Print Border

Print the map with a border. Click Color to select the
required border color.

Print Caption

Enter the caption in the text area and click Font to select
the required custom font.

Print Crop Marks

Print the crop marks.

Print Current
Selection

Print the selected graph nodes and their relationships.

Print Current
Window

Print the part of the view that appears in the pane.

Print Entire Drawing

Print the complete view.

Print Page Numbers

Print the page numbers.

Zoom Level

Print the view at the current zoom level.




@ Toolbar Options

The following table contains a description of each Topology Map toolbar
option, organized alphabetically.
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Note: These toolbar options are relevant for RTSM applications.

Button Option Name | Use This Option to...
- Additions Calculate the number of instances that are created as a result of
e Count an Enrichment Rule. The number of TQL query node instances
and relationships that are created appear next to the
Enrichment query nodes/relationships, as seen in the figure
below.
InSubnet{d)
Mermbershipis1)
=
Mewy Mode{h1)
Note: This option appears in the toolbar in Enrichment
Manager only.
Advanced Toggle between hiding and displaying the Advanced Pane at the
Pane bottom center of the screen.
To access: Select View > Advanced Pane.
Calculate Calculate the number of instances found for each TQL query
Query Result | node/relationship.
Count
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Button Option Name | Use This Option to...

Change Label | Enter the maximum number of characters that the labels should

Length/ contain.

Properties To access: In IT Universe Manager and the Modeling Studio,
select Layout > Change Label Properties. In the other managers,
select Layout > Change Label Length.

Cl Types Tree | Toggle between hiding and displaying the CI Type Selector at
the right of the screen.

To access: Select View > Cl Types Tree.
Note: In the Modeling Studio, this option is called CI Types.
H Create In most managers, create a relationship between two existing

X Relationship TQL query nodes. For details, see "Add Query Nodes and
Relationships to a TQL Query" on page 32.
In IT Universe Manager, create a relationship between existing
CIs. For details, see "Attaching Existing CIs" on page 238.

% Delete Delete a CI from IT Universe Manager or a TQL query node from

Selected Impact Analysis Manager or Enrichment Manager.

Item(s)

Drag Map Drag the view.

To access: Open the drop-down menu in the Mode box or select
View > Drag Map. In IT Universe Manager and the Modeling
Studio, select Layout > Dragging Mode.

ITs Drill Down Move down one level in the topology map. This option is

One Layer enabled only if there is an additional CI layer below it, created
by setting the hierarchy of the view. For details on setting the
hierarchy, see "Setting the View Hierarchy" on page 340.

Note: This option appears only in IT Universe Manager.
5 Enable/ Toggle between disabling and enabling the redrawing of the
gl Disable topology map with related CIs when selecting a new CI in the

Related Cls CI Selector.

Retrieval

Note: This option appears only in IT Universe Manager in the
Related ClIs tab.
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Button

Option Name

Use This Option to...

Entities Tree

Toggle between hiding and displaying the manager specific
entities tree at the left of the screen.

To access: Select View > Entities Tree.

Note: In the Modeling Studio, each of the tabs of the Left pane
(Resources, CI Types, CI Selector) is listed as a separate option.

Export Map Save the topology map to a file. For details, see "Export Map to

to Image Image Dialog Box" on page 178.
To access: Select Operations > Export Map to Image.

Fit to Fit the complete map in the pane.

Window

To access: Select Layout > Fit to Window.

Generate Generate a direct link to a view or CI.

Direct Link To access: Select Edit > Generate Direct Link.

1 Go Up One Move up one level in the topology map. This option is enabled
. Layer only if there is an additional CI layer above it, created by setting

the hierarchy of the view. For details on setting the hierarchy,
see "Setting the View Hierarchy" on page 340.
Note: This option appears only in IT Universe Manager.

Hide All Toggle between showing and hiding Inheritance_f relationships

Inheritance and their connecting query nodes.

From Map To access: Select Layout > Hide All Inheritance From Map.
Note: This option is only active in the toolbar in CI Type
Manager.

Hide All Toggle between showing or hiding the CI/CIT/query

Query Node node/pattern labels.

Labels To access: Select Layout > Hide All Query Node Labels.
Note: This option is not available in IT Universe Manager and
the Modeling Studio.

Hide All Toggle between showing or hiding the relationship labels.

EeLatlionship To access: Select Layout > Hide All Relationship Labels.

abels

Note: This option is called Hide edges’ labels in IT Universe
Manager and the Modeling Studio.
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Button Option Name | Use This Option to...
Hide All Toggle between showing and hiding the relationships in the
Relationships | displayed map.
To access: Select Layout > Hide All Relationships.
Note: This option is not available in IT Universe Manager and
the Modeling Studio.
..'ﬁq Hide/Show Toggle between hiding and displaying the Get Related CIs pane.
Get Related Note: This option appears only in IT Universe Manager in the
Cls pane Related ClIs tab.
Hide/Show Toggle between hiding and displaying the topology map legend.
Legend Note: This option appears only in IT Universe Manager and the
Modeling Studio.
Interactive » Decrease the view magnification by clicking and pushing the
Zoom pointer upwards.
» Magnify the view by clicking and pulling the pointer
downwards.
To access: Open the drop-down menu in the Mode box or select
View > Interactive Zoom.
Note: This option is not available in IT Universe Manager and
the Modeling Studio.
Layout Define the view’s layer layout, by assigning positions for the
Properties query nodes and relationships of the view. For details, see

"Layout Properties Dialog Box" on page 180.

To access: Select Layout > Layout Properties.
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Button

Option Name

Use This Option to...

Layout

Select the layout display from the list. The options are:

» Hierarchical Layout. Enables you to display the precedence
relations in the topology map.

» Symmetric Layout. Enables you to display clear
representations of complex networks.

» Circular Layout. Groups a graph’s nodes into groups or
clusters.

» Orthogonal Layout. Enables you to display views of
outstanding clarity that are achieved by employing only
horizontal and vertical edge routing.

» Manual Layout. Enables you to display the changes you have
made manually to the topology map.

For further details about each of the options, see "Layout

Properties Dialog Box" on page 180.

Note: These layout options are only relevant for Enrichment
Manager, CIT Manager, and Impact Analysis Manager.

Log
Configuratio
n

Open the Log Configuration dialog box.

To access: Select Tools > Log Configuration.

Map
overview

Open a small box with a copy of the topology map. This is
useful in large views when zooming in.

To access: Select Layout > Map Overview. In IT Universe
Manager and the Modeling Studio, select Layout > Show Map
Overview.

Maximize
Workspace/
Restore
Workspace

Toggle between the regular display and a full-screen display of
the topology map.
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Button Option Name | Use This Option to...
Navigation Take the pointer to the next connected CI/CIT/TQL query node
in a clockwise direction.
» Left-click to move in a clockwise direction.
» Right-click to point to the next CI/CIT/query node/pattern in
a clockwise direction.
To access: Open the drop-down menu in the Mode box or select
View > Navigation.
Note:
» You can use this option only on CI/CIT/query
nodes/patterns that are connected by relationships.
» This option is not available in IT Universe Manager and
the Modeling Studio.
s New CI Define a new unrelated CI. For details, see "Working with CIs"
on page 232.
Note: This option appears in the toolbar in IT Universe Manager
only.
=) New Related | Define a new related CI. For details, see "Working with CIs" on
Cl page 232.
Note: This option appears in the toolbar in IT Universe Manager
only.
Place in Place the selected CI/CIT/query nodes/pattern in the center of
Center the map.
To access: Select Layout > Place in Center.
Note: This option is not available in IT Universe Manager and
the Modeling Studio.
Print Print the contents of the topology map. For details, see "Print

Dialog Box" on page 198.

To access: Select Operations > Print...

Print Preview

Preview the contents of the map before printing.

To access: Select Operations > Print Preview.
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Query Nodes

Button Option Name | Use This Option to...
Print Setup Define print settings for printing the topology map. For details,
see "Print Setup Dialog Box" on page 199.
To access: Select Operations > Print Setup...
2 Remove Remove the instances created from an Enrichment rule from the
_.m Enrichment RTSM.
Results Note: This option appears in the toolbar in Enrichment
Manager only.
Screen Take a snapshot of the screen using the Screen Capture tool.
Capture To access: Select Tools > Screen Capture.
IE Select Select a CI/CIT/TQL query node or multiple CIs/CITs/TQL query
nodes.
To access: Open the drop-down menu in the Mode box or select
View > Select. In IT Universe Manager and the Modeling Studio,
select Layout > Selection Mode.
Select All Select all the CIs and relationships in a selected layer.
To access: Select Edit > Select All.
Note: This option is not available in IT Universe Manager and
the Modeling Studio.
Select All Select all the query nodes in a selected layer.

To access: Select Edit > Select All Query Nodes.

Note: This option is not available in IT Universe Manager and
the Modeling Studio.

|W| Select Enables you to select the columns to be displayed. For details,
= Columns see "Select Columns Dialog Box" on page 570.
Note: This option is displayed in Text mode of IT Universe
Manager only.
Set Change Open the Change Timeframe dialog box, which enables you to
Timeframe set the period for the display of added or changed CI indicators.

Note: This option appears in the toolbar in IT Universe Manager
only.
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Button Option Name | Use This Option to...
o4 Set scope of Select the scope of inter-layer relationships to display in the
62 inter-layer view. The available options are:
relationships | , None. Hide all inter-layer relationships.
displayed . . . .
> Inter-layer. Display regular inter-layer relationships, but not
duplication metalinks.
» Full. Display all inter-layer relationships.
2 Show Identify the CIs in the current view which are candidates for
: Candidates deletion with the following icon ﬂ .
for Deletion Note: This option appears in the toolbar in IT Universe Manager
only.
© Show Display the scheduling information for the selected job. For
Schedule Info | details, see "Discovery Scheduler Dialog Box" in the RTSM Data
Flow Management Guide.
Note: This option appears in the toolbar in the Dependency
Map tab of DFM. For details, see "Dependency Map Tab" in the
RTSM Data Flow Management Guide.
24 Sort Column Enables you to set the order of the visible columns. For details,
- Content see "Sort Column Content Dialog Box" on page 572.
Note: This option is displayed in Text mode of IT Universe
Manager only.
Straighten Straightens any selected relationship between two query nodes
that has angles.
To access: Select Layout > Straighten.
Note: This option is only available in Enrichment Manager and
Impact Analysis Manager.
User Opens the User Preferences dialog box which enables you to
Preferences reset warning message preferences. For details, see "User

Preferences Dialog Box" on page 102.

To access: Select Tools > User Preferences.
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Button Option Name | Use This Option to...
User Profile Opens the User Profile dialog box which displays the user details
for the user currently logged in.
To access: Select Tools > User Profile
Zoom In Zoom in on a specific section of the topology map by clicking

and drawing a selection rectangle around the part to magnify.
The area you select is displayed at the highest percentage that
fits in the topology map.

To access: Open the drop-down menu in the Mode box or select
View > Zoom In. In IT Universe Manager and the Modeling
Studio, select Layout > Zoom in.
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@ Topology Map Sidebar

The following table contains a description of each Topology Map sidebar
option. The Topology Map sidebar appears in IT Universe Manager and the

Modeling Studio.
Button Option Name Use This Option to...
] Move Layout Move the sidebar to the right or left side of the screen.
Toolbar to
(] Right/Left
Q Zoom In/Out Zoom in or out on the topology map.
a
Selection Enable selection mode in the topology map.
Mode
an Dragging Enable dragging mode in the topology map.
h Mode
a Refresh to get | Refresh the topology map to optimize the layout.
an optimal
layout
Fit to Window | Fit the complete map in the pane.
2 Hide Edges’ Hide the labels of all relationships.
“ Labels
@ Change label Open the Map Label Properties dialog box which enables you
= properties to set the maximum label length per line and maximum
number of lines per label.
Fu Show Map Open a small box with a copy of the topology map. This is
Overview useful in large views when zooming in.
Hierarchical Display the topology map in a layout displaying the
Layout precedence relations.
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Button Option Name Use This Option to...

£ Hierarchical Display the topology map in a layout displaying the
Layout with precedence relations using only horizontal and vertical edge
Orthogonal routing.
Routing

Circular Layout

Display the topology map in a layout that groups a graph'’s
nodes into groups or clusters.

1% Orthogonal Display the topology map in a layout using only horizontal
Layout and vertical edge routing.

g Symmetric Display the topology map in a layout showing clear
Layout representations of complex networks.
Print Print the topology map.

NG|

Export Map to
Image

Save the topology map to a file.
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7

Best Practices for Modeling

This chapter includes:

Reference

» Using Modeling Studio on page 216

» Models and Perspectives on page 216

» Building Models on page 217

» Model Dependencies on Other Cls in the RTSM on page 222
» Modeling an Application with Running Software on page 223

» Creating Views Using the Modeling Studio on page 223
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Reference

@ Using Modeling Studio

The Modeling Studio is the RTSM module for building and modeling views
for display in Service Health. This document details the required flow to
create Service Health views using the Modeling Studio.

The motivation behind developing the Modeling Studio is to create a
separation between the need to change the RTSM content by creating Cls
and relationships and the need to consume (view) the RTSM content. In
earlier versions, altering the RTSM content was part of the view creation
workflow. Hence, users were unintentionally changing the RTSM and
influencing other users’ views. In the Modeling Studio, you build models
and transform your content into views to be consumed by HP Business
Service Management.

® Models and Perspectives

216

A model is a CI collection that represents a managed business entity such as
an application, business service, or line of business. A model is usually
created by solution or application architects who are familiar with the
content and hierarchy of the model. The model content can include system
ClIs (typically nodes), running software CIs (such as web servers, databases,
and J2EE servers), end user monitoring components (Business Process
Monitor or Real User Monitor applications), business processes, groups, and
other existing models.

To generate a view from a model, a perspective needs to be applied. A
perspective is a TQL-based tool that enriches the model content by adding
additional ClIs, thus creating a view. The default perspectives that are applied
to create Service Health views add all descendent ClIs that are related by
impact links down to the level of monitor Cls. There are other perspectives
provided out of the box that can be used to address additional use cases.
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The resulting view shows the model content as it is monitored by
HP Business Service Management.

@ Building Models

The information required to define a model includes the CI content, the
hierarchy, and the dependencies upon additional ClIs.

HP Business Service Management is configured with a predefined list of CI
types that represent your business entities. When creating a new model
using the Modeling Studio, the following list of valid models appears:

Select Cl Type

@ BuzinessApplication
BusinezzFunction

LTEI_J Buziness Service

@ BusinessTransactionFlow
(8] CiCallzction

& Infraztructure Service

I'El Organization

217



Chapter 7  Best Practices for Modeling

218

The model CI types can be arranged in hierarchies to reflect the
organization’s specific needs. Here is an example of a typical recommended
model hierarchy:

Line of Business

Y

Business Service/Business
Unit

N

Business Process Application

A 4

Groups (infra/End User)

—

Software Elements/
System Monitors BEMELLY

A model can be nested in any logical hierarchy, but it is best to create a
hierarchy that starts from high level business entities down to more specific
model types.

It is strongly recommended to build models in a way that allows them to be
reused as components of other models.

Building a model creates a contains link between the model and its Cls
according to the defined hierarchy.

The creation of a CI which is a model CI results in the creation of an empty
model by default. Therefore, if you want to create a model for a CI that does
not yet exist, you create a new model and thus, a new CI. If you want to
model an existing CI for the first time, select the CI in the CI Selector, drag it
onto the canvas and select Create a New Model.
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Preconfigured Models

HP Business Service Management creates out-of-the-box models for
applications monitored by Business Process Monitor and Real User Monitor.

The Business Process Monitor model is of type business transaction flow and
it contains business transaction Cls.

£ Banking* X
1% v [ETen] 5 @ LB ®|&%=EAQ-G-&-| A
Name | Cl Type
= @ Banking BusinessApplication
@ Credit cards BusinessTransactionFlow
@ trans_1 BusinessTransaction
@ trans_2 BusinessTransaction
@ trans_3 BusinessTransaction
@ trans_4 BusinessTransaction

The Real User Monitor model is of type application and contains the End
User Management Application related group and business process step Cls.
The Real User Monitor model is also impacted by the Real User Monitor
Sessions monitor Cls, Real User Monitor Errors events Cls, and Real User
Monitor Informational events Cls, which are visible in the Related ClIs pane.

Cf Saving Account X
Text Mode ¥ |EE 60 B ] B AL | Ay - Gy - B | Q Find

[:% Name | Cl Type
|EI— {% Saving Account | Application
. & Business Processes End User Management Application Related Group
“_.5 Show accounts list Business Process Step
‘_.5 Select account Business Process Step
‘_.5 update profie Business Process Step
‘_.5 Search by dates Business Process Step
‘_.5 request check book Business Process Step
‘_.5 Account history Business Process Step
Properties Related Cls ‘Watchpaints
Saving Account (Application)
Filter | <Show All> |v | by ‘

Direction | cl Cltype | Relation type
& P * Rum Info Everts RUM Informational Everts J Impacted By (Potentially)
{E} » plication Sessions RUM Sessions manitor ] Impacted By (Potentially)
{E} » =, Pum Errors RUM Errors events ] Impacted By (Potentially)
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Building Model Content

Create a model of the desired type and assign it a name. The new model
appears as the top CI in the content pane of the Model Editor. Drag and
drop CIs from the CI Selector into the content pane to build the model
content.

A model can contain system Cls, running software Cls, SiteScope groups,
and other models (both existing models and new ones created during the
modeling process).

The only ClIs that cannot be part of a model containment tree are monitors.
Monitor Cls are added to a model after you generate a view from the model
using one of the monitor perspectives. You can include monitors in view by
dragging them into the Related CIs pane when a model CI is selected in the
upper pane of the Model Editor. If you try to drop a monitor CI into the
upper pane, a message appears prompting you to add the monitor CI to the
Related Cls pane.

The CI Selector pane offers two ways to search for a CI (both model Cls and
non-model Cls):

» Browse Views

Use this option when you are familiar with a view that contains the CI
you are looking for. The following out-of-the-box views can help you find
commonly used Cls:

» End User Monitors view - contains business process groups and their
content.

> System Monitors view - contains SiteScope groups hierarchy.
> System Software Monitoring view - contains running software Cls and
the servers on which they are deployed.
In the CI Selector, select Browse Views and begin entering the view name
or use the view tree to look for a CI in a specific folder.

» Search Cls

If you know the CI type you are looking for, select the Search Cls mode
and use the quick search dialog to locate the desired CI. Use the Advanced
Search option for CIs that do not appear in the quick search mode.
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The search result appears in the left pane. After the list of ClIs is refreshed,
you can drag and drop ClIs into the model content pane. It is possible to
drag and drop multiple CIs in a single selection.

Models can be placed in a hierarchical mode. During the process of building
the content you can insert new models and create groups.

Hierarchies between CI types which are not models is not supported.

Grouping
In some cases, there is a need to divide the model into logical groups
according to ownerships, locations or any other custom representation.

In the following example the application contains two groups that represent
data centers:

) Bank One Data Centers® * |
15 men [FETen] | 5" 60 L@ 65 T3 X |G %6 M - Gy - B -] Q@ Find
Name | Cl Type
El (& Bank One Data Centers BusinessService
[} N¥ Data Center CiCollection
E 127.0.0.1 DefauttDomain Mode
E 10-END1-E Windows
| = [ LA Data center CiCollection
0gbBI362eaf devlab ad Windows
0gbBI3734wa cleviab ad Windows
ABM1APPO3 Windows
= ] LaBM3AMINTOS Windows

For details on creating groups in a model, see "CI Collection" on page 400.
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@ Model Dependencies on Other Cls in the RTSM

Each model CI in the model can be dependent on other ClIs that exist in the
RTSM but are not part of the model itself. Examples of such Cls include
shared resources such as database servers and storage devices.

The model structure may vary between organizations according to policies
and responsibilities in the IT department. There are organizations where
shared resources are considered to be part of the application and are
monitored as part of it, while in other organizations they are considered
external to the application. In the first case, shared resources are part of the
model and appear in the content pane, whereas in the second case they
appear as related ClIs (in the lower pane of the Model Editor).

To create a dependency between a CI in the model and another CI in the
RTSM, search for a CI in the left pane and drag it into the Related Cls tab.
This operation creates a usage link in the RTSM.

In order to create a dependency relationship between two ClIs, there must be
a valid link in the RTSM between the two CI types. By default, all business
ClIs can be dependent on other business ClIs.

The following example shows an application that depends on a web server
and Oracle software elements:

(G Credit cards*> |
’W‘[ﬁ' (<2 B i fg o« Gy - BB - Q Find
Name Cl Type
=3 _,"35 Credit cards Business Process Group

'_.'- Future debits Business Process Step
'_.'- Select credit card Business Process Step
'_.'- Request data from Amex Business Process Step
'_.'- Request new credi card Business Process Step
'_.'- Last statement Business Process Step

Properties Related Cls Watchpoints

Fitter | <Show All= > | by

Direction | cl | Cltype | Relation type

i P 2 Microsoft IS WebServer (1659 57.145) s J Depends On
o % D536 (abmZamdbl1) Oracle J Depends On
D

222



Chapter 7 e Best Practices for Modeling

HP Business Service Management offers a revised out-of-the-box impact
model. The impact model describes the impact relationships between CI
types. For example, a running software CI is impacted by the node on which
it is deployed. In the Modeling Studio, when you include a running software
CI as part of a model, the node on which it is deployed appears in the
Related Cls tab, since the running software is dependent on the server.

@ Modeling an Application with Running Software

Running software CIs are Cls that describe the implementation components
of an application. Examples include web servers such as IIS or Apache,
application servers such as Webshpere or Weblogic, and databases.

To build the implementation model of a three tier application using its
running software Cls, create an application model.

You can use the Running Software search in the Advanced Search dialog or
browse the System Software Monitoring view to locate running software Cls.
The names of the running software ClIs are formed by combining the
running software CI type with the server name, for example, Microsoft IS
web server (Server1).

Drag the relevant running software Cls into the modeling pane. The server
on which the running software was deployed as well as the monitor of the
running software both appear automatically in the Related ClIs pane. This
change derives from the new SiteScope monitoring model. In previous
versions, all monitors (of both hardware and software) were connected to
the Server CI. The SiteScope model was enhanced and now hardware
monitors are connected to the server CI, while software monitors are
connected to the running software Cls.

@ Creating Views Using the Modeling Studio

There are two methods of creating perspective-based views using the
Modeling Studio. The first option is to create a view based on a model (or on
several models); the second one is to create a view out of CI collection that is
not a model.
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A view based on a model is updated automatically when the model content
is updated. For example, a view was generated using a business process
group model that initially contained five business process steps. The
business process group was then updated to include additional business
process steps. Those changes are automatically reflected in the view.

This option is the recommended one, since it creates a dynamic view.

In a view based both on models and individual CIs, the view content is
updated according to changes in the models.

Generating a View from a Model

After building a model and saving the model definition, select the top
model and select Generate view for selected model. In the dialog box that
opens, select the desired perspective according to the desired view content.

The recommended perspective is the Impact Perspective. It creates a view
with all the ClIs in the model and for each CI, it adds all the child CIs
including the monitor Cls. Additional perspectives that may be used for
other purposes are described in "Predefined Perspectives" on page 344.

If the selected model includes dependent Cls (which appear in the Related
ClIs tab), they are also enriched by the perspective and become part of the
view.

The Content Only perspective does not make any changes in the view, even
for model Cls.

Hiding Irrelevant Cls from a View

The view result appears in the View Results pane. At this point, you may
choose to hide Cls that appear in the view.

Hiding CIs from a view does not change the status calculation of CIs in the
view (the status calculation is performed according to the RTSM hierarchy).
For example, hiding two business process steps from a business process
group with five steps does not affect the business process group status. If a
hidden CI has a critical status and the remaining ClIs are OK, the business
process group shows a critical status.
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For details on hiding Cls and restoring them to a view, see "Including and
Excluding Child CIs" on page 352.
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IT Universe Manager

This chapter includes:

Concepts

» IT Universe Manager Overview on page 228

» Working with Views in IT Universe Manager on page 229
» View Tree Structure on page 231

» Working with CIs on page 232

» Working with Relationships on page 236

Tasks

» Create CIs and Relationships in the RTSM on page 244

» View Related CIs on page 245

» Check Status of Application Discovery (Rediscover a View) on page 247
» Retrieve Impact Analysis Results — Scenario on page 250
» Take a Snapshot of a View on page 257

» Print and Save a Topology Map to File on page 258
Reference

» IT Universe Manager User Interface on page 259

227



Chapter 8  IT Universe Manager

Concepts

& IT Universe Manager Overview

228

IT Universe Manager enables you to manage the content of your IT Universe
model. The following tasks represent the basic functionality of the
application:

» Creating Cls without creating relationships. You can define new CIs that
are added to the RTSM individually, so that no new relationships are
created. For details, see "Creating a Non-Related CI" on page 233.

» Creating Cls with relationships for them. You can define new CIs and
attach them to existing Cls, so defining a new CI and a new relationship
in the RTSM. For details, see "Creating a Related CI" on page 233.

» Adding existing Cls and creating relationships for them. You can attach
ClIs to an existing CI, so creating new relationships for existing Cls. For
details, see "Attaching Existing CIs" on page 238.

» Deleting Cls. You can delete CIs from the RTSM. For details, see "Deleting
CIs" on page 234.

» Getting Impact Analysis results. You can run the Impact rules you defined
for a view to simulate how certain defined changes impact your system,
and to discover the root causes of the changes. For more information
about Impact rules, see "Impact Analysis Manager Overview" on page 450.

Populating the IT Universe Model

The IT Universe model in the RTSM contains the CIs and relationships
produced by the Cl-generating tools that operate within HP Business Service
Management. Most Cls and relationships originate from one of the
following sources:

> Data Flow Management (DFM). Automatically creates ClIs and
relationships based on the discovered IT resources and topology in your
company’s infrastructure. For details, see "Data Flow Management
Overview" in the RTSM Data Flow Management Guide.
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» IT Universe Manager. Enables you to manually create ClIs and
relationships that represent logical and physical elements of the business.
For details, see "Working with CIs" on page 232.

> End User Management Administration and System Availability
Management Administration. Enables you to manually create
relationships between the Cls for monitor objects and CIs in the RTSM.
For details, see "Integrating SiteScope Data with BSM’s Configuration
Items" in Using System Availability Management.

» Enrichment Manager. Enables you to add CIs and relationships to the
RTSM by receiving data from the attributes of Enrichment query nodes as
defined in the Enrichment TQL query. For details, see "Enrichment
Manager" on page 519.

& Working with Views in IT Universe Manager

In IT Universe Manager, you analyze data at the view level. Views are subsets
of the IT Universe, containing only those CIs relating to a specific area of
interest. All views are based on a pattern which determines the content of
the view.

» Pattern views and template-based views are built from a TQL (Topology
Query Language) query that defines the structure of the view. The view
displays only those CIs and relationships that satisfy the query definition.

» Perspective-based views are built manually, by selecting a group of Cls
and applying perspectives to them. A perspective is a pattern used to
define which related Cls are included in the view.

You build all views in the Modeling Studio, using the appropriate editor for
each view type. For information on the different view types and how they
function, see "View Formats" on page 338.

Note: You must have Change permissions for a view to edit the view. If you
do not have the necessary permissions, contact your HP Business Service
Management Administrator.
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CIs created by DFM are automatically added to each view where the Cls (and
their relationships) fit the TQL definition for the view. When you open a
view in the CI Selector, the TQL query for the view queries the RTSM for ClIs
that match the defined pattern. If there are no matches (for example, in the
case of a view for a DFM process where the process has not yet run) then the
view remains empty.

When you define a new CI while working in any view in IT Universe
Manager, the CI (and any associated relationship) is created in the RTSM.
The CI is added to your current view only if it meets the view’s TQL
specifications.

If the created CI and relationship do not meet the TQL requirements, then
the CI and relationship are created in the RTSM but are not visible in the
view. Similarly, if you attach an existing CI to a CI in the view, and the new
pattern does not meet the TQL requirements, then the attached CIs do not
appear in the view, but the relationship is still created.

Templates and Template-based Views

If you open a template in IT Universe Manager, it is displayed in the
topology map like a pattern view. Click the Show Template Parameters
button in the CI Selector toolbar to open the Template Parameter Values
dialog box, where you can change the values of the template parameters and
thereby affect the view results displayed in the topology map. You can try
different parameter values and see the resulting topology map, but you
cannot save changes to the template itself. To save the view results as a
template-based view with the selected parameters, click the Save As View
button in the Template Parameter Values dialog box.

You can also create a direct link to a template in IT Universe Manager and
insert the parameter values directly into the URL. For details, see "Create a
Direct Link to a Template with Parameter Values" on page 120.

View Lifecycle

If you do not access a view from the CI Selector for a specified period of
time, the view is cleared out, to save memory in the system. It is not deleted
from the RTSM; the view can be retrieved by clicking on it. The default time
period for clearing out unused views is one hour.
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Note: Views defined as persistent are not cleared out and always remain in
the memory.

Hidden Views

You can designate a view as a hidden view that does not appear in
IT Universe Manager by defining a bundle for hidden views and assigning
the view to that bundle.

To designate a view as a hidden view:

1 In the Infrastructure Settings Manager, select Hidden Bundles Names in Cl
Selector.

2 Enter the name of the new bundle as the default value and save the
setting.

3 In the Modeling Studio, open the relevant view and click the View
= Definition Properties button in the toolbar.

4 In the View Definition Properties dialog box, select the hidden views
bundle and assign the view to it.

& View Tree Structure

Views are organized in a hierarchical tree format in the left pane of

IT Universe Manager, which is known as the CI Selector. The view name
appears in the View box above the tree and acts as the containing folder for
the Cls in the view.

The first level of the CI Selector tree consists of the query nodes for the root
ClIs. A root ClI is the starting point for a view subtree. A view may contain
any number of subtrees. Under the root CIs come the branch Cls, expanding
down to the leaf ClIs as the last query nodes at the ends of each branch.
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The CIs at each level in a subtree are considered to be attached to the CI on
the branch directly above. This attachment generally depicts a dependent
relationship, so that the higher branch (closer to the root CI) represents a
component of your business that depends on the CIs on the next branch
down (closer to the leaf Cls) in the business process. For example, an
application depends on the servers running the application.

The attachment between a higher and a lower query node is referred to as a
parent-child relationship. The parent CI may have many attached child CIs,
and the child Cls pass operational status to the parent. The status at each
level is viewed in Service Health.

BPM_Profile1 - |
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The tree topology is determined by the hierarchy defined for the view. In a
pattern view, these are defined for the specific view. In a template-based or a
perspective-based view, the hierarchy is defined as part of the template or
perspective. For details on defining the hierarchy, see "Setting the View
Hierarchy" on page 340.

& Working with Cls

232

In IT Universe Manager, you can create related and non-related Cls, delete
CIs, edit the CI properties, and remove out-of-date Cls using the aging
mechanism.

This section includes the following topics:

» "Creating a Non-Related CI" on page 233
» "Creating a Related CI" on page 233
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> "Deleting CIs" on page 234
» "CI Properties" on page 235
> "Removing Out of Date Cls Using the Aging Mechanism" on page 236

Creating a Non-Related CI

You can define a new CI in IT Universe Manager by clicking the New ClI
button in the toolbar. The New CI dialog box opens, which enables you to
define the properties for the new CI. The CI is created in the RTSM. For
details, see "New CI/New Related CI Dialog Box" on page 289.

Note: The CI is added to the view only if it meets the specifications of the
pattern, template, or perspective of the view.

A CI created in this way is added as an independent entity without any
relationship to any other existing CI in the RTSM.

Creating a Related CI

You can define a new CI to be added as a parent, child, or sibling of an
existing CI.

To define a new related ClI:
1 Select the CI in your view to which you want to attach the new CI.
2 Click the New Related Cl button in the toolbar.

3 In the New Related CI dialog box, define the properties and relationship
for the CI. For details, see "New CI/New Related CI Dialog Box" on
page 289.

The CI and relationship are created in the RTSM.
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Note: The CI and relationship are added to the view only if they meet the
specifications of the pattern of the view, template, or perspective.

Deleting Cls

You can delete a CI by selecting Delete from CMDB from the shortcut menu
in IT Universe Manager. The Cl is deleted from the RTSM and from all views.
If the CI has children, they are not automatically deleted when you delete
the parent CI. If you delete a CI without first deleting the relationship
between the CI and any child CIs that appear with the parent CI in a view,
the child CIs are removed from the view.

If the child CIs do not appear in any other view, they remain in the RTSM
without appearing in a view. The child CIs might appear in the future in
views where they meet the pattern requirements.

One exception to this rule is when the relationship between a child and
parent CI is a Composition relationship; in that case, when the parent CI is
deleted, the contained CI is also removed from the RTSM. For example, if a
node CI is the container for a child CPU CI, then when the node CI is
deleted, the CPU is also removed from the RTSM.

When you delete a CI that was created by the DFM process, the CI is
restored the next time that DFM runs (if the CI is still valid), and it reappears
in all relevant views.
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Cl Properties

In IT Universe Manager, you can edit the properties of a CI. The CI
properties are divided into several categories which appear in the New CI
dialog box:

» The general properties of a CI are common to all CIs. Some general
properties are defined automatically during CI creation; others can only
be defined manually in the New CI dialog box.

» CIT-specific properties are created as part of the CIT definition in the CI
Type Manager. The values for the CIT-specific properties are taken from
the Cls discovered during DFM. The values can also be entered manually,
when you manually create CIs to represent entities in your infrastructure.
For details, see "CI Type Manager" on page 475.

» Key properties can be general or CIT-specific properties, which must be
assigned a value to create an instance of the CI type.

You can access the Configuration Item Properties dialog box to view the CI
properties from IT Universe Manager by right-clicking the CI and selecting
Properties or by clicking the Properties tab in the Advanced pane. You can
also edit the CI properties if you have the necessary permissions for editing
ClIs. For details on CI properties, see "Configuration Item Properties Dialog
Box" on page 266.

The CIT-specific properties are displayed in the Specific Properties section of
the Configuration Item Properties dialog box when you sort the properties
using the Categorized button. Some properties for the automatically created
ClIs can be edited, however, if the CI is configured to Allow Cl Update (in the
General Properties), then DFM may override your changes when it updates
the CI. A description of the selected property can be found in the
Description area at the bottom of the Configuration Item Properties dialog
box.

Some of the CIT-specific properties for DEM CIs are set by default to be
monitored for changes. When one of these properties has been modified,
information on the change can be viewed in a CI change report, and in
some cases, an icon is displayed in Service Health. For more information, see
"CI Change Report" on page 426.
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Removing Out of Date Cls Using the Aging Mechanism

If a CI or relationship is not updated or refreshed over a period of time (for
example, a Cl is not rediscovered by DFM and no manual update occurs), an
aging mechanism deletes the CI from the RTSM. For details, see "CI Lifecycle
and the Aging Mechanism" in the RTSM Administration Guide.

& Working with Relationships

236

1w

Many of the relationships between Cls in the RTSM are created
automatically, for example, by DFM. In addition, you can create
relationships manually in IT Universe Manager, Enrichment Manager,
Impact Analysis Manager, or the Modeling Studio. You can also create
relationships in System Availability Management and End User
Management Administration.

This section includes the following topics:

> "Creating Relationships" on page 236

» "Creating Hierarchical Relationships" on page 237
"Attaching Existing CIs" on page 238

"Setting the View Hierarchy" on page 239
"Viewing Related CIs" on page 240

"Deleting Relationships" on page 240

Y YV Y Y Y

"Inter-Layer Relationships" on page 241

Creating Relationships

You can create relationships in IT Universe Manager by right-clicking a CI or
multiple CIs in the CI Selector pane or the Topology Map and selecting
Relate to Cl from the shortcut menu. In the Topology Map, you can define a
relationship between two ClIs in the view by drawing a line between the two,
using the Create Relationship button from the toolbar. Either of these
actions opens the Insert Relationship dialog box. For details, see "Insert
Relationship Dialog Box" on page 273.
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You can create as many relationships as necessary between a CI in the RTSM
and other CIs. Each new relationship exists as its own entity in the RTSM,
and has its own properties that can be edited in IT Universe Manager (as
described in "Configuration Item Properties Dialog Box" on page 266). You
can also create more than one relationship between the same two Cls, when
each relationship is based on a different relationship type. In the following
example, host7 has both a Backbone and a Talk relationship with switch3.

=
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Creating Hierarchical Relationships

By attaching one CI to another in IT Universe Manager or System
Availability Management or End User Management Administration you
create a hierarchical relationship (parent-child) between them, so that one
Cl is influenced by the other.
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Certain relationships defined in this way are restricted to the relationship
type usage (if the relationship is between two non-monitoring ClIs), or the
relationship type Monitored By (if the child CI in the relationship is a
monitor type CI); however, other relationship types are used between
specific types of Cls. For example, if a relationship is defined between two
node ClIs, there are several possible relationship types.

Select Relationship
Source Cl. host08 (Mode)
Target Cl(s). hostO7

Relationship: | -
i I— Membership -
Direction: Dependency

Define Relation

’— Backbone -
=1

4 I} 3

Note: When you attach a child CI to a parent CI, you are creating that
relationship in the RTSM. The child therefore impacts on the parent CI in
every view where the relationship exists, and is displayed in every view
where the child and relationship match the TQL query.

When performing status calculations, the Business Logic Engine only
recognizes calculated relationships. For details on calculated relationships,
see "Impact Rules" on page 111.

Attaching Existing Cls

You can attach existing Cls using the Insert Relationship dialog box. The
dialog box has two modes:

» Selecting the ClIs that you want to attach.
» Defining the relationship between the original CI and the CIs to attach.
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When selecting the CIs to attach, you can select multiple Cls from a view to
attach to the original CI. However, all CIs that you want to attach in one
operation must have the same relationship type. For example, you cannot
attach a CI that uses the relationship usage in the same operation as a CI
that uses the relationship Monitored By.

Note: SiteScope monitor Cls should not be attached to other Cls from
within the RTSM. You should only create links to SiteScope monitor Cls
from within SiteScope.

Setting the View Hierarchy

After setting the query node and relationship definitions of a view, you can
set a hierarchy for the view. This enables you to define the organizational
structure of CIs in the view by displaying selected Cls at different levels.
When no hierarchy is defined, the Topology Map or table displays all Cls
included in the query results on one level by default. For example, if the
query results include nodes and IP Subnets, both CI types are displayed on
the same level in the Topology Map or table.

Note: The maximum number of CIs that can be displayed in a single layer of
the Topology Map is 900. If a view contains a layer with more than 900 ClIs,
the view is not displayed in the Topology Map until the hierarchy is
changed. However, a layer with more than 900 Cls can be displayed in a
table in Text mode.

For details on setting the hierarchy, see "Setting the View Hierarchy" on
page 340.
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Viewing Related Cls

You can view all the ClIs related to a selected CI in the topology map. Select
a Clin a view and then select the Related Cls tab. The Get Related CIs pane
enables you to select the scope of the display. If you select View, the
topology map displays only the selected CI and its related Cls in the view
(no matter where it is in the view hierarchy). If you select CMDB, it displays
the selected CI and all of its related ClIs in the RTSM. You can also filter the
results from the Get Related CIs pane by CI type and apply perspectives to a
CI. For details, see "Get Related ClIs Pane" on page 287.

You can also display Related ClIs using the Get Related CIs from CMDB
dialog box. For details, see "Get Related Cls From CMDB Dialog Box" on
page 272.

Deleting Relationships

The Topology Map shows only the relationships for the ClIs that are part of
the current view; however, the same relationships may also be part of other
views. When you delete a relationship in IT Universe Manager, it is deleted
from the RTSM and from all views.

When a relationship is deleted, the CI on the other end of the relationship

may remain in the view, if it still matches the pattern of the view. However,
if the deleted relationship is a composition link, the target CI is deleted with
it.

In a perspective-based view, you can remove the CI completely from the
view (without deleting it from the RTSM), by hiding it from the view in the
Perspective-based View Editor in the Modeling Studio.

When you delete a relationship that was created by the DFM process, the
relationship is restored the next time that DFM runs (if the relationship is
still valid), and it reappears in all relevant pattern views.

It can take a few minutes to delete subtrees, or multiple CIs and
relationships, from a view.
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Inter-Layer Relationships

In certain circumstances, IT Universe Manager displays a relationship
between ClIs in a layer of a view that does not reflect an actual relationship
between the Cls in that layer, but rather a relationship between Cls on
deeper layers of the view. Such a relationship is known as an inter-layer
relationship.

For example, in the following view, two node Cls are related to each other
with a dependency relationship. Each is also related to an IP Subnet by a
membership relationship and the view hierarchy is defined such that the
nodes are on the layer beneath the IP Subnet.

@
InSubn

Membershin %, wambership_1

é‘ Dependency @

Mode_1 Mode

When you consume the view in IT Universe Manager, the relationship
between the node CIs (which are under different IP Subnets) is displayed in
the higher layer of the view as a relationship between the parent IP Subnets,
even though the actual relationship only exists between the Cls in the lower
layer of the view. You can double-click the relationship to display the full
path between the IP Subnets.
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Another form of inter-layer relationship occurs when the same CI appears
under more than one parent CI of the same type in the layer above it. In
such a case, the child CI and its relationships are duplicated in the view
display, due to the hierarchy definition. The relationships of such child Cls
result in inter-layer relationships between the parent Cls. This type of inter-
layer relationship is known as a duplication metalink.

For example, in the following view, a single node CI appears under two IP
Subnet CIs in the hierarchy. The node and its children thus appear twice in
the view - once under each IP Subnet. Each node is effectively related to the
child CIs of the node under the other IP Subnet, which generates an inter-
layer relationship between the two IP Subnets.
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Inter-layer relationships and duplication metalinks are displayed in gray in
the topology map. IT Universe Manager provides the following options for
viewing inter-layer relationships:

> None. Hide all inter-layer relationships.

> Inter Layer. Display inter-layer relationships of the first type, but not
duplication metalinks.

> Full. Display all inter-layer relationships, including duplication metalinks.
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A tooltip for the inter-layer relationship displays the inner relationships
which it represents. If there is only one inner relationship, the relationship
label displays that relationship type. If there are multiple inner
relationships, the label becomes Inter-layer and the tooltip displays a list of
all the inner relationships. If there are more than ten inner relationships,
only the first ten are displayed, and a note indicates that there are more
inner relationships.
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Tasks

P Create ClIs and Relationships in the RTSM

This task describes how to create related and non-related Cls, as well as
relationships between Cls, in the RTSM.

This task includes the following steps:

» "Define a New Non-related CI" on page 244
> "Define a New Related CI" on page 244
» "Attach Existing CIs" on page 244

Define a New Non-related Cl

@ Click the New CI button in the toolbar. In the New CI dialog box, select a CI
type from the tree and define the properties for the new CI. For details, see
"New CI/New Related CI Dialog Box" on page 289.

Define a New Related CI

Click the New Related Cl button in the toolbar. In the New Related Cl
dialog box, select a CI type from the tree and define the properties for the
new CI. On the Relationship page of the dialog box, select the type of
relationship and define its properties. For details, see "New CI/New Related
CI Dialog Box" on page 289.

Attach Existing Cls

Select a CI in a view. Right-click the CI and select Relate to Cl. In the Insert
Relationship dialog box, select a target CI. On the Relationship page of the
dialog box, select the type of relationship and define its properties. For
details, see "Insert Relationship Dialog Box" on page 273.
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P View Related Cls

The following steps describe the options for viewing related Cls in
IT Universe Manager.

"Display Related CIs" on page 245
"Select the Scope of the Display" on page 246
"Filter the Related CIs" on page 246

Y VY VY Y

"Apply Perspectives to a CI" on page 246

Display Related Cls

In IT Universe Manager, select a CI in the Topology map or the CI Selector

and select the Related Cls tab. Click the Enable Related Cls Retrieval button.
g The selected CI is displayed with its related Cls. Select a different CI or

multiple CIs from the CI Selector, and the display changes accordingly.

Note: You can display the Related CIs content in map mode or in text mode.

For details on the Get Related Cls user interface, see "Get Related CIs Pane"
on page 287.
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Select the Scope of the Display

In the Get Related CIs pane, select the scope of the related Cls display. Click
the Show Related Cls button. The display changes according to your
selection.

Filter the Related Cls

In the Filter Related ClIs by CI Type section, select the CI types to appear in
the related ClIs display. Click the Filter Related Cls button. The filtered
results appear in the tab. The scope selected above still applies and the
display is reduced according to your filter selection.

Apply Perspectives to a Cl

In the Apply Perspectives to CI section, select the perspectives to apply to
your selected CI. Click the Apply Perspectives button. The results are
displayed in the tab.

Note: This feature is only relevant when CMDB is selected as the scope.
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T Check Status of Application Discovery (Rediscover a

View)

You, the application owner or administrator, need to be kept informed of
any problems to your application. So, for example, you need to know that
discovery is working correctly and that its current configuration can
connect to the application database. This section explains how to run the
rediscovery procedure that enables you to check the current status of the
discovery of an application.

Note:

>

Set up and configuration is performed by the HP Business Service
Management administrator. For details, see "Prerequisites" on page 248.

Rediscovery is performed by the application owner/administrator. For
details, see "Access the View" on page 248.

You do not need any knowledge of Data Flow Management (DFM) to run
this procedure.

By default, you can run the rediscovery procedure on views that include
less than 10,000 ClIs. For details on changing this number, see "Important
information" on page 298.

This task includes the following steps:

Y VY VY Y

"Prerequisites" on page 248

"Access the View" on page 248

"View Results in the View" on page 249
"Schedule the Rediscovery" on page 250

247



Chapter 8  IT Universe Manager

1 Prerequisites

Note: This step is performed by the HP Business Service Management
administrator.

a In DFM, create a module that contains the jobs that must discover the
application. For details, see "How to Use Discovery Control Panel —
Advanced Mode Workflow" in the RTSM Data Flow Management Guide.

b Activate the module and all the jobs. The jobs must remain activated.

¢ Verify that the module has run without errors. For details, see "Error
Messages Overview" in the RTSM Developer Reference Guide and
"Discovery Status Pane" in the RTSM Data Flow Management Guide.

d Correct any errors in the application and confirm that DFM finds no
errors during the next run.

Caution: The application owner cannot rediscover a view if DFM is
reporting errors. You must set an error-free baseline.

e In the Modeling Studio, define a view that includes the application CI
or CIs to be rediscovered. These are the Cls that are created when you
activate the jobs that discover the application. For details, see "Create a
Pattern View" on page 359.

f Notify the application owner of the name of the view.

2 Access the View

Note: This step is performed by the application owner/administrator.
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In IT Universe Manager, access the view that includes the application CIs
to be rediscovered. For details, see "Search for CIs in Search Mode" on
page 157.

3 View Results in the View

a You need to check the complete application. You click the Show
Discovery and Changes Summary button in the CI Selector toolbar.
The Show Discovery Status and Changes of View dialog box is
displayed. The dialog box displays information about which jobs and
trigger CI discovered the ClIs in the view, on the last occasion that DFM
ran the discovery for the jobs. For details, see "Show Discovery Status
and Changes Dialog Box" on page 298.

To run the discovery, click the Rerun Discovery button. To view
information about the jobs and trigger CIs, use the links to drill down.
For details, see "Error Messages Overview" in the RTSM Developer
Reference Guide.

b You need to check specific components of your application. You select
the component’s CI in the Topology Map pane and display the
Discovery tab in the Advanced pane. For details, see "Show Discovery
Status and Changes Dialog Box" on page 298.

To rediscover several Cls, press CTRL, select the CIs and display the
Discovery tab.

To run the discovery, click the Rerun Discovery button.
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4

Schedule the Rediscovery

You can schedule how often the rediscovery procedure should run. In the
Job Definition window, choose the Rerun Discovery on View action. For
details, see "Job Definition Dialog Box" on page 88.

T Retrieve Impact Analysis Results — Scenario

250

Impact Analysis Manager enables you to create an Impact rule that allows
you to simulate the impact certain infrastructure changes have on your
system. The results of the Impact rule are displayed in IT Universe Manager.
The Impact Analysis results in this task describe how a change in CPU
operation impacts the node to which it is connected.

This task includes the following steps:

Y VY VY Y

-—)

"Define an Impact Analysis TQL Query" on page 250
"Define an Impact Rule" on page 251

"Create a View in the Modeling Studio" on page 253
"Get Impact Analysis Results" on page 253

Define an Impact Analysis TQL Query

To define an Impact Analysis TQL query, you need to create an Impact
rule and then add the TQL query nodes and relationships that define the

query.
To create an Impact Analysis TQL query, select Admin >
RTSM Administration > Modeling > Impact Analysis Manager. For details

about how to add query nodes and relationships to a query, see "Add
Query Nodes and Relationships to a TQL Query" on page 32.
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Example of an Impact Analysis TQL Query:

In this Impact Analysis TQL query, a CPU and a node are linked by a
Composition relationship.

(a0

i

=
=)

| Composition

¥

o

Cpu

2 Define an Impact Rule

When you define an Impact rule, you must specify the required causal
relationship between the query nodes. Define one query node as the
trigger, or the query node that represents the changes you want to make
to the system, and another query node as the one that is impacted.

Right-click the query node you want to define as the trigger and select
Define Impacted to open the Impacted Query Nodes dialog box. Select
the query node that you want the trigger query node to impact and click
Next. Then click the Add button to open the Impact Rules Definition
dialog box to set conditions for defining impacted query nodes. For
details about how to define an Impact rule, see "Impact Rules Definition
Dialog Box" on page 467.

Note: The change state option in the Impact rule definition is no longer
relevant for Impact Analysis. The only supported state is operation.
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Example of an Impact Rule:

The Conditions area in the Impact Rules Definition dialog box defines the
conditions under which the simulated change in the system is triggered.
The Severity area defines the severity of the impact on the impacted query
node.

The Impact rule in this example states that when the CPU operation is
not in the normal state, the node is impacted. Since the severity is set to
100% of the trigger’s severity, the severity of the node is the same as the
severity of the CPU, which is determined when Impact Analysis is run.

Description: | |

|| ~Condiizns

State: | operation |v |

Operator: | Mot equal |" |

Walue comparison: | Maormal |' |

() Fixed severity:
(®) severity relative to trigger severity (%):
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In the resulting TQL query, an upward arrow appears next to the query
node defined as the trigger query node and a downward arrow appears
next to the query node defined as the impacted query node.

Cornposition

‘;'+

Cpu

Create a View in the Modeling Studio

Go to the Modeling Studio and create a view matching the TQL query of
the Impact rule you defined. For details, see "Pattern View Editor" on
page 413.

Get Impact Analysis Results

Select Admin > RTSM Administration > Modeling > IT Universe Manager
and select the required view in the CI Selector. To get Impact Analysis
results, you need to run the Impact rule on a CI instance in the topology
map that is a trigger. Right-click a trigger CI and select Run Impact
Analysis to open the Run Impact Analysis dialog box. For details on how
to run an Impact rule, see "Run Impact Analysis Dialog Box" on page 294.
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Example for Getting Impact Analysis Results:

An Impact Analysis TQL query is created containing a CPU and node
connected by a Composition relationship. The CPU query node is defined
as the trigger query node and the query node of type node is defined as
the impacted query node.

The following Impact rule is defined for the query.

Impact Rules Definition E

Dezcription: | |

Il ~Conditicns

State: | operation |v |

Operator: | Mot equal |v |

Value comparizon: | Mormal |v |

Scope

® any
Cran
O Pange % = %

() Fixed severity:

(®) Severtty relative to trigger severtty (%):
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Right-click a CPU CI in the view, and select Run Impact Analysis to open
the Run Impact Analysis dialog box. Set the trigger severity to a value
other than Normal.

Ru'\ Impact Analysis [ %]
<=1 Run Impact Analysis
=

Select the impact analysis trigger and the set of impact rules that will be sxecuted

Trigger Severity

-0

[ ' [ [ [
Critical

Correlation Pules

® 4l Impact Pules
@] Only impact rules located in specified bundle
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To see results, click one of the following:

» Show in Views. This assigns a status to all the ClIs in the view. Only the
node CI connected to the CPU CI (whose severity was changed),
becomes impacted. The trigger CI and the impacted CI turn orange
because the trigger severity was set as Major (7) on the scale in the Run
Impact Analysis dialog box, which is assigned an orange color.

[

+

i

VIAMGATBE

Composition

-
(4

LABM3IAMDEDT

m
“J
=

Compaositian
Carmposition
U o=
CPUD CPN LABM2AM71
Compaosition
Composition

I

» Show Map. A map appears in a separate window containing only the
trigger CPU CI and the node CI it impacted. The relationship
connecting the two ClIs contains the name of the Impact rule defined
in Impact Analysis Manager.
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Note: Optionally, you can create a URL that enables you to embed the
map. For details, see "Direct Link Parameters — Impact Map Page" on
page 132.

®

L2,

YIMAMGOAT 6

Composition

f]:

CPUO

» Generate Report. Generates an Impact Analysis report that displays a
list of ClIs that are impacted in the system as a result of the simulated
changes. For details, see "Run Impact Analysis Dialog Box" on
page 294.

T Take a Snapshot of a View

You can take a snapshot of a view in IT Universe Manager, save it, and then
compare snapshots of the same view taken at different times using the
Compare Snapshots Report.

» For details on how to take a snapshot of a view, see "Save Snapshot Dialog
Box" on page 296.

» For details on how to view actual differences in the compared views, see
"Compare Snapshots Report" on page 318.
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P Print and Save a Topology Map to File

258

You can print the content of any topology map and then save it to file.
Before printing, it is recommended to define your print settings and arrange
the contents of the topology map according to your requirements.

» For details on how to define print settings, see "Print Setup Dialog Box" on
page 199.

» For details on how to preview the content of the topology map before
printing, see "Print Preview Dialog Box" on page 199.

» For details on how to print the content of a topology map, see "Print
Dialog Box" on page 198.

» For details on how to save a topology map to file, see "Run Impact
Analysis Dialog Box" on page 294.
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Reference

@ IT Universe Manager User Interface

This section includes (in alphabetical order):

» Add CIs to Model Dialog Box on page 259

» Add CIs to View Dialog Box on page 260

» Change Timeframe Dialog Box on page 261

» CI/Relationship History Dialog Box on page 262

» Configuration Item Properties Dialog Box on page 266
» Get Related ClIs From CMDB Dialog Box on page 272
» Insert Relationship Dialog Box on page 273

> IT Universe Manager Page on page 278

» New CI/New Related CI Dialog Box on page 289

» Run Impact Analysis Dialog Box on page 294

» Save Snapshot Dialog Box on page 296

» Show Discovery Status and Changes Dialog Box on page 298
» Show Impact Pane on page 300

@ Add Cls to Model Dialog Box

This dialog box enables you to add selected Cls to a model.

To access Select Admin > RTSM Administration > Modeling >
IT Universe Manager. Right click a CI or multiple ClIs in
the CI Selector and select Add Cls to Model.

Important This feature is only relevant for instance based models.
information You cannot add selected ClIs to a pattern based model.
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User interface elements are described below:

Ul Element (A-Z)

Description

<Model tree>

When Existing Model is selected, select a model from the
tree.

Define New ClI
Properties

When New Model is selected, define the name and
properties of the model.

Existing Model

Select Existing Model to add the selected ClIs to an
existing model.

New Model

Select Cl Type

When New Model is selected, select a CI type for the
model.

® Add Cls to View Dialog Box

This dialog box enables you to add selected ClIs to a perspective based view.

To access

Select Admin > RTSM Administration > Modeling >
IT Universe Manager. Right click a CI or multiple CIs in
the CI Selector and select Add Cls to View.

User interface elements are described below:

Ul Element (A-Z)

Description

<View tree>

When Existing View is selected, select a view from the
tree.

Existing View Select Existing View to add the selected ClIs to an existing
perspective based view.

New View Select New View to add the selected CIs to a new
perspective based view

View Name When New View is selected, edit the name of the view.

260

Select New Model to add the selected CIs to a new model.
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@ Change Timeframe Dialog Box

This dialog box enables you to display changes in the topology map and set
the time frame for the changes to display.

To access Select Admin > RTSM Administration > Modeling >
IT Universe Manager. Click the Set Change Timeframe
button in the main toolbar or the IT Universe status
bar.

Important When the change indicators are displayed in the topology

information map, a message appears in the IT Universe status bar

Change Timeframe is Active.

To hide the indicators, open the dialog box and select Do
not display changes, or select the Reset Change
Timeframe ‘Q button in the IT Universe status bar.

User interface elements are described below:

Ul Element (A-Z)

Description

Display changes
according to the
selected timeframe

follows:

» *#1 Indicator for an added CI
» & Indicator for a changed CI

Custom, click the ellipsis | ... button to select the Date

When the indicators are displayed, you can click the
indicator to open the CI History dialog box, which
displays the history for the CI over the selected period.

Select this option to display an indicator next to each CI
that was added or changed within the selected period as

Select a time period from the drop-down list. If you select

From and Date Until fields. The changes to the CIs of the
view within the selected period are displayed in the map.

Do not display
changes

Select this option to hide the change indicators.
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@ Cl/Relationship History Dialog Box

This dialog box displays a list of CI or relationship attributes in which
changes have occurred as well as the differences between two configuration
tiles.

To access » In IT Universe Manager, right-click the selected CI or
relationship in the CI Selector or the Topology Map
and select Cl History.

» In Data Flow Management, in the Discovered by
[Module or Job Name] Cls dialog box, right-click a CI
and choose CI History.

Note: CI and relationship history data is also available in

the History tab of the Advanced pane in IT Universe

Manager.

Important Only attributes marked with the Change Monitored or
information Comparable qualifiers are tracked in the CMDB History
database. If you want an attribute to appear in the CI
history, select the Change Monitored or the Comparable
qualifier for it in the Attributes tab of the CI Type
Manager. For Cls, some attributes are designated as
Change Monitored by default. For relationships the
attributes must be designated manually in the CI Type
Manager.

In addition, to track history for a relationship, you must
select the TRACK_LINK_CHANGES qualifier for the
relationship in the Qualifier tab of the CI Type Manager.
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User interface elements are described below:

Ul Element (A-Z) Description

|§| Click Refresh to refresh the data in the table.

Q View the difference between two history entries for the
content of a configuration file. This is relevant in the
following situations:

» Select two history entries for the Document Content
attribute for CIs of the type Configuration Document
to compare to each other.

» Select one history entry for the Document Content
attribute for CIs of the type Configuration Document
to compare to the current content for that CI.

Click the Show difference button to open the Visualdiff
report, which displays a comparison of the two entries.
Text added to the second entry appears highlighted in
yellow. Text removed from the first entry appears
highlighted in red. Differences between the entries
appear highlighted in green.
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Ul Element (A-Z)

Description

8

Choose the export format for the table data. The available
options are:

>

>

Excel. The table data is formatted as an .xls (Excel) file
that can be displayed in a spreadsheet.

PDF. The table data is exported in PDF format.

Note: When exporting to PDE, select a reasonable
number of columns to display to ensure that the report
is legible.

RTF. The table data is exported in Rich Text Format.
CSV. The table data is formatted as a comma-separated
values (CSV) text file that can be displayed in a
spreadsheet.

Note: For the CSV formatted table data to display
correctly, the comma (,) must be defined as the list
separator. In Windows, to verify or modify the list
separator value, open Regional Options from the
Control Panel, and on the Numbers tab ensure that the
comma is defined as the List Separator value.

XML. The table data is formatted as an XML file that
can be opened in a text or XML editor.

Tip: To extract HTML code from the report:

» Save the file as HTML

» Open the file in an HTML editor

» Copy the relevant table into the target file

Attribute

The name of the attribute.

Change Date

The date when the last change occurred.

Filter by

Filter the data in the table by one or more of the
following filters:

>

>

>

Time Range. Select the time period for which the CI
history is displayed.

Change Type. Select the type of changes displayed in
the table.

Attribute. Select the attribute types displayed in the
table.
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Ul Element (A-Z)

Description

Modified By Indicates the cause of the change. For example, the field
can contain the name of a user or a DFM job.

New Value The new value of the attribute.

Old Value The previous value of the attribute.

265



Chapter 8  IT Universe Manager

@ Configuration Item Properties Dialog Box

This dialog box enables you to view and edit basic information for an
existing CI or relationship.

To access Select Admin > RTSM Administration > Modeling >
IT Universe Manager and use one of the following:

» Select a CI in the topology map or the CI Selector. In the
Advanced Pane, select the Properties tab and click Edit.

» Right-click a CI in the CI Selector or the Topology map
and select Properties.

Important The Configuration Item Properties dialog box contains two
information types of properties:

» General properties, which include general information
about the CI or relationship. These properties are
common to all CITs and are documented below.

» ClT-specific properties, which include properties specific
to that CI. These properties vary according to the type of
CI or relationship and are not documented except in the
case of TransactionVision Monitor CIs. For details about
TV Monitor CIs, see "Transaction Configuration Page,
Tracing Tab" in Using Transaction Management.

When you sort the properties by category, the CIT-specific
properties appear at the top of the list and the general
properties appear at the bottom.

You can view a description of the selected property in the
Description Area at the bottom of the dialog box. Click the
Show/Hide Description Area button to display the
Description Area.

When accessing the Configuration Item Properties dialog
box from within certain applications, the fields are not
editable.

Mandatory fields are denoted by an asterisk.

Note: HP Universal CMDB does not fully support surrogate
pairs and combining characters.

See also "CI Lifecycle and the Aging Mechanism" in the RTSM
Administration Guide
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User interface elements are described below:

Ul Element (A-Z) Description

= Click to display the properties by category.
B) Click to display the properties alphabetically.
i Toggles between showing and hiding the description area at

the bottom of the CI Properties dialog box.

Click Expand to expand the properties tree when the
properties are displayed by category.

£

Click Collapse to collapse the properties tree when the
properties are displayed by category.

»
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Ul Element (A-Z)

Description

*ﬁ Export -

Choose the export format for the table data. The available
options are:

>

>

Excel. The table data is formatted as an .xls (Excel) file
that can be displayed in a spreadsheet.

PDF. The table data is exported in PDF format.

Note: When exporting to PDEF, select a reasonable
number of columns to display to ensure that the report is
legible.

RTF. The table data is exported in Rich Text Format.

CSV. The table data is formatted as a comma-separated
values (CSV) text file that can be displayed in a
spreadsheet.

Note: For the CSV formatted table data to display
correctly, the comma (,) must be defined as the list
separator. In Windows, to verify or modify the list
separator value, open Regional Options from the Control
Panel, and on the Numbers tab ensure that the comma is
defined as the List Separator value.

XML. The table data is formatted as an XML file that can
be opened in a text or XML editor.

Tip: To extract HTML code from the report:

» Save the file as HTML

» Open the file in an HTML editor

» Copy the relevant table into the target file
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Ul Element (A-Z)

Description

<Quick filter>

Enter a string in the Quick filter box to filter the property
names and values. Click the left end of the box to open the
drop-down menu of filter options:

» Select All to search for the filter string in both property
names and property values. Select Name to search for the
filter string in property names only. Select Value to search
for the filter string in property values only.

» Select Case sensitive to search for the filter string exactly
as entered. Select Case insensitive to ignore the case of
the filter string.

» Select Use wild cards to use the wildcard symbol * in the
filter string.

» Select Match from start to search for the filter string at
the beginning of a property name or value. Select Match
exactly to search for the exact filter string. Select Match
anywhere to search for the filter string anywhere in the
properties.

Actual Deletion
Period

The number of days after which the CI or relationship is
deleted.

Allow Cl Update

When selected, this option allows the DFM process to
automatically update the CI or relationship properties with
information that it discovers. If you change the value of a
property supplied by the DFM process, the value is
overridden by the discovered value.

When this option is cleared, the CI or relationship
properties are not overridden by the DFM process.

Apply Click Apply to save the changes made to the CI or
relationship properties.

Cl Type The type of the CI or relationship (read-only value). For
information about CITs in HP Business Service
Management, see "CI Type Manager" on page 475.

Created By The user name of the administrator who manually created

the CI or relationship, where applicable (read-only value).

Create Time

The date and time when the CI or relationship was created.
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Ul Element (A-Z)

Description

Deletion
Candidate Period

The period after which the CI becomes a candidate for
deletion when the aging mechanism is enabled.

Description

A brief description of the CI or relationship.

Display Label

The name of the CI or relationship as it appears in the CI
Selector.

Edit

In the Properties tab of the Advanced pane, you can view a
CI's properties but you cannot edit them. Click Edit to open
the Configuration Item Properties dialog box where you can
edit the properties.

Enable Aging

If a CI or relationship is not updated or refreshed over a
period of time (for example, a CI is not rediscovered by DFM
and no manual update occurs), an aging mechanism deletes
the CI from the RTSM. For details, see "CI Lifecycle and the
Aging Mechanism" in the RTSM Administration Guide.

True: the aging mechanism is enabled for this CI or
relationship.

Default value: False. The default value for DFM ClIs is True.
Note:

» If the aging mechanism is disabled, this field is ignored.
» This field is displayed for certain CIs only.

Global Id

The internal ID of the CI or relationship in the RTSM (read-
only value).

Last Access Time

The time that the CI or relationship was last accessed,
whether when being updated or being discovered by DFM.
This field is only displayed for certain CIs or relationships.

This parameter is used by the aging mechanism. For details,
see "CI Lifecycle and the Aging Mechanism" in the RTSM
Administration Guide.

Last Modified
Time

The date and time when the CI or relationship properties
were last updated.

Monitored By

Indicates whether the CI is monitored by a SiteScope
monitor or an EMS Integration monitor.
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Ul Element (A-Z) Description

Name The name of the CI or relationship.

Note Enables you to enter other information about the CI or
relationship.

Origin An ID for the source that automatically created the CI or
relationship, or the application where the CI or relationship
was created (read-only value).

Reset Click the Reset button to restore the original property
settings of the CI or relationship.

Updated by The user name of the administrator who updated the CI or
relationship properties.

User Label Enables you to define a display label for the CI or
relationship. If no value is entered, the CI name appears as
the default label.

Shortcut Menu

Menu Item

Description

Copy Property Name
and Value

Copies the name and value of the selected property to the
memory.
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@ Get Related CIs From CMDB Dialog Box

This dialog box enables you to view the Cls related to a specified CI in the
RTSM in map or table format.

To access In IT Universe Manager, right-click the required CI and
select Get Related Cls.

Important The Get Related CIs From CMDB dialog box is a
information standalone version of the Related ClIs tab in IT Universe
Manager. You can control the content of the display using
the features in the Get Related CIs pane. For details, see
"Get Related CIs Pane" on page 287.

You cannot select the scope of the related CIs displayed in
the Get Related CIs From CMDB dialog box. The scope is
the entire CMDB.

Note: The text mode format includes the icons found in
the Element Instances dialog box. For details, see
"Element Instances Dialog Box" on page 77.

Relevant tasks "View Related CIs" on page 245
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@ Insert Relationship Dialog Box

This dialog box enables you to attach Cls to the CI you selected in the CI

Selector.
To access In IT Universe Manager, right-click a CI in the Topology
Map or the CI Selector, and select Relate to CI.
Important To create a relationship between two ClIs, select the source
information CI in the CI Selector or the Topology Map and then select

Relate to Cl from the shortcut menu. On the first page of
the dialog box (the CI Selection page), you select the target
CI(s). Then click Relationship, to select the relationship type
on the second page of the dialog box.

You can also create a relationship between two Cls
graphically by clicking the Create Relationship |, button
in the toolbar and drawing a line between the two CIs. In
this case, a smaller version of the Insert Relationship dialog
box opens, which contains the following tabs:

» Select Relationship. Displays a tree with the available
relationship types. Select the required relationship.

Note: You can double-click the relationship you select to
save using the default properties.

> Relationship Properties. Displays the properties of the
selected relationship. You can edit the properties as
described in "Define Relationship Properties Pane" on
page 275.

Relevant tasks

"Create CIs and Relationships in the RTSM" on page 244

See also

"CI Selector" on page 163

User interface elements are described below:

Ul Element (A-Z)

Description

E )

Click to add the selected ClIs in the left pane to the Target
ClIs pane.

4

Click to remove selected CIs from the Target CIs pane (this
does not delete the CIs from the RTSM).
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Ul Element (A-Z)

Description

Select target Cls

Select a view to display in the view tree and select CIs to
move to the Target CIs pane.

For details on the Select target Cls pane, see "CI Selector" on
page 163.

Source Cl

The CI you selected as the source CI.

Target Cls

Displays the CIs you have selected as target Cls for the
relationship.

® Relationship Page

This page enables you to define the relationship to be created between the
original CI and the ClIs selected in the CI Selection page of the dialog box.

To access Click the Relationship button from the Insert Relationship
dialog box.

Important When defining multiple relationships, you can define

information different descriptions and property values for each

relationship. Skip the property definitions here and edit
each relationship individually after it is created.

User interface elements are described below:

Select Relationship Pane

Ul Element (A-Z)

Description

Direction Select the direction of the relationship.
For some relationship types (for example, Composition, or
between a group CI and a monitor CI), only one direction is
valid.

Relationship Define the type of relationship created between the original

CI and the CIs being attached. Select an option from the
list.
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Ul Element (A-Z)

Description

Source CI Displays the name of the CI on the first end of the
relationship. This is the CI that you selected in the view.
Target Cl Displays the name of the CI on the second end of the

relationship, that is attached to the original CI.

Define Relationship Properties Pane

Ul Element (A-Z)

Description

Actual Deletion
Period

The period after which the relationship is deleted when the
aging mechanism is enabled.

Allow Cl Update

When the value is set to true, the DFM process
automatically updates the relationship.

Created By

The user name of the administrator who manually created
the relationship, where applicable.

Create Time

The date and time when the relationship was created.

Deletion
Candidate Period

The number of days after which the relationship becomes a
candidate for deletion.

Description A detailed description of the relationship.

Destination Defined only for route links. Indicates the destination
Network Address network address to which this route is configured.
Enable Aging If a CI or relationship is not updated or refreshed over a

period of time (for example, a CI is not rediscovered by DFM
and no manual update occurs), an aging mechanism deletes
the CI from the RTSM. For details, see "CI Lifecycle and the
Aging Mechanism" in the RTSM Administration Guide.

True: the aging mechanism is enabled for this CI or
relationship.

Default value: false. The default value for DFM ClIs is true.
Note:

» If the aging mechanism is disabled, this field is ignored.
» This field is only displayed for certain Cls.
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Ul Element (A-Z)

Description

Last Access Time

The time that the relationship was last accessed, whether
when being updated or being discovered by DFM. This field
is displayed only for certain CIs.

This parameter is used by the aging mechanism. For details,
see "CI Lifecycle and the Aging Mechanism" in the RTSM
Administration Guide.

Last Modified
Time

The date and time when the relationship properties were
last updated.

Must

When the value is set to true, the child CI is dominant when
the percentage rule is used to calculate status for the parent
CI. If the CI has low status, the parent must take the child
ClI status, if necessary overriding the percentage rule
calculation. This is useful to give emphasis to an important
CI. For example, you might want to define Must for a
database CI, so that status is critical all the way up the
subtree if the database falls, regardless of the status of the
other CIs in the subtree.

The must status defined for a relationship applies for that
relationship only - it is not used in any other relationships
of the child CI. For details, see "Understanding the
Percentage Rule" in Using Service Health.

Name

A brief description of the relationship. If no value is entered,
the relationship type is used in place of the name.

Note

Enables you to enter other information about the
relationship.

Origin

An ID for the source that automatically created the
relationship, or the application where the relationship was
created.

Updated By

The user name of the administrator who updated the CI
properties.
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Ul Element (A-Z)

Description

User Label Enables you to define a display label for the relationship. If
no value is entered, the relationship name appears as the
default label.

Weight When a weight value is entered, the child CI is given more

weight in percentage calculations, when percentage rule is
used to calculate status for the parent CI. For example, if a
child ClI is given a weight of 3, then it has three times more
impact on the parent status calculation than its unweighted
siblings.

The weight defined for a relationship applies for that
relationship only - it is not used in any other relationships
the child CI may have. For more details, see "Understanding
the Percentage Rule" in Using Service Health.
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@ IT Universe Manager Page

This page enables you to define and manage the CIs and relationships in

your views.
To access Select Admin > RTSM Administration > Modeling >
IT Universe Manager.
Important The IT Universe Manager page contains the following
information panes:

» Cl Selector. Displays the CIs of a selected view. You can
select the view from a drop—down list or search for a
specific CI. For details, see "CI Selector" on page 163.

» Topology Map. Displays the CIs of a selected view in
Map mode or Text mode.

» Advanced Pane. Displays properties, history, and
discovery for the selected CI or view.

» Get Related Cls. This pane can be accessed from the
Related CIs tab of the Topology Map. It controls the
content of the display in the tab.

In IT Universe Manager, you can create new Cls, modify
existing ClIs, or delete ClIs. All of these actions have a
direct effect on the entire IT Universe model. For
example, if you delete a CI in your view, that CI is deleted
from the IT Universe model and no longer appears in any
view.
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This area displays the CIs of the currently selected view in graphical or table
format. By default, the CIs are displayed in graphical format.

To access

Select Admin > RTSM Administration > Modeling >
IT Universe Manager.

Important
information

When you select a CI in the CI Selector or the Topology
Map, the Configuration Items drop-down in the Main
Menu becomes active. The options available under that
drop-down are the same as those available by right-
clicking the CI.

You can customize the Topology Map shortcut menu to
include other commands (for example, ping, run a
program, open a URL) from within CI Type Manager. For
details, see "Create Configuration Item
Type/Relationship/Calculated Relationship Wizard" on
page 496.

Note: For grouped ClIs and the relationships between
them, not all of the shortcut menu options are active.
Grouped Cls appear in parentheses in the CI Selector and
in the Topology Map. You can double-click a link to a
grouped CI to open the Link Map, which displays the
individual CIs and relationships. Right-click a CI or
relationship in the Link Map to display the regular
shortcut menu. For details about grouping ClIs, see "Query
Node Grouping Dialog Box" on page 425.

See also

"Working with Topology Map" on page 175
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User interface elements are described below (unlabeled elements are shown

in angle brackets):

Ul Element (A-Z)

Description

153 MeR Map Click Map to display the selected layer of CIs in topology

mode map format.
Note: If the selected layer of the view is too large to
display in topology map format, a message appears with a
link to display the layer in text format.

B Text Text mode | Click Text to display the attribute properties of the CIs in

the selected layer in table format.

For details on some of the toolbar icons in Text Mode, see
"Element Instances Dialog Box" on page 77.

Show Cl instances of. | MNetwork ¥

Specify the CIT you want displayed in the table. The table
also includes the children of the selected CIT.

Note: This option is displayed in Text mode only.

<Breadcrumbs>

At the top of the topology map, the breadcrumbs indicate
the relevant query nodes in each layer of the view for the
path to the selected layer. The first item in the path is the
Top Layer. When you select a CI from the layer below, the
parent CI forms the next item in the breadcrumb path.
You can click on any item in the path to display that layer
in the topology map.

<Cl type attributes>

The columns appearing in Text mode represent the CIT
attributes of the selected Cls.

<IT Universe Status
Bar>

The status bar below the topology map indicates the
status of the following processes:

» if Impact Analysis is active or not

» if Change Timeframe is active or not

» if Candidates for Deletion are shown or not

» the time of the last update of the data
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Ul Element (A-Z)

Description

<Legend>

Indicates the icons displayed next to CIs with any of the
following special statuses:

» Added. When Change Timeframe is active, indicates
that the CI was added.

» Impacted. When Impact Analysis is active, indicates an
impacted CI.

» Impacted and Trigger. When Impact Analysis is active,
indicates a trigger CI that is impacted.

» Candidate for Deletion. Indicates that the Cl is a
candidate for deletion.

» Changed. When Change Timeframe is active, indicates
that the CI was changed.

» Note. Indicates that a note was added for the CI.

» Trigger. When Impact Analysis is active, indicates a
trigger CI.

<Main Menu>

For details, see "Main Menu" on page 197.

<Query Node>

The query nodes in the topology map represent Cls.

Hold the pointer over a query node to display its tooltip
which describes the type of the CI.

<Relationship>

The links in the topology map represent relationships.

Hold the pointer over a relationship to display its tooltip,
which describes the type of the relationship.

Note: When you select a calculated relationship, the
Delete @£ button in the toolbar is disabled.

<Toolbar>

For details, see "Toolbar Options" on page 201.

Note: When accessing the Topology map via direct links,
the toolbar includes options from the Related CIs Map.
For details, see "Get Related CIs From CMDB Dialog Box"
on page 272.

<Topology Map
Sidebar>

For details, see "Topology Map Sidebar" on page 210.
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Ul Element (A-Z)

Description

Related Cls

Click the Related Cls tab to display the interdependencies
of the selected CI within the view or the entire RTSM. You
can control the scope of the display from the Get Related
CIs pane.

View Results

Click the View Results tab to display an entire layer
within a view.
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IT Universe Manager Shortcut Menu

The IT Universe Manager page includes the following elements (listed
alphabetically) available by right-clicking a CI or relationship in the CI
Selector pane or the Topology Map:

Menu ltem

Description

Actions

Select one of the following options:

» Add Cl to Discovery Job. Displays the Add CI to
Discovery Job dialog box, which enables you to
manually invoke a DFM job for the selected CI. You
can use this option to discover additional information
about the CI through one of the available DFM jobs.

» Remove Cl from Discovery Job. Displays the Remove
CI from Discovery Job dialog box, which enables you
to manually remove a CI from the DFM job.

» Show Discovery status. Opens the Discovery Status
dialog box for the selected CI.

» Open Cl Credentials. Displays the Protocol Parameter
dialog box, which enables you to view the details of a
previously-defined credential for that CI. You cannot
make any changes. This option is only relevant for Cls
that include a credentials property.

For details, see "Protocol Parameter Dialog Box" in
RTSM Data Flow Management Guide.

» Edit Cl Credentials. Displays the Choose Credentials
dialog box, which enables you to choose another
credentials set or edit the existing credentials. This
option is only relevant for CIs that include a
credentials property.

For details, see "Supported Protocols" in RTSM Data
Flow Management Guide.

Add Cls to Model

Adds selected Cls to a new or existing model.

Add Cls to View

Adds selected CIs to a new or existing perspective based
view.

Cl/Relationship
History

Displays the CI History dialog box. For details, see
"Cl/Relationship History Dialog Box" on page 262.
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Menu Item

Description

Compare Cls Report

Run a Compare CIs Report for the selected CI. For details,
see "Compare ClIs Report" on page 432.

Delete from CMDB

Enables you to delete the selected CI or relationship from
the view and from the RTSM.

Note: When you delete a parent CI, the selected CI and
its children are removed from the view, but only the
selected CI is removed from the database.

Get Related Cls

Opens the Get Related CIs from CMDB dialog box. For
details, see "Get Related CIs From CMDB Dialog Box" on
page 272.

Label

Select one of the following options:
» Edit Label. Opens the Edit Label dialog box which
enables you to edit the name of the CIL.

» Restore Default Label. Resets the CI name to its default
value from the RTSM.

Note

Select one of the following options:

» Add Note. Opens an editing box where you can add a
note to the CIL.

» Delete Note. Deletes all text saved in a note for the
selected CI.

Properties

Displays the Properties page for the selected CI or
relationship. For details, see "Configuration Item
Properties Dialog Box" on page 266.

Relate to CI

Opens the Insert Relationship dialog box. For details, see
"Insert Relationship Dialog Box" on page 273.

Run Impact Analysis

Enables you to run the Impact rule you defined in the
Impact Analysis Manager. Displays the Run Impact
Analysis dialog box. For details, see "Impact Analysis
Manager" on page 449.

Note: You can only see Impact Analysis results if you
defined an Impact rule for that view in Impact Analysis
Manager.
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Menu Item Description

Show Compound Appears only for compound relationships. Displays the

Path Link Map for the selected relationship, which shows the
ClIs involved in the compound relationship.
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Menu Item

Description

Show Impact

Enables you to select a CI that is defined by an Impact
rule as a root cause CI, and to display all the CIs that are
impacted by it, and their statuses, in a separate window.

This option appears only after the following has occurred:

» You defined an Impact rule for the selected view in
Impact Analysis Manager (for details, see "Impact
Analysis Manager" on page 449).

» You clicked Show in Views in the Run Impact Analysis
dialog box.

» Impact Analysis results appear in the Topology Map.

For example, suppose an Impact rule is defined (for an IP
Address CI) that specifies that the rule impacts nodes,
ports, and client-servers linked to the IP Address.

By using the Show Impact option, you can display all CIs
that are impacted by the IP Address CI.

Show Root Cause

This option enables you to retrieve root cause
information for CIs that are impacted by a chain of
Impact rules. The output of Show Root Cause displays a
logical map that describes a chain of trigger/impacted
CITs that impact the CI.

The root cause CI is displayed in a separate window. If
only one Impact rule is defined for this CI, the Impact
Analysis window is directly displayed.

This option appears only after the following has occurred:

» You defined an Impact rule for the selected view in the
Impact Analysis Manager (for details see, "Impact
Analysis Manager" on page 449).

» You clicked Show in Views in the Run Impact Analysis
dialog box.

» Impact Analysis results appear in the Topology Map.

A window is displayed containing the root cause CI and
all the other CITs in the Impact rule chain.

To view the information about specific CIs that are
triggered or impacted by the Impact rule, double-click the
relationship connecting the CIs. A map is displayed.
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Advanced Pane

User interface elements are described below:

Ul Element (A-Z) Description

Discovery tab Displays the DFM run status for the selected Cls. For
details, see "Show Discovery Status and Changes Dialog
Box" on page 298 and "Discovery Status Pane" in the
RTSM Data Flow Management Guide.

History tab Displays the history for the selected CI. For details, see
"CI/Relationship History Dialog Box" on page 262.

Properties tab Displays the selected CI’s properties (the same properties
that appear in the Configuration Item Properties dialog
box). You can view the properties in the properties tab,
but you must open the dialog box to edit the properties.
For details, see "Configuration Item Properties Dialog
Box" on page 266.

Get Related Cls Pane

This pane enables you to control the different options for viewing related
Cls for a selected CI.

To access Appears in the Related ClIs tab of IT Universe Manager. If
it is hidden, click the Show Get Related Cls pane ..'ﬁq
button in the toolbar to display it.

Important You can control the display in the Related CIs tab with
information the following controls:

» Set the scope of the display

» Filter the related ClIs by CI type

» Apply perspectives to the selected CI

It is possible to display related CIs for several CIs at the
same time. Use the CTRL key to select multiple CIs at the
same time in the CI Selector or the topology map.

Note: The Get Related CIs functionality is not available
for federated Cls.

Relevant tasks "View Related CIs" on page 245
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User interface elements are described below:

Ul Element (A-Z)

Description

Display the previous search results.

<3
& Display the next search results.
g When the button is selected, the related Cls are added to
= the current results. When it is not selected, the current
display content is cleared and only the new related CIs
are displayed.
Apply perspectivesto | Select perspectives from the list to apply to the selected
Cl CI. Only perspectives relevant to the selected CI appear in

the list. The selected ClI is used as content for the selected
perspectives and the view results are displayed.

Note: Application of perspectives is only relevant when
CMDB is selected as the scope. The feature is inactive
when View is selected as the scope.

Filter Related Cls by
Cl Type

Select the CI types from the list to display in the related
ClI results. Only the selected CI types appear in the
displayed results.

Select scope

Select the scope of the related ClIs displayed:
» View. All related ClIs in the selected view.
» CMDB. All related ClIs in the RTSM.

Note: This feature is not available in the Get Related CIs
from CMDB dialog box opened from the shortcut menu.

Show Related Cls

Click to display the related Cls according to your
selection.
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@ New CI/New Related Cl Dialog Box

This dialog box enables you to define a new CI or a new related CI.

To access In IT Universe Manager, click the New Cl icon " in the
toolbar to create a non-related CI. Select a CI in the
topology map and click the New Related Cl icon & to
create a related CI.

Important To define a new CI, select the CI type from the tree at the
information top of the dialog box. The CI types in the tree that are
available to be instantiated appear in black. The CI types in
faded text cannot be instantiated.

Edit the properties in the Define new CI properties area. The
table below includes the properties which are common to
all CIs. In addition, there are other properties specific to
each CI.

If you are creating a related CI, click the Relationship button
to go to the relationship mode of the dialog box. Select a
relationship and edit its properties.

Relevant tasks "Create CIs and Relationships in the RTSM" on page 244

See also » "CI Selector" on page 163

» "CI Lifecycle and the Aging Mechanism" in the RTSM
Administration Guide

User interface elements are described below:

Ul Element (A-Z) Description

Actual Deletion The period after which the CI is deleted when the aging
Period mechanism is enabled.

Allow Cl Update When the value is set to true, this option enables the DFM
process to automatically update the CI properties with
information that it discovers. If you change the value of a
property supplied by the DFM process, the value is
overridden by the discovered value.

When the value is set to false, the CI properties are not
overridden by the DFM process.

289



Chapter 8  IT Universe Manager

290

Ul Element (A-Z)

Description

Created By

The user name of the administrator who manually created
the CI, where applicable.

Create Time

The date and time when the CI was created.

Deletion
Candidate Period

The period after which the CI becomes a candidate for
deletion when the aging mechanism is enabled.

Description A description of the CI.
Display Label The label that appears for the CI in the topology map.
Enable Aging If a CI or relationship is not updated or refreshed over a

period of time (for example, a CI is not rediscovered by DFM
and no manual update occurs), an aging mechanism deletes
the CI from the RTSM. For details, see "CI Lifecycle and the
Aging Mechanism" in the RTSM Administration Guide.

True: the aging mechanism is enabled for this CI or
relationship.

Default value: false. The default value for DFM ClIs is true.
Note:

» If the aging mechanism is disabled, this field is ignored.
» This field is displayed for certain CIs only.

Is Candidate For
Deletion

Indicates if the CI is a candidate for deletion.

Last Access Time

The time that the CI was last accessed, whether when being
updated or being discovered by DFM. This field is displayed
only for certain CIs.

This parameter is used by the aging mechanism. For details,
see "CI Lifecycle and the Aging Mechanism" in the RTSM
Administration Guide.

Last Modified
Time

The date and time when the CI properties were last updated.

Name

The name of the CI.

Note

Enables you to enter other information about the CI.
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Ul Element (A-Z) Description

Origin An ID for the source that automatically created the CI, or
the application where the CI was created.

Relationship For a related ClI, click Relationship to go to the relationship
mode of the dialog box.

Select Cl Type Enables you to select the CI type from the tree for the new
CI. The CI types that are available for the selected CI or view
appear active in the CI type tree. The other CI types appear
in faded text and cannot be selected.

To limit the CI type tree to CI types from the current view,
select Cl Types from the current view on the right. To
display all CI types in the tree, select All Cl Types.

Updated By The user name of the administrator who updated the CI
properties.
User Label Enables you to define a display label for the CI. If no value is

entered, the CI name appears as the default label.

® Relationship Dialog Box

This page enables you to define the relationship between the new CI and
the CI selected in the view, as well as the properties of the relationship.

To access Click the Relationship button from the New Related CI
dialog box.

Important This page only appears for new related CIs.

information

User interface elements are described below:

Ul Element (A-Z) Description

Allow CI Update When the value is set to true, the DFM process
automatically updates the relationship.

Cl Definition Click CI Definition to return to the CI properties mode of
the dialog box.

291



Chapter 8  IT Universe Manager

292

Ul Element (A-Z)

Description

Created By

The user name of the administrator who manually created
the relationship, where applicable.

Create Time

The date and time when the relationship was created.

Description A description of the relationship.
Direction Select the relationship direction from the drop-down box.
Enable Aging If a CI or relationship is not updated or refreshed over a

period of time (for example, a CI is not rediscovered by DFM
and no manual update occurs), an aging mechanism deletes
the CI from the RTSM. For details, see "CI Lifecycle and the
Aging Mechanism" in the RTSM Administration Guide.

True: the aging mechanism is enabled for this CI or
relationship.

Default value: false. The default value for DFM ClIs is true.
Note:

» If the aging mechanism is disabled, this field is ignored.
» This field is displayed for certain CIs only.

Last Access Time

The time that the relationship was last accessed, whether
when being updated or being discovered by DFM. This field
is only displayed for certain relationships.

This parameter is used by the aging mechanism. For details,
see "CI Lifecycle and the Aging Mechanism" in the RTSM
Administration Guide.

Must

When the value is set to true, the child CI is dominant
when the percentage rule is used to calculate status for the
parent CI. If the CI has low status, the parent must take the
child CI status, overriding the percentage rule calculation if
necessary. This is useful to give emphasis to an important
CI. For example, you might want to define Must for a
database CI, so that status is critical all the way up the
subtree if the database falls, regardless of the status of the
other CIs in the subtree.

The Must status defined for a relationship applies to that
relationship only - it is not used in any other relationships
of the child CI.
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Ul Element (A-Z)

Description

Name The name of the CI.

Network Address Defined only for route links. Indicates the destination
network address to which this route is configured.

Note Enables you to enter other information about the CI.

Origin An ID for the source that automatically created the
relationship, or the application where the relationship was
created.

Relationship Enables you to define the type of relationship that is created
between the two ClIs.

Source Cl The name of the CI on the first side of the relationship. This
is the CI that you selected in the view.

Target Cl The name of the CI on the second side of the relationship.
This is the new CI that you are creating.

Updated By The user name of the administrator who updated the
relationship properties.

Update Time The date and time when the CI properties were last updated.

User Label Enables you to define a display label for the relationship.

Weight When a weight value is entered, the child CI is given more

weight in percentage calculations, when the percentage rule
is used to calculate status for the parent CI. For example, if a
child ClI is given a weight of 3, then it has three times more
impact on the parent status calculation than its unweighted
siblings.

The weight defined for a relationship applies to that
relationship only - it is not used in any other relationships
of the child CI.
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@ Run Impact Analysis Dialog Box

294

This dialog box enables you to run the Impact rule you defined in Impact
Analysis Manager for that view.

To access Select Admin > RTSM Administration > Modeling >

IT Universe Manager. Right-click a trigger query node in
the Topology Map and select Run Impact Analysis or click
the Run Impact Analysis Now [ button in the

IT Universe status bar.

Important You can:

information » Display in a new window all the CIs that are impacted

by the trigger CI. The relationships in the map
represent the Impact rules. The name of the
relationship is the name of the Impact rule you defined
in the Impact Analysis Manager. For details, see "Show
Map" on page 296.

» Simulate how the statuses of the impacted CIs are
impacted. For details, see "Show in Views" on page 295.

» Generate a report that displays a list of CIs that are
impacted in the system as a result of the simulated
changes. For details, see "Generate Report" on
page 295.

Note: This dialog only appears if an Impact rule is defined
for that view. For details, see "Impact Analysis Manager"
on page 449.

Relevant tasks "Retrieve Impact Analysis Results — Scenario" on page 250

User interface elements are described below:

Ul Element (A-Z) Description

All Impact rules Select to execute all impact rules in the impact analysis.

Impact rules bundle Select the bundle containing the required impact rules

for the impact analysis.
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Ul Element (A-Z)

Description

Generate Report

Generates an Impact Analysis report, which displays
information that is divided as follows:

» Grouping by CIT. All the impacted Cls (the CIs that are
impacted in the system as a result of the simulated
changes), sorted by CIT.

» Affected Application. All the impacted CIs that belong
to a specific business service.

» Triggered Cls. The CIs that represent the changes you
want to make to the system.

For details on the Impact Analysis report, see "Impact
Analysis Report" on page 323.

Only Impact rules
located in specified
bundle

Select to execute the impact rules from the specified
bundle in the impact analysis.

Show in Views

Simulates how the statuses of the impacted CIs are
impacted for the selected state. The Topology Map
displays the statuses of the trigger CIs as well as all
statuses of the CIs that are impacted by it.

The Topology Map also displays the Impact Analysis
indicators:

> A trigger CI is marked by this [+] (up arrow) indicator.

» A CI that is both an impacted and a trigger CI is
marked by this E (up and down arrow) indicator.

» An impacted CI is marked by this |+| (down arrow)
indicator.

Note: The statuses that appear here and the colors that
represent each status are defined in the severity list for
that state in the System Type Manager. For details, see
"Create/Update List/Enumeration Definition Dialog Box"
on page 513.
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Ul Element (A-Z)

Description

Show Map

Enables you to select an Impact rule, and then display in
a new window, a simulation of all the CIs that are
impacted by the trigger CI for the selected state. If only
one Impact rule is defined for this CI, the Impact Rules
window is displayed directly. For more details, see "Show
Impact Pane" on page 300.

The relationships in the map represent the Impact rules
and the name of the relationship is the name of the
Impact rule you defined in the Impact Analysis Manager.

Note: Show Map enables you to view the results of
multiple triggers.

Trigger Severity

Select the required severity on the scale.

Note: The severity scale was defined for the state in the
System Type Manager. For details, see "System Type
Manager" on page 479.

For example, you can create an Impact rule in the Impact
Analysis Manager that defines the severity of the trigger
query node as other than Warning (1). If you select a
severity other than Warning (1), for example, Minor (3),
the condition is met and the simulated changes in the
system are triggered.

For details, see the "Impact Rules Definition Dialog Box"
on page 467.

® save Snapshot Dialog Box

296

This dialog box enables you to take a snapshot of a view and save it.

To access In IT Universe Manager, click the Snapshot [ button in
the CI Selector and select Save Snapshot.

Important You can compare snapshots of the same view taken at

information different times using the Compare Snapshots Report. For

details, see "Compare Snapshots Report" on page 318.

Relevant tasks

"Take a Snapshot of a View" on page 257




Chapter 8 ¢ IT Universe Manager

User interface elements are described below:

Ul Element (A-Z)

Description

field cannot be edited.

Description A description of the snapshot (optional).
Note A note about the snapshot (optional).
View Name The name of the view as it appears in the CI Selector. This
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@ Show Discovery Status and Changes Dialog Box

298

This dialog box enables you to find recent changes, for example, to an
application, by rediscovering the CIs and jobs in a view.

To access

In IT Universe Manager:

» To rediscover all CIs of a view, click the Show
Discovery and Changes Summary (! button in the CI
Selector toolbar. The Show Discovery Status and
Changes dialog box is displayed.

» To rediscover one CI or several Cls in a view, select the
CI and display the Discovery tab in the Advanced
pane.

Important
information

By default, you can run the rediscovery procedure on
views that include less than 10,000 ClIs.

To increase the number of Cls that you can rediscover in

a view:

1 Access the Infrastructure Settings Manager (Admin >
Platform > Setup and Maintenance > Infrastructure
Settings).

2 Select the Max Cls in view supported to rediscover
setting in the infrastructure settings table.

3 Click the Value column and change the number.
4 Restart the server for the change to take effect.

For details on working with the Infrastructure Settings
Manager, see "Infrastructure Settings" in Platform
Administration.

Relevant tasks

"Check Status of Application Discovery (Rediscover a
View)" on page 247

See also

"Discovery Status Pane" in RTSM Data Flow Management
Guide
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User interface elements are described below:

Ul Element (A-Z) Description
|§| Click to refresh the status of the selected ClIs.
- This button is disabled when there is no data to be
reloaded.
|§| Click to rerun the discovery.
Discovery Progress For details, see "Discovery Status Pane" in the RTSM Data
Status on View Flow Management Guide.

History Changes on For details, see "Cl/Relationship History Dialog Box" on
View page 262.
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@ Show Impact Pane

This page opens a window that displays the statuses of the trigger CI as well
as all statuses of the CIs that are impacted by it.

To access In the Run Impact Analysis Dialog box, click Show Map.

If Impact Analysis is already active, click on the Impact
Analysis Is Active link in the IT Universe status bar.

Important The following tabs are available:

information » Impact Results. Displays a map of all CIs impacted by

the selected CI.

» Trigger Cls. Displays a table of information on the
selected trigger Cls.

You can only see Impact Analysis results if you defined an
Impact rule for that view in Impact Analysis Manager. For
details, see "Impact Analysis Manager" on page 449.

To view information about specific CIs that are triggered
or impacted by the Impact rule, double-click the
relationship connecting the CIs. A map is displayed.

The relationships in the map represent the Impact rules.
The name of the relationship is the name of the Impact
rule you defined in the Impact Analysis Manager.

Relevant tasks "Retrieve Impact Analysis Results — Scenario" on page 250
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User interface elements are described below (unlabeled elements are shown

in angle brackets):

Ul Element (A-Z)

Description

<Legend>

Indicates the icons displayed next to CIs with any of the

following special statuses:

» Added. When Change Timeframe is active, indicates
that the CI was added.

» Impacted. When Impact Analysis is active, indicates
an impacted CIL

» Impacted and Trigger. When Impact Analysis is active,
indicates a trigger CI that is impacted.

» Candidate for Deletion. Indicates that the Cl is a
candidate for deletion.

» Changed. When Change Timeframe is active, indicates
that the CI was changed.

» Note. Indicates that a note was added for the CI.

» Trigger. When Impact Analysis is active, indicates a
trigger CI.

<Relationship>

The relationships represent the Impact rule you defined
in the Impact Analysis Manager. For details, see "Impact
Rules Definition Dialog Box" on page 467.

<The statuses and
the colors that
represent each one>

The statuses that appear and the colors that represent
each status are the ones that are defined in the severity
list for that state in the System Type Manager. For details,
see "Create/Update List/Enumeration Definition Dialog
Box" on page 513.

<Toolbar>

The Show Impact pane toolbar contains most of the
buttons in the IT Universe Manager toolbar.

<Topology Map
Sidebar>

For details, see "Topology Map Sidebar" on page 210.
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Reports

This chapter includes:

Concepts

» Topology Reports Overview on page 304
Tasks

» Compare CIs on page 305

» Compare Snapshots on page 307
Reference

» Cron Expressions on page 309

» Reports User Interface on page 310
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Concepts

& Topology Reports Overview

304

Topology reports provide a method of displaying the data from views in a
report format. Every view defined in the Modeling Studio has a
corresponding topology report. The report settings are defined in the view
definition in Report mode in the Pattern View Editor. For details, see
"Pattern View Editor" on page 413.

For details on selecting the CIs to be displayed in a view, see "Working with
the CI Selector" on page 155.

Templates and perspectives do not have topology reports. However,
template-based views do have topology reports. The reports settings for such
views are based on the settings defined in the base template or perspective.

Several additional reports are available in IT Universe Manager, including
Asset Report, Compare Cls Report, Compare Snapshots Report, and Impact
Analysis Report.
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Tasks

P Compare Cls

This task explains how to compare the hierarchies of two compound Cls,
view a CI’s configuration file, and show the difference between two
configuration files.

1 Select the Required Cls

In IT Universe Manager, select the two CIs you want to compare. The
hierarchies of the two compound Cls are compared in the Compare Cls
report (for details, see "Compare Cls Report" on page 313). You can choose
to compare two Cls that appear in a selected view, or in the RTSM. For
details, see "CI Selector" on page 163.

Example of Nonmatching Cls:
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The following example displays the following:

» The No Matching Cl icon next to the CI LABM3QCRNDDBO3 because
it has no corresponding CI on the other side.

» The Show Different Attribute Values icon is displayed next to the
MemorySize properties for the CIs LABM3QCRNDDBO02 and
LABM3ASTDBO1 since they have different MemorySize values.

® (& 10000 @ (] 192.168.226.0
@ Ip&ddress pAddress
=@ (2] Windows q Z:‘— 192.168.226.1
[ LaBm3qcrNDDEOZ | P Windows
=[E] | ABM3QCRNDDEOS L [E] LaBM3ASTDEOD1
4 I} 3
il 202020 @@ | em[ 0000 1@O
P

MName | Value Name | Value
DiscoveredWen... Dizcovered\yen...
DizcoveredOsM...  Windows 2003 DizcoveredOs... Windows 2003
DizscoveredOsV...  Microsoft DizcoveredOs...  Microsoft
Host Operating ... | 3790 Host Operating ... 3790
! MemorySize 2,045 ﬁ ! MemorySize |4,093
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2 View a CI's Configuration File

Select a CI of the CIT Configuration File and view the configuration file.
For details, see "Compare Cls Report" on page 313.

3 Show the Difference Between Two Configuration Files

Select two CIs of the CIT Configuration File and view the difference
between the two configuration files. For details, see "Compare Cls Report"
on page 313.

T Compare Snapshots

This task describes how to take a snapshot of a view, and then compare two
snapshots of a specific view taken at different times.

1 Take a Snapshot of a View

In IT Universe Manager, click the Snapshot button and select Save
Snapshot to take a snapshot of a view and save it. For details, see the "Save
Snapshot Dialog Box" on page 296.

Save Snapshots on a Periodic Basis

Optionally, you can schedule snapshots to be taken of a certain view at
specific times by defining a task. For details, see "Schedule Snapshot
Dialog Box" on page 327.

Compare Snapshots

Compare the snapshots of a view taken at different times. Click the
Snapshot button and select Compare snapshots. For details, see "Compare
Snapshots Report" on page 318.

Example of Snapshots of a View Taken at Different Times:

In the following example, the Deleted Item icon next to the
192.168.163.0 Cl in the right pane, indicates that the CI has been deleted
in the newer view.
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| Legend: 4+ Contains An Updated kem & Deleted tem New tem @ Updated rt|

MNetwork Topology Wed Mar 10111818 IST 2010

192.168.161.0 N
192 168.184.0
192 168.206.0
192.168.21.0

192.168.211.0
192 168.213.0
192 168.229.0

L
e[ 1©0 | me[ 10 6

192.168.161.0 N
% (=] 192.188.163.0
192.168.184.0
192.168.206.0
192.168.21.0
192.168.211.0

i [

LN

Lo/ L]

EIRI
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Reference

® Cron Expressions

A Cron Expression is a string composed of six or seven fields separated by
white space. Six of the fields are mandatory, and one is optional.

The following table contains the fields used in a Cron Expression.

Field Name Allowed Values Allowed Special Characters
Seconds 0-59 , -

Minutes 0-59 , =%/

Hours 0-23 , =%/

Day of month 1-31 ,-*?2/LWC

Month 1-12 or JAN-DEC ,-*/

Day of week 1-7 or SUN-SAT ,-*?/LC#

Year (optional) empty, 1970-2099 -

The following table contains examples of how to use Cron expressions.

Cron Expression

Meaning

0012**? The task runs every Wednesday at 12:00 PM.

0151072 ** The task runs at 10:15 AM every day.

01510 **?2005 The task runs at 10:15 AM every day during the
year 2005.

00/514**7? The task runs every 5 minutes starting at 2 PM and
ending at 2:55 PM, every day.

0151015*? The task runs at 10:15 AM on the 15th day of

every month.
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® Reports User Interface

310

Cron Expression

Meaning

01510?*6L

The task runs at 10:15 AM on the last Friday of
every month.

015107 *6#3

The task run at 10:15 AM on the third Friday of
every month.

For more details about Cron expressions, go to
http://confluence.zutubi.com/display/pulse0101/Project+Cron+Triggers

This section includes (in alphabetical order):

» Asset Report on page 311

» Compare CIs Report on page 313

» Compare Snapshots Report on page 318

» Impact Analysis Report on page 323

» Job List Dialog Box on page 325

» Schedule Snapshot Dialog Box on page 327

» Toolbar Options on page 329

» Topology Report on page 333
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@ Asset Report

This report displays a list of all the CIs in a specified view, their attribute
values, as well as their child CIs in the RTSM. You use Asset reports to view
and analyze the contents of the view and focus on the data that is of interest
to you. For example, an Asset report can display a list of all the servers that
are part of a specific application contained in the view.

View: | SAM Topology | | ... Include information based on (® CMDE () View

Display Label |||||| Primary DnsName |||||

= [E 000E7FFD9aF LABMIMAMI1 deviab ad
L [m] 165956 213

To access Select Admin > RTSM Administration > Modeling >
IT Universe Manager and click the Asset Report i
button.

Important The report contains only the attributes whose Asset Data
information check box was selected in the Attributes tab in the CI
Type Manager. For more details, see "Add/Edit Attribute
Dialog Box" on page 489.

User interface elements are described below (unlabeled elements are shown
in angle brackets):

Ul Elements (A-Z) Description

<Toolbar> For details, see "Toolbar Options" on page 329.

<Shortcut menu> For details, see "IT Universe Manager Shortcut Menu" on
page 283.
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Ul Elements (A-Z)

Description

Include information
based on

Select one of the following:

» CMDB. Includes information from the selected view as
well as information about the child CIs and their
attribute values in the RTSM.

By choosing this option, the report includes ClIs that

are connected by the Container qualifier to the CIs in
selected view. For example, the report would include

the CPU and memory of a server that is contained in
the view.

» View. Includes only information about the CIs and
their attributes that are contained in the selected view.

View

Enables you to select a view by opening the View Selector.
For details, see "CI Selector" on page 163.

Note: When you generate an Asset report from a specific
view, the report retains the same hierarchical structure as
the relevant view in the Topology Map.




@ Compare Cls Report
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This report enables you to compare the hierarchies of two compound Cls. A
compound ClI is a CI that is linked to another CI by a relationship with
CONTAINER qualifier. You can display the compared Cls and their child CIs
that appear in a selected view, or in the RTSM.

Compared Cl  000129F42269

Compared C| 1659 5088 DefaultDomain ens)

|+"|

Mutual View:  unix_View_1

Compare on: O view (® cMDB

| Legend: @ Cortains An Updated tem = Mo Matching C1 ¢ Updated tem |

@ (@] SHMP

000129F42269 16.59.50.88 DefaultDomain
=+ B4 000129F 42280 =< 24 16,59 50.88 DefaultDomain
= Interface Ipdddress
@ (@] Ipaddress L[] 16.59.50 88
L[] 16.44 49 38 SHNMP

¢ 73 SNMP (000129F42269)

L {73 SNMP (16.59.50.88 Defautt

-

pe: [ 1O

To access

Select Admin > RTSM Administration > Modeling >
IT Universe Manager. Right-click a CI in the Topology
Map and select Compare Cls Report.
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Important
information

» The Compare CIs page is divided into two panes. Each
side displays a hierarchical tree structure of the CIs you
selected. When you select a CI on one side, the
corresponding CI on the other side is automatically
selected, provided Synchronize Selection is pressed.

» You can compare only two CIs of the same CI type or
one of the CI type’s children in the hierarchy.

Relevant tasks

"Compare CIs" on page 305

User interface elements are described below:

Ul Elements (A-Z)

Description

g

Finds the previous occurrence of an item marked as
changed.

ol

Finds the next occurrence of an item marked as changed.

Show Configuration Files Differences. Shows the
difference between the content of the two configuration
files. Configuration files use the .xml, .txt or .ini
extensions.

Select a CI of the CIT Configuration File in both panes
and click the Show Differences button. A window opens
displaying the differences (marked in blue) in the
configuration files.

A
‘g

Show Only Different Cls in Tree. In the <Properties
panes>, displays only the part of the tree structure
containing ClIs that do not match.

Show Only Different Attribute Values. In the <Properties
panes>, toggles between displaying all the comparable
attribute values of the selected CI or only the attribute
values that are different.
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Ul Elements (A-Z)

Description

ag”

Inu‘

Enables you to select a CI on one side and have its
corresponding CI automatically selected on the other
side.

The default state for the Synchronize Selection button is
selected. Deselecting this button allows you to select
different CIs from each of the two trees. This enables you
to compare two different Cls and see their different
properties.

8|

Contains An Updated Item. Indicates that a CI's attribute
value has changed. For example, a Contains an Updated
Item icon is displayed next to the IpAddress CI in the
figure below since the attribute of its child CI
10.168.100.2 icon has changed.

=@ [E] 10.0.0.0
H@l@] paddress
o [ 10,002
¢ [IL] 10.168.100.2
<[] 10.188.100.3
= Met Device

10000
= Windows

No Matching CI. Indicates that a CI in one pane does not
match any corresponding CI in the other pane.

The following example displays the No Matching Cl icon
next to the Windows icon because it does not have a
corresponding CI in the other pane.

=@ & 10000 o [E 16591240
@ IpAddress IpAddress
[l 10002 ':: [ 15581241
e ] 101881002 [l 1659124 2
<[] 10168100 3 Mew Mods
+ @] Net Device L 1591240
Mew Mode -' Switch
+ (@] Windows 4 '::ﬁ m3-cnb-01
 [2¢] m3-cnb-02
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Ul Elements (A-Z)

Description

[

Updated Item. Indicates that the attribute value of a CI
has changed.

For example, the figure below shows that the CIs 10.0.0.2
and 16.59.124.1 display the Updated Item icon because
they was updated with a new IP Network Mask value, as
indicated by the Show Only Different Attribute Values

@ icons (see the Name and Value columns in the
bottom panes underneath the tree structure).

10.0.0.0 16.59.124.0
= (=] 10000 =@ (=] 16591240
@ Ip&ddresz Ip&ddress
10.0.0.2 16.59.124.1
10.168.100.2 16591242
<[l 10.168.1003 Mew Mode
(@] Net Devies LBl 16591240

New Mode q -' Switch
(@] Windows b “ [2€] m3-cnb-01
= ma3-cnkb-02

y e . =

BT

Name | Value Name | Value

Routing Domain Default Domain Routing Domain Cefault Comain

|_!|IP Metwork Mask  255.255 2550 |!_|P Metwork Maslke 255285 2520

@ @]

Enables you to move to the next or previous result of the
search for the string entered in the Find field.

<Toolbar>

For details, see "Toolbar Options" on page 329.

<Shortcut menu>

For details, see "IT Universe Manager Shortcut Menu" on
page 283.
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Ul Elements (A-Z)

Description

<Properties pane>

Displays the attributes of the selected CI.
The Properties pane contains the following fields:

» Name. Displays the attribute name for the selected CI,
which was marked as Comparable in the CI Type
Manager. "Create Configuration Item
Type/Relationship/Calculated Relationship Wizard" on
page 496

» Value. Displays the attribute value for the currently
selected CI.

<Left and right
panes>

Displays a tree of the compared CIs and their child CIs
that appear in the selected view or in the RTSM,
depending on whether you selected the View or the
CMDB options.

Compare in

Select one of the following:
» CMDB. Includes the selected CIs and their child CIs
that appear in the entire RTSM.

» View. Includes the selected CIs and their child ClIs that
appear only in a specific view.

Compared CI

Enables you to select the two CIs you want to compare.
Click J to open the ClIs Selector dialog box. For details,
see "CI Selector" on page 163. The CI you select in the top
box is displayed in the left pane and the CI you select in
the bottom box is displayed in the right pane.

Find

Find. Enter a search name or a portion of a search name
in the Find field to locate it in the list.

Mutual View

If the CIs that you are comparing both exist within the
same view, the name of that view is displayed in this
field. Otherwise, the field displays the words No mutual
view.
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@ Compare Snapshots Report

318

This feature enables you to compare two snapshots of a specific view taken
at different times. It enables you to visualize the differences between the
views by comparing the statuses of the view at the times the snapshots were
taken.

Compare Snapshots displays the status of a view in one snapshot by
comparison with its status taken at a different time. You can compare a
current snapshot to a previous snapshot or two snapshots both taken in the
past.

Compare Snapshots Report1®* |
Lﬁﬁepnr‘marame{ers |: | &= - ¥ oA A | 457

View with snapshots | Metwork Topology |v|
Awailable Snapshots | Time |Descrip...| Qwner | Size | Mote |
Current Current 3,861
Mon Apr...  snapshot? 3,861
[] | Mon Apr...  snapshoti 3,861

g Generate

| Legend: @ Contains &n Updated tem # Deleted tem = Mew tem < Updated kem |

NetworkTopology Mon Apr 12 14:34:56 IDT ...

3
]
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To access Select Admin > RTSM Administration > Modeling >
IT Universe Manager. Click the Snapshot [ button and
select Compare snapshots.
Important » You can compare a current snapshot to a previous
information snapshot or two snapshots both taken in the past.

» You can define a schedule that takes snapshots of a
specific view on a periodic basis and saves them. For
details, see "Schedule Snapshot Dialog Box" on
page 327.

» Snapshots of views that are marked as Track Changes
are created on a daily basis.

Relevant tasks

» "Compare Snapshots" on page 307

See also

» "Save Snapshot Dialog Box" on page 296
» "Schedule Snapshot Dialog Box" on page 327

User interface elements are described below (unlabeled elements are shown

in angle brackets):

Ul Elements (A-Z)

Description

Expands the entire hierarchical tree structure of the CIs

b}
iz you selected.
iR Collapses the hierarchical tree structure of the CIs you
selected.
” Finds the previous occurrence of an item marked as
e changed.
. Finds the next occurrence of an item marked as changed.
e L
B Show Configuration Files Differences. Shows the
J..-'

difference between the content of the two configuration
files. Configuration files use the .xml, .txt or .ini
extensions.

Select a CI of the CIT Configuration File in both panes
and click the Show Differences button. A window opens
displaying the differences (marked in blue) in the
configuration files.
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Ul Elements (A-Z)

Description

foa

Show Only Different Cls in Tree. In the <Properties
panes>, displays only the part of the tree structure
containing ClIs that do not match.

=]

Show Only Different Attribute Values. In the <Properties
panes>, toggles between displaying all the attribute
values of the selected CI or only the attribute values that
have changed.

ag”

Inu‘

Enables you to select a CI on one side and have its
corresponding CI automatically selected on the other
side.

The default state for the Synchronize Selection button is
selected. Deselecting this button allows you to select
different CIs from each of the two trees. This enables you
to compare two different CIs and see their different
properties.

8|

Contains An Updated Item. Indicates that a CI's attribute
value has changed. For example, a Contains an Updated

Item icon is displayed next to the 10.0.0.0 CI in the figure
below since the attribute of its child CI 10.168.100.3 icon
has changed.

10.0.0.0

= 10000
4+ Ipdddress

] 10.168.100.2
-4 (i) 10.168.100.3
=} 2] Windows

[  [©6

Name | Value
Routing Domain Default Dom ...
| 2 )P Network Mask | 255.0.0.0

Deleted Item. Indicates that a CI has been deleted from
the view.
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Ul Elements (A-Z)

Description

New Item. Indicates that a new CI has been added to the
view.

B4 [E] 10000
B4 IpAddress
(] 10188 100.2
s [ 10.188.100.3
=1 (@) Windows

Updated Item. Indicates that the attribute value of a CI
has changed.

For example, the figure below shows that the CIs
LABM3MAM16 displays the Updated Item icon because it
was updated with a new Version value, as indicated by
the Show Only Different Attribute Values [ icons (see
the Name and Value columns in the bottom panes
underneath the tree structure).

sanity rep Sun Apr 11 10:55:08 IDT...
I 3 e
‘4 LABM3LTDEO1 ‘4 LAEM3LTDBED (LAEM3LTDEDT)
‘4 LABM3LTDEOZ2 S 4 LAEM3LTDBEO2 (LABM3LTDBOZ) =
@ 4 | ABM3LTDDBO1 g @ [ | ABM3LTDDEO1 (LABM3LTDDBO
? 'Y LABM3LTDDEOZ @ [ L ABM3ILTDDEOZ (LABM3LTDDBO
Y LABM3MAM16 - 59 LABM3IMAMTE (LABM3MAMIE)
4 1l 3 4 il 3
g [ 00 1@ © e [ | @ ©
o
Name | Value MName | Value
DiscoveredProduc...  MSSQL DB DiscoveredProduc...  MSSQL DB
Application Category = Database Application Category Database
Application Versio... Application Versio...
Product Name =gl_server_datab. .. ProductMame =ql_server_databa...
¥ Version ! Version 2005

<Left and right
panes>

Displays a hierarchical tree structure of all the CIs in the
view for that snapshot version. The left side always
represents the newer of the two versions.
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Ul Elements (A-Z)

Description

<Properties pane>

Displays the attributes of the selected CI.
The Properties pane contains the following fields:

» Name. Displays the name of the selected CI as defined
in the CI's label.

» Value. Displays the attribute value for the currently
selected CI.

<Toolbar>

For details, see "Toolbar Options" on page 329.

Available Snapshots

Displays the current status and previously saved
snapshots of the view selected in the View with
Snapshots field. Select the two snapshots you want to
compare.

Note: Visible when Show Report Parameters button is
pressed.

View with snapshots

Displays the name of the view whose snapshots you want
to compare. Only views for which snapshots have been
taken are displayed.

Note: Visible when Show Report Parameters button is
pressed.
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@ Impact Analysis Report

This report displays a list of CIs that are impacted in the system as a result of
simulated changes. For details, see "Run Impact Analysis Dialog Box" on
page 294.

I 5! Report Parameters | B4 &&= - ¢:__°| =
Triggered Cls:  C2 s Se\rer'rty: Pule Bundle: =

Triggered Cls || Grouping by CIT || Affected Application

Show Cl instances of: | structureElement (3) Vl ﬁ D:Q =t | Q
Cisplay Label
] 1abm2am11
Lh 1112222
] 1abm2am04
To access In IT Universe Manager, click Generate Report from the

Run Impact Analysis dialog box.

See also » "Impact Analysis Manager" on page 449
» "Run Impact Analysis Dialog Box" on page 294

User interface elements are described below (unlabeled elements are shown
in angle brackets):

Ul Elements (A-Z) Description
<Toolbar> For details, see "Toolbar Options" on page 329.
Rule Bundle Enables you to select the rule group with which the

Impact Analysis rule works.

Severity Sets the severity level that we want to simulate for the
triggered Cls.

Triggered Cls Select the ClIs that represent the changes you want to
make to the system. Opens the CI Selector.
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Affected Application Tab

This tab displays all the CIs that belong to a specific business application,
which were affected by the triggered CI severity change.

User interface elements are described below:

Ul Elements (A-Z)

Description

Display Label The name of the CI or relationship as it appears in the
toplogy map.
Trigger Severity The severity selected in the Severity box.

Grouping by CIT Tab

This tab displays all the ClIs related to the triggered Cls that are impacted in
the system as a result of the simulated changes, sorted by CI type.

User interface elements are described below:

Ul Elements (A-Z)

Description

Display Label

The name of the CI or relationship as it appears in the
toplogy map.

Trigger Severity

The severity selected in the Severity box.

Triggered Cls Tab

This tab displays all the Cls that represent the changes you want to make to
the system. The CIs in this tab are the ClIs selected in the Triggered Cls box.

User interface elements are described below:

Ul Elements (A-Z)

Description

Display Label

The name of the CI or relationship as it appears in the
toplogy map.
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This dialog box displays a list of the reports/snapshots that were scheduled
to run in the "Schedule Snapshot Dialog Box" on page 327.

To access

Select Admin > RTSM Administration > Modeling >
IT Universe Manager. Click the Snapshots [& button,
and select Show Scheduled Snapshot Jobs.

User interface elements are described below:

Ul Elements (A-Z)

Description

Insert New Scheduled Report. Define a new job using the
Schedule Job dialog box.

Edit Job. Edit the selected job using the Schedule Job
dialog box.

Create Copy. Enables you to create a copy of the selected
job. Opens a new job in the Schedule Job dialog box that
uses the details of the selected job.

Remove Job. Deletes the selected job from the list of

X scheduled jobs.

B Run Job Immediate. Runs the selected job.

il Pause Job. Pauses the selected job. Enabled only if the job
has a Pending status.

® Resume Job. Resumes the selected job.

Note: The Resume button is enabled only for jobs that
have a Paused status.

Refreshes the list of scheduled jobs.

Clears the current filter.

Change visible columns. Enables you to select the
columns to be displayed.
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Ul Elements (A-Z)

Description

Current Status

The current status of each scheduled job:

» Running. The job is currently executing.

» Pending. The job is waiting for the scheduling
requirements to be fulfilled.

» Completed. The job has finished executing.

» Paused. The job has been paused.

Note. If a job has a Completed status, and you want to
resume running the job, you can either click Run Job
Immediate or change the Next Execution Time to the
current time. If you change it to a future time, the status
changes to Pending.

Description

A description of the scheduled job as defined in the
Schedule Job dialog box.

Execution Status

The job's current execution status:

» Success. The job completed successfully.
» Failure. The job failed to execute.

» None. The job has not yet been executed.

Job Type

A scheduled job can either be Schedule Report or
Schedule Snapshot.

Last Execution Time

The last time the report ran.

Name

The name of the scheduled job as defined in the Schedule
Job dialog box.

Next Execution Time

The next time the report is scheduled to run.
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@ Schedule Snapshot Dialog Box

This dialog box enables you to define a schedule for taking snapshots of a
specific view. You can see the list of reports/snapshots that have been
scheduled to run in the "Job List Dialog Box" on page 325.

To access

Select Admin > RTSM Administration > Modeling >
IT Universe Manager. Click the Snapshots [& button in
the CI Selector, and select Schedule Snapshot.

Relevant tasks

» "Compare CIs" on page 305

» "Compare Snapshots" on page 307

The following elements are included:

Ul Elements (A-Z)

Description

Click to validate the Cron expression you entered in the
Cron Expression box.

Cron Expression

Enter a Cron expression to schedule a job. For a
description of the fields used in Cron expressions and
examples of how to use them, see, "Cron Expressions" on
page 3009.

Description

A description of the scheduled job.

Ends

Select one of the following options:

» Never. Do not specify an end date. Not relevant if you
define a report to run only once.

» Until. Choose the date and time by which you want
the action to stop running. Relevant only if you are
using Cron expressions.

Locale

Select the language for the report.

Name

The name of the scheduled job.
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Ul Elements (A-Z)

Description

Repeat

Select one of the following actions:

» Once. Activates a job only once.

» Daily. Runs a job on a daily basis.

» Weekly. Runs a job on a weekly basis. Select the day or
days on which you want the action to run.

» Monthly. Runs a job on a monthly basis. Select the
month or months in which you want the job to run.

» Yearly. Runs a job on a yearly basis.

» Cron. Use a Cron expression to schedule a job. For a
description of the fields used in Cron expressions and
examples of how to use them, see, "Cron Expressions"
on page 309.

Repeat every

(Appears only when you select Daily, Weekly, Monthly or
Yearly.) Select a value for the interval between successive
runs.

For example, if you select Weekly and then 2, the job runs
every second week.

Server Time The exact server time according to the client’s time zone.

Starts Choose the time and date when you want the job to
begin running.

Time Zone Set the required time zone.

328




@ Toolbar Options

Chapter 9 © Reports

This section describes the toolbar options for reports.

Ul Elements (A-Z)

Description

| @Repar‘c Farameters |

Displays the parameters that are defined for the report.

[]

Save Report. Saves the selected report.

1)

Schedule Report. Opens the Schedule Job dialog box,
which enables you to define a job that:
» Schedules the generation of a report

» Specifies one or more formats in which to send the
report, and the report’s recipients

» Specifies the recurrence of the job

For more information on the Schedule Job dialog box,
see, "Schedule Snapshot Dialog Box" on page 327.

Note: This option is available only before you generate a
report or when you open a saved report.

Send Mail. Opens the Send Mail dialog box. You can send
an email containing the generated report in various
formats, or as a direct link. For details on the various
formats, see "Export Report." on page 330.

Select one or more of the available formats for the
generated report to be sent as attachments to an email
recipient.

Note: Required fields are marked with an asterisk.

Archive Report. Enables you to save the report results in
the database. After the report is archive, a icon
appears next to the report name.

Note: Enabled only for Topology reports.

Generate Direct Link. Creates a direct link to the specific
location on the server of the selected report, or to the
data that you have exported as a specific format.
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Ul Elements (A-Z)

Description

8

Export Report.

Enables you to select the export format for the report. The
available options are:

» Excel. The report data is formatted as an .xls (Excel) file
that can be displayed in a spreadsheet.

» PDF. The report data is exported in PDF format.

» CSV. The report data is formatted as a comma-
separated values (CSV) text file that can be displayed in
a spreadsheet.
Note: For the CSV formatted table data to display
correctly, the comma (,) must be defined as the list
separator. In Windows, to verify or modify the list
separator value, open Regional Options from the
Control Panel, and on the Numbers tab ensure that the
comma is defined as the List Separator value.

» XML. The report data is formatted as an XML file that
can be opened in a text or XML editor.

Tip: To extract HTML code from the report:
» Open the file in an HTML editor
» Copy the relevant table into the target file

Wl Bar Chart Bar Chart. Displays the generated report as a bar chart.
2 Fie Chart Pie Chart. Displays the generated report as a pie chart.
B Table Table. Displays the generated report in tabular format.
& Show Short Labels. Toggles between displaying the chart

labels minimal/maximum information.

Note: This option is available only for pie charts.

[E]

Show Legend. Toggles between hiding and displaying the
chart’s legend.

Note: This option is available only for pie charts.
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Ul Elements (A-Z)

Description

v

Slice chart. Toggles between displaying the pie chart with
exploded and unexploded segments.

Note: This option is available only for pie charts.

B Expand All. Expands the tree structure.
B Collapse All. Collapses the tree structure.
W% Delete from CMDB. Deletes the selected CI from the

CMDB.

Opens the Configuration Item Properties dialog box for
the selected CI.

Refresh. Refreshes the report tree.

m Select Columns. Select the columns you want to display
in the report.

= Sort Column Content. Enables you to set the sort order of
the selected column’s content.

Q Find. Toggles between displaying and hiding the Find

utility.

Find the next occurrence of the phrase/Find the previous
occurrence of the phrase. Enables you to move to the
next or previous result of the search for the string entered
in the Find field.

= Highlights all occurrences of the phrase. Highlights all
occurrences in the CI tree of the string entered in the Find
field.

[, Generate Generate Report. Enables you to generate the selected
report.

o

Note: This button appears disabled prior to defining the
report parameters.
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Ul Elements (A-Z)

Description

<breadcrumbs>

Displays the levels through which you have navigated to
get to the current level. Appears horizontally across the
top of the chart.

Note: Each level in the list of breadcrumbs is a clickable
link.

<Generated report>

Displays the active generated report.

Find

Enter a search name or a portion of a search name in the
Find field to locate it in the list.
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This report displays the topology of a view in report format.

To access Select Admin > RTSM Administration > Modeling >
IT Universe Manager and click the View Based Report
F" button.

Important Every view in the RTSM can be displayed in report

information format. You define the settings for the report in the
Report tab of the view in Modeling Studio.

User interface elements are described below:

Ul Elements (A-Z)

Description

<Bar graph/Pie
chart>

Each segment of the pie chart/column in a bar graph
represents a CI on the selected level of the view.

Click a slice/bar to drill down to the next level, if one
exists. You can also display the information in table
format.

When you hold the mouse over the relevant segment/bar,
a tooltip indicates the number of instances there are for
that CIT, the percentage of the pie it represents (when
viewing the information in pie chart format), and the CIT
or CIT attribute the slice/bar represents.

<Toolbar>

For details, see "Toolbar Options" on page 329.
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Modeling Studio

This chapter includes:

Concepts

» Modeling Studio Overview on page 337

» View Formats on page 338

» Building a Business View on page 339

» Templates and Perspectives on page 342

» Predefined Folders and Views on page 343

» Creating Template Based Views on page 345

» Business CI Models on page 346

» Building a Perspective Based View on page 349
» Revealed Cls and Watchpoints on page 354
Tasks

» Create a Pattern View on page 359

» Create a Template on page 360

» Create a Perspective on page 362

» Create a Template Based View on page 365

» Create Multiple Template Based Views on page 367
» Define Report Settings on page 369

» Build an Instance-based Model on page 370

» Build a Pattern-based Model on page 372

» Build a Perspective-based View Based on a Model on page 374
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> Build a Perspective-based View Based on a Collection of CIs on page 374
» Build a Business CI Model — Scenario on page 375
Reference

» Modeling Studio User Interface on page 378

Tip: For more information about using Modeling Studio in HP Business
Service Management, see "Best Practices for Modeling" on page 215.
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Concepts

& Modeling Studio Overview

Modeling Studio is a tool for creating and managing views. You can create
your own views, or work with the out-of-the-box (factory) views provided
with your HP Business Service Management installation.

The IT Universe model in the configuration management database can be
very large, holding thousands of configuration item (CI)s. A view enables
you to build a subset of the overall IT universe model, containing only those
ClIs relating to a specific area of interest. You can define your own views to
display only the information that is relevant to your organization’s business
needs.

The views are used to display performance status in Service Health, and for
setting up SLAs in Service Level Management. HP Business Service
Management supports three view formats: pattern views, template based
views, and perspective based views, which are populated through different
processes. For details, see "View Formats" on page 338.
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& View Formats

338

HP Business Service Management supports three view formats, by which to
populate your view:

> Pattern views are built from a Topology Query Language (TQL) query that

defines the structure of the view. You can create a new TQL query as you
build the view or base the view on an existing query. The view displays
only those Cls and relationships that satisfy the query definition. When
the view is displayed or refreshed, the Modeling Studio queries the RTSM
for all elements that fit the query, and automatically updates the view
with those elements.

Template based views are based on a TQL query, to which a template is
then applied. The template is a reusable view that includes parameters,
which are saved as part of the template. This enables you to build
multiple views with the same settings without having to re-enter the
parameter information. The view displays only those CIs and
relationships that satisfy the query definition and the conditions of the
template. For details on templates, see "Templates and Perspectives" on
page 342.

Perspective based views are built by selecting a collection of individual
ClIs and applying a special type of template, known as a perspective, to it.
Instance views, which no longer exist, are replaced by perspective based
views. For details on perspectives, see "Templates and Perspectives" on
page 342.

When you select a view for editing from the view tree in the left pane, it
opens on the editing pane in the appropriate editor.
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& Building a Business View

In the Modeling Studio, you can define your own views to model your
business environment.

This section includes the following topics:

» "The Structure of a View" on page 339

> "Setting the View Hierarchy" on page 340

The Structure of a View

The views you create should provide the business users with logical
representations of your company’s structure, processes, and goals. To meet
these requirements, you generally build multiple views representing
different aspects of your business; for example, you could build business
views that revolve around any of the following:

» Company structure, so that data is organized by the geographical location
of branches, or by data centers.

» Business processes, so that data is organized by line of business, or by
applications.

» Business goals, so that data is organized by sales, or by key customers.

The views depend on the particular demands of your organization and the
actual hierarchical structure of the views should reflect those demands.

The usual hierarchical format of a view is as follows:

» Top level. The highest levels of the view, consisting of the root CI and the
branches below it, are normally built from logical Business CI types such
as Location, Line of Business, Customer, Application, and so on.

> Intermediate level. The intermediate branches of the view normally
consist of System CI types, representing actual hardware and software
and/or monitoring group CI types, representing groups containing
monitors.
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> Bottom level. The lowest level of the view, consisting of leaf ClIs at the
ends of the subtrees, is built from the Monitor CI types. These CIs receive
the actual data from the data sources, used to determine KPI status all the
way up the view subtrees, and so provide business context to the view.

Note: The bottom level is only relevant when a monitoring solution such as
HP Business Service Management is connected and modeled in the RTSM.

Setting the View Hierarchy

The Pattern View Editor enables you to set the view hierarchy using the
Hierarchy pane on the right side of the screen. There are two methods
available for setting the hierarchy: Manual and Rule-based. The manual
method is selected by default.

Manual Hierarchy Method

In the manual hierarchy method, the query nodes of the view are displayed
in a tree format. You can create the hierarchy by manually dragging a
selected query node under another query node or by using the toolbar
buttons. The system only allows you to move a query node under another
query node when the resulting hierarchy is valid. For details, see "Hierarchy
Pane" on page 414.

It is possible to place a single query node from the view into the hierarchy
multiple times. You can then adjust the hierarchy so that the query node
appears in different layers, according to the required layout. The view results
in such an instance would be the same as if you added another query node
to the TQL query. Using the same query node twice in the hierarchy enables
you to achieve the desired view results using a simpler TQL query.
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Query Node Grouping

When setting the view hierarchy manually, you can create subgroups to
group CIs by different criteria for the convenience of viewing the display.
Click the Add Group By button and select one of the options. You can create
a subgroup for CIs of the same type in the Topology Map using the Add
Group by Cl Type option. You can create a subgroup for a specific query
node by selecting the Add Group by Query Node option. You can group Cls
by a common attribute using the Add Group by Attribute button and
entering a regular expression as described in "Query Node Grouping Dialog
Box" on page 425. For details about regular expressions, see "Regular
Expression Examples" on page 575.

You can also create nested groups (a query node group inside another query
node group) to help fine-tune the TQL query results that are displayed in
the Topology Map.

For example, after grouping query nodes of type node by their CIT, you can
use their operation state attribute to create more focused groups.

Rule-Based Hierarchy Method

In the rule-based hierarchy method, you define hierarchy rules, using the
Hierarchy Rules dialog box. You select a source CIT, target CIT, relationship
type, and relationship direction, which define the conditions for a hierarchy
rule. Any ClIs in the view which satisfy the defined conditions are subject to
the rule, that is, the target CI is placed on the layer below the source CI. For
details on defining hierarchy rules, see "Hierarchy Rules Dialog Box" on
page 388.
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& Templates and Perspectives

342

A template is a reusable pattern view with defined parameters. You use
templates to build template-based views, setting the values of the
parameters for each specific view. Any changes made to a template affect all
existing views based on that template.

Template-based views can be opened in IT Universe Manager, like pattern
views. You can also open the template itself in IT Universe Manager to view
the results for various parameter values. If you want to save the results, you
must save it as a template-based view. You define templates, template-based
views, and pattern views in the Pattern View Editor.

Perspectives are a type of template designed to be applied to a specific
collection of ClIs, similar to the pattern in a pattern view. For example, a
perspective could comprise a node containing an IP Address. In that case,
the resulting perspective-based view would include all the CIs from among
the Cls in the CI selection, along with the IP Addresses contained in the
node ClIs.

The most basic perspective is known as the Content Only perspective and
consists of only the query node itself. If you apply the Content Only
perspective to a CI collection, the resulting view contains only the selected
ClIs themselves.

Perspectives are also created and edited in the Pattern View Editor. You can
have multiple views, templates, and perspectives open in the Pattern View
Editor simultaneously, each with its own tab.

Perspectives do not appear in the list of views in IT Universe Manager,
however perspective-based views can be opened in IT Universe Manager,
like all other views. For details, see "Building a Perspective Based View" on
page 349.

In summary, the Views tree in the Resources tab of the CI Selector in the
Modeling Studio can include five distinct entities:

> pattern views
> templates

» template based views
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> perspectives

» perspective based views
You can filter the tree to select the types of views or templates to display.

The following table summarizes the types of views and where they are
created and viewed:

: . Can be opened in
Type of View Created in: IT Universe Manager
Pattern View Pattern View Editor Yes
Template Pattern View Editor Yes, for the current

session only

Template-based View | Pattern View Editor Yes
Perspective Pattern View Editor No
Perspective-based Perspective-based View Yes
View Editor

& Predefined Folders and Views

The Views tree in the Resources tab of the CI Selector in the Modeling Studio
includes predefined folders and views, as described in the following
sections:

» "Predefined Folders" on page 343
> "Factory Views" on page 344

» "Predefined Perspectives" on page 344

Predefined Folders

The hierarchical file folder system in the CI Selector can help you organize
your views. Predefined folders are provided for the out-of-the-box views;
you can modify these folders, or add additional folders according to your
organization’s requirements.
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Factory Views

Your HP Business Service Management installation includes out-of-the-box
pattern views, templates, and perspectives. These views provide a quick start
for working with the RTSM for setting up SLAs, and for viewing system
performance information in Service Health.

The out-of-the-box views are initially empty. As soon as ClIs are added to the
RTSM by one of the CI generators, the TQL query built into each pattern
view is able to identify the CIs that meet the pattern requirements, and add
them to the view.

Views for Cls are created when a discovery process is run; the out-of-the-box
views that are provided correspond to the relevant Data Flow Management
(DEM) packages. For example, the Oracle view (Root > Database > Oracle >
Oracle) is populated with ClIs that are created when Data Flow Management
activates the Database - Oracle module. For details on running DFM, see
"How to Use Discovery Control Panel — Advanced Mode Workflow" in the
RTSM Data Flow Management Guide.

For details on the cross-application processes for setting up the SAP views,
see "Application Management for SAP Reports and Views" in Solutions and
Integrations.

Some of the out-of-the-box views are set by default to display in specific
HP Business Service Management applications. There are some
out-of-the-box views that are hidden by default.

Some of the out-of-the-box views are considered basic to the system and
cannot be deleted from the folders.

Predefined Perspectives

HP Business Service Management also provides out-of-the-box perspectives.
One example is the Content Only perspective, which includes only the
elements of the view content itself, without any additional Cls.
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The following out-of-the-box perspectives are intended to be used in Service
Health:

» System Monitors only. This perspective enriches the model by adding
child CIs down to the level of monitors. Use this perspective to create a
Service Health view that includes System monitors only.

> End User Monitors. This perspective enriches the model by adding child
ClIs related to the end user experience of the application, such as Business
Transaction and Business Transaction Flow. Use this perspective to create
a Service Health view that includes monitoring statuses for End User
Management only.

» Impact. This perspective enriches the model with all child CIs related by
impact links. Use this perspective to configure additional monitors using
the Monitor Deployment Wizard.

» Model and Dependency Hierarchy. This perspective enriches the model
with all dependent CIs in the RTSM. Use this perspective to create a view
with the full model hierarchy.

» APM Perspective. This perspective enriches the model with Business
Transactions Flow and Business Transaction Cls. Use this perspective to
add related infrastructure elements and SiteScope monitors to create a
view that includes all APM information.

& Creating Template Based Views

Template-based views based on the same template contain the same query
nodes and relationships. They differ only in their parameter values. You
create template-based views using the Template-based View wizard. The
wizard enables you to create multiple views at one time based on the same
template. When creating multiple views, you have the option of entering
parameter values manually or importing them from a CSV file. The CSV file
must be formatted correctly for the wizard to import the values. It must
contain the name of at least one of the template parameters in the first row
and it must contain at least one record. The records should be in separate
rows and the parameter values for each record should be in the same row,
separated by commas.
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The wizard also provides an Advanced Naming feature, which enables you
to define an expression for the view names based on parameter values. For
example, if your base template is called Server_Template, and one of the
template parameters is Serial Number, you could define the view names to
be Server <Serial Number>. In this way, the wizard automatically inserts the
respective value of the parameter Serial Number into the name of each view.

An alternate way to assign names to the views when importing values from
a CSV file is to include a column in the file called
template_based_view_name. The file entries corresponding to this column
are automatically entered by the wizard as the view names. Note that this
naming method overrides the Advanced Naming feature; that is, view
names are assigned the entries in the template_based_view_name column of
the file, even when the Advanced Naming feature is selected.

For details on creating template-based views, see "Template-based View
Wizard" on page 434.

You can also edit the parameters of a template-based view when the view is
open in the Editor, from the Template Parameter Values dialog box. For
details, see "Template Parameter Values Dialog Box" on page 440.

You cannot edit the report layout for a template-based view. To change the
report layout, you need to make changes in the base template of the view.

& Business Cl Models

346

This section includes the following topics:

> "Instance-based Models" on page 347

» "Pattern-based Models" on page 348
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The collection of CIs which compose the view content of perspective-based
views can be selected in two ways. You can select Cls from the CI Selector
and drag them onto the editing pane. In this case, you can build a view by
applying a perspective to the collection and the collection cannot be reused
in another view without repeating the selection process. The other way to
select the CIs to appear in the view is by creating a model.

A model is a reusable collection of CI instances that define a business entity,
such as a business service or line of business. By creating a model, you are
building a CI collection that can be reused with other perspectives to create
different views. Any changes you subsequently make to the model are
reflected in all the views based on that model. There are two types of
models: instance-based models and pattern-based models.

Instance-based Models

You build an instance-based model by first selecting a business CI to serve as
its basis. The available business Cls include group, application, business
service, business unit, and line of business. Then, you can add CIs to your
model in the following ways:

» Manually, by dragging CIs from the CI Selector into the Model Editor

» Revealing related CIs using a reveal path and selecting the ones to add to
the model

» Defining a watchpoint for a selected CI and automatically adding ClIs to
the model

You can also begin building a model by dragging Cls onto the empty canvas
and selecting Create a new model.

The model you create is a CI itself and the ClIs in your model are related to
the model by Contains relationships. You must save your model before
applying a perspective to it to build a view.
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Caution: The changes you make in a model affect the entire universe, not
just the views based on that model. Thus, if you delete a CI from a model,
you are deleting the relationship that existed between the CIs from the
RTSM.

When working in IT Universe Manager, you can add selected CIs directly to
a new model or an existing model. For details, see "Add ClIs to Model Dialog
Box" on page 259.

Pattern-based Models

Another type of model you can build is a pattern-based model. In a pattern-
based model, you define a TQL query to determine the ClIs included, rather
than selecting them manually. You can base your pattern-based model on an
existing TQL query or create a new TQL query.

You must designate at least one query node in the model’s TQL query as
output for the model. The CIs of that type which match the pattern of the
TQL query are the ones included in the model output.

The pattern-based model created is saved as a CI like an ordinary model, and
can be used to form the content of a perspective-based view. The new TQL
query created is saved as an ordinary query and can be used as the basis for a
pattern view.
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& Building a Perspective Based View

A perspective based view is composed of perspectives applied to a model or a
collection of CIs. The perspective is a special type of template which is
designed to be applied to a subset of the IT Universe model.

The Content pane of the Perspective-based View Editor displays the models
or CIs you have selected to serve as the basis of your view. The Perspective
pane displays the selected perspectives. The Preview pane displays the
resulting view based upon your content and perspective selections. When
you make a change in the content or perspective selections, the view is
updated accordingly in the Preview pane. For details, see "Perspective-based
View Editor" on page 419.

This section includes the following topics:

"Content" on page 349
"Perspectives" on page 350

"Views Based on Multiple Perspectives" on page 351

Y VY VY Y

"Including and Excluding Child CIs" on page 352

Content

The content in a perspective based view can be selected in two ways:

» You can add individual CIs to the view manually, using the CI Selector.
The ClIs in the collection are independent of each other. In this case, the
collection of ClIs is not defined as a model and cannot be reused in
another view.

» You can add one or more models to the view, using the CI Selector.
Alternatively, you can start by working with a model in the Model Editor
and select Generate View for Selected Model to build a view based on that
model. In this case, the identical content can be used to build another
view by selecting the same models.

You can select both individual CIs and models to form the content of a
perspective based view, however in that case, the models are treated as
ordinary CIs. The models themselves are included in the view without their
hierarchy of child ClIs.
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K

When working in IT Universe Manager, you can add selected Cls directly to
the content of a new or an existing perspective based view. For details, see
"Add ClIs to View Dialog Box" on page 260.

Perspectives

The perspectives you select for your view determine which Cls are included
in the view. A perspective is a reusable pattern, similar to a template. The
difference between a perspective and a regular template is that the
perspective includes one or more query nodes designated as contact query
nodes. A contact query node is a query node in the pattern which is used to
apply the pattern to specific content and it is indicated by a small icon that
appears next to the query node.

For example, in the following perspective, a query node of type Windows is
designated as the contact query node and it has an IP Address related to it by
a containment relationship.

=

s

indows

Contalnment

@!

IpAddress

When this perspective is applied to a CI collection, the resulting view
contains all the CIs in the original collection as well as the IP Addresses
connected to the Windows ClIs in the collection (the Cls that were added by
applying the perspective).

A perspective can have several contact query nodes, but every disconnected
graph within a perspective must have at least one contact query node.

If you make a change to a perspective, all views based on that perspective are
affected.
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Views Based on Multiple Perspectives

You can select multiple perspectives to apply to the content of your view.
There are two ways to select multiple perspectives:

» Perspective groups

» Perspective chains

In a perspective group, you select two or more perspectives to apply
simultaneously to the same input content.

In a perspective chain, you select two or more perspectives at different levels
of the view creation. The perspective in the first level is applied to the
original view content to generate results in the form of a CI collection that
serves as input content for the next level. The perspective in the second
level is then applied to this content to generate the view results. You can
build views based on multiple levels of perspectives, each one generating
input content for the following level.

It is possible to apply both of the above methods at the same time, that is,
by selecting multiple perspectives in each of the levels of a perspective
selection.

For example, select a collection of IP Subnet CIs as your input content and
select a perspective that adds the node CIs related to the IP Subnets as the
tirst level perspective. The results of this stage consist of the original IP
Subnets and their related nodes. Then add a second perspective level and
select two perspectives for it: one that adds CPU CIs related to nodes and
one that adds File System CIs related to nodes. The final results include the
original IP Subnets, their related nodes, and the CPUs and File Systems
related to those nodes.

These options help to simplify the process of creating a perspective-based
view, by breaking down the functionality of a perspective into its
component parts. Instead of building a separate large and complex
perspective for each required view, you can construct a custom perspective
combination to match the requirements of your specific case from smaller
and more basic perspectives.
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Including and Excluding Child Cis

When adding CIs that have children to a view, the CI and its children are
only included in the view if the pattern of the perspective includes children
for the selected CI type. In that case, children are included for all CIs of that
type. After creating a view, you can hide specific Cls from the view by
selecting the CI in the View Results pane and selecting Hide Cl from View
from the shortcut menu or clicking the Hide Cl from View button in the
toolbar. This option is only available for CIs that were added to the view via
the perspective and were not part of the original content on which the view
was based. Thus, if the view was based on a collection of CIs, the ClIs in that
collection cannot be hidden from the view. If the view was based on a
model, the model itself cannot be hidden from the view, but the CIs
contained in the model can be hidden.

When KPI status is calculated for a CI and displayed in Service Health, the
status is based on all child CIs that exist in the RTSM for the parent CI. The
Business Logic Engine calculates status from all child Cls attached to that
parent CI, across all views. The calculation is based on all the relationships
for the CI in the RTSM, without connection to the child CIs displayed in
any particular view. To restrict the number of Cls displayed in the view, you
can change the perspective to hide child CIs. This has no effect on KPI status
— status is still calculated based on all child CIs, whether they are displayed
in the view or hidden.

Whether or not all child ClIs are displayed in the view does not influence the
status calculations made for the parent CI and the status displayed in Service
Health.
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For example, the following pictures show status in Service Health for the
same CI, Group1, in two views: In the first view, child Cls are included, and
in the second, they are excluded. The same status result is shown for the CI
in both views, regardless of the perspective in use.

Top View I Console | Filters | Geographical Map | Custom Map | | Reports |
BPM_Profile1 - PREEE]

Performance @ tg Availability 0 +g ack &

Hierarchy KPIs Business Impact Alerts Changes & Incidents

Paerformance Availability Ack

Qo Oto =]

Do Oto 2

Qg Q¢ 8

Qg (VA =]

Top View I Console | Filters Geographical Map Custom Map Reports

: o o

BPM_Profile1 ~ a| 8| % o

Performance Q*o Availability ':-—"*O aAck &

When a CI has child Cls that are excluded from the view, the KPI tooltip in
Service Health shows the number of hidden child CIs with KPIs attached, to
indicate that the KPI status of the parent is based on CIs that are not in the
view.

Details - Performance

CI name: fist_bprn_praofile_1
Status: Critical

Calculation Rule: Warst Child Rule
Held status since /1006 10:02:50 AM
Hidden child CIs

(with attached 5

KPIs):

You can use the Find Visible and Hidden Child Cls option to view
information on hidden children. For details, see "How to Find Visible and
Hidden Child CIs" in Using Service Health.
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& Revealed CIs and Watchpoints

354

The Modeling Studio provides two advanced methods of adding Cls to an
existing model: revealing related CIs and defining watchpoints.

This section includes the following topics:

» "Revealing Cls" on page 354
> "Watchpoints" on page 357

Revealing Cis

One approach to building a model is to add ClIs related to the CIs in the
model. The Modeling Studio provides a tool to help you reveal those Cls.
The process of revealing related Cls involves constructing a reveal path,
which is a chain of CI types that are related to each other. The first item in
your reveal path is the CI type of the CI from which you started to reveal
ClIs. The Modeling Studio locates all of its related Cls and lists their CI types.
By selecting one of those types, you build the next step of your path. All the
related ClIs of that type appear in the lower pane of the dialog box. You can
select the ones you want to include in your model. The process is repeated
to build the following step of the path.
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For example:

1

If you begin to reveal CIs from a CI of type Windows, the Modeling
Studio may reveal related CIs of types Interface, Network, and IP. If you
select Network, the related ClIs of type Network appear in the lower pane
and can be added to the model by dragging them into the CIs Basket or
clicking the CIs Basket icon:

Reveal CIs x|
Revealing Related Cls... (2)
& Ateach step of the reveal path, selectrevealed Cls to add to your model.
Feveal Path. % Windows = Save path
X I Cl Type [ Conditi [ Cl count
54 Interface 1
iR 1
Find: | @ @ E‘ |
av
@ Drop Cls inorder to add them to modsl... _:a
MName Cl Type
Find: ‘ | @ @ E‘ |
Cle Basket
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2 Click Next to build the next step of the path using Network as your
selection. The Modeling Studio reveals related CIs of type Windows, Unix,
and IP. Unix is selected and the Unix Cls appear in the lower pane and
can be added to the model by dragging the selected ones into the Cls
Basket pane:

x|
Revealing Related Cls... (3)
At each step ofthe reveal path, select revealed Cls to add to your model.
Reveal Path: 4 Windows = 5% Network 3. Save path
® =
I Cl Type [ [= [ Cl count
ﬁ ‘Windows 35
e 43
Enc: \ @ ] = |
av
@ Drop Clz in order to add them to model :a
Mame Cl Type
5 tabm1ss04 Unix
§! notredame Uniixt
5 labm1suns Unix
B iabmitgo7 Unix
Bl iabmiitg10 Unix
B tabm1hp7 Unix
5 labmitgd2 Unix
‘ Eind: | ‘ @ @ = |
Cls Basket
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3 Click Next to build the next step of the path using Unix as your selection:

x|
4 Revealing Related Cls... (4)
uq At each step ofthe reveal path, select revealed Cls to add to your model.
Reveal Path: [ Windows & 5% Network & & Unix =
Cl Type C iti Cl count
+ SHMP 12 | =
“ai OS User 122
=4 Disk 12|
L EcPU 8|
% Interface 23
’,’f Network 2
« S5H 13 |
— e 5
aw
(@ Drop Cls in order to add them to mode|
Name | Cl Type
Cls Basket

In this case, a reveal path of Windows > Network > Unix was constructed. At
each step, you have the option of adding any of the revealed related ClIs to
your model. For details on revealing ClIs, see "Reveal Cls Dialog Box" on
page 427.

It is also possible to construct a reveal path without revealing Cls. For
details, see "Create/Edit/Save Reveal Path Dialog Box" on page 385.

Watchpoints

Another method of locating related ClIs to add to the model is by defining a
watchpoint for a selected CI in the model. A watchpoint is a mechanism
which is triggered when a new related CI of a specified type is created. Every
watchpoint is defined in connection with a reveal path. If a new related CI
of any CI type included in the path is created, the watchpoint is triggered
and an indicator appears next to the model. For details on defining a
watchpoint, see "New Watchpoint Dialog Box" on page 409.
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Note: You must save a new model before defining watchpoints for its Cls.

All the related CIs detected by the watchpoint are displayed in the
Watchpoints Updates dialog box. The dialog box enables you to select the
ones to add to your model and the ones to suppress, or exclude from your
model. For details, see "Watchpoints Updates Dialog Box" on page 446.

You also have the option to include the detected Cls in your model
automatically by selecting the check box in the New Watchpoint dialog box.
In this case, all Cls detected by the watchpoint are added to the model.

A watchpoint can also be used to detect Cls included in the model which are
no longer related to the model. If such ClIs are found along the reveal path
connected to the watchpoint, they also appear in the Watchpoints Updates
dialog box. You can accept the suggestion to remove the Cls from your
model, or you can suppress the suggestion, thereby keeping the Cls in your
model.

Note: Although a watchpoint is defined for an individual CI, the
watchpoint results display related ClIs of the CI types included in the reveal
path for all CIs in the model.
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Tasks

T Create a

Pattern View

This task describes how to create a pattern view and define its TQL query.

This task includes the following steps:

Y Y Y Y Y

-—)

"Open a New View in the Pattern View Editor" on page 359

"Add Query Nodes and Relationships to a TQL Query" on page 359
"Set the View Hierarchy" on page 360

"Define the Report Settings - Optional" on page 360

"Set Permissions" on page 360

Open a New View in the Pattern View Editor

Click the New = button and select Pattern View. In the New Pattern
View dialog box, select the base TQL query on which your new view is
based, or select Create new query to build a new TQL query. The Pattern
View Editor opens. For details, see "New Pattern
View/Template/Perspective Dialog Box" on page 407.

Add Query Nodes and Relationships to a TQL Query

Add the query nodes and relationships that define the query. For details
on how to add query nodes and relationships to a TQL query, see "Add
Query Nodes and Relationships to a TQL Query" on page 32.

Note: If you are starting with a blank view, you must add at least one
query node in order to save your view.
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3 Set the View Hierarchy

Set the hierarchy for the view by moving the required query nodes in the
Hierarchy pane. For details, see "Setting the View Hierarchy" on page 340.

When you are finished, click Save to save the view.

4 Define the Report Settings - Optional

Select the Report tab in the Pattern View Editor. Select the attributes you
want to include in the report for each query node of the view. You can
also set the order of the report columns, set the sort order of each column,
and add a chart. For details, see "Define Report Settings" on page 369.

5 Set Permissions

Apply viewing and editing permissions to users and user groups for the
new view. You set permissions in Admin > Platform > Users and
Permissions, select a user or a group and select Permissions. For details,
see "How to Assign Permissions" in Platform Administration.

T Create a Template
This task describes how to define a new template.
This task includes the following steps:

> "Open a New Template in the Pattern View Editor" on page 361

> "Add Query Nodes and Relationships to a TQL Query" on page 361
"Set Parameter Values" on page 361

"Set the Template Hierarchy" on page 361

"Define the Report Settings - Optional" on page 362

Y Y VY Y

"Set Permissions" on page 362
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1 Open a New Template in the Pattern View Editor

Click the New ‘= button and select Template. In the New Template
dialog box, select the base TQL query on which your new template is
based, or select Create new query to build a new TQL query. For details,
see "New Pattern View/Template/Perspective Dialog Box" on page 407.

2 Add Query Nodes and Relationships to a TQL Query

Add the query nodes and relationships that define the query. For details
on how to add query nodes and relationships to a TQL query, see "Add
Query Nodes and Relationships to a TQL Query" on page 32.

Note: If you are starting with a blank template, you must add at least one
query node in order to save your template.

3 Set Parameter Values

Right-click a query node or relationship in the TQL query and select
Query Node Properties. In the Attributes tab, add an attribute with a
parameterized value. For details, see "Query Node/Relationship Properties
Dialog Box" on page 85.

Note: If you do not set any parameters, when you try to save your
template, you must save it as a pattern view.

4 Set the Template Hierarchy

Set the hierarchy for the template by moving the required query nodes in
the Hierarchy pane. For details, see "Setting the View Hierarchy" on
page 340.

When you are finished, click Save to save the template.

361



Chapter 10 ¢ Modeling Studio

T Create

362

5

Define the Report Settings - Optional

Select the Report tab in the Pattern View Editor. Select the attributes you
want to include in the report for each query node of the view. You can
also set the order of the report columns, set the sort order of each column,
and add a chart. For details, see "Define Report Settings" on page 369.

Set Permissions

Apply viewing and editing permissions to users and user groups for the
new template. You set permissions in Admin > Platform > Users and
Permissions, select a user or a group and select Permissions. For details,
see "How to Assign Permissions" in Platform Administration.

Perspective

This task describes how to define a new perspective.

This task includes the following steps:

>

"Open a New Perspective in the Pattern View Editor" on page 363

> "Add Query Nodes and Relationships to a TQL Query" on page 363

Y VY VY Y

"Select a Contact Query Node" on page 363
"Set the Perspective Hierarchy" on page 363
"Define the Report Settings - Optional" on page 364

"Set Permissions" on page 364
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1 Open a New Perspective in the Pattern View Editor

Click the New ‘= button and select Perspective. In the New Perspective
dialog box, select the base TQL query on which your new Perspective is
based, or select Create new query to build a new TQL query. For details,
see "New Pattern View/Template/Perspective Dialog Box" on page 407.

2 Add Query Nodes and Relationships to a TQL Query

Add the query nodes and relationships that define the query. For details
on how to add query nodes and relationships to a TQL query, see "Add
Query Nodes and Relationships to a TQL Query" on page 32.

3 Select a Contact Query Node

Select at least one query node in the TQL query to be a contact query
node. Right-click the query node and select Use As Contact Query Node.

Note: If you do not select a contact query node, when you try to save
your perspective, you must save it as a pattern view.

4 Set the Perspective Hierarchy

Set the hierarchy for the perspective by moving the required query nodes
in the Hierarchy pane. For details, see "Setting the View Hierarchy" on
page 340.

When you are finished, click Save to save the perspective.
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5 Define the Report Settings - Optional

Select the Report tab in the Pattern View Editor. Select the attributes you
want to include in the report for each query node of the view. You can
also set the order of the report columns, set the sort order of each column,
and add a chart. For details, see "Define Report Settings" on page 369.

6 Set Permissions

Apply viewing and editing permissions to users and user groups for the
new perspective. You set permissions in Admin > Platform > Users and

Permissions, select a user or a group and select Permissions. For details,
see "How to Assign Permissions" in Platform Administration.
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Template Based View

This task describes how to define a single template based view.

This task includes the following steps:

Y Y Y Y Y Y

-

"Prerequisites" on page 365

"Define a New Template Based View" on page 365

"Select a Template" on page 365

"Select the Method for Adding Parameter Values" on page 366
"Set Parameters" on page 366

"Set Permissions" on page 366

Prerequisites

If you want to base your view on a new template, create the template first.
For details, see "Create a Template" on page 360.

Define a New Template Based View

You define a new template based view using the Template-based View
wizard. Click the New - button and select Template Based View.

Select a Template

On the Select Template page of the wizard, select a template on which to
base your view. For details, see "Select Template Page" on page 435.
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4 Select the Method for Adding Parameter Values

On the Import Parameter Values page of the wizard, select the method for
adding the parameter values. For details, see "Import Parameter Values
Page" on page 436.

Set Parameters

On the Parameters page, enter the parameter values for the view. For
details, see "Parameters Page" on page 437.

Note: You can also edit the parameters from within the Editor after
creating the view, by selecting Show Parameters ¢?» from the toolbar or
the shortcut menu.

When vou are finished, click Finish to open the view in the Editor. Click
Save to save the view.

Set Permissions

Apply viewing and editing permissions to users and user groups for that
view. You set permissions in Admin > Platform > Users and Permissions,
select a user or a group and select Permissions. For details, see "How to
Assign Permissions" in Platform Administration.
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T Create Multiple Template Based Views

This task describes how to define multiple template-based views.

This task includes the following steps:

Y VY VY Y

Y VY VY Y

)

"Prerequisites" on page 367
"Define New Template Based Views" on page 367
"Select a Template" on page 367

"Select the Methods for Adding Parameter Values and Naming Views" on
page 368

"Set Parameters" on page 368
"Select the Location for Saving the Views" on page 368
"Save the Views" on page 368

"Set Permissions" on page 368

Prerequisites

If you want to base your views on a new template, create the template
first. For details, see "Create a Template" on page 360.

Define New Template Based Views

You define new template based views using the Template-based View
wizard. Click the New - button and select Template Based View.

Select a Template

On the Select Template page of the wizard, select a template on which to
base your views. For details, see "Select Template Page" on page 435.
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4 Select the Methods for Adding Parameter Values and Naming

Views

On the Import Parameter Values page of the wizard, select the method for
adding the parameter values. Also, if you want to use the Advanced
Naming feature, select the check box on this page. For details, see "Import
Parameter Values Page" on page 436.

Set Parameters

On the Parameters page, enter the parameter values for the view. If you
selected to import the parameter values from a CSV file, they are
automatically entered in the table. You can edit the view names and
parameter values manually on this page. You can also add new views to
the table or delete views from the table. For details, see "Parameters Page"
on page 437.

Select the Location for Saving the Views

On the Select Location page, select the location in the view tree in which
to save the new views. For details, see "Select Location for Views Page" on
page 438.

Save the Views

On the Summary page, review the details of the views you created. If
there are no further changes, click Save to save the views in the selected
location.

Set Permissions

Apply viewing and editing permissions to users and user groups for each
view created. You set permissions in Admin > Platform > Users and
Permissions, select a user or a group and select Permissions. For details,
see "How to Assign Permissions" in Platform Administration.
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T Define Report Settings

This task describes how to define report settings for a view, template, or
perspective.

This task includes the following steps:

» "Prerequisites" on page 369

> "Select Attributes to Appear as Report Columns" on page 369

\

"Add Function Columns to the Report - Optional" on page 370

\

"Set the Sort Order of the Column Content" on page 370

\

"Add a Chart to the Report - Optional" on page 370

-

Prerequisites

After defining the content and hierarchy of a view, template, or
perspective, you can define the report settings. Select the Report tab in
the Pattern View Editor.

2 Select Attributes to Appear as Report Columns

For each query node in the view, select the query node in the Hierarchy
pane and select the attributes to appear as columns in the report for that
query node. You select attributes in the Query Node Definition pane by
moving them from the Attributes list to the Report Layout list. Set the
order of the columns using the arrow buttons in the Report Layout list.
For details, see "Query Node Definition Pane" on page 416.
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Add Function Columns to the Report - Optional

You have the option of adding a column for a selected query node
consisting of data derived from a function performed on one of its child
query nodes. Click the Add Function /z button to open the Add
Function dialog box where you can select the relevant settings. For
details, see "Add/Edit Function Dialog Box" on page 379.

Set the Sort Order of the Column Content

Click the Set Sort Order =T button to open the Sort Column Content
dialog box. Determine the columns by which to sort the report by
moving columns from the Available Columns list to the Sorted Columns
list. Use the arrow buttons to set the sort order of the columns. Use the
Sort Ascending/Sort Descending buttons to set the sort direction for each
column. For details, see "Sort Column Content Dialog Box" on page 433.

Add a Chart to the Report - Optional

You have the option of adding a chart to your report, in place of a table,
for a selected layer of the view. When the necessary conditions for adding
a chart are satisfied, the Define Chart link in the Chart Properties section
of the Query Node Definition pane is active. Click the link and enter the
chart settings. For details, see "Chart Properties" on page 418.

T Build an Instance-based Model

This task describes how to build an instance-based business CI model which
can serve as the basis for a view.

370

This task includes the following steps:

Y VY VY Y

"Create the New Model" on page 371

"Add ClIs to the Model Manually" on page 371

"Reveal CIs" on page 371

"Define Watchpoints for Cls in the Model" on page 371
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1 Create the New Model

In the Modeling Studio, click the New :: button and select Instance
Based Model to open the New Model dialog box. Select a CI type and
enter the values for its properties. For details, see "New Model Dialog Box"
on page 407.

2 Add Cis to the Model Manually

In the CI Selector, search for the ClIs you want to include in your model.
Select them and drag them into the model.

Tip: You can select more than one CI by holding the CTRL key while
selecting Cls.

3 Reveal Cls

Select a CI in the model and reveal its related Cls along a reveal path. Add
selected CIs from among the revealed CIs to your model. When you are
done, save the model. For details, see "Reveal CIs Dialog Box" on

page 427.

4 Define Watchpoints for Cls in the Model

Right-click a CI in the model and select Watchpoint > New Watchpoint.
The New Watchpoint dialog box opens. Select a reveal path and click OK.
A small icon appears next to the CI indicating that a watchpoint is
defined for it. For details, see "New Watchpoint Dialog Box" on page 409.
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P Build a Pattern-based Model

This task describes how to build a pattern-based model which can serve as
the basis for a perspective-based view.

372

This task includes the following steps:

Y Y Y Y Y Y

-—)

"Define the New Model" on page 372

"Enter the Model Details" on page 372

"Select a TQL Query" on page 372

"Add Query Nodes and Relationships to a TQL Query" on page 372
"Set Output Query Nodes" on page 373

"Save the Model" on page 373

Define the New Model

You define a pattern-based model using the Pattern-based Model wizard.
Click the New - button and select Pattern Based Model.

Enter the Model Details

On the first wizard page, select a CI type for the model and enter the
properties. For details, see "Select CI Type Page" on page 411.

Select a TQL Query

On the next wizard page, select a TQL query for the model. You can create
anew TQL query or select an existing query from the tree. The TQL Query
Editor opens with the selected query. For details, see "Query Selection
Page" on page 412.

Add Query Nodes and Relationships to a TQL Query

Add the query nodes and relationships that define the query. For details
on how to add query nodes and relationships to a TQL query, see "Add
Query Nodes and Relationships to a TQL Query" on page 32.
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5 Set Output Query Nodes

Select one or more query nodes in the TQL query to serve as output for
the model by right-clicking them and selecting Add to Model Output.
The query node is indicated by a small icon next to it.

6 Save the Model

When you are finished, save the model with a unique name. If you
created a new TQL query, the query is also saved independently of the
model and can be re-used as a regular TQL query.
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T Build a Perspective-based View Based on a Model

This task describes how to build a view in the Modeling Studio based on a
model and a perspective.

1 Open the Model

In the Modeling Studio, select Models as the Resource type in the left
pane, select the relevant model, and click Open Model [ in the left pane
toolbar.

2 Select a Perspective

In the Model Editor, right-click the model and select Generate View for
selected model. The Creating New View dialog box opens. Select
perspectives to apply to the model. For details, see "Creating New View
Dialog Box" on page 386.

3 Save the View

The Perspective-based View Editor opens with your new view. Optionally,
build a perspective chain by selecting perspectives for additional levels of
the view creation. Rename the view and save it in the correct folder. For
details, see "Perspective-based View Editor" on page 419.

P Build a Perspective-based View Based on a Collection of

Cls

374

This task describes how to build a view in the Modeling Studio based on a
collection of Cls and a perspective.

This task includes the following steps:

> "Create the New View" on page 375
> "Add ClIs to the View" on page 375

> "Select a Perspective and Save the View" on page 375
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Create the New View

In the Modeling Studio, click the New :: button and select Perspective
Based View to open the Perspective-based View Editor. For details, see
"Perspective-based View Editor" on page 419.

Add Cls to the View

In the CI Selector, search for the Cls you want to include in your view.
Select them and drag them into the view. For details on the CI Selector,
see "CI Selector" on page 163.

Tip: You can select more than one CI by holding the CTRL key while
selecting Cls.

Select a Perspective and Save the View

In the Perspective pane, select perspectives to apply to your CI collection.
Optionally, you can build a perspective chain by selecting perspectives for
additional levels of the view creation. Rename the view and save it in the
correct folder. For details, see "Perspective-based View Editor" on

page 419.

T Build a Business Cl Model - Scenario

This scenario describes how to build a business CI model for use in a human
resources application.

This task includes the following steps:

Y VY VY Y

"Create a Model" on page 376

"Create Application CI Models Within Your Model" on page 376
"Add System ClIs to Your Model" on page 376

"Add ClIs to Your Model as Related CIs" on page 377
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1 Create a Model

To create a model, you need to select a CI type and enter its key
properties.

Select Admin > RTSM Administration > Modeling > Modeling Studio to
open the Modeling Studio. For details about how to create a model, see
"New Model Dialog Box" on page 407.

Example of a Business Cl Model:

In this example, a human resources application called Onboard Employee
is to be created. Select Business Process as the CI type and enter Onboard
Employee as the name under the key properties.

Create Application Cl Models Within Your Model

You can create models within your model by clicking the New Model icon
& in the Model Editor. For details, see "Model Editor" on page 396.

Example of Application Cl Models:

Within the Onboard Employee model, create a model of type Application.
Enter HR Enterprise Resource Planning (ERP) as the name under the key
properties. The application CI is created as a model within the Onboard
Employee model. Repeat the process to create the following applications:
Active Directory (AD) and Customer Relationship Management (CRM). The
Onboard Employee model now includes three application models.

Add System CIs to Your Model

Add to your model the Cls for the servers or other software elements on
which the applications are running.

Example of System Cl Models:

Under the HR ERP application, drag the System CI SAP System. Under the
AD application, drag the System CI Node. The System ClIs are included in
the model and their related ClIs, such as Hosts and Monitors, are
automatically added to the model as related Cls.
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4 Add Cis to Your Model as Related Cls
Add the ClIs that are to be related to the CIs in the model but are not
included in the model. For details, see "Model Editor" on page 396.
Example of Related Cls:

Create an application CI of type Portal. Select the CRM application and
click the Related ClIs tab in the Information pane. Drag the Portal CI into
the Information pane. The CI is added as a related CI to CRM.
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Reference

® Modeling Studio User Interface

378

This section includes (in alphabetical order):

» Add/Edit Function Dialog Box on page 379

» Change Query Node/Relationship Type Dialog Box on page 381
» Choose Operation for Selected Items Dialog Box on page 383
» Conditions of Related CIs Dialog Box on page 383

» Create/Edit/Save Reveal Path Dialog Box on page 385

» Creating New View Dialog Box on page 386

» Cycle Definition Dialog Box on page 387

» Hidden CIs Dialog Box on page 388

» Hierarchy Rules Dialog Box on page 388

> Left Pane on page 389

» Manage CI Watchpoints Dialog Box on page 395

» Model Editor on page 396

» Modeling Studio Page on page 404

» Models Containing Selected CI Dialog Box on page 406

» New Model Dialog Box on page 407

» New Pattern View/Template/Perspective Dialog Box on page 407
» New Watchpoint Dialog Box on page 409

» Open Reveal Path Dialog Box on page 410

» Pattern-based Model Wizard on page 411

» Pattern View Editor on page 413

» Perspective-based View Editor on page 419
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» Query Node Grouping Dialog Box on page 425

» Query/View Definition Properties Dialog Box on page 426
» Reveal CIs Dialog Box on page 427

» Save Query Dialog Box on page 430

» Save View/Template/Perspective Dialog Box on page 431
» Select Data Sources Dialog Box on page 432

» Sort Column Content Dialog Box on page 433

» Template-based View Wizard on page 434

» Template Parameter Values Dialog Box on page 440

» TQL Query Editor on page 440

» Views Containing Selected CI Dialog Box on page 444

» Watchpoints Updates Dialog Box on page 446

» <Query/Template/Perspective Name> Dependencies Dialog Box
on page 447

@ Add/Edit Function Dialog Box

This dialog box enables you to define which of the query node’s functions
and parameters you want to include in the report.

To access Click the Add Function button under the Report Layout
box in the Query Node Definition pane of the Pattern
View Editor.
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Important
information

When defining the report columns for a selected query
node in a view, template, or perspective, you can define a
column consisting of data deriving from a function
defined for one of its child query nodes. Select the
relevant child query node, attribute, and function that
you want to define.

First, select the required query node and function. The
attribute list adjusts to display the relevant attribute for
the selected combination. Select the required attribute.

Relevant tasks

"Define Report Settings" on page 369

User interface elements are described below:

Ul Element (A-Z)

Description

Attribute

Select an attribute from the list.

Function

From the Function list, select the function you want to
use to calculate the results on these columns.

The following are the available options:

» Average. The average value of the selected attribute for
all the CI instances of the selected query node.

» Concatenated List. Lists the values of the selected
attribute for all the CI instances of the selected query
node.

» Count. Calculates the number of CI instances of the
selected query node.

» Distinct List. Lists the unique values of the selected
attribute for all the CI instances of the selected query
node.

» Max. The maximum value of the selected attribute for
all the CI instances of the selected query node.

» Min. The minimum value of the selected attribute for
all the CI instances of the selected query node.

» Sum. The sum of the selected attribute values for all
the CI instances of the selected query node.
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Ul Element (A-Z)

Description

Related Query Node

The child query node on which you want to perform the
function.

Title

The name of the function attribute displayed in the
report.

® Change Query Node/Relationship Type Dialog Box

This dialog box enables you to change the CI type of a TQL query node or
relationship after you have created a TQL query.

To access In the TQL Query Editor or Pattern View Editor, right-
click the required query node and select Change Query
Node Type. For relationships, right-click the required
relationship and select Change Relationship Type.

Important You can change the CI type of the selected query node to

information any other valid type based on the existing relationships

and conditions of the selected query node.

Relevant tasks

» "Define a TQL Query" on page 30

» "Implement a Discovery Adapter" in the RTSM
Developer Reference Guide

» "Create a Pattern View" on page 359

User interface elements are described below (unlabeled elements are shown

in angle brackets):

Ul Element (A-Z)

Description

e

Click Expand All to expand all the folders in the tree.

Bl

Click Collapse All to collapse all the folders in the tree.
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Ul Element (A-Z)

Description

Tree View

|£|

Click Tree View to select the display format of the CI
type/Relationship tree. The following options are
available:

» Display label

» Class name

» Legacy class name

<l
type/Relationship
tree>

Select the required CI type or relationship.

Relationship
Direction

Select the direction of the relationship.

Note: Only relevant for relationships.

Relationship Name

The name of the relationship.

Note: Only relevant for relationships.

Relationship
Restrictions

Select an option to define how to handle relationships
between identical query nodes or self relationships in the
query results. A self relationship is a relationship that
leads from a query node to itself.

» Allow All Relationships. All relationships appear in the
query results.

» Allow Self Relationships only. Only self-relationships (a
relationship that leads to itself) appear in the query
results.

» Allow Non Self Relationships only. Self-relationships
do not appear in the query results.

Note: Only relevant for relationships.
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@ Choose Operation for Selected Items Dialog Box

This dialog box enables you to create models and views from selected ClIs.

To access In the Modeling Studio, drag CIs from the CI Selector
onto the empty canvas.

Important You can drag individual or multiple CIs onto the canvas.

information You can select ordinary Cls and/or models to drag onto
the canvas. Use the CTRL key while selecting ClIs to select
multiple Cls.

See also "Best Practices for Modeling" on page 215

User interface elements are described below:

Ul Element (A-Z)

Description

Create a new model

Select to build a model comprising the CIs in your
selection. If the CIs you dragged onto the canvas include
at least one CI that has no valid links to any of the model
CI types, this option is disabled.

Create a new view

Select to build a view based on the CI collection formed
by your selection.

Edit the model of the
selected CI

Select to edit the selected model in the Model Editor.

Note: This option only appears when a single model is
dragged onto the canvas.

@ Conditions of Related Cls Dialog Box

This dialog box enables you to define conditions for the CI types in a reveal

path.
To access Click the Add Condition or Edit Condition buttons from
the Conditions column of the Reveal CIs dialog box.
See also "Best Practices for Modeling" on page 215
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User interface elements are described below:

Ul Element (A-Z)

Description

Add the attribute condition you have defined.

L
3¢ Delete an attribute condition.
Move a selected row up.
Y Move a selected row down.
lﬁ View the condition definition.
And/Or Click inside the And/Or field and select either And or Or

to link multiple conditions.

Attribute name

Select an attribute from the list.

C » Brackets

Click inside the Brackets box to display a list of brackets
you can use to build more complex, logical statements.

Criteria

Contains the attribute condition definition as defined in
the Element Instances dialog box.

Not

Select NOT if you want the condition statement to do the
opposite of what is defined.

Note: If you select NOT, query results do not include data
from the CI instances that were not assigned a value. For
example, your system contains three node CIs: Nodel is
assigned the value A, Node2 is assigned the value B and
Node3 is not assigned a value. You create a query to
retrieve all nodes that are equal to A and select NOT; the
results of your query only include Node2 because Node3
is not assigned a value.

Operator

Select the required operator. For details, see "Attribute
Operator Definitions" on page 45.

Value

Enter or select the value of the attribute. The Value
options vary according to the attribute type you select.
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@ Create/Edit/Save Reveal Path Dialog Box

This dialog box enables you to define a new reveal path or edit an existing

path.

To access To define a new reveal path, click the Reveal i button
from the Model Editor, and select Create Reveal Path.
To edit an existing reveal path, select a path from the
Open Reveal Path dialog box and click Edit.
To save a reveal path, click Save Path from the Reveal CIs
dialog box.

See also "Best Practices for Modeling" on page 215

User interface elements are described below:

Ul Element (A-Z)

Description

Description Enter a description of the path.

Name Enter the name of the path.

Preview Opens the Reveal CIs dialog box displaying the related
CIs in the path.
Note: This button does not appear in the Save Reveal
Path dialog box.

Reveal Path Build the path by clicking the = icon to open a dialog

box with a CI type tree. Select the CI type for the next
item in the path.

When you hold the pointer over a reveal path item, the
following options are available:

» Delete Selected Item(s). Deletes the selected item
from the reveal path.

» Add condition. Opens the Conditions of Related Cls
dialog box, which enables you to set conditions for
the reveal path item.

» Refine Query Node Type. Opens a CI type tree, which
enables you to change the CI type of the reveal path
item.
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@ Creating New View Dialog Box

This dialog box enables you to select a perspective to create a view from a

model.

To access In the Modeling Studio, right-click a model in the Model
Editor, Perspective-based View Editor, or CI Selector and
select Generate view for selected Model or click the
Generate view for selected model icon [ from the
Model Editor.

Important You select perspectives in the left pane and move them to

information the right pane using the arrow buttons.

Relevant tasks "Build a Perspective-based View Based on a Model" on
page 374

See also "Best Practices for Modeling" on page 215

User interface elements are described below (unlabeled elements are shown
in angle brackets):

Ul Element (A-Z) Description
Available A list of the available perspectives to apply to your
Perspectives model.

Selected Perspectives | The perspectives you selected to apply to your model.
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@ Cycle Definition Dialog Box

This dialog box enables you to define a cyclical hierarchy in a view.

To access

In the Modeling Studio, right-click a query node in the
Hierarchy pane of the Pattern View Editor and select
Define Cycles.

Important
information

You can extend the TQL query definition of a view by
defining a cycle in the view hierarchy. Select a query
node in the Hierarchy pane to be the source query node.
The Cycle Definition dialog box displays the valid target
query nodes for that source. The target query node in the
cycle, along with its hierarchyj, is treated as a child or
sibling of the source query node (depending on your
folding rule selection).

See also

"Best Practices for Modeling" on page 215

User interface elements are described below (unlabeled elements are shown

in angle brackets):

Ul Element (A-Z)

Description

Folding Rule

Select one of the following options:
» Folded cycle under source. The target query node
becomes a child of the source query node.

» Flattened cycle under parent. The target query node
becomes a sibling of the source query node.

Target

Displays the valid target query nodes for the selected
source query node. A query node is defined as a valid
target query node if all of the following conditions are
true:

» it is related to the source query node

» it is an ancestor of the source query node (or the
source query node itself)

» it is a query based node (not a grouping node)
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@ Hidden Cls Dialog Box

This dialog box enables you to restore hidden ClIs to a view.

To access From the Perspective-based View Editor, click the Show
Hidden Cls icon from the toolbar of the View Results
pane.

See also "Best Practices for Modeling" on page 215

User interface elements are described below (unlabeled elements are shown

in angle brackets):

Ul Element (A-Z)

Description

<check box>

Select the check boxes for the CIs you want to restore.

Cl Type The CI type of the excluded CI.

Name The name of the excluded CI.

Restore Click Restore to include the selected ClIs in the view.

Select All Click Select All to select all the CIs in the list for
inclusion in the view.

Unselect All Click Unselect All to clear the check boxes of all the CIs

in the list.

@, Hierarchy Rules Dialog Box

388

This dialog box enables you to set the hierarchy of a view by defining

hierarchy rules.

To access From the Hierarchy pane of the Pattern View Editor,
when Rule Based is selected as the hierarchy method,
click the Add Hierarchy Rule < button from the toolbar.

Important For each hierarchy rule you define, select a source CI

information type, target CI type, relationship, and direction.

See also "Best Practices for Modeling" on page 215
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User interface elements are described below (unlabeled elements are shown

in angle brackets):

Ul Element (A-Z) Description
4 Click to add a hierarchy rule.

W% Click to delete the selected hierarchy rule.

Relationship Select a relationship from the drop-down list to edit the
selected hierarchy rule.

Relationship Select a direction from the drop-down list to edit the

Direction selected hierarchy rule.

Source Select a CI type for the source CI type from the drop-
down tree to edit the selected hierarchy rule.

Target Select a CI type for the target CI type from the drop-
down tree to edit the selected hierarchy rule.

@ Left Pane

This area enables you to browse views and TQL queries, search for CIs or
models to open in the Editor pane, and select CI types to use in the TQL
Query Editor or Pattern View Editor.

To access Located to the left of the Editor pane in Modeling Studio.
Important The following tabs are available:
information » Cl Selector. See "CI Selector" on page 163.
» Resources. Enables you to select a model, view, or TQL
query to open in the Editor pane.
» Cl Types. Enables you to select CI types from the tree
to add as a query node to your TQL query.
See also "Best Practices for Modeling" on page 215
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Resources Tab

Important When Views or Queries is selected as the resource type,
information you can drag and drop views, queries, or folders to move
them from one folder to another.

User interface elements are described below (unlabeled elements are shown
in angle brackets):

Ul Element (A-Z) Description
E?] Click New Folder to create a new folder in the resource
tree.

Note: This button only appears when Queries or Views
are selected as the resource type.

3¢ Click Delete to delete the selected resource from the
RTSM.
|§| Click Refresh to refresh the resource tree.
B Click Expand All to expand all the folders in the resource
tree.

Note: This button only appears when Queries or Views
are selected as the resource type.

B Click Collapse All to collapse all the folders in the
resource tree.

Note: This button only appears when Queries or Views
are selected as the resource type.

B When Queries or Views are selected as the resource type,
click Hide Empty Folders to display only folders
containing views or TQL queries.

When Models is selected as the resource type, click Show
only models with content to display only models
containing ClIs.
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Ul Element (A-Z) Description

T When Views is selected as the resource type, click Filter
Tree to filter the types of views and templates that appear
in the tree.

When Queries is selected as the resource type, it enables
you to filter the TQL queries that appear in the tree by
query type.

When Models is selected as the resource type, click Filter
Table to filter the models in the table by CI type.

0 Click Open Query to open the selected TQL query in a
new tab.

Note: This button only appears when Queries is selected
as the resource type.

| Click Open View to open the selected view in a new tab.

Note: This button only appears when Views is selected as
the resource type.

5 Click CI Properties to view the properties of the selected
= model.

Note: This button only appears when Models is selected
as the resource type.

i Click Show views containing selected Cl/model to
= display a list of views including the selected CI or model.

Note: This button only appears when Models is selected
as the resource type.

Click Open Model to open the selected model in the

= Model Editor.
Note: This button only appears when Models is selected
as the resource type.

o Click Import From XML to import XML files that contain

saved views or queries to the Modeling Studio.

Note: This button only appears when Queries or Views
are selected as the resource type.
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Ul Element (A-Z)

Description

=

(ETT

Click Export To XML to export the view or query as an
XML script. This option can be used to move a view or
query from one workstation to another.

Note: This button only appears when Queries or Views
are selected as the resource type.

<Resources>

When Views or Queries is selected as the resource type,
the available views or TQL queries are displayed under
their respective folders in tree format. When Models is
selected as the resource type, the available models are
displayed in a table.

For views, the following view types are included:

» LI Denotes a pattern view.

» [Z] Denotes a template.

> L Denotes a template-based view.

» [2] Denotes a perspective.

» L& Denotes a perspective-based view.

Resource Type

Select the resource type to display in the pane. The
available options are Models, Views, and Queries.

Resources Tab Shortcut Menu

The Resources tab includes the following elements (listed alphabetically)
available by right-clicking a resource:

Menu Iltem

Description

Create a new
View/Template/Pers
pective

Create a new view, template, or perspective based on the
selected view, template, or perspective.

Note: This option is only active for queries when a query
of type view, template, or perspective is selected.

Delete

Delete the selected resource from the RTSM.

Export To XML

Export the view or query as an XML script. This option
can be used to move a view or query from one
workstation to another.

New Folder

Create a new folder in the resource tree.
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Menu Item

Description

New Template Based
View

Edit the parameters of the selected template to define a
new template-based view.

Note: This option is only active when a template is
selected in the view tree.

Open Open the selected view, TQL query, or model in a new
Query/View/Model tab.
Properties Opens the CI Properties dialog box for the selected
model.
Note: This option is only relevant for models.
Refresh Refresh the resource tree.
Remove Remove the selected model.

Note: This option is only relevant for models.

Rename Folder

Rename the selected folder.

Save As

Save the selected TQL query with a new name.

Show containing
views

Opens the Views containing selected CI dialog box for
the selected model.

Note: This option is only relevant for models.

Cl Types Tab

User interface elements are described below (unlabeled elements are shown

in angle brackets):

Ul Element (A-Z)

Description

B Click Expand All to expand all the folders in the CI Type
tree.
B Click Collapse All to collapse all the folders in the CI Type

tree.
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Ul Element (A-Z)

Description

Tree View

|£|

Click Tree View to select the display format of the CI type
tree. The following options are available:

» Display label

» Class name

» Legacy class name

Click to add the selected CI type to the TQL query which
is open in the Editor pane.

Note: This button is only active when a view or TQL
query is open in the Editor pane.

=]

Click Refresh to refresh the CI Type tree.

<Cl Type tree>

The available CI types are displayed in tree format.

Cl Types Tab Shortcut Menu
The CI Types tab includes the following elements (listed alphabetically)
available by right-clicking a CI type:

Menu ltem

Description

Add Selected CITs to
Query

Select to add the selected CI type to the TQL query open
in the Editor pane.

Go to Cl Type
Definition

Takes you directly to the selected CI type in CIT Manager.

Show Element
Instances

Opens the CI Instances window, which displays all
instances of the selected CIT. For details, see "Element
Instances Dialog Box" on page 77.
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@ Manage Cl Watchpoints Dialog Box

This dialog box enables you to add or remove watchpoints for a Cl in a

model.

To access

From within a model in the Model Editor, click the
Watchpoint @, button and select Manage CI
Watchpoints or right-click a CI in the model and select
Watchpoint > Manage Cl Watchpoints.

User interface elements are described below:

Ul Element (A-Z)

Description

Add

4

Click to open the New Watchpoint dialog box which
enables you to add a new watchpoint.

W% Remove

Click to delete the selected watchpoint.

Automated A check mark indicates that the new CIs found by the
watchpoint are to be added to the view automatically.
Source Cl Displays the CI forming the beginning of the reveal path.

Watchpoint Name

The name of the reveal path associated with the
watchpoint.

Watchpoint Path

Displays the reveal path for the watchpoint.
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® Model Editor

This feature enables you to create and edit models.

396

To access

In the Modeling Studio, click the New :: button and
select Instance Based Model to create a new model or
select Models as the Resource type and open an existing
model.

Important
information

The Model Editor contains the following panes:

» Content pane. Lists the CIs and models contained in
the model.

» Information pane. Displays the properties, related CIs
and watchpoints for the selected CI or model.

You can drag CIs from the CI Selector into the Content
pane of an existing model to add them to the model.
However, you cannot drag in a CI that is already included
in the model.

You can drag CIs from the CI Selector into the Related Cls
tab of the Information pane provided that the selected
source and target CI can be related by a usage
relationship.

See also

"Best Practices for Modeling" on page 215

Content Pane

User interface elements are described below:

Ul Element (A-Z)

Description

Select Text Mode to display the ClIs in a list.

Click CI Properties to open the Configuration Item
Properties dialog box for the selected CI.

Click Show models containing selected Cl to display a
list of the models containing the selected CI.

Select Map Mode to display the CIs as icons in a diagram.
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Ul Element (A-Z)

Description

L&

Click Show views containing selected Cl/model to
display a list of the views containing the selected CI or
model.

Click Open selected model in a new tab to open the
selected model in a separate Model Editor tab.

hd

Click Generate view for selected model to create a view
based on the current model. The Creating New View
dialog box opens, which enables you to select a
perspective to apply.

Click to remove a selected CI from the model (it remains

X in the RTSM).
& Click Insert new model to open the New Model dialog
& box which enables you to define a new model within the
existing model.
B Click Expand All to expand the model hierarchy.
B Click Collapse All to collapse the model hierarchy.
rq Click Reveal for the following options:

» Start Revealing. Opens the Reveal ClIs dialog box. For
details, see Reveal CIs dialog box.

» Create Reveal Path. Opens the Create Reveal Path
dialog box. For details, see Create Reveal Path dialog
box.

» Open Reveal Path. Opens the Open Reveal Path dialog
box. For details, see Open Reveal Path dialog box.
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Ul Element (A-Z)

Description

Click Watchpoint for the following options:

» Watchpoints Updates. Display the watchpoint results
and select CIs to add to the model. For details, see
Watchpoints Updates dialog box.

» New Watchpoint. Define a new watchpoint for the
selected CI. For details, see New Watchpoint dialog
box.

» Manage Cl Watchpoints. Add new watchpoints to the
CI or remove existing ones. For details, see Manage CI
Watchpoints dialog box.

Click CI Collection to group ClIs in a collection under a
model. Select one of the following options:

» Insert New CI Collection. Create a new empty CI
Collection. After creating the collection, you can drag
Cls into it from the CI Selector, the related ClIs tab, or
from the model itself.

» Join to Cl Collection. Select a CI or several ClIs in the
model and join them to an existing CI collection or
form a new collection.

» Decompose Cl Collection. Select a CI collection and
decompose it. Its CIs remain directly under the main
model.

Click Find to toggle between displaying and hiding the
Find box and arrow controls.

Note: This button only appears in Text mode.

Click to refresh the map and optimize the map layout.

Note: This button only appears in Map mode.

Click Fit to Window to resize the map to fit the size of the
pane.

Note: This button only appears in Map mode.
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Ul Element (A-Z) Description

A Select ~ Select the functionality of the cursor from the Mode
drop-down. The following options are available:

> Select
» Drag Map
» Zoom In

Note: This feature only appears in Map mode.

& Prirt Click the Print button to select Print, Print Preview or
Print Setup.

Select a CI and click Show External Relationships to
display the related CIs for that CI.

of

Note: This button only appears in Map mode.

? Click Hide External Relationships to hide the related CIs.
Note: This button only appears in Map mode.

Indicates that watchpoints are defined for the current CI.

al)

) Indicates that the watchpoints have detected new CIs
related to the current model. Click it to open the
Watchpoints Updates dialog box.

Cl Type column Displays the type of each CI in the model.

Find Enter a CI name or a portion of a CI name in the Find
box to locate a CI in the model.

Find Next Click to go to the next occurrence of the selected search
phrase in the model.

Find Previous Click to go to the previous occurrence of the selected
search phrase in the model.

Highlight Click to highlight all occurrences of the search phrase in
the model.

Name column Displays the name of each CI in the model.
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Shortcut Menu Options

Menu Item

Description

Cl Collection

Click ClI Collection to group ClIs in a collection under a
model. Select one of the following options:

» Insert New ClI Collection. Create a new empty
collection. After creating the collection, you can drag
Cls into it from the CI Selector, the related Cls tab, or
from the model itself.

» Join to Cl Collection. Select a CI or several CIs in the
model and join them to an existing CI collection or
form a new group.

» Decompose Cl Collection. Select a CI collection and
decompose it. Its Cls remain directly under the main
model.

Fit to Window

Resizes the map to fit the size of the pane.

Note: This option only appears in Map mode.

Generate view for
selected model

Select to create a view based on the current model. The
Creating New View dialog box opens which enables you
to select a perspective to apply.

Hide External
Relationships

Hides the related Cls from the map.

Note: This option only appears in Map mode.

Insert New Model

Opens the New Model dialog box which enables you to
create a new model within the existing model.

Open selected model

Opens the selected model in a separate Model Editor tab.

in a new tab
Print Select one of the following options:
» Print
» Print Preview
» Print Setup
Properties Opens the Configuration Item Properties dialog box for

the selected CI.

Refresh Layout

Refreshes the map and optimizes the map layout.

Note: This option only appears in Map mode.
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Menu Item Description

Reveal The following options are available:

» Start Revealing. Opens the Reveal CIs dialog box. For
details, see Reveal CIs dialog box.

» Open Reveal Path. Opens the Open Reveal Path
dialog box. For details, see Open Reveal Path dialog
box.

Remove Selected Deletes the selected CIs from the model (it remains in
Cl(s) from the Model the RTSM).

Select Select the functionality of the cursor. The following
options are available:

>» Select
» Drap Map
» Zoom In

Note: This option only appears in Map mode.

Show Containing Click to display a list of the models containing the
Models selected CI.

Show Containing Click to display a list of the views containing the
Views selected CI or model.

Show External Displays the related CIs for the selected CI.

Relationships Note: This option only appears in Map mode.

Watchpoint The following options are available:

» Watchpoints Updates. Display the watchpoint results
and select CIs to add to the model. For details, see
Watchpoints Updates dialog box.

» New Watchpoint. Define a new watchpoint for the
selected CI. For details, see New Watchpoint dialog
box.

» Manage Cl Watchpoints. Add new watchpoints to the
CI or remove existing ones. For details, see Manage CI
Watchpoints dialog box.

Zoom Select the size of the map from the list of percents.

Note: This option only appears in Map mode.
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Information Pane - Properties Tab

This area displays the properties of the selected CI.

Important This pane is identical to the Properties tab of the
information Information pane in IT Universe Manager. For details, see
"Configuration Item Properties Dialog Box" on page 266.

Information Pane - Related Cls Tab
This area displays the CIs related to the model by one of the triplets that
includes an Impacted By (Potentially) relationship.

User interface elements are described below (unlabeled elements are shown
in angle brackets):

Ul Element (A-Z) Description

W% Click to delete the relationship to the selected CI.
=5 Click Invert Direction to switch the direction of the
L2

relationship for the selected CI.

Note: This option is only active for CIs related by a usage
relationship.

<Cl list> Lists the name and CI type of the CIs related to the
model by usage relationships, as well as the direction of
the relationship.

Filter by Select a field by which to filter the results and enter the
value in the by box.
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Information Pane - Watchpoints Tab

This area displays the watchpoints defined for the selected CI.

User interface elements are described below:

Ul Element (A-Z)

Description

Click to open the Manage CI Watchpoints dialog box,

g which enables you to edit the watchpoint.
Automated Indicates whether the new CIs found by the watchpoint
are automatically added to the view.
Source Cl Displays the CI forming the beginning of the reveal path.

Watchpoint Name

The name of the reveal path associated with the
watchpoint.

Watchpoint Path

Displays the reveal path of the watchpoint.
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@ Modeling Studio Page

This page enables you to create and edit models and views.

Tip: For more information about using Modeling Studio in HP Business
Service Management, see "Best Practices for Modeling" on page 215.

To access

Select Admin > RTSM Administration > Modeling >
Modeling Studio.

Important
information

The Modeling Studio page contains the following panes:

» Left pane. Enables you to search for CIs or select a
view, model, or TQL query to open. For details, see
"Left Pane" on page 389.

» Editor pane. Displays the topology map of a selected
view, model, or TQL query.

The Editor pane is a blank canvas before any views or
models are opened. When you open a view, model, or
TQL query, the relevant editor appears there. Multiple
views, models, and queries can be open at the same time
in the Editor pane, each within a separate tab.

See also

"Model Editor" on page 396, "Perspective-based View
Editor" on page 419, "Pattern View Editor" on page 413,
and "TQL Query Editor" on page 440.
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User interface elements are described below (unlabeled elements are shown
in angle brackets):

Ul Element (A-Z) Description

New Click the click the New button to select one of the
following options:

> Instance Based Model. To create a new instance based
model.

» Pattern Based Model. To create a new pattern based
model.

» Pattern View. To create a new pattern view.

» Template Based View. To create a new template-based
view.

» Perspective Based View. To create a new perspective-
based view.

» Template. To create a new template.
> Perspective. To create a new perspective.
» Query. To create a new TQL query.

) Click Save to save the changes to your view, model, or
query.

For views, a dialog box opens which enables you to
rename your view and save it in the appropriate folder.

B Click Save As to save your view, model, or TQL query
‘ under a new name.

Click Undo to reverse the last change you made.

2 Click Redo to repeat the last action you took.

= Click Maximize Workspace to toggle between the regular
display and a full-screen display of the editor.

<Menu> For details, see "Main Menu" on page 197.
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® Models Containing Selected Cl Dialog Box

This dialog box enables you to display a list of the models containing the

selected CI.

To access Click the Show models containing selected Cl [F) button
in the Model Editor or select Show containing models
from the shortcut menu.

See also "Best Practices for Modeling" on page 215

User interface elements are described below:

Ul Element (A-Z)

Description

5

Click CI Properties to open the Configuration Item
Properties dialog box for the selected model.

L&

Click Show views containing selected Cl/model to
display a list of views containing the selected model.

Click Remove model to delete the selected model.

b4

Cl Type Displays the CI types of the models containing the
selected CI.

Find Enter a model name or a portion of a model name in the
Find box to locate it in the list.

Find Next Click to go to the next occurrence of the selected search

phrase in the list.

Find Previous

Click to go to the previous occurrence of the selected
search phrase in the list.

Name

Displays the names of the models containing the selected
CL

Note: The name of the current model appears in faded
text.
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® New Model Dialog Box

This dialog box enables you to define a reusable model containing a
collection of CIs.

To access Click the New :: button and select Instance Based
Model or drag a CI from the tree in the CI Selector onto
the editing pane and select Create a new model.

Relevant tasks "Build an Instance-based Model" on page 370

See also "Best Practices for Modeling" on page 215

User interface elements are described below:

Ul Element (A-Z) Description
Define new Cl Enter the values for the CI properties. You must enter
Properties values for key properties and required properties. The key

properties are marked with a key symbol § and the
required properties are marked with an asterisk.

Select ClI Type Select a CI type from the list to serve as the basis for your
model.

@ New Pattern View/Template/Perspective Dialog Box

This dialog box enables you to define a new pattern view, template, or
perspective using the Pattern View Editor.

To access In the Modeling Studio, click the New - button and
select Pattern View, Template, or Perspective from the
drop-down menu.

Important After making your selection and clicking OK, you go
information directly to the Pattern View Editor to begin building your
view. For details, see "Pattern View Editor" on page 413.
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Relevant tasks

» "Create a Pattern View" on page 359
» "Create a Template" on page 360
» "Create a Perspective" on page 362

See also

"Best Practices for Modeling" on page 215

User interface elements are described below (unlabeled elements are shown

in angle brackets):

Ul Element (A-Z)

Description

Click to go to the next occurrence of the selected search
phrase in the list of TQL queries.

Click to go to the previous occurrence of the selected
search phrase in the list of TQL queries.

Click to highlight all occurrences of the search phrase in
the list of TQL queries.

<TQL query tree>

Displays the existing TQL queries in tree format.

Choose base query

If you want to base your new view on an existing TQL
query, select this option and select a TQL query from the
tree. The Pattern View Editor opens with the selected
TQL query on the canvas.

Create new query

If you want to base your new view on a new TQL query,
select this option. The Pattern View Editor opens with a
blank canvas.

Find

Enter a TQL query name or a portion of a query name in
the Find box to locate a TQL query in the list.
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® New Watchpoint Dialog Box

This dialog box enables you to define a watchpoint for a CI in a model.

To access From within a model in the Model Editor, click the
Watchpoint @ button and select New Watchpoint or
right-click a CI in the model and select Watchpoint >
New Watchpoint.

Important If no reveal paths are found for the selected CI, no
information watchpoints can be defined.

You cannot define watchpoints for Cls in a new model
until you save the model.

Relevant tasks "Build an Instance-based Model" on page 370

User interface elements are described below:

Ul Element (A-Z) Description

Automatically update | Select to automatically add all revealed CIs from the

model selected path to the model.

Control updates Select to manually add revealed CIs from the selected

manually path to the model.

Select Watchpoint Select a reveal path from the drop-down list.

reveal path

Show reveal paths Select a CI type from the drop-down list. All reveal paths

for Cl type beginning with that CI type appear in the list in the
lower drop-down box.
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® Open Reveal Path Dialog Box

This dialog box enables you to open an existing path.

410

To access From within a model in the Model Editor, click the
Reveal /i button and select Open Reveal Path or right-
click a CI in the model and select Reveal > Open Reveal
Path.

Important After selecting the reveal path you want to use, click

information Execute. If CIs are found on the selected path, the Reveal

ClIs dialog box opens for that path. If no ClIs are found, a
message appears stating that no CIs were found on the
path.

User interface elements are described below:

Ul Element (A-Z)

Description

Description column

Displays the descriptions of the existing paths.

Edit Opens the Edit Reveal Path dialog box which enables you
to edit the selected path.

Execute Opens the Reveal CIs dialog box for the selected reveal
path.

Find Enter a path name or a portion of a path name in the
Find box to locate a path in the list.

Find Next Click to go to the next occurrence of the selected search

phrase in the list of paths.

Find Previous

Click to go to the previous occurrence of the selected
search phrase in the list of paths.

Highlight

Click to highlight all occurrences of the search phrase in
the list of paths.

Name column

Displays the names of the existing paths.

Remove

Deletes the selected path.

Show reveal paths
for Cl type

Select a CI type from the drop-down list. All paths

beginning with the selected CI appear in the table below.
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® pPattern-based Model Wizard

This wizard enables you to build a pattern-based model.

To access

In the Modeling Studio, click the New - button and
select Pattern Based Model from the drop-down menu.

Important
information

When you create a pattern-based model, the model is
saved as a CI, as with an ordinary model. If you based
your model on a new TQL query, the query is also saved
and appears in the TQL query tree.

Relevant tasks

"Build a Pattern-based Model" on page 372

Wizard map The Pattern-based Model Wizard contains:
Select CI Type Page > Query Selection Page
See also "Pattern-based Models" on page 348

® select CI Type Page

This wizard page enables you to select a CI type for the model and define its

details.

Wizard map

The Pattern-based Model Wizard contains:
Select CI Type Page > Query Selection Page

User interface elements are described below (unlabeled elements are shown

in angle brackets):

Ul Element (A-Z)

Description

Define new CI
Properties

Enter the values for the CI properties. You must enter

properties are marked with a key symbol § and the
required properties are marked with an asterisk.

values for key properties and required properties. The key

Select Cl Type

model.

Select a CI type from the list to serve as the basis for your
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® Query Selection Page

This wizard page enables you to select a TQL query upon which the model is

based.

Wizard map

The Pattern-based Model Wizard contains:

Select CI Type Page > Query Selection Page

User interface elements are described below (unlabeled elements are shown

in angle brackets):

Ul Element (A-Z)

Description

Click to go to the next occurrence of the selected search
phrase in the list of TQL queries.

Click to go to the previous occurrence of the selected
search phrase in the list of TQL queries.

Click to highlight all occurrences of the search phrase in
the list of TQL queries.

<TQL Query tree>

Displays the existing TQL queries in tree format.

Choose base query

If you want to base your model on an existing TQL query,
select this option and select a query from the tree. The
TQL Query Editor opens with the selected query on the
canvas.

Create new query

If you want to base your model on a new TQL query,
select this option. The TQL Query Editor opens with a
blank canvas.

Find

Enter a TQL query name or a portion of a query name in
the Find box to locate a query in the list.
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®, pattern View Editor

This feature enables you to build and edit pattern views, templates, and
perspectives.

To access To open a new view in the Pattern View Editor, go to the
Modeling Studio, click the New - button and select the
required type of view.

To open an existing view in the Pattern View Editor, go to
the Resources tab of the left pane in the Modeling Studio
and select Views as the Resource type. Right click a view
in the tree and select Open View or double click a view or
drag a view onto the Editor pane. The topology map of
the view opens in the Editor pane.

Important You can access the Editor in View mode or in Report
information mode.

» In View mode, the following panes are included:

» Query Definition pane. For details, see "TQL Query
Editor" on page 440.

» Advanced pane. For details, see "Advanced Pane" on
page 442.

» Hierarchy pane. Enables you to set the hierarchy of
the view. (Located in the right portion of the Editor
page.)

» In Report mode, the following panes are included:

» Hierarchy pane. Enables you to set the hierarchy of
the view. (Located in the left portion of the Editor
page.)

» Query Node Definition. Enables you to select the
attributes to be included in the report and to set
their order.

Note: To save your view, template, or perspective, use the
Save button in the Modeling Studio main toolbar.

Relevant tasks » "Create a Pattern View" on page 359
» "Create a Template" on page 360
» "Create a Perspective" on page 362

See also "Best Practices for Modeling" on page 215
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Hierarchy Pane

User interface elements are described below (unlabeled elements are shown
in angle brackets):

Ul Element (A-Z) Description
= Click Add Group By to create a subgroup in the

hierarchy. The following options are available:

» Add Group By Attribute. Opens the Query Node
Grouping dialog box, which enables you to select an
attribute for a subgroup in the hierarchy.

» Add Group By Cl Type. Create a subgroup in the
hierarchy for the CI type of the selected query node.

» Add Group by Query Node. Create a subgroup in the
hierarchy for the selected query node only.

& Click Edit Group By Attribute to open the Query Node
Grouping dialog box, which enables you to edit the
attribute for a subgroup in the hierarchy.

Click Rename to rename the selected query node.

Click Delete Query Node to delete the selected query
b4 .
node from the hierarchy tree.

& Click Move Query Node Layer Up to place the selected
query node one layer higher in the hierarchy.

Click Move Query Node Layer Down to place the selected
query node under the query node above it in the
hierarchy.

Note: If the selected query node is located at the top of
the hierarchy tree, clicking Move Query Node Layer
Down places it under the query node beneath it in the
hierarchy.

s Click Move Query Node Up to move the selected query
node up in the hierarchy tree. The query node order in
the hierarchy determines the query node order in the
report generated for the view in Reports.
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Ul Element (A-Z)

Description

L

Click Move Query Node Down to move the selected
query node down in the hierarchy tree. The query node
order in the hierarchy determines the query node order
in the report generated for the view in Reports.

a

Click Preview to display a preview of the topology report.

Note: This option only appears in the Hierarchy pane
when Report mode is selected.

<Hierarchy tree>

The query nodes of the TQL query are arranged in a
hierarchical tree reflecting the hierarchy defined for the
view.

You can click and drag query nodes to change the
hierarchy. When you click a query node and begin to
drag it, the query nodes under which it is possible to
place your query node are highlighted in green.

Hierarchy Method

Select the method of setting the hierarchy:
» Manual. Set the hierarchy manually, by dragging
query nodes and using the toolbar buttons.

» Rule Based. Open the Hierarchy Rules dialog box
which enables you to set rules for the hierarchy.

Shortcut Menu

The Hierarchy pane includes the following elements (listed alphabetically)
available by right-clicking a query node in the hierarchy tree:

Menu ltem

Description

Add Group By
Attribute

Select Add Group By Attribute to open the Query Node
Grouping dialog box, which enables you to select an
attribute for a subgroup in the hierarchy.

Add Group By Cl
Type

Select Add Group By Cl Type to create a subgroup in the
hierarchy for the CI type of the selected query node.

Add Group By Query
Node

Select Add Group By Query Node to create a subgroup in
the hierarchy for the selected query node only.
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Menu Item

Description

Define Cycles

Select Define Cycles to define a cyclical hierarchy. For
details, see "Cycle Definition Dialog Box" on page 387.

Delete Query Node

Select to delete the selected query node from the
hierarchy tree.

Move Query Node
Down

Select to move the selected query node down in the
hierarchy tree.

Move Query Node
Layer Down

Select Move Query Node Layer Down to place the
selected query node under the query node above it in the
hierarchy.

Note: If the selected query node is located at the top of
the hierarchy tree, selecting Move Query Node Layer
Down places it under the query node beneath it in the
hierarchy

Move Query Node
Layer Up

Select Move Query Node Layer Up to place the selected
query node one layer higher in the hierarchy.

Move Query Node
Up

Select to move the selected query node up in the
hierarchy tree.

Rename

Select to rename the selected query node.

Subgraph Hierarchy

Enables you to define whether the subgraph defined for
the selected query node is displayed as flat or as folded
under the query node.

Note: This option is only relevant for query nodes that
have a defined subgraph.

Query Node Definition Pane

Important
information

The Query Node Definition pane is disabled for template
based views. To make changes to the report layout, edit
the based template of the view. When you open a
template based view in the Editor and select the Report
tab, a warning message appears containing a link to the
base template of the view.




Chapter 10 * Modeling Studio

User interface elements are described below:

Ul Element (A-Z)

Description

s Click Up to move a selected attribute up in the report
layout order.

i Click Down to move a selected attribute down in the
report layout order.

& Click Edit to edit the function for the selected attribute.

3 Click Delete to delete a selected attribute from the report
layout.

-3 Click to move the selected attributes to the Report Layout

list.

Add Function

Click Add Function to open the Add Function dialog box,
which enables you to define the functions to include in
the report for the selected query node. Each function that
you add is treated as an attribute and becomes a column
in the report.

Note: This button is only active if there is a query node
below the selected query node in the view hierarchy.

Attributes The list of available attributes for the selected query
node.
Define Chart Click Define Chart to display the data for the current

layer of the view in a graphical chart format. The Chart
Properties fields are displayed.

The Define Chart option is only active for a query node
or a grouping node that:

» has a layer below it in the view hierarchy

» is the only query node on its layer of the view

» has at least one numeric attribute selected for the
report layout
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Ul Element (A-Z)

Description

Report Layout

Displays the list of attributes selected to appear in the
report. Use the toolbar buttons to change the order of the
attributes in the report and to add functions.

Set Sort Order

Click to open the Set Column Sort Order dialog box
which enables you to set the order of the report columns.

Chart Properties

The Chart Properties portion of the pane includes the following elements

(listed alphabetically):

Ul Element (A-Z)

Description

#

Click Remove Chart to remove the chart from the report.
The report is generated in table format.

Breakdown by

The chart is broken down by the CI or grouping node
display label. This is fixed for all reports.

Chart Type

Select Pie to create a pie chart or Bar to create a bar chart.

Value

Select a value from the drop-down list.
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@ Perspective-based View Editor

This feature enables you to create and edit perspective-based views.

To access

In the Modeling Studio, click the New - button and
select Perspective Based View to create a new view or
drag CIs from the CI Selector onto the blank canvas and
select Create a new view.

To open an existing view in the Editor, select Views as the
resource type in the Resources pane, select the required
perspective-based view from the tree, and click Open
View LI or double-click the view.

Important
information

The Perspective-based View Editor contains the following
panes:

» Content pane. Drag Cls and/or models onto this pane
to include them in your view.

» Perspective pane. Select perspectives to apply to the
content to build a view.

» View Results pane. Displays a topology map with a
preview of the current view. This pane includes most
of the IT Universe Manager functionality.

Relevant tasks

» "Build a Perspective-based View Based on a Model" on
page 374

» "Build a Perspective-based View Based on a Collection
of CIs" on page 374

See also

"Best Practices for Modeling" on page 215

Content Pane

User interface elements are described below:

Ul Element (A-Z)

Description

=)

Go directly to IT Universe Manager for the current view.

i

Click Properties to open the Configuration Item
Properties dialog box for the selected CI.
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Ul Element (A-Z)

Description

&

Click Show models containing selected Cl to display a
list of the models containing the selected CI.

L&

Click Show views containing selected Cl/model to
display a list of the views containing the selected CI or
model.

Click Open selected model in a new tab to open the
selected model in a separate Model Editor tab.

hd

Click Generate view for selected model to create a view
based on the selected model. The Creating New View
dialog box opens which enables you to select a
perspective to apply.

Click to remove a selected CI from the view content.

Click View Definition Properties to open the View
Definition Properties dialog box which enables you to set
properties for the view.

Click Find to toggle between displaying and hiding the
Find box and arrow controls.

Cl Type column

Displays the type of each CI in the view.

Find Enter a CI name or a portion of a CI name in the Find
box to locate a ClI in the view
Find Next Click to go to the next occurrence of the selected search

phrase in the view.

Find Previous

Click to go to the previous occurrence of the selected
search phrase in the view.

Highlight

Click to highlight all occurrences of the search phrase in
the view.

Name column

Displays the name of each CI in the view.
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Shortcut Menu Options

Menu ltem

Description

Generate view for
selected model

Select to create a view based on the selected model. The
Creating New View dialog box opens which enables you
to select a perspective to apply.

Open selected model
in a new tab

Opens the selected model in a separate Model Editor tab.

Properties

Opens the Configuration Item Properties dialog box for
the selected CI.

Remove Base Cls

Deletes the selected CI or model from the view content.

Show Containing
Models

Click to display a list of the models containing the
selected CI.

Show Containing
Views

Click to display a list of the views containing the
selected CI or model.

Perspective Pane

User interface elements are described below:

Ul Element (A-Z)

Description

Delete the selected level of the perspective selection.

b4

e Shift the perspective selection from the current level to
the previous one.

I Shift the perspective selection from the current level to
the following one.

4 Add a new level to the perspective selection. The results

of the previous perspective level serve as the input
content for the new level.

Open a dialog box with the available perspectives. Move
the required perspectives from the available column to
the selected column using the arrow buttons.
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Ul Element (A-Z) Description
Apply Over Model For views based on models, select the Apply Over Model
Hierarchy Hierarchy check box to include the model hierarchy in

the view and apply the perspectives to the CIs included
in the model as well as to the model itself. Clear the
check box to exclude the model hierarchy from the view
and apply the perspectives to the model itself only. In
this case, the model is treated as an ordinary CI.

Note: This option is disabled for a view based on a
collection of CIs or on a model and a collection of ClIs.

Perspectives Lists the selected perspectives.

A default perspective appears in the window before any
selection is made. You can set the value of the default
perspective using the Selected perspectives for new
perspective based views infrastructure setting.

View Results Pane

User interface elements are described below (unlabeled elements are shown
in angle brackets):

Ul Element (A-Z) Description
Map Click to display the view results in Map mode.
Text Click to display the view results in Text mode.
ty Create a relationship between two ClIs in the view.
Toggle between hiding and displaying the topology map
legend.
P Move up one level in the topology map.

Move down one level in the topology map.

Delete the selected CI from the view.

x| &

Click Show CI Properties to open the Configuration Item
Properties dialog box for the selected CI.

i
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Ul Element (A-Z) Description
|§| Click Refresh to refresh the view results.
m Click Hide CI from View to hide the selected CI from the

view. This option is only relevant for CIs that were added
to the view via the perspective. You cannot hide CIs from
the original view content from the view.

Note: Hidden ClIs can be restored from the Hidden ClIs
dialog box.

= Click Show Hidden Cls to open the Hidden CIs dialog
box which enables you to restore CIs that were hidden
from the view manually.

rd Click Create view based on selected Cl/s to create a new

= view based on the CIs selected from the View Results
pane.

- Click Expand preview display to display the preview in a
separate pane.

<Breadcrumbs> At the top of the topology map, the breadcrumbs

indicate the relevant query nodes in each layer of the
view for the path to the selected layer. The first item in
the path is the Top Layer. When you select a CI from the
layer below, the parent CI forms the next item in the
breadcrumb path. You can click on any item in the path
to display that layer in the topology map.
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Ul Element (A-Z)

Description

<Legend>

Indicates the icons displayed next to CIs with any of the
following special statuses:

» Added. When Change Timeframe is active, indicates
that the CI was added.

» Candidate for Deletion. Indicates that the Cl is a
candidate for deletion.

» Changed. When Change Timeframe is active,
indicates that the CI was changed.

» Impacted. When Impact Analysis is active, indicates
an impacted CI.

» Impacted and Trigger. When Impact Analysis is active,
indicates a trigger CI that is impacted.

» Note. Indicates that a note was added for the CI.

» Trigger. When Impact Analysis is active, indicates a
trigger CI.

<Topology Map>

The topology map in the View Results pane follows the
layout of the topology map in IT Universe Manager. For
details, see "Topology Map" on page 279.

<Topology Map
Sidebar>

For details, see "Topology Map Sidebar" on page 210.

Shortcut Menu Options

Menu Item

Description

<IT Universe Shortcut
Menu options>

The IT Universe Manager shortcut menu options are
available. For details, see "IT Universe Manager Shortcut
Menu" on page 283.

Create view based on
selected Cl/s

Select Create view based on selected Cl/s to create a
new view based on the ClIs selected from the View
Results pane.
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Menu Item

Description

Hide CI from View

Click to hide the selected CI from the view. This option
is only relevant for CIs that were added to the view via
the perspective. You cannot hide CIs from the original
view content from the view. In the case of a view based
on a model, the model cannot be hidden but its CIs can.

Show Hidden Cls

Restore hidden ClIs to the view.

® Query Node Grouping Dialog Box

This dialog box enables you to define a new grouping of CIs or to edit an

existing grouping.

To access

Click the Add Group by [ button in the Hierarchy pane
of the Pattern View Editor and select Add Group by
Attribute or right click the required query node and
select Add Group by Attribute from the shortcut menu.

User interface elements are described below:

Ul Element (A-Z)

Description

Expression capture
group index

Enter the number of the relevant portion of the regular
expression. Enter 0 if the entire expression is relevant.

Group by

Select an attribute from the drop-down list.

Mask to group by

Enter a regular expression pattern representing the
structure of the selected attribute.

For details, see "Query Node Grouping" on page 341.
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@ Query/View Definition Properties Dialog Box

This dialog box enables you to configure the properties of a TQL query or

view.
To access In the Modeling Studio, click the Query/View Definition
Properties 5! button in the TQL Query Editor or Pattern
View Editor.
See also "Best Practices for Modeling" on page 215

User interface elements are described below:

Ul Element (A-Z)

Description

Base Query

Select an existing TQL query on which to base your new
query.

Note:

» This field is only relevant for TQL queries.

» This field is optional.

Bundles

A method of grouping TQL queries or views by category.
Select the bundles associated with the current query or
view or create a new bundle for it.

Note: This field is optional.

Description

A description of the TQL query or view.

Inter-Layer Links

Set the scope of inter-layer relationships displayed in the
topology results.

Note: This field is only relevant for views.

Persistent

Select to define the TQL query as persistent. A persistent
query remains in the memory permanently.

Note: This field is only relevant for TQL queries.
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Ul Element (A-Z) Description

Priority Select a priority level for the TQL query or view from the
drop-down list (Low, Medium, High, Express, Not
Active). This setting determines how often the query
should be rerun automatically by the system to include
updated information from the RTSM.

Note: When you change the priority of a view, the
priority of the TQL query on which the view is based is
also changed.

Scope Select the scope of the TQL query from the drop-down
list.

Note: This field is only relevant for Integration TQL
queries.

Type Select the type of the TQL query from the drop-down list.

Note: This field is only relevant for TQL queries.

® Reveal Cls Dialog Box

This dialog box enables you to search for CIs related to the Cls in a model
and add them to the model.

To access In the Model Editor of the Modeling Studio, select a CI,
click the Reveal (i button, and select Start Revealing or
right-click a CI in the model and select Reveal > Start
Revealing.
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Important The upper pane displays the CI types of the CIs related to
information the selected CI. The lower pane displays the ClIs of the
type selected in the upper pane.

The first step in the reveal path is the CI type of the CI
you began with. When you select a CI type from the list
in the upper pane, that CI type becomes the second step
in the path. Click Next to display the CI types available
for the next step of the path.

The number at the top of the box in parentheses
indicates the length of the constructed path thus far.

Relevant tasks "Build an Instance-based Model" on page 370

User interface elements are described below (unlabeled elements are shown
in angle brackets):

Ul Element (A-Z) Description

W% Click to delete a selected item from the CIs basket.

- Click to add a selected CI from the lower pane to the CIs
-J basket.

Click to go to the next occurrence of the selected search
phrase in the list of Cls.

Click to go to the previous occurrence of the selected
search phrase in the list of CIs.

<Lower pane> Displays a list of related ClIs of the type selected in the
upper pane.

Cl count Indicates how many related CIs of each type were found.

Cls Basket Displays the related CIs you selected to include in the
model.

Cl Type Displays a list of CI types of the ClIs related to the selected
CL
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Ul Element (A-Z) Description

Conditions A check mark indicates that conditions were defined for
the selected CI type. Click the Conditions column for the
CI type you want to select and click the Add Condition or
Edit Condition button to open the Conditions of Related
CIs dialog box. This enables you to define and edit
conditions for the CI type.

Find Enter a CI name or a portion of a CI name in the Find
box to locate a CI in the list of CIs.

Finish Click Finish when you have finished adding CIs to the CI
basket.
Next Click Next to display the CI types available for the next

step of the path.

Reveal path Displays the reveal path being constructed.

Clicking the blue arrows in the path = displays a drop-
down list of the CI types available for the next step of the
path.

Clicking the CI types in the path displays the following

options:

> Jump to page. Refreshes the table with the available CI
types for the selected step of the path.

» Edit Condition. Opens the Conditions of Related Cls
dialog box.

» Delete Selected Item(s). Deletes the selected CI type
from the reveal path (the path ends at the previous CI
type).

Save Path Opens the Save Reveal Path dialog box which enables
you to save the path. This option is only active when a
unique reveal path has been constructed.
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@ Save Query Dialog Box

This dialog box enables you to save a new TQL query.

To access In the Modeling Studio, click the Save [¥] button when
defining a new TQL query.
See also "Best Practices for Modeling" on page 215

User interface elements are described below (unlabeled elements are shown

in angle brackets):

Ul Element (A-Z)

Description

EE] Click New Folder to create a new folder in the resource
tree.
32 Click Delete to delete the selected resource from the

RTSM.

=]

Click Refresh to refresh the resource tree.

B Click Expand All to expand all the folders in the resource
tree.
B Click Collapse All to collapse all the folders in the
resource tree.
Click to go to the next occurrence of the selected search
) phrase in the tree.
& Click to go to the previous occurrence of the selected
search phrase in the tree.
= Click to highlight all occurrences of the search phrase in

the tree.

<Resource tree>

Select a folder in the tree in which to save the query.

Find

Enter a folder name or a portion of a name in the Find
box to locate a folder in the list.

Query Name

Enter the name of the new TQL query.
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@ Save View/Template/Perspective Dialog Box

This dialog box enables you to save a new pattern view, template-based
view, perspective-based view, template, or perspective.

To access In the Modeling Studio, click the Save [*] button when
defining a new pattern view, template-based view,
perspective-based view, template, or perspective.

See also "Best Practices for Modeling" on page 215

User interface elements are described below (unlabeled elements are shown
in angle brackets):

Ul Element (A-Z) Description

EE] Click New Folder to create a new folder in the resource
tree.

3% Click Delete to delete the selected resource from the
RTSM.

|§| Click Refresh to refresh the resource tree.

B Click Expand All to expand all the folders in the resource
tree.

B Click Collapse All to collapse all the folders in the

resource tree.

Click to go to the next occurrence of the selected search
phrase in the tree.

Click to go to the previous occurrence of the selected
search phrase in the tree.

= Click to highlight all occurrences of the search phrase in
the tree.
<Resource tree> Select a folder in the tree in which to save the view,

template, or perspective.

Find Enter a folder name or a portion of a name in the Find
box to locate a folder in the list.
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Ul Element (A-Z) Description

New query Select New query if the view is based on a new TQL
query.
Note: This field is not relevant for template-based views
and perspective-based views.

View Name Enter the name of the new view, template, or perspective.

@ Select Data Sources Dialog Box

This dialog box enables you to select the required data sources for a TQL

query node.

To access In the Modeling Studio, right-click a TQL query node and
select Set Data Sources.

Important You can select the data sources from which the TQL

information query generates the results for each query node. For
details on data sources, see "Integration Studio Overview"
in the RTSM Data Flow Management Guide.

See also "Best Practices for Modeling" on page 215

User interface elements are described below (unlabeled elements are shown

in angle brackets):

Ul Element (A-Z)

Description

<Data Source list>

A list of available data sources.

All Data Sources

Select to include CIs from all RTSM and external sources
for the selected query node in the TQL query results.

Local Data Source

Select to include ClIs from the RTSM only for the selected
query node in the TQL query results.

Select Data Sources

Select to include CIs from the selected sources only for
the selected query node in the TQL query results.
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@ Sort Column Content Dialog Box

This dialog box enables you to set the order of the column content in a

report.
To access In the Modeling Studio, click Set Sort Order in the Query
Node Definition pane of the Pattern View Editor (in
Report mode).
Important The report is sorted by columns following the order of
information the attributes in the Sorted Columns pane. Each selected

column is sorted in ascending or descending order
according to your selection.

Relevant tasks

"Define Report Settings" on page 369

See also

"Best Practices for Modeling" on page 215

User interface elements are described below:

Ul Element (A-Z) Description
> Click Move to Sorted Columns to move the selected
attribute to the Sorted Columns pane.
& Click Move to Available Columns to move the selected
attribute to the Available Columns pane.
= Click to move all the attributes to the Sorted Columns
pane.
= Click to move all the attributes to the Available Columns
pane.
Y Click to move the selected attribute down in the Sorted
Columns list.
1 Click to move the selected attribute up in the Sorted
Columns list.
= ick Sort Ascending to sort the selected column in
=t Click Sort A ding he selected col i
- ascending order.
= Click Sort Descending to sort the selected column in
descending order.
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Ul Element (A-Z)

Description

Available Columns

The attributes selected to appear as columns in the
report.

Sorted Columns

The columns selected to be sorted.

@ Template-based View Wizard

This wizard enables you to define template-based views manually or by
importing parameter data from a CSV file.

To access Click the New - button and select Template Based
View.

Important The wizard enables you to create multiple template-based

information views based on the same template. When creating

multiple views, the wizard includes the Save Views page
as the final page. When creating a single template-based
view, the wizard finishes with the Parameters page and
opens the new view in the Editor. You can save the new
view from within the Editor.

Relevant tasks

» "Create a Template Based View" on page 365
» "Create Multiple Template Based Views" on page 367

Wizard map The Template-based View Wizard contains:
Select Template Page > Import Parameter Values Page >
Parameters Page > Select Location for Views Page >
Summary Page > Save Views Page

See also "Creating Template Based Views" on page 345

434




Chapter 10 * Modeling Studio

. select Template Page

This wizard page enables you to select a template on which to base your

view.
Important If you don’t want to use any of the templates in the tree,
information you can create a new template first and then build a view
based on it. For details on creating a template, see "Create
a Template" on page 360.
Wizard map The Template-based View Wizard contains:

Select Template Page > Import Parameter Values Page >
Parameters Page > Select Location for Views Page >
Summary Page > Save Views Page

User interface elements are described below (unlabeled elements are shown

in angle brackets):

Ul Element (A-Z)

Description

=]

Click Refresh to refresh the template tree.

e

Click Expand All to expand all the folders in the template
tree.

Bl

Click Collapse All to collapse all the folders in the
template tree.

Click to go to the next occurrence of the selected search
phrase in the tree.

Click to go to the previous occurrence of the selected
search phrase in the tree.

Click to highlight all occurrences of the search phrase in
the tree.

<Template tree>

Displays the existing templates in tree format.

Find

Enter a template name or a portion of a name in the Find
box to locate a template in the list.
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® Import Parameter Values Page

This wizard page enables you to import parameter values from a CSV file.

Important If you are creating a large number of views based on the
information same template, you can save the parameter values in a
CSV file and import them directly into the wizard.

Wizard map The Template-based View Wizard contains:

Select Template Page > Import Parameter Values Page >
Parameters Page > Select Location for Views Page >
Summary Page > Save Views Page

User interface elements are described below (unlabeled elements are shown
in angle brackets):

Ul Element (A-Z) Description

Add parameter Select this option to enter the parameter values manually,
values manually whether for a single view or for multiple views.

Import parameter Select this option to import the parameter values from a

values from a CSV file | CSV file. Click the ellipsis ... button to browse your files
for the required file.

Use Advanced Select the Use Advanced Naming option to automatically
Naming name the created views based on parameter values. In the
box, enter an expression containing at least one
parameter name in angle brackets. The views are named
based on the values of the selected parameter.
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¥ parameters Page

This wizard page enables you to set the values of the template’s parameters
for each new view created.

Important If you are creating multiple views, click Next after you set
information the parameter values to proceed to the Save Views page.

If you are creating a single view, click Finish after you set
the parameter values to open the new view in the Editor.

Wizard map The Template-based View Wizard contains:

Select Template Page > Import Parameter Values Page >
Parameters Page > Select Location for Views Page >
Summary Page > Save Views Page

User interface elements are described below (unlabeled elements are shown
in angle brackets):

Ul Element (A-Z) Description
4 Click to add a new view instance.
W% Click to delete the selected view instance.
<Parameter In each parameter column, enter or select the required
columns> parameter value for each view.
Reset Click to reset the selected parameter to its original value.
Use Advanced Select the Use Advanced Naming option to automatically
Naming name the created views based on parameter values. In the
box, enter an expression containing at least one
parameter name in angle brackets. The views are named
based on the values of the selected parameter.
Note: All view names must be unique.
View Name Enter names for each of the new views, or use the default
names assigned.
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®, Select Location for Views Page

This wizard page enables you to select the location in which to save the
created views.

Important All created views must be saved in the same location
information
Wizard map The Template-based View Wizard contains:

Select Template Page > Import Parameter Values Page >
Parameters Page > Select Location for Views Page >
Summary Page > Save Views Page

User interface elements are described below (unlabeled elements are shown
in angle brackets):

Ul Element (A-Z) Description

Eal Click New Folder to create a new folder in the view tree.

|§| Click Refresh to refresh the view tree.

B Click Expand All to expand all the folders in the view tree.

B Click Collapse All to collapse all the folders in the view
tree.

Click to go to the next occurrence of the selected search
phrase in the tree.

Click to go to the previous occurrence of the selected
search phrase in the tree.

= Click to highlight all occurrences of the search phrase in
the tree.

<View tree> Select a folder (or the root) from the view tree.

Find Enter a template name or a portion of a name in the Find

box to locate a template in the tree.
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® Summary Page

This wizard page displays the details of the created views before saving.

Wizard map

The Template-based View Wizard contains:

Select Template Page > Import Parameter Values Page >
Parameters Page > Select Location for Views Page >
Summary Page > Save Views Page

User interface elements are described below (unlabeled elements are shown

in angle brackets):

Ul Element (A-Z)

Description

Save view summary

A summary of the views created including the name of
the base template, the number of views created, and the
location selected for saving the views.

¥ save Views Page

This wizard page enables you to save the new views you created.

Important This wizard page is only relevant when you are creating
information multiple template-based views.
Wizard map The Template-based View Wizard contains:

Select Template Page > Import Parameter Values Page >
Parameters Page > Select Location for Views Page >
Summary Page > Save Views Page

User interface elements are described below (unlabeled elements are shown

in angle brackets):

Ul Element (A-Z)

Description

Save Results

A table displays the names of the new views and a
message indicating whether each view was saved
successfully or not.
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@ Template Parameter Values Dialog Box

This dialog box enables you to edit the parameters of a template-based view.

To access From within a template-based view in the Modeling
Studio, right-click a query node with parameters defined
and select Show Node Parameters, or click the Show
Parameters < button in the toolbar.

Important When you open the dialog box from the shortcut menu
information by right-clicking a query node with parameters defined,
the dialog box only displays the parameters for the
selected query node. When you open the dialog box
from the toolbar, it displays all the parameters defined
for any of the query nodes in the view.

See also "Best Practices for Modeling" on page 215

User interface elements are described below:

Ul Element (A-Z) Description

<Parameters> Edit the values of the parameters.

@ TQL Query Editor

This feature enables you to build and edit TQL queries.

To access To open a new TQL query in the TQL Query Editor, go to
the Modeling Studio, click the New - button and select
Query.

To open an existing TQL query in the TQL Query Editor,
go to the Resources tab of the left pane in the Modeling
Studio and select Queries as the Resource type. Right click
a TQL query in the tree and select Open Query or double
click a TQL query or drag a TQL query onto the empty
canvas. The TQL query opens in a new tab.

Important To save your TQL query, use the Save button in the
information Modeling Studio main toolbar.
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Relevant tasks

"Define a TQL Query" on page 30

See also

"Best Practices for Modeling" on page 215

User interface elements are described below (unlabeled elements are shown

in angle brackets):

Ul Element (A-Z)

Description

Click Show View Results in IT Universe to go directly to

9 the selected view in IT Universe Manager.
Note: This button only appears for views, templates, or
perspectives.

n Click Create Relationship to draw a relationship from
one query node to another.

Click Hide/Show Legend to toggle between hiding and
displaying the topology map legend.

B Click Calculate Query Result Count to calculate the

number of instances found for each TQL query node or
relationship.

a

Click Preview to display a preview of the TQL query
results as they would appear in IT Universe Manager.

Click Delete to delete the selected query node or
relationship from the query.

S

For queries, opens the Query Definition Properties dialog
box which enables you to edit the type, scope, and
priority of the TQL query.

For views, opens the View Definition Properties dialog
box.

L3

Opens the Template Parameter Values dialog box which
enables you to edit the parameters of a query node in a
template-based view.

Note: This button only appears for template-based views.
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442

Ul Element (A-Z) Description

<Legend> Indicates the icons displayed next to CIs with any of the
following special designations:
» It is defined as a contact query node in a perspective

» It is defined as the output query node of a pattern-
based model

» It has attributes defined

» It has selected identities defined
» It is set as an invisible element
» It has a subgraph defined

<Main menu> For details, see "Main Menu" on page 197.

<Shortcut menu For details, see "Shortcut Menu Options" on page 40.
options>

<Topology Map For details, see "Topology Map Sidebar" on page 210.
Sidebar>

Advanced Pane

This area displays the properties, conditions, and cardinality for the selected
query node and relationship.

Important The Advanced pane appears in the lower part of the
information window in the following managers and user interfaces:
Modeling Studio, Impact Analysis Manager, Enrichment
Manager, the Input Query Editor and Trigger Query
Editor in DFM.

A small green indicator * appears next to the tabs that
contain data.

Relevant tasks "Define an Impact Rule — Workflow" on page 452
"Define an Enrichment Rule — Scenario" on page 523
"Define a TQL Query" on page 30

"Create a Pattern View" on page 359

"Create a Template" on page 360

YYVYVYYVYY

"Create a Perspective" on page 362
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User interface elements are described below:

Ul Elements (A-Z)

Description

4k

If the window is not wide enough to display all the tabs, use
the left and right arrows to move to the required tab.

Click Show List to display a list of the available tabs for the
current module. You can select a tab from the list.

Attributes

Displays the attribute conditions defined for the query node
or the relationship. For details, see "Attribute Tab" on
page 87.

Cardinality

Cardinality defines how many query nodes you expect to
have at the other end of a relationship. For example, in a
relationship between a node and an IP Address, if the
cardinality is 1:3, the TQL query retrieves only those nodes
that are connected to between one and three IP Addresses.
For details, see "Cardinality Tab" on page 89.

Data Sources

Displays the data sources set for the selected query node.

Note: This tab appears only in the Modeling Studio.

Details

Displays the following information:

» Cl Type. The CIT of the selected query node/relationship.

» Visible. A green check indicates that the selected query
node/relationship is visible in the topology map. A red
mark indicates that it is not visible.

» Include subtypes. A green check indicates that both the
selected CI and its children are displayed in the topology
map. A red mark indicates that only the selected CI
appears.

Edit

Click Edit to open the relevant dialog box for the selected
tab.
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Ul Elements (A-Z)

Description

Enrichment Rules

Displays the Enrichment rule defined for the selected query
node or relationship. If the Enrichment rule is used to
update the attributes of a CI, click Edit to open the Query
Node/Relationship Definition dialog box and edit the rule if
required. For details, see "Query Node/Relationship
Definition Dialog Box" on page 544.

Note: This tab appears only in Enrichment Manager.

Impacted Query
Nodes

Indicates which query node is affected by the changes that
occur in the selected trigger query node. If required, you can
click Edit to open and modify the Affected Query Nodes
dialog box. For details, see "Impacted Query Nodes Dialog
Box" on page 466.

Note: This tab appears only in Impact Analysis Manager.

Qualifiers

Displays the qualifier conditions defined for the query node
or the relationship. For details, see "Qualifier Tab" on
page 92.

Selected Identities

Displays the element instances that are used to define what
should be included in the TQL query results. For details, see
"Identity Tab" on page 95.

@ Views Containing Selected ClI Dialog Box

444

This dialog box enables you to display a list of the views containing the

selected CI.

To access Click the Show views containing selected Cl/model [
button in the Model Editor or select Show containing
views from the shortcut menu.

See also "Best Practices for Modeling" on page 215
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User interface elements are described below:

Ul Element (A-Z)

Description

Click Show View Results in IT Universe to go directly to

3
the selected view in IT Universe Manager.

W% Click Delete Selected Item(s) to delete the selected view.

t Click Disconnect view from perspective to disconnect

: the selected view from its perspective. The view becomes
a pattern view.

Find Enter a view name or a portion of a view name in the
Find box to locate it in the list.

Find Next Click to go to the next occurrence of the selected search

phrase in the list.

Find Previous

Click to go to the previous occurrence of the selected
search phrase in the list.

Highlight Click to highlight all occurrences of the search phrase in
the list.
View Name Displays the list of views dependent on the selected

template or perspective.

Note: The name of the current view appears in faded
text.
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% Watchpoints Updates Dialog Box

This dialog box displays the changes found in related Cls by a watchpoint

defined for a model.

To access From within a model in the Model Editor, click the
Watchpoint @ button and select Watchpoints Updates
or right-click a CI in the model and select Watchpoint >
Watchpoints Updates.

Important The Watchpoints Updates dialog box indicates any

information changes found involving the CIs related to the model via

the associated reveal path. If a new related CI is found
which is not included in the model, the suggested update
is an added CI. If a CI in the model is found to no longer
be related via the path, the suggested update is a removed
CL

This option is only enabled when watchpoints are
defined for the model and CIs have been found.

User interface elements are described below:

Ul Element (A-Z) Description

Accept Select the check boxes for the CIs you want to add to
your model or remove from your model.

Accept All Click Accept All to apply all the suggested changes to
your model.

Cl The names of the CIs found by the watchpoint.

Cl Type The types of the CIs found by the watchpoint.

Clear All Click Clear All to clear the check boxes for all the found
Cls.

Restore Select the check boxes for the CIs in the Suppressed Cls
pane that you want to consider for inclusion in your
model.

Show/Hide Toggle between hiding and displaying the Suppressed CIs

Suppressions pane of the dialog box.
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Ul Element (A-Z)

Description

Suggested Update

Indicates whether the suggested change is an added CI or
a removed CIL.

Suppress Select the check boxes for the CIs you want to exclude
from your model or leave in your model.
Suppress All Click Suppress All to decline all the suggested changes to

your model.

% <Query/Template/Perspective Name> Dependencies

Dialog Box

This dialog box enables you to clarify the status of dependent views when
saving changes to a query, template, or perspective.

To access In the Modeling Studio, make a change to a query,
template, or perspective with dependent views. When
you click Save, the dialog box opens.

Important Any change made to a resource affects the views based on

information that resource. Before the changes are saved, you need to

specify the desired result on the dependent views. For
each dependent view, select one of the available options:
Delete, Re-Apply, or Detach.

User interface elements are described below:

Ul Element (A-Z)

Description

Delete

Select this option to delete the selected dependent view.

Detach

Select this option to detach the selected dependent view
from the template or perspective. The view becomes a
pattern view.

Note: This option is not relevant for queries.
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Ul Element (A-Z)

Description

Re-Apply Select this option to apply the revised query, template, or
perspective to the selected dependent view. The view
type remains the same as it was previously (pattern view,
template-based view, or perspective-based view).

Resource The dependent views are displayed in a tree format.
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Impact Analysis Manager

This chapter includes:

Concepts

» Impact Analysis Manager Overview on page 450
Tasks

» Define an Impact Rule - Workflow on page 452
Reference

» Impact Analysis Manager User Interface on page 456
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Concepts

& Impact Analysis Manager Overview

450

Impact Analysis Manager enables you to define the interdependencies
between components in your IT infrastructure to simulate how
infrastructure changes (for example, a new software installation or upgrade)
can impact your system.

By creating Impact rules based on TQL queries, you can determine the true
origin of a problem and its business impact. Each Impact rule you define is
attached to a specific Impact Analysis TQL query. For more information
about TQL queries, see "Topology Query Language" on page 21.

You define Impact rules to specify a causal relationship between two or more
Impact Analysis query nodes. Define one query node as the trigger, or the
query node that represents the changes you want to make to the system,
and another query node as the one that is impacted. After the causal
relationship is established, Impact Analysis Manager enables you to
determine the effect of the changes occurring in root cause query nodes.

You then run the Impact rules in IT Universe Manager to simulate how the
changes impact your system and discover the root causes of the changes (for
details, see "Run Impact Analysis Dialog Box" on page 294). This enables you
to evaluate and handle accordingly, the possible implications of any action,
update, new deployment, or a failure of the service delivery.

A simulated change in an impacted CI can alter the CI’s map status, which is
manifested through an addition of a status icon to the CI’s symbol. The
Topology Map displays the statuses of the trigger Cls as well as all statuses of
the ClIs that are impacted by it. Each color represents a different status.

For details about the status icons and the colors that represent them, see
"Show Impact Pane" on page 300.
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You can then generate a report displaying the following:

» ClIs in the system that are impacted by the changes.

» Trigger CIs (the ClIs that represent the changes you want to make to the
system).

» ClIs that belong to a specific business service.
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Tasks

P Define an Impact Rule - Workflow

452

This section describes how to define an Impact rule whereby a change in
CPU operation impacts the node to which it is connected.

This task includes the following steps:

> "Create an Impact Analysis TQL Query" on page 452

» "Define an Impact Rule" on page 453

1 Create an Impact Analysis TQL Query

To create an Impact Analysis TQL query, you need to create an Impact
Analysis TQL and then add the TQL query nodes and relationships that
define the query.

Select Admin > RTSM Administration > Modeling > Impact Analysis
Manager to open the Impact Analysis Manager. For details about how to
create an Impact Analysis TQL query, see "New Impact Rule/Impact Rule
Properties/Save As Impact Rule Wizard" on page 469. For details about
how to add query nodes and relationships to a query, see "Add Query
Nodes and Relationships to a TQL Query" on page 32.
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Example of an Impact Analysis TQL Query:

In this Impact Analysis TQL query, a CPU and a node are linked by a
Composition relationship. The TQL query results must comply with the
direction of the arrows.

nibie

|

| Composition
o

Cpu

Note: An Impact Analysis TQL query is subject to certain validation
restrictions. For details, see "Troubleshooting and Limitations" on
page 103.

Define an Impact Rule

When you define an Impact rule, you must specify the required causal
relationship between the query nodes. Define one query node as the
trigger, or the query node that represents the changes you want to make
to the system, and another query node as the one that is impacted.

Right-click the query node you want to define as the trigger query node
and select Define Impacted to open the Impacted Query Nodes dialog
box. Select the query node you want the trigger query node to impact.
Then click the Add button to open the Impact Rules Definition dialog box
to set conditions for defining impacted query nodes. For details about
how to define an Impact rule, see "Impact Rules Definition Dialog Box" on
page 467.
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Note: The change state option in the Impact rule definition is no longer
relevant for Impact Analysis. The only supported state is operation.

Example of an Impact Rule:

The Conditions area in the Impact Rules Definition dialog box defines the
conditions under which the simulated change in the system is triggered.
The Severity area defines the severity of the impact on the impacted query
node.

The Impact rule in this example states that when the CPU operation is
not in the normal state, the node is impacted. Since the severity is set to
100% of the trigger’s severity, the severity of the node is the same as the
severity of the CPU, which is determined when Impact Analysis is run.

Dezcription: | |

Il ~Conditicns

State: | operation |v |

Operator: | Mot equal |" |

Walue comparison: | Maormal |' |

Scope

() Fixed severity:
(®) severity relative to trigger severity (%):
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In the resulting TQL query, an upward arrow appears next to the query
node defined as the trigger query node and a downward arrow appears
next to the query node defined as the impacted query node.

Composition

Q*

cpu

Note: To retrieve the Impact Analysis results, you must run the Impact
rule in IT Universe Manager. For details, see "Retrieve Impact Analysis
Results — Scenario" on page 250.
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Reference

@ Impact Analysis Manager User Interface

456

This section includes (in alphabetical order):

» Details Dialog Box on page 457

» Impact Analysis Manager Page on page 458

» Impacted Query Nodes Dialog Box on page 466
» Impact Rules Definition Dialog Box on page 467

» New Impact Rule/Impact Rule Properties/Save As Impact Rule Wizard
on page 469
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@ Details Dialog Box

This dialog box displays the new Impact rule you created in the Impact
Rules Definition dialog box.

To access In the Impact Analysis Manager, click Next in the
Impacted Query Nodes dialog box.

Relevant tasks "Define an Impact Rule — Workflow" on page 452

User interface elements are described below:

Ul Element (A-Z) Description

Description The description of the new Impact rule.

State The category you chose from the State list in the Impact
Rules Definition dialog box.
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@ Impact Analysis Manager Page

This page enables you to define Impact rules.

To access Select Admin > RTSM Administration > Modeling >
Impact Analysis Manager.

Important When selecting query nodes to function as Impact

information Analysis triggers, they must comply with certain

restrictions. For details, see "Troubleshooting and
Limitations" on page 103.

Relevant tasks "Define an Impact Rule — Workflow" on page 452

See also "Impact Analysis Manager Overview" on page 450

Impact Rules Pane

This area displays a hierarchical tree structure of predefined folders and
Impact rules. Each Impact rule is associated with a TQL query.

Important
information

You can create your own Impact rules, or work with the
default rules provided with your HP Business Service
Management installation.

The predefined folders are provided for the default
Impact rules; you can modify these folders, or add
additional folders according to your organization'’s
requirements.

You can drag and drop Impact rules or folders to move
them from one folder to another.

User interface elements are described below:

Ul Element (A-Z)

Description

Eel

Create a new folder.

Creates an Impact rule. Opens the New Impact Rule
Wizard.

Deletes the selected folder or Impact rule.
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Ul Element (A-Z) Description

|§| Refreshes the data content of the hierarchical tree
N structure that may have been modified by other users.

=) (Enabled only when a new Impact rule is created or when
changes are made to an existing one.) Saves the Impact
rule to the RTSM.

Opens the Impact Rule Properties Wizard. Enables you to
change the description of the rule.

B

Generates a preview of the results of the selected Impact

2l

rule.
ES Represents a folder.
2 Represents an Impact rule.
<Ilmpact Rules tree> Displays the existing Impact rules in tree format.

Note: Only Impact Analysis rules appear in the tree. TQL
queries of type Impact Analysis (created in the Modeling
Studio) do not appear.

The following elements are available by right-clicking a folder or Impact
rule:

Ul Element (A-Z) Description
Delete Delete the selected folder or Impact rule.
Export To XML Displays a standard Save As dialog box, enabling you to

save the Impact rule as an XML script. This option can be
used to move an Impact rule from one workstation to
another, provided the related TQL query is also relocated.

Import From XML Imports XML files that contain saved Impact rules to
Impact Analysis Manager.

New Creates an Impact rule. Opens the New Impact Rule
Wizard.
New Folder Creates a new folder.
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Ul Element (A-Z)

Description

Preview Generates a preview of the results of the selected Impact
rule.
Properties Opens the Impact Rule Properties Wizard. Enables you to

change the description of the rule.

Rename Folder

Rename the folder.

Save (Enabled only when a new Impact rule is created or when
changes are made to an existing one.) Saves the Impact
rule to the RTSM.

Save As Displays the Save As Impact Rule Wizard, enabling you to

create new Impact rules based on an existing query.

Editing Pane

This area displays the selected Impact rule, which consists of query nodes
that are defined in the TQL query and the relationships between them.

Important
information

» When you select a folder in the Impact Rules pane, the
editing pane is empty.

» When you select an Impact rule in the Impact Rules
pane, the editing pane displays the selected rule, which
consists of TQL query nodes that are defined in the
TQL query and the relationships between them.

Relevant tasks

"Add Query Nodes and Relationships to a TQL Query" on
page 32

See also

When selecting query nodes to function as Impact
Analysis triggers, they must comply with certain
restrictions. For details, see "Troubleshooting and
Limitations" on page 103.
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User interface elements are described below (unlabeled elements are shown

in angle brackets):

Ul Element (A-Z)

Description

Indicates a trigger query node. Located to the right of the
trigger query node's icon.

Indicates an impacted query node. Located to the right of
the impacted query node’s icon.

Indicates query nodes that are both impacted and trigger
query nodes.

<Main Menu>

For details, see "Main Menu" on page 197.

<Query Node>

A component from which TQL queries are built.

<Relationship>

The entity that defines the relationship between two
query nodes.

<Shortcut menu

For details, see "Shortcut Menu Options" on page 40.

options>
<Toolbar> For details, see "Toolbar Options" on page 201.
<Tooltip> Hold the cursor over a query node or relationship to view

its tooltip.
The tooltips contain the following information:

» Element name. The name of the query node.

» Cl Type. The CIT of the query node as defined in the CI
Type Manager. For details, see "CI Type Manager" on
page 475.

» Definitions of the selected query nodes and
relationships. The attribute conditions, as described in
"Query Node/Relationship Properties Dialog Box" on
page 85.

» Names of the trigger and the impacted query nodes.
This is only relevant if the query node over which the
cursor is hovering is the trigger query node.
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Cl Type Selector

This area displays a hierarchical tree structure of the CI Types found in the
ODB.

Important The CI Type Selector is part of Enrichment Manager,
information Impact Analysis Manager, and Trigger TQL Editor.

To create or modify a TQL query, click and drag query
nodes to the Editing pane and define the relationship
between them. Your changes are saved to the ODB. For
details, see "Add Query Nodes and Relationships to a TQL
Query" on page 32.

Note: The number of instances of each CIT in the ODB is
displayed to the right of each CIT.

Relevant tasks » "Define an Impact Rule — Workflow" on page 452

» "Define an Enrichment Rule — Scenario" on page 523
» "Define a TQL Query" on page 30

» "Create a Pattern View" on page 359

User interface elements are described below (unlabeled elements are shown
in angle brackets):

Ul Elements (A-Z) Description
& Click Add CI Type to Map to move the selected CI type
to the Editing pane.
|§| Click Refresh to refresh the CI type tree.
Q Click Search to search for the CI type entered.
B Click Expand All to expand all subtrees within the CI
type tree.
B Click Collapse All to collapse the subtrees within the CI
type tree.
<Search window> Enter the name or part of a name of a CI type for which
to search.
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Shortcut Menu Options

The CI Type Selector includes the following elements (listed alphabetically)
available by right-clicking a CI Type:

Menu Item

Description

Add Cl Type to Map

Select to add the selected CI type to the Editing pane.

Go to Cl Type
Definition

Takes you directly to the selected CI type in CIT Manager.

Show CIT Instances

Opens the CIT Instances window, which displays all
instances of the selected CIT. For details, see "Element
Instances Dialog Box" on page 77.

Advanced Pane

This area displays the properties, conditions, and cardinality for the selected
query node and relationship.

Important
information

The Advanced pane appears in the lower part of the
window in the following managers and user interfaces:
Modeling Studio, Impact Analysis Manager, Enrichment
Manager, the Input Query Editor and Trigger Query
Editor in DFM.

A small green indicator * appears next to the tabs that
contain data.

Relevant tasks

YYVYVYYVYY

"Define an Impact Rule — Workflow" on page 452
"Define an Enrichment Rule — Scenario" on page 523
"Define a TQL Query" on page 30

"Create a Pattern View" on page 359

"Create a Template" on page 360

"Create a Perspective" on page 362
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User interface elements are described below:

Ul Elements (A-Z) Description

711 If the window is not wide enough to display all the tabs, use

the left and right arrows to move to the required tab.
- Click Show List to display a list of the available tabs for the

current module. You can select a tab from the list.

Attributes Displays the attribute conditions defined for the query node
or the relationship. For details, see "Attribute Tab" on
page 87.

Cardinality Cardinality defines how many query nodes you expect to

have at the other end of a relationship. For example, in a
relationship between a node and an IP Address, if the
cardinality is 1:3, the TQL query retrieves only those nodes
that are connected to between one and three IP Addresses.
For details, see "Cardinality Tab" on page 89.

Data Sources Displays the data sources set for the selected query node.

Note: This tab appears only in the Modeling Studio.

Details Displays the following information:

» Cl Type. The CIT of the selected query node/relationship.

» Visible. A green check indicates that the selected query
node/relationship is visible in the topology map. A red
mark indicates that it is not visible.

» Include subtypes. A green check indicates that both the
selected CI and its children are displayed in the topology
map. A red mark indicates that only the selected CI
appears.

Edit Click Edit to open the relevant dialog box for the selected
tab.
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Ul Elements (A-Z)

Description

Enrichment Rules

Displays the Enrichment rule defined for the selected query
node or relationship. If the Enrichment rule is used to
update the attributes of a CI, click Edit to open the Query
Node/Relationship Definition dialog box and edit the rule if
required. For details, see "Query Node/Relationship
Definition Dialog Box" on page 544.

Note: This tab appears only in Enrichment Manager.

Impacted Query
Nodes

Indicates which query node is affected by the changes that
occur in the selected trigger query node. If required, you can
click Edit to open and modify the Affected Query Nodes
dialog box. For details, see "Impacted Query Nodes Dialog
Box" on page 466.

Note: This tab appears only in Impact Analysis Manager.

Qualifiers

Displays the qualifier conditions defined for the query node
or the relationship. For details, see "Qualifier Tab" on
page 92.

Selected Identities

Displays the element instances that are used to define what
should be included in the TQL query results. For details, see
"Identity Tab" on page 95.
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@ Impacted Query Nodes Dialog Box

This dialog box enables you to define which query node in the TQL query is
the trigger Impact Analysis query node and which query nodes are impacted
by the changes that occurred in the system.

To access Right-click the query node or relationship that functions
as a trigger and select Define Impacted. The Impacted
Query Nodes dialog box opens to display the query nodes

in the TQL query.
Important Before creating the TQL query, you must know which
information query node in the query is the trigger Impact Analysis

query node and which are impacted by the changes
beforehand. The definition is performed here.

Relevant tasks "Define an Impact Rule — Workflow" on page 452.

User interface elements are described below:

Ul Element (A-Z) Description

Impacted Query Contains a list of the Impact Analysis query nodes in the

Nodes pane Impact rule. Select the query nodes to be impacted by the
trigger query node.
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@ Impact Rules Definition Dialog Box

This dialog box enables you to set conditions for defining impacted query
nodes, define the scope of the trigger conditions, and define the severity of

the impact.
To access In the Impact Analysis Manager, click Add in the Details
dialog box.
Important » In the Conditions area, set conditions for defining
information impacted query nodes. When this condition is met,

the simulated change in the system is triggered.

For example, you can define an Impact Analysis
condition that states that the operational state of the
query node is other than Normal. When the
operational state of the query node instance changes
and is no longer Normal, the condition is met and the
simulated changes in the system are triggered.

» In the Scope area, define how many instances of the
trigger query node should fulfill the conditions for
triggering the changes in the system.

You can apply the trigger conditions to a single
instance of a trigger query node, to a certain
percentage of the trigger instances, or to all of them.

For example, you can define that impact is calculated
when at least 10% of the system’s nodes are down.

» In the Severity area, define the severity of the Impact
Analysis impact.

Relevant tasks

"Define an Impact Rule — Workflow" on page 452

User interface elements are described below:

Ul Element (A-Z)

Description

All All instances should fulfill the conditions.
Any One instance or more should fulfill the conditions.
Description A description of the Impact rule you are defining.
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Ul Element (A-Z)

Description

Fixed severity

Define a fixed severity level for every system change
generated. Then, select the required severity level from
the list.

Function

Select Function (displayed when you selected the All and
Range options in the Scope area) to define a severity level
for the system changes, as a function of the severity levels
of all the trigger query node instances that are included

in the range. From the list, select either Average or Max.

For example, if you select Average, the severity level of
the system changes is the average severity of all the
trigger instances.

Operator

Select the required operator. For a list of the operators you
can use for defining an attribute condition, see "Attribute
Operator Definitions" on page 45.

Range

A certain percentage of all instances should fulfill the
conditions. For example, if you enter a range of 50% to
100%, the changes are triggered when 50% or more of
the instances meet the conditions.

Severity relative to
trigger severity (%)

Select Severity relative to trigger severity (%) (displayed
when you selected the Any option in the Scope area) to
define a severity level for each system change that is
relative (as a percentage) to the severity of the trigger
event.

Enter the percentage in the box provided.

State

Choose the required state. The states that appear in the
list are the states that are defined in the State Manager.
For details, see "State Manager" in the RTSM
Administration Guide.

Value comparison

Select the required attribute.
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@ New Impact Rule/Impact Rule Properties/Save As Impact
Rule Wizard

This wizard enables you to create or modify an Impact rule.

To access » To create an Impact rule, right-click anywhere in the
Impact Rules pane and click New or click the New
button.

» To modify an Impact rule, right-click an Impact rule in
the Impact Rules pane and select Properties.

» To create a new Impact rule based on an existing
query, right-click an Impact rule in the Impact Rules
pane and select Save As.

Important » Any major change made to the TQL query after
information creating an Impact rule causes the system to delete the
rule. These changes include deleting a root cause or
impacted query node or changing the Min and Max
relationship definitions. For details, see "Cardinality

Tab" on page 89.
» Minor changes, such as adding a query node to the
TQL query, do not cause the deletion of the rule.

» The Impact Analysis TQL query that serves as the basis
of the Impact rule, is subject to certain validation
restrictions. For details, see "Troubleshooting and
Limitations" on page 103. If the TQL query is not
valid, it cannot be used for the creation of an Impact

rule.
Relevant tasks "Define an Impact Rule — Workflow" on page 452
Wizard map The New Impact Rule/Impact Rule Properties/Save As

Impact Rule Wizard contains:

Impact Rule General Attributes Page > Impact Rule Base
Query Page > Impact Rule Groups Page
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® Impact Rule General Attributes Page

This wizard page enables you to enter a unique name and description for the
Impact rule.

Important » The Impact Analysis TQL query that serves as the basis
information of the Impact rule, is subject to certain validation
restrictions. For details, see "Troubleshooting and
Limitations" on page 103. If the TQL query is not
valid, it cannot be used for the creation of an Impact
rule.

» For important information on the effects of making
changes to the TQL query after creating it, see "New
Impact Rule/Impact Rule Properties/Save As Impact
Rule Wizard" on page 469.

» By default, this wizard is set to display a Welcome
page. You can choose not to display the Welcome page
by changing the user preferences. For details, see "User
Preferences Dialog Box" on page 102.

Wizard map The New Impact Rule/Impact Rule Properties/Save As
Impact Rule Wizard contains:

Impact Rule General Attributes Page > Impact Rule
Base Query Page > Impact Rule Groups Page

See also "IT Universe Manager" on page 227

User interface elements are described below:

Ul Element (A-Z) Description
Rule Description (Optional) Enter a description of the Impact rule.
Rule Name Enter a unique name for the Impact rule.

The rule name cannot contain any of the following
characters:\/:"<>|%?

Note: If the Impact rule name is either empty, contains a
name used by another Impact rule, or uses invalid
characters, the Next and Finish buttons are disabled.
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® Impact Rule Base Query Page

This wizard page enables you to define the properties of the TQL query on
which the Impact rule is based. You can use an existing query or create a

new query.

Important
information

» The Impact Analysis TQL query that serves as the basis
of the Impact rule is subject to certain validation
restrictions. For details, see "Troubleshooting and
Limitations" on page 103. If the TQL query is not
valid, it cannot be used for the creation of an Impact
rule.

» For important information on the effects of making
changes to the TQL query after creating it, see "New
Impact Rule/Impact Rule Properties/Save As Impact
Rule Wizard" on page 469.

Wizard map

The New Impact Rule/Impact Rule Properties/Save As
Impact Rule Wizard contains:

Impact Rule General Attributes Page > Impact Rule Base
Query Page > Impact Rule Groups Page

See also

"IT Universe Manager" on page 227

User interface elements are described below:

Ul Element (A-Z)

Description

Base the Impact rule
on a new query

Select this check box if you want to base the Impact rule
on a new TQL query. The query results are based on the
attributes defined for the new TQL query.

Base the Impact rule
on an existing query

Select this check box if you want to base the Impact rule
on an existing TQL query. Select the required Impact
Analysis TQL query from the drop-down list.

Base Query
Description

(Optional) Enter a description of the TQL query.
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Ul Element (A-Z)

Description

Base Query Name

Enter a unique name for the Impact Analysis TQL query.

If you selected the Base the Impact rule on an existing
TQL option, select the Impact Analysis TQL query on
which you want to base the rule.

Base Query Priority

There is no need to make a selection here since all TQL
queries of the type Impact Analysis are automatically set
to inactive.

Save a new query
based on the current
definition

Select to save a new TQL query based on your Impact rule
definition.

Note: This field only appears in the Save As Impact Rule
wizard.

® Impact Rule Groups Page

This wizard page enables you to define where you can run Impact rules.

Important
information

» The Impact Analysis TQL query that serves as the basis
of the Impact rule, is subject to certain validation
restrictions. For details, see "Troubleshooting and
Limitations" on page 103. If the TQL query is not
valid, it cannot be used for the creation of an Impact
rule.

» For important information on the effects of making
changes to the TQL query after creating it, see "New
Impact Rule/Impact Rule Properties/Save As Impact
Rule Wizard" on page 469.

» By default, this wizard is set to display a Completion
page after clicking Next in this page. You can choose
not to display the Completion page by changing the
user preferences. For details, see "User Preferences
Dialog Box" on page 102.
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Wizard map The New Impact Rule/Impact Rule Properties/Save As
Impact Rule Wizard contains:

Impact Rule General Attributes Page > Impact Rule Base
Query Page > Impact Rule Groups Page

See also "IT Universe Manager" on page 227

User interface elements are described below:

Ul Element (A-Z) Description

UCMDB Enables you to run an Impact rule in IT Universe
Manager. For details, see "IT Universe Manager Overview"
on page 228.
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Cl Type Manager

This chapter includes:

Concepts

» CI Types Overview on page 476

» CI Type Attributes on page 477

» CI Type Relationships on page 478

» Deprecated CI Types on page 478

> System Type Manager on page 479

Tasks

» Create a CI Type on page 481

» Create a Relationship Type on page 483

» Create a Calculated Relationship Type on page 484

» Create List and Enumeration Definitions on page 485

» Create an Enumeration Definition — Workflow on page 486
Reference

» View Descriptions for CI Types and Relationships on page 488
» CI Type Manager User Interface on page 488

Note to HP Software-as-a-Service customers: The data in CI Type Manager
can be viewed but not edited.
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Concepts

& Cl Types Overview

476

A configuration item (CI) can represent hardware, software, services,
business processes, or any component of your IT infrastructure. CIs with
similar properties are grouped under a CI type (CIT). Each CIT provides a
template for creating a CI and its associated properties.

Every CI must belong to a CI type. The following are the main categories of
CITs:

> Business Element. CITs that correspond to the logical elements of your
business, such as processes and organizational groups.

> IT Process Record. CITs that correspond to changes that occur in your IT
infrastructure.

» Monitor. CITs that handle incoming metrics collected from your business
universe.

» Location. CITs that correspond to the location of devices and business
organizations or people supporting a function.

> Party. CITs that correspond to an active entity such as a person or
organization.

» Cl Collection. A logical collection of Cls.

> Infrastructure Element. CITs that correspond to the physical elements
(hardware and software) installed in your business environment.

The CITs are arranged in a tree structure under these categories in the CI
Types pane. You can browse the CI Type model by expanding the tree in the
CI Types pane. The CIT selected in the left pane is displayed in the topology
map along with all the potential valid relationships to other CITs.

You can also define new CITs to match your business needs. For details on
defining new CITs, see "Create Configuration Item
Type/Relationship/Calculated Relationship Wizard" on page 496.
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& Cl Type Attributes

Every CI type has attributes which define it such as name, description, and
default value. The CITs grouped under other CITs in the CI Type tree inherit
attributes from the higher-level CITs.

When you define a new CI type, you first select a Base Configuration Item
Type from a list of existing CITs. Your new CIT inherits the attributes of the
existing CIT. You can then set the attributes for the new CIT. You edit the
attributes of an existing CIT by selecting a CIT from the tree in the CI Types
pane and selecting the Attributes tab of the topology map. For details on
CIT attributes, see "Attributes Page" on page 498.

You can designate one or more of the CIT’s attributes as key attributes. A key
attribute is an attribute that is used as an identifier of the CIT. When you
define an instance of a CIT, the CIT’s key attributes are mandatory fields for
CIs of that type. You can assign as many key attributes as you want to a
given CIT. If you do not assign a key attribute when defining a new CIT, you
must select one of the following qualifiers on the Qualifier page of the
wizard:

» ABSTRACT_CLASS. The CIT is created, but it remains abstract, that is, you

are unable to create instances of it.

» RANDOM_GENERATED_ID_CLASS. You can create instances of the CIT,
but their ID is not based on a key attribute (it is generated randomly).

You can remove the key attributes of an existing CIT as long as at least one
key attribute remains. You cannot remove all the key attributes of an
existing CIT unless it has one of the above qualifiers.

Entity names in HP Business Service Management for RTSM-based
applications follow the conventions described below:

> CIT attributes values. All primitive types are supported: long, double,
float, string, and so on.

» CIT attributes values-type string. All special characters are supported. The
maximum length is 4000 characters.
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» CIT names and attributes names. The following are permitted: a-z, A-Z,
and underscore (_). The length is limited to 200 characters. The CIT name
must be in English. The number 0-9 are also permitted, but they must not
be the first character in the CIT name.

> CIT attribute length. The total length of all the attribute values in one CIT
cannot exceed 8K bytes due to a Microsoft SQL Server limitation.

& Cl Type Relationships

A relationship defines the link between two Cls. Relationships represent the
dependencies and connections between the entities in your IT environment.
When you select relationships or calculated relationships in the drop-down
box in the CI Types pane, the topology map displays all the valid instances
of CITs linked by the selected relationship. For details about calculated
relationships, see "Impact Modeling" on page 109.

The same attributes defined for CITs are also defined for relationships. You
can also assign key attributes for relationships but it is not required. For
details on defining new relationship types, see "Create Configuration Item
Type/Relationship/Calculated Relationship Wizard" on page 496.

& Deprecated Cl Types

478

CITs and relationships that are scheduled to be removed in a subsequent
product version are known as deprecated CITs. Such CITs appear in the user
interface in strikethrough font. You can hold the pointer over a deprecated
CIT to display a tooltip with information about it, including which CIT
replaces it.

Note: The strikethrough font is only visible when a font size of 14 points or
higher is selected for the topology map.
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Deprecated CITs appear in the CIT tree in Modeling Studio, however it is not
recommended to use them in building new TQL queries and views. In place
of a deprecated CIT, use the CIT indicated in the tooltip as its replacement.
Deprecated CITs do not appear in out-of-the-box queries and views.

CIT attributes which are scheduled to be removed are deprecated attributes.
They also appear in strikethrough font in the user interface.

The following image displays a TQL query containing a deprecated CIT:

@Jntainmem
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& System Type Manager

System Type Manager enables you to create a predefined list whose values
define an attribute type. For more details on System Type Manager, see
"System Type Manager Dialog Box" on page 516.

You can create the following attribute types:
» List. Enables you to create a predefined list of values, for example,
Location.

» Enumeration. Enables you to create a predefined list of values, as well as
assign each value a color. Enumerations are designed to be used as severity
value lists by states. For details, see "State Manager" in the RTSM
Administration Guide.
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Severity lists are used for:

» Retrieving Impact Analysis results in IT Universe Manager. For details, see
"IT Universe Manager" on page 227.

» Creating an Impact rule. For details, see "Impact Analysis Manager" on
page 449.

You can use both List and Enumeration values for:

» Editing the attributes of a CIT. For details, see "Create a CI Type" on
page 481.

» Defining an attribute condition for a TQL query node or relationship. For
details, see "Query Node/Relationship Properties Dialog Box" on page 85.
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Tasks

T Create a

Cl Type

This task describes the process you follow to create a CIT using the Create CI
Type wizard.

This task includes the following steps:

>

Y Y Y Y Y Y Y

-

"Prerequisites" on page 481

"Define the CI Type" on page 481

"Set the CI Type Attributes" on page 481
"Assign Qualifiers to the CI Type" on page 482
"Assign an Icon to the CI Type" on page 482
"Customize the CI Type Menu" on page 482
"Define the CI Type Default Label" on page 482
"Define the Matching Rules" on page 482

Prerequisites

From the CI Type Manager, select Cl Types from the list box in the CI
Types pane. Then select New to start the Create CI Type Wizard.

Define the Cl Type

Enter the name, description and base configuration item type for the new
CI type. For details, see "Details Page" on page 497.

Set the Cl Type Attributes

Edit the attributes of the new CI type and define key attributes for it. For
details, see "Attributes Page" on page 498.
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482

Note: List and Enumeration definitions are created in the System Type
Manager. If required, you can create additional List and Enumeration
definitions. For details, see "Create List and Enumeration Definitions" on
page 48S5.

Assign Qualifiers to the Cl Type

Assign qualifiers to the definition of the new CI type. For details, see
"Qualifiers Page" on page 502.

Assign an Icon to the Cl Type

Select an icon to assign to the new CI type. For details, see "Icon Page" on
page S50S.

Customize the Cl Type Menu

Select the menu items and commands to appear in the shortcut menu for
the new CI type. For details, see "Attached Menu Page" on page 506.
Define the Cl Type Default Label

Define the attributes to appear in the CI type label. For details, see
"Default Label Page" on page 510.

Define the Matching Rules

If necessary, define the matching rules for the new CI type. For details, see
"Matching Rules Page" on page 512.

Note: This step is only relevant for customers running HP Universal
CMDB Configuration Manager.
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Relationship Type

This task describes the process you follow to create a relationship type using
the Create Relationship wizard.

This task includes the following steps:

>

"Prerequisites" on page 483

» "Define the Relationship" on page 483

Y Y VY Y

-—)

"Set the Relationship Attributes" on page 483
"Assign Qualifiers to the Relationship" on page 484
"Customize the Relationship Menu" on page 484

"Define the Relationship Default Label" on page 484

Prerequisites

From the CI Type Manager, select Relationships from the list box in the CI
Types pane. Then select New to start the Create Relationship Wizard.

Define the Relationship

Enter the name, description and base CI type for the new relationship. For
details, see "Details Page" on page 497.

Set the Relationship Attributes

Edit the attributes of the new relationship and define key attributes for it.
For details, see "Attributes Page" on page 498.

Note: List and Enumeration definitions are created in the System Type
Manager. If required, you can create additional List and Enumeration
definitions. For details, see "Create List and Enumeration Definitions" on
page 4835.
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P Create

484

4

Assign Qualifiers to the Relationship

Assign qualifiers to the definition of the new relationship. For details, see
"Qualifiers Page" on page 502.

Customize the Relationship Menu

Select the menu items and commands to appear in the shortcut menu for
the new relationship. For details, see "Attached Menu Page" on page 506.
Define the Relationship Default Label

Define the attributes to appear in the relationship label. For details, see
"Default Label Page" on page 510.

Calculated Relationship Type

This task describes the process you follow to create a calculated relationship
type using the Create Calculated Relationship wizard.

This task includes the following steps:

>

>

>

>

"Prerequisites" on page 484

"Define the Calculated Relationship" on page 484
"Assign Qualifiers to the Relationship" on page 485
"Add Required Triplets" on page 485
Prerequisites

From the CI Type Manager, select Calculated Relationships from the list
box in the CI Types pane. Then select New to start the Create Calculated
Relationship Wizard.

Define the Calculated Relationship

Enter the name, description and base CI type for the new calculated
relationship. For details, see "Details Page" on page 497.
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3 Assign Qualifiers to the Relationship

Assign qualifiers to the definition of the new relationship. For details, see
"Qualifiers Page" on page 502.

4 Add Required Triplets
Add the required triplets. For details, see "Triplets Page" on page 503.

P Create List and Enumeration Definitions

This section describes the tasks for creating List and Enumeration
definitions.

This task includes the following steps:

» "Create a List Definition" on page 485

» "Create an Enumeration Definition" on page 485

1 Create a List Definition

You can create a List definition of predefined values. For example, a List
definition called Location might contain:

» New York
» Boston
» Baltimore

For details, see "Create/Update List/Enumeration Definition Dialog Box"
on page 513.

2 Create an Enumeration Definition

You can create an Enumeration definition, which enables you to assign a
color for each value on the list. For details, see "Create/Update
List/Enumeration Definition Dialog Box" on page 513. For an example of
an Enumeration definition, see "Create an Enumeration Definition —
Workflow" on page 486.
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P Create an Enumeration Definition - Workflow

486

The following steps describe how to create an Enumeration definition.

Note: To retrieve the required results, you must follow each step in this
task.

To create an Enumeration definition:
1 Select Admin > RTSM Administration > Modeling > Cl Type Manager.

2 From the Main Menu, select Cl Types > System Type Manager to open the
System Type Manager dialog box.

3 Click the Add button to open the Create List Definition dialog box.

Note: Alternatively, you can select Admin > RTSM Administration >
Administration > State Manager and then click the New Enumeration
button to open the Create Enumeration Definition dialog box.

4 Select Enumeration.
5 In the Name box, enter the required name.
6 (Optional) In the Display Name box, enter the required display name.

This example describes how to create the following severity list:

Key Value Severity Represented
0 Green Normal

1 Orange Major

2 Red Critical




7 Click the Add button to create a new row.
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8 In the Value box, enter Normal, in the Key box, enter 0, and in the Color

section, select Green.

9 Click the Add button to create another row.

10 In the Value box, enter Major, in the Key box, enter 1, and in the Color

section, select Orange.

11 Click the Add button to create another row.

12 In the Value box, enter Critical, in the Key box, enter 2, and in the Color

section, select Red.

The following image shows the Enumeration Definition section after the

changes:
Mame: |Ope|'_5‘tates |
Display Name: | |
() List (®) Enumeration

Enumeration Definition

4
Marmal Walue:
Major
b3 _J_ Key:
Critical
Color
O
.
-]
4

[critical

l2

Green
Light Qlive
Yelow
Crange
Red

Gray

13 Click OK to save your changes.
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Reference

@ View Descriptions for Cl Types and Relationships

You can view a complete list of available CI types in tree format in the left
pane of CI Type Manager. You can search incrementally for a specific CI type
as described in "CI Type Manager" on page 492. To see a description for a
particular CI type, select it from the tree and hold the pointer over the icon
which corresponds to it in the Topology Map. A tooltip containing a
description of the CI type is displayed.

For relationships, select Relationships in the left pane and search
incrementally by the first letter of the relationship. Select the relationship
you want and hold the pointer over its icon in the Topology Map to display
a tooltip containing a description of the relationship.

For detailed information on CI types and relationships, refer to the
HP Software BTO Data Model Reference file, hp-software-core-dm-1.1-
final.html, in the <BSM root directory>\AppServer\webapps\site.war\
amdocs\eng\pdfs folder.

@ Cl Type Manager User Interface

488

This section includes (in alphabetical order):

» Add/Edit Attribute Dialog Box on page 489

» Add/Remove Relationship Dialog Box on page 492
» CI Type Manager on page 492

» Create Configuration Item Type/Relationship/Calculated Relationship
Wizard on page 496

» Create/Update List/Enumeration Definition Dialog Box on page 513

» System Type Manager Dialog Box on page 516
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@ Add/Edit Attribute Dialog Box

This dialog box enables you to define a new attribute to add to a CIT or to
edit an existing attribute of a CIT.

To access In the CI Type Manager, select the Attributes tab, then click
the Add = button, or select an attribute and click the Edit
button or double-click the attribute.

Important In Edit mode, fields that cannot be changed are disabled.

information

Details Tab

User interface elements are described below:

Ul Element (A-Z)

Description

Attribute Name

Enter a unique name for the new attribute. The name can
contain all characters except the following: "\ / []:|<>+=
2 *

1y

Note: The attribute name is not case sensitive.

Attribute Type

Select one of the following options:

» Primitive. Choose from one of the following field types:
boolean, bytes, date, double, float, integer, integer_list, long,
string, string_list, xml.

» Enumeration/List. Contains a list of Enumerations and
Lists defined in the System Type Manager. For details, see
"System Type Manager" on page 479.

This option enables you to define an attribute with a
predefined value. For example, a location attribute might
be defined by a location list containing the following
values: Singapore, Paris, New York.

Default Value

Enter or select a default value for the attribute. The options
for the Default Value field vary depending on the attribute
type you selected.

Note: If you select the integer_list or string_list Primitive
attribute type, you can enter multiple values.
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Ul Element (A-Z)

Description

Description Enter a description for the new attribute.
Note: This field is optional.
Display Name Enter a name for the new attribute to identify it in
HP Business Service Management.
Note: This field is optional.
Scope Select the scope of the new attribute (the class model to
which it belongs).
Value Size Enter a value for the maximum physical size of the new

attribute. (Enabled for bytes and string only).

Advanced Tab

User interface elements are described below:

Ul Element (A-Z)

Description

Asset Data Select to display the attribute value in the Asset Report.
Change Select to define attributes whose values are being marked as
Monitored Change Monitored in CI Type Manager. The changes in the

values of such attributes are saved in the CMDB History
database.

Note:

» When this qualifier is selected for a given attribute, the
attribute appears as a visible column in the Element
Instances dialog box. For details, see "Element Instances
Dialog Box" on page 77.

» Change Monitored is not relevant for attributes of the
type list of integers or list of strings.

Comparable

Select to enable this attribute to be used for comparing
compound ClIs.

Editable

Select to enable future editing of the attribute. Only
attributes that are marked as Editable (or ones that have
values) are displayed in the Properties tab in IT Universe
Manager.
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Ul Element (A-Z)

Description

Enable Auto
Truncate by DFM

If selected, when attributes of type STRING exceed the size
limit, Discovery truncates the value. For details, see "Data
Validation on the Data Flow Probe" in RTSM Data Flow
Management Guide.

Index Select to accelerate the attribute retrieval performance. This
option is recommended for attributes that are used
frequently in search conditions. For example, IP address is
usually an index attribute of a node.

Lower Case When this option is selected, the attribute value appears in
lower case.

Password When this option is selected, the attribute value appears as
asterisks (a hidden value).

Required Select to define this attribute as a required one, if its value is
required for the creation of the CIT.

Static Select to define this attribute as static.

Unique When this option is selected, different instances of this CI
type must have unique values.

Upper Case When this option is selected, the attribute value appears in

upper case.

Use Update Value
Policy

Select this option to add the ALLOW_VOLATILITY qualifier.
For details on this qualifier, see "The ALLOW_VOLATILITY
Qualifier" on page 28.

Visible

Select to display this attribute in the Properties tab in
IT Universe Manager.
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® Add/Remove Relationship Dialog Box

This dialog box enables you to add or remove default or new relationships
between CITs, which define their physical or logical connections.

To access In the CI Type Manager, right-click a CIT or two CITs
and select Add/Remove Relationship.

Important When adding a relationship between two CITs, select

information the two CITs to be linked by holding down CTRL and

clicking the CIT names. Then right-click one of them
and select Add/Remove Relationship.

User interface elements are described below (unlabeled elements are shown

in angle brackets):

Ul Element (A-Z)

Description

<query nodel to
query node2>

Select the relationships to add in the direction of the
first query node to the second.

<query node2 to
query nodel>

Select the relationships to add in the direction of the
second query node to the first.

Relationship Name

A list of the possible relationships.

@ Cl Type Manager

This page enables you to view the information in the CI Type model, which
contains the definitions of all configuration item types (CITs) defined in the
system and the relationships that define the connections between them.
Each CIT has its own attributes, as well as the attributes inherited from its

parent CIT.

To access

Select Admin > RTSM Administration > Modeling > Cl Type
Manager.
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User interface elements are described below (unlabeled elements are shown

in angle brackets):

Ul Element (A-Z)

Description

Click the New button to open the Create Configuration
Item Type Wizard which enables you to define a new CI
type. For details, see "Create Configuration Item
Type/Relationship/Calculated Relationship Wizard" on
page 496.

Click Delete to delete the selected CI type or relationship.

#
|§| Click to refresh the data content of the hierarchical tree

= structure that may have been modified by other users.
Click the Save button to save changes made to a CI type.
I~ Enables you to import CITs from an external file.
fa Enables you to export a CIT as an XML file. Use this option
frs to move CITs from one server to another.
& Enables you to export a CIT as a PDFE.
<l Select one of the following options:

Type/Relationship
Box>

» Cl Types. Display the CI types in the CIT model.
» Relationships. Display the relationships in the CIT model.

» Calculated Relationships. Display the calculated
relationships in the CIT model.
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Ul Element (A-Z)

Description

<Editing Pane>

The following tabs are available:

» Dependencies. Displays the CI Type model in a topology
map, including the CITs and the relationships between
them. The name of the selected CI type or relationship
appears in the border at the top of the pane. When you
point to a CIT, a tooltip displays the display name of the
CIT and its description.

» Details. Enables you to edit the basic information about
the CI type selected in the left pane. For details, see
"Details Page" on page 497.

» Attributes. Enables you to edit the attributes of the
selected CIT. For details, see "Attributes Page" on
page 498.

» Qualifiers. Enables you to assign qualifiers to the selected
CIT. For details, see "Qualifiers Page" on page 502.

» Triplets. Enables you to create a calculated relationship.
For details, see "Triplets Page" on page 503. This tab
appears only for calculated relationships.

» lcon. Enables you to assign an icon to the selected CIT.
For details, see "Icon Page" on page 505. This tab does not
appear for relationships.

» Attached Menu. Enables you to customize the shortcut
menu of a CI by adding menu items and commands (for
example, ping, run a program, open a URL). The
customized menu is displayed when you right-click a CI
instance in IT Universe Manager. For details, see
"Attached Menu Page" on page 506.

» Default Label. Enables you to define attributes that appear
in the CIT label. You can include more than one attribute
by using the function buttons. For details, see "Default
Label Page" on page 510.

» Matching Rules. Enables you to define matching rules for
use in HP Universal CMDB Configuration Manager. For
details, consult the Configuration Manager
documentation. This tab does not appear for
relationships and only appears when UCMDB is running
with Configuration Manager.
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Ul Element (A-Z)

Description

<Main Menu>

For details, see "Main Menu" on page 197.

<Toolbar>

For details, see "Toolbar Options" on page 201.

Cl Types Pane

A hierarchical tree structure of the CI Type model containing
the inheritance relationships among CITs, and displaying
the number of instances of each CIT in the RTSM.

All CITs included in the CI Type model are classified as
either a CIT or a relationship.

You can drill down and view the relationships and neighbors
of the selected CIT in the topology map. You can search in
the list of CITs or relationships using the Incremental Search
by entering the first letter of the CIT or relationship
repeatedly until you reach the required selection. You can
also search for a CIT or relationship by entering its full
name.

Shortcut Menu

CI Type Manager includes the following options available by right clicking a
CI type in the CI Types pane or the Dependencies map:

Ul Element (A-Z)

Description

Add/Remove
Relationship

Opens the Add/Remove Relationship dialog box, which
enables you to add or remove relationships from CITs. For
details, see "Add/Remove Relationship Dialog Box" on
page 492.

Delete Selected
Item

Deletes the selected CI type. This option is only available for
CI types that have no children and no instances.

Export To XML

Enables you to export a CIT as an XML file. Use this option
to move CITs from one server to another.
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Ul Element (A-Z)

Description

New Opens the Create Configuration Item Type Wizard which
enables you to define a new CI type. For details, see "Create
Configuration Item Type/Relationship/Calculated
Relationship Wizard" on page 496.

Show CIT Opens the Show All Instances dialog box, which displays all

Instances instances of the selected CIT. For details, see "Element

Instances Dialog Box" on page 77.

@ Create Configuration Item Type/Relationship/Calculated
Relationship Wizard

496

This wizard enables you to define a new configuration item type or

relationship.

To access Click a CI type or relationship in the topology map or CI
Types pane of the CI Type Manager and select New or click
the New . button in the CI types pane.

Wizard map The Create Configuration Item

Type/Relationship/Calculated Relationship Wizard
contains:

Details Page > Attributes Page > Qualifiers Page > Triplets
Page > Icon Page > Attached Menu Page > Default Label Page
> Matching Rules Page

The Create Configuration Item Type wizard includes the following pages:

Y Y Y Y Y Y

"Details Page" on page 497
"Attributes Page" on page 498
"Qualifiers Page" on page 502
"Triplets Page" on page 503

"Icon Page" on page 505

"Attached Menu Page" on page 506
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> "Default Label Page" on page 510

> "Matching Rules Page" on page 512

. Details Page

This wizard page enables you to enter basic information about the new CI
type you are defining.

Important For general information about the Create Configuration

information Item Type Wizard, see "Create Configuration Item
Type/Relationship/Calculated Relationship Wizard" on
page 496.

Wizard map The Create Configuration Item

Type/Relationship/Calculated Relationship Wizard
contains:

Details Page > Attributes Page > Qualifiers Page > Triplets
Page > Icon Page > Attached Menu Page > Default Label Page
> Matching Rules Page

User interface elements are described below:

Ul Element (A-Z)

Description

Base Cl Type

Select a base CIT for the CIT you are creating. The new CIT
inherits the base CIT’s attributes.

Note: This field only appears in the Create CI Type Wizard.
It is not relevant when editing an existing CIT in the Details
tab of CI Type Manager.

Created By

The user who created the new CIT.

Note: This field is optional.

Description

A description for the new CIT.
Note: This field is optional.

Display Name

The name of the CIT as it appears in the HP Business Service
Management interface.

Note: This field is optional.
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Ul Element (A-Z)

Description

Identification

Displays the key attributes or reconciliation rule by which
the CIT is identified.

Note: This field only appears when editing an existing CIT
in the Details tab of CI Type Manager. It is not relevant in
the Create CI Type Wizard.

Name

The unique name of the new CIT. The name must be in
English. The name can contain all characters except the
following: "\ /[]:|<>+=;,?*

Note: The name field is case sensitive, but you cannot use
the same name with different cases for two different CITs.

Scope

Select the scope of the new CIT (the class model to which it
belongs).

¥ Attributes Page
This wizard page enables you to edit the attributes of the CI type.

Wizard map

The Create Configuration Item
Type/Relationship/Calculated Relationship Wizard
contains:

Details Page > Attributes Page > Qualifiers Page > Triplets
Page > Icon Page > Attached Menu Page > Default Label Page
> Matching Rules Page
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User interface elements are described below (unlabeled elements are shown

in angle brackets):

Ul Element (A-Z)

Description

i

To define an attribute as a key attribute, click in the Key
column beside the attribute name. A key icon appears in the
cell. A key attribute is an attribute that must be defined for
ClIs of that CI type.

To remove the key attribute definition, click in the Key
column again. The key icon disappears.

For more information on key attributes, see "CI Type
Attributes" on page 477.

Denotes a static attribute. A static attribute takes the same
value for all the CIs of that type. If it is changed, all the CIs
of that type are affected and automatically display the new
value. A static attribute cannot be defined as a key attribute.

Note: You cannot define an attribute as static from within
the CIT Manager. It is done by deploying the relevant
package. Static attributes are for internal use only.

Click the Add button to define a new attribute. For details,
see "Add/Edit Attribute Dialog Box" on page 489.

Select a row and click the Edit button to open the Edit
Attribute dialog box. For details, see "Add/Edit Attribute
Dialog Box" on page 489.

Note: If you modify an attribute belonging to a CIT’s parent,
the text turns light blue. If you modify an attribute
belonging to the CIT itself, the text remains dark blue.

Click the Delete button to delete a selected attribute. This
option is only active for newly defined attributes.

Click the Reset button to reset the attribute settings after
editing a pre-existing attribute.

Click Select Columns to select the columns to appear using
the Select Columns dialog box. For details, see "Select
Columns Dialog Box" on page 570.
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Ul Element (A-Z)

Description

<Attributes>

Displays all attributes associated with the new CIT.
Attributes appearing in black are ones that the new CIT
inherits from the base CIT. Attributes appearing in dark blue
are ones that are private to this CIT and its descendants.
Attributes appearing in light blue are inherited ones that
have been modified for the new CIT.

Asset Data

Indicates whether the attribute value is displayed in the
Asset Report. For details see "Asset Report" on page 419.

Note: When this qualifier is selected for a given attribute,
the attribute appears as a visible column in the Element
Instances dialog box. For details, see "Element Instances
Dialog Box" on page 77.

BDM Scope

Indicates whether the attribute is included in the BDM class
model.

Change
Monitored

Select to define attributes whose values are being marked as
Change Monitored in CI Type Manager. The changes in the
values of such attributes are saved in the CMDB History
database.

Note: When this qualifier is selected for a given attribute,
the attribute appears as a visible column in the Element
Instances dialog box. For details, see "Element Instances
Dialog Box" on page 77.

Comparable

Indicates whether this attribute is to be used for comparing
compound ClIs. For details, see "Compare Cls Report" on
page 432. The changes in the value of such an attribute are
saved in the CMDB History database.

Note: When this qualifier is selected for a given attribute,
the attribute appears as a visible column in the Element
Instances dialog box. For details, see "Element Instances
Dialog Box" on page 77.

Default Value

The default value for the attribute. This value appears when
the new CIT is defined and there is no runtime value for the
attribute.

Description

A description of the attribute.
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Ul Element (A-Z)

Description

Display Name

The attribute name that appears in the HP Business Service
Management interface.

Editable

Indicates whether the attribute can be edited.

Only attributes that are marked as Editable (or ones that
have values) are displayed in the Properties tab in
IT Universe Manager.

Enable Auto
Truncate by DFM

Indicates whether the auto-truncate feature for attributes of
type STRING is enabled.

Index

Indicates whether the attribute has been defined as an index
attribute, which enables you to accelerate the attribute
retrieval performance.

This option is recommended for attributes that are used
frequently in search conditions. For example, IP address is
usually an index attribute of a node.

Key

When the key icon § appears in this column, it indicates
that the attribute is defined as a key attribute.

When the static attribute icon = appears in this column, it
indicates that the attribute cannot be defined as a key
attribute.

Lower Case

Indicates whether to keep the attribute value in lower case.

Name

The actual name of the attribute (compare to Display Name).
The name must be in English.

Required

Indicates whether this attribute is defined as a required one,
whose value is required for the creation of the CIT.

Static

Indicates whether this attribute is defined as static.

Type

The type of the attribute.

Unique

Indicates whether this attribute is defined as unique, for
which different instances of this CI type must have unique
values

Upper Case

Indicates whether to keep the attribute value in upper case.

Visible

Indicates whether this attribute is displayed in the Properties
tab in IT Universe Manager.
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¥ qQualifiers Page

This wizard page enables you to assign qualifiers to a CI type definition.

Important Qualifiers enable you to define added attribute definitions

information to the CIT. In the Qualifiers list, select the required qualifiers
using the Add buttons to move your selections to the
Configuration Item Type Qualifiers list. You can make
multiple selections by holding down the CTRL key.

Wizard map The Create Configuration Item

Type/Relationship/Calculated Relationship Wizard
contains:

Details Page > Attributes Page > Qualifiers Page > Triplets
Page > Icon Page > Attached Menu Page > Default Label Page
> Matching Rules Page

User interface elements are described below (unlabeled elements are shown

in angle brackets):

Ul Element (A-Z)

Description

L

Click this button to move all qualifiers to the Configuration
Item Type Qualifiers list.

> Select the qualifier and click this button to add the qualifier
to the Configuration Item Type Qualifiers list. Select
multiple qualifiers by holding down the CTRL key.
rs To remove a qualifier from the CIT definition, select the

qualifier from the Configuration Item Type Qualifiers list
and click this button.

iifr

Click this button to remove all qualifiers from the
Configuration Item Type Qualifiers list.

To define a new, custom qualifier, enter the qualifier name
in the text box and click Insert. The qualifier appears in the
Configuration Item Type Qualifiers list.
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Ul Element (A-Z)

Description

<Configuration

The list of qualifiers that define attributes of the new CIT.

Item Type For example, you can use a qualifier to define a CIT as

Qualifiers> abstract, which means that you cannot create instances from
it.

<Qualifiers> For a list of the available qualifier options, see "Qualifier Tab"

on page 92.

® Triplets Page

This wizard page enables you to create a calculated relationship. Each row
on the Triplets page represents one of the allowed steps in the path leading
from the source CI to the target CI in the topology map.

Note: This step of the wizard is only relevant for calculated relationships.

Important
information

» This page is displayed if you select Calculated
Relationships in the drop-down box in the CI Types
pane.

» For details about calculated relationships, see "Impact
Modeling" on page 109.

» For general information about the Create Configuration
Item Type Wizard, see "Create Configuration Item
Type/Relationship/Calculated Relationship Wizard" on
page 496.

Wizard map

The Create Configuration Item
Type/Relationship/Calculated Relationship Wizard
contains:

Details Page > Attributes Page > Qualifiers Page > Triplets
Page > Icon Page > Attached Menu Page > Default Label
Page > Matching Rules Page

See also

"Impact Modeling" on page 109
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User interface elements are described below:

Ul Element (A-Z)

Description

Click to define the allowed steps in a path in the topology

=
graph leading from the source CI to the target CI in the
calculated relationship. Opens the Add Triplet dialog box.
For details, see "Add Triplet Dialog Box" on page 73.

o Select a row and click the Edit button to edit the triplet.
Opens the Edit Triplet dialog box. For details, see "Add
Triplet Dialog Box" on page 73.

¢ Click the Delete button to delete a selected triplet.

Relationship The required relationship connecting the two query nodes.

Relationship The source and target of a relationship.

Direction » = The direction is from source to target.
» = The direction is from target to source.

Source The required source query node.

Target The required target query node.
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® Icon Page

This wizard page enables you to select an icon to assign to the new CI Type.

Note: This step of the wizard is not relevant for relationships.

Important Each CIT is displayed with a default icon. However, you can
information attach different icons to the same CIT when certain
conditions apply. For example, you can associate different
icons with the same CIT when one of its attribute values
changes.

Wizard map The Create Configuration Item
Type/Relationship/Calculated Relationship Wizard
contains:

Details Page > Attributes Page > Qualifiers Page > Triplets
Page > Icon Page > Attached Menu Page > Default Label
Page > Matching Rules Page

User interface elements are described below:

Ul Element (A-Z) Description

o Click to add a row.
Note: Only active if Change the Configuration Item Type

icon according to its attribute value is selected.

%€ Click to remove a row.

Note: Only active if Change the Configuration Item Type
icon according to its attribute value is selected.

Attributes Select an attribute to determine the icon assigned to the CIT.
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Ul Element (A-Z)

Description

Change the
Configuration
Item Type icon
according to its
attribute value

Enables you to assign an icon for each attribute value. For
example, you could define two values for the City attribute:
if City=London, one icon is displayed. If City=Beijing, another
icon is displayed.

Note: If you change the icon of a CIT that appears in an
existing view, the CIT's icon is not updated in the view.

Configuration
Item Type Main
Icon

Select the group to which the CIT belongs.

Icon Select an icon to associate with the value you entered in the
Value column.
Value Enter a value corresponding to the attribute you selected.

You can add a new line for each value you enter.

@ Attached Menu Page

This wizard page enables you to customize the shortcut menu of a CI by
adding menu items and commands (for example, ping, tun a program, open
a URL). The customized menu is displayed when you right-click a CI
instance in IT Universe Manager.

Important If a CIT does not have a method defined specifically for it,

information the CIT inherits all the menus from its parent CIT or the
nearest ancestor that does have a method defined for it.
If you create or modify a menu, the change occurs only in
the specific CIT that is being edited.

Wizard map The Create Configuration Item

Type/Relationship/Calculated Relationship Wizard
contains:

Details Page > Attributes Page > Qualifiers Page > Triplets
Page > Icon Page > Attached Menu Page > Default Label
Page > Matching Rules Page
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User interface elements are described below:

Ul Element (A-Z)

Description

=

Select a menu item from the tree and click the button. A
new entry appears under the selected item.

Click to remove a menu item.

1t

Click to move a selected menu item up in the menu.

kg

Click to move a selected menu item down in the menu.

<Tree>

Hierarchical tree containing the default menu items.

Caution: It is not recommended to edit the definitions of the
default menu items.

Command

To connect to a specific location on the World Wide Web,
select URL, and enter the exact Internet address, for
example, http://www.hp.com/go/software. (Available only if
you select the URL command type option.)

Note: If you use a variable in the Command field, use the
format command name %1 and define the CIT attributes as
described in Parameters. The parameter values replace %1
according to their order in the list. For example, %1 is
replaced by the first parameter in the list, %2 is replaced by
the second parameter in the list, and so on.

Description

Enter a description for the method. (This is for internal use
only and does not appear in the menu.)

Existing Method

Select to choose a command from a list of defined methods
inherited from the IT Universe CIT and all its ancestors.

lcon

Select the icon to appear next to the menu option in the
shortcut menu.

Note: This field is optional.

Menu Item Name

Enter a name for the new menu item as it should appear in
the menu.
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Ul Element (A-Z)

Description

Method

Enables you to add a command to the menu.

Note: To create a method and not override the existing
method, it is recommended to create a new menu item and
place the new method there.

Method Name

Enter a name for the command.

New Method Select to add an action (for example, ping) to the menu
item.
Parameters To add attributes to the command or URL, click the Add

Parameter button and select the attribute from the list.

To delete an existing entry, select it and click the Remove
Parameter button.

Note: Parameters are not relevant when Inner Process is
selected.

Require user
confirmation

Select the check box for users to confirm access to a menu
item before the item is displayed.

Separator To place a separator between two menu items:
Click OK to place a separator underneath the selected menu
option.

Shortcut Press any key combination to create a shortcut for the menu

item, for example, CTRL+H.

Note: This field is optional.
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Ul Element (A-Z)

Description

Sub-Menu

Select to create a sub-menu under the selected menu option.

SJ CI History

Mote (]
[: ] Add No‘te
% Delete T

Sub-menu

[, New Related CI < Menu

Actions 3

Type

Choose a command type:

» URL. Opens a web page to the specified URL. Enter the
URL of a Web page for the command to open in the URL
box.

» Inner Process. Triggers an internal HP Business Service
Management action. Select an action from the drop-down
list of actions.

» Execute. Triggers an executable action. Enter an
executable command in the Executable box.

Note: In the Executable box, enter only the name of the
executable file (for example, notepad.exe). Do not enter a
path to the executable file. A path cannot execute a
program.
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@, Default Label Page

This wizard page enables you to define attributes that appear in the CI type
label. You can include more than one attribute by using the function
buttons. This is the final step of the Create Configuration Item Type Wizard.

Important You build a label by selecting attributes in the CI Type
information Attributes pane and adding them to the Format pane, using
the operators in the Format pane to connect them.

The label appears as the title under a CI of the new CI Type.
The label definition can be customized to include different
attribute values. For example, if the function label of the
node CIT is composed of hostname and network, the
displayed label is: server1 10.0.65.0.

Labels can also be created using regular expressions.

Wizard map The Create Configuration Item
Type/Relationship/Calculated Relationship Wizard
contains:

Details Page > Attributes Page > Qualifiers Page > Triplets
Page > Icon Page > Attached Menu Page > Default Label
Page > Matching Rules Page

User interface elements are described below:

Ul Element (A-Z) Description

1 Click to add the selected attribute to the Format pane.

Adds parentheses to the formatted text (use in conjunction
with the other functions).

e
L

& Places an AND operator between two attributes in the
formatted text. For example,
network_netaddr&network_domain displays the network
address and the domain of a query node.

[ Places an OR operator between two attributes in the
formatted text.
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Ul Element (A-Z)

Description

Adds a regular expression (using regular expression syntax)
to the label definition. The structure of the entry is (v1, v2,
v3), where v1 represents the selected attribute, v2 represents
the regular expression itself (which divides the value into
groups), and v3 represents the number of the selected group.

For example, if the selected attribute is a name, consisting of
a first name, a space, and a surname, the regular expression
would be (name, (\S*)(\s*)(\S*), 3), which indicates that the
surname can be used for the name attribute in the default
label.

For examples of how to use regular expression syntax, see
"Regular Expression Examples" on page 575.

Click to undo the last change in the Format pane.

o

Click to clear the Format pane.

Cl Type Attributes

Displays the available options of attributes to be included in
the CIT label.

Cl Type Label
Definition Format

Displays the attributes that you select to appear in the CIT
label.

For example, to label a node by its host name and operating
system, choose the host_hostname and host_os attributes.
The CIT label is host1 UNIX.

You can define conditions using AND and OR combinations.

Note: To delete an attribute from the Format pane, highlight
it and press the DELETE key.
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® Matching Rules Page

This wizard page enables you to define matching rules for comparable
attributes for use in HP Universal CMDB Configuration Manager.

Important
information

This page is only relevant when Configuration Manager is
installed. For details on matching rules, refer to the
Configuration Manager documentation.

Note: You can activate the Matching Rules page manually
by setting the Enable Configuration Manager Matching
Rules setting to true in the Infrastructure Settings Manager.

Wizard map

The Create Configuration Item
Type/Relationship/Calculated Relationship Wizard
contains:

Details Page > Attributes Page > Qualifiers Page > Triplets
Page > Icon Page > Attached Menu Page > Default Label Page
> Matching Rules Page

User interface elements are described below:

Ul Element (A-Z)

Description

>

Click to move the selected comparable attributes to the
Matching Rules pane. Select multiple attributes by holding
down the CTRL key.

Click to remove an attribute from the Matching Rules pane.

L

Click to move all attributes to the Matching Rules pane.

iifr

Click this button to remove all attributes from the Matching
Rules pane.

1| [

Set the order of the matching rules using the up and down
buttons.

Comparable
Attributes

A list of all the attributes of the selected CI type with the
comparable qualifier selected.

Matching Rules

The attributes selected to determine matching rules for
Configuration Manager.
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@ Create/Update List/Enumeration Definition Dialog Box

This dialog box enables you to define a new List or Enumeration definition.
The List or Enumeration definition you have created appears in the System
Type Manager dialog box, where you can edit it if required (for details, see
"System Type Manager Dialog Box" on page 516).

To access Click the Add button in the System Type Manager dialog
box.

Important You can access the Create/Update Enumeration Definition

information dialog box from the State Manager as well. For details, see

"State Manager" in the RTSM Administration Guide.

Relevant tasks

"Create List and Enumeration Definitions" on page 485

User interface elements are described below:

Ul Element (A-Z)

Description

Display Name

Enter the name you want to appear in the list of System
Type Definitions. If you leave this field empty, the entry in
the Name field is used.

Enumeration

Enables you to create a predefined list of values, as well as
assign each value a color. For details, see "Enumeration
Definition Area" on page 515.

List Enables you to create a predefined list of values. For details,
see "List Definition Area" on page 514.
Name Enter a unique name for the definition.
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List Definition Area

This area enables you to create a predefined list of values.

To access Select List in the Create List/Enumeration Definition
dialog box.

Important For example, a Location attribute might be defined by a

information location list containing the following values:

» New York
» Boston
» Baltimore

The following elements are included (unlabeled elements are shown in

angle brackets):

Ul Element (A-Z)

Description

Add a List definition. Double-click inside the row and

=
either select a date from the calendar that appears (if
you chose the type Date) or type the required value.
W% Delete a List definition.
Type Choose one of following field types:

» Date
» Double
> Integer
» Long
» String
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Enumeration Definition Area

This area enables you to create a list from a predefined list of values (similar
to List), with capabilities such as assigning a color for every value.

To access Select Enumeration in the Create List/Enumeration
Definition dialog box.

Important Enumerations are designed to be used as severity value

information lists by states. You can use Enumerations for lists that
require key values.

See also "Create an Enumeration Definition — Workflow" on

page 486

User interface elements are described below:

Ul Element (A-Z)

Description

Add an Enumeration definition.

=
% Remove an Enumeration definition.
Color Select a color that indicates the severity level.

Note: Gray is only enabled when you create an
Enumeration of the type Admin.
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Ul Element (A-Z) Description

Key Type a number to create an enumeration that describes
a severity list for a category.

Assign key values according to the following rules:

» The list of key values must always begin with zero
(0). (Zero represents the Normal state.) Otherwise, it
does not appear in the State Manager (for details, see
"State Manager" in the RTSM Administration Guide).

» The list must always be numbered consecutively.
For an example of an Enumeration definition, see

"Create an Enumeration Definition — Workflow" on
page 486.

Value Type a value, either a string or a number, for example,
Red or my value. The value appears in the tooltip for
the Cl in IT Universe Manager.

@ system Type Manager Dialog Box

This dialog box enables you to display the attribute types you defined in the
Create List/Enumeration Definition dialog box.

To access From the CI Type Manager, select Cl Types > System
Type Manager.

Relevant tasks "Create List and Enumeration Definitions" on page 485

See also "Create an Enumeration Definition — Workflow" on
page 486
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User interface elements are described below (unlabeled elements are shown

in angle brackets):

Ul Element (A-Z)

Description

Create a predefined list whose values define an attribute
type. You can create a definition for the following attribute

types:
» List definition.
» Enumeration definition.

For a description of these attribute types, see "Create/Update
List/Enumeration Definition Dialog Box" on page 513.

Enables you to edit an existing definition. For details, see
"Create/Update List/Enumeration Definition Dialog Box" on
page 513.

#

Delete an existing definition. Select the system type
definition you want to delete and click the Delete button.

<System Type
Definitions>

The list of Enumeration and List definitions created in the
System Type Manager.
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Enrichment Manager

This chapter includes:

Concepts

» Enrichment Manager — Overview on page 520
Tasks

» Define an Enrichment Rule - Scenario on page 523

» Add Enrichment Query Nodes and Relationships to an Enrichment TQL
Query on page 528

Reference

» Enrichment Manager User Interface on page 530
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Concepts

& Enrichment Manager - Overview

520

Enrichment rules can be used for several purposes:

» Adding new CIs and relationships to the RTSM.
» Deleting specific CI instances from the RTSM.
» Updating the attribute values of specific CI instances in the RTSM.

Enrichment query nodes and relationships differ from other query nodes
and relationships in that they are conceptual deductions that represent real
relationships and CIs that cannot be discovered automatically by the
discovery process.

Enrichment query nodes and relationships are created as part of a TQL
query, whose other TQL query nodes are regular ones, meaning TQL query
nodes that already exist in the RTSM. For more information about TQL
queries, see "Topology Query Language" on page 21.
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The following example displays a regular query node of type Node linked to
a Websphere AS Enrichment query node by an Enrichment Composition
relationship.

et

Enrichment *
querynede — ad
Websphere AS

) *
Enrichment + Compaosition
relationship \[ ]
Existing query node .,_,.

MNode
Containment

_l_
m

IpAddress

By placing an Enrichment query node within a TQL query context, the
query receives data from its attributes, and uses it to insert new information
into the RTSM.
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When you create Enrichment rules, the following results can occur:

» The RTSM is enlarged. Add Enrichment query nodes and relationships
that are currently not included in the RTSM.

The following Enrichment rule example displays a regular Windows query
node (that already exists in the RTSM) connected to a Log File
Enrichment query node by an Enrichment Composition relationship.

Enrichment D
 —— +
query node
Lag File
+ Comnposition
Existing query node —4—7m7M —— M kﬁ]
Windows

This Enrichment rule states that for every Windows CI instance that is
found in the RTSM, a new Log File CI instance is created, and linked to
the Windows CI with a Composition relationship.

» Specific Cl instances are deleted from the RTSM. For an example, see
"Define an Enrichment Rule — Scenario" on page 523.

» The values of Cl attributes are updated. Use an Enrichment rule to update
the attributes of a CI that already exists in the RTSM.

The following Enrichment rule example illustrates that a regular Windows
query node (that already exists in the RTSM) has been updated with an
Enrichment rule.

=

Windows

This Enrichment rule states that every Windows CI found in the RTSM is
updated with the attribute value defined in the Enrichment rule.
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Tasks

T Define an Enrichment Rule - Scenario

This task describes how to create the following Enrichment rule:

An IP Address CI is connected to two identical Node CIs: one Node CI is
identified by its IP address and the other is identified by its lowest MAC
address. For every such instance, delete the Node CI that is identified by its
IP address from the RTSM.

Note: To reach the required result, you must implement each one of the
following steps.

This task includes the following steps:

» "Create an Enrichment TQL Query" on page 524

> "Define the Query Node of Type Node that Is Identified by its Lowest
MAC Address" on page 526

» "Define the Query Node of Type Node that is Identified by its IP Address"
on page 526

> "Define the Enrichment Rule" on page 527
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524

1 Create an Enrichment TQL Query

To create an Enrichment TQL query, you need to define an Enrichment
rule and then add the regular TQL query nodes and relationships that
define the query.

Note: You can add Enrichment query nodes and relationships only after
at least one regular query node has been added to the query.

Select Admin > RTSM Administration > Modeling > Enrichment Manager.
For details about how to create an Enrichment TQL query, see "New
Enrichment Rule/Enrichment Rule Properties/Save As Enrichment Rule
Wizard" on page 539. For details about how to add query nodes and
relationships to a query, see "Add Query Nodes and Relationships to a
TQL Query" on page 32.

Example of an Enrichment TQL Query:

A new Enrichment TQL query called doubleHosts1 (located under the
Network folder) is created in Enrichment Manager.

Rule Mame: | doubleHosts1

Fule Description: | Delete incomplete host

Fule is Active
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The doubleHosts1 Enrichment rule is displayed in the Enrichment Rules
pane.

B root
[]—F_=| Application
[]—F_=| Cluster
[]—F_=| Correlation
[]—F_=| Databaze
[]—F_=| Dizcovery
I:—]—EE| Enrichment
53 I1BM WebSphere MG
H-E5 J2EE
[]—F_=| Layer2
[]—F_=| Mairframe
I:—]—r—_:| Metwork
[@ doubleHozsts
@
[ Update_Broadcast_IP
B3 siebel
e-E5 soa

In this Enrichment TQL query, an IP Address query node is linked to two
query nodes of type Node by a Containment relationship. The TQL results
must comply with the direction of the arrows.

Mode_2 Mode
Containgment_2

Containment

il

IpAddress

Note: A TQL query is subject to certain validation restrictions. For details,
see "Troubleshooting and Limitations" on page 103.
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526

2 Define the Query Node of Type Node that Is Identified by its

Lowest MAC Address

At the top of the Enrichment Manager page, select Query mode. In the
editing pane, right-click the required query node of type Node, select
Query Node Properties to open the Query Node Properties dialog box.
Then define an attribute condition in the Attribute tab. For details on
how to define an attribute condition, see "Attribute Tab" on page 87.

Example of an Attribute Condition Definition that Identifies the Node by
its Lowest Mac Address:

In the Attribute tab, this attribute condition definition identifies the
required Node by its lowest MAC address.

> Attribute name — Node is Complete
» Operator — Equal

» Value — True

Define the Query Node of Type Node that is Identified by its
IP Address

At the top of the Enrichment Manager page, select Query mode. In the
editing pane, right-click the required query node of type Node, and select
Query Node Properties to open the Query Node Properties dialog box.
Then define two attribute conditions in the Attribute tab. For details on
how to define an attribute condition, see "Attribute Tab" on page 87.

Example of an Attribute Condition that Enables a Node to Be Identified
by its IP Address:

This attribute condition is the first attribute condition you need to define
in the Attribute tab to enable the query node of type node to be identified
by its IP Address.

Attribute name — Node is Complete
Operator — Equal

Value — False
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This is the second attribute condition you need to define in the Attribute
tab to enable the query node of type node to be identified by its IP
address.

Attribute name — Node is Complete
Operator — Is null

Value — Value cannot be changed

Define the Enrichment Rule

Define the Enrichment rule that deletes all instances of the query node of
type Node that are identified by their IP addresses. From the toolbar,
select Enrichment mode. In the Enrichment Rules pane, select the
doubleHosts1 Enrichment rule. Then right-click the query node of type
Node that is identified by its IP address and select Delete
Relationship/Query Node Item.

Example of a Query Node of Type Node Containing a Removed Indicator:

The query node of type Node now has a removed indicator to denote that
all node instances that have identical attribute and cardinality settings are
removed from the RTSM. The Enrichment query now looks like this.

= =
Mode Maode_2
Containment\' /CDntainment_E

Al

Ipaddress
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P Add Enrichment Query Nodes and Relationships to an
Enrichment TQL Query

528

This section describes how to add Enrichment query nodes and
relationships to an Enrichment TQL query in Enrichment Manager.

To add Enrichment query nodes and relationships to a TQL query:

1 From the tree in the Enrichment Rules pane, select the Enrichment rule to
which you want to add Enrichment query nodes and relationships or
create a new one. For details, see "New Enrichment Rule/Enrichment Rule
Properties/Save As Enrichment Rule Wizard" on page 539.

2 From the Query/Enrichment drop-down at the top of the page, select
Enrichment Mode.

Enrichment Mocle | *
Query Mode
Enrichment Mode

3 From the tree displayed in the CI Type Selector, click and drag the query
nodes you want to function as an Enrichment query node on to the
editing pane. These are the TQL query nodes that are included in the
query. Added Enrichment query nodes are displayed by an added
indicator.

Note: You can add more than one Enrichment query node to a rule.

4 Link the Enrichment query node to an existing TQL query node or query

nodes, to provide the Enrichment query node with the needed context
for its operation.

Following are the Enrichment rule validations:

> You must link the new Enrichment query node to at least one of the
existing TQL query nodes in the rule.

» Enrichment query nodes can only be linked to one another with an
Enrichment relationship.
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» If the new Enrichment query node must be contained (according to its
CIT definition) in another query node, you must use the Composition
relationship to connect this Enrichment query node to an existing
TQL query node.

» You cannot link an Enrichment query node to a TQL query node that
is not visible.

5 To add a relationship between two query nodes:

» Select the required query nodes by holding down CTRL and clicking
the TQL query nodes, right-click and select Add Relationship.

or

» Click the Create Relationship icon and draw a line between the
required query nodes.

Added Enrichment relationships are displayed by an added indicator.

The Add Relationship dialog box opens. For details, see "Add/Edit
Relationship Dialog Box" on page 63.

Click OK. The selected query nodes are linked by the relationship you
have selected.
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Reference

@ Enrichment Manager User Interface

This section includes (in alphabetical order):
» Enrichment Manager Page on page 530

» New Enrichment Rule/Enrichment Rule Properties/Save As Enrichment
Rule Wizard on page 539

» Query Node/Relationship Definition Dialog Box on page 544
» Query Node Definition — Advanced Attribute Dialog Box on page 546

@ Enrichment Manager Page

This page enables you to define Enrichment rules. These rules, which are
based on a specific TQL query, can be used for several purposes, including:

» Adding new ClIs and relationships to the RTSM.
» Deleting specific CI instances from the RTSM.
» Updating the attribute values of specific CI instances in the RTSM.

To access Select Admin > RTSM Administration > Modeling >
Enrichment Manager.

Important Enrichment Manager has two modes in which you can

information work. Always check the Enrichment/Query mode list in

the toolbar to verify the currently selected mode.

Relevant tasks "Define an Enrichment Rule — Scenario" on page 523
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Enrichment Rules Pane

This area displays a hierarchical tree structure of predefined folders and
Enrichment rules. Each Enrichment rule is associated with a TQL query.

Important You can create your own Enrichment rule, or work with
information the out-of-the-box (factory) Enrichment rules provided
with your HP Business Service Management installation.

The default folders are provided for the out-of-the-box
queries. You can modify these folders, or add additional
folders according to your organization’s requirements.

You can drag and drop Enrichment rules or folders to
move them from one folder to another.

User interface elements are described below:

Ul Element (A-Z) Description

Ezl Creates a new folder.

Creates an Enrichment rule. Opens the New Enrichment
Rule/Properties wizard.

W% Deletes the selected folder or Enrichment rule.

|§| Refreshes the data content of the hierarchical tree
. structure that may have been modified by other users.

) (Enabled only when an Enrichment rule is created or
when changes are made to an existing one.) Saves the
Enrichment rule to the RTSM.

B Opens the New Enrichment Rule/Properties wizard.
- Enables you to change the description and the activation
state of the Enrichment rule.

@ Generates a preview of the results of the selected
Enrichment rule.

ES Represents a folder.
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Ul Element (A-Z)

Description

® Represents an Enrichment rule.
<Enrichment Rule Displays the existing Enrichment rules in tree format.
tree>

Note: Only Enrichment rules appear in the tree. TQL
queries of type Enrichment (created in the Modeling
Studio) do not appear in the tree.

The following elements are available by right-clicking a folder or

Enrichment rule:

Ul Element (A-Z)

Description

Delete

Deletes the selected folder or Enrichment rule.

Export To XML

Displays a standard Save As dialog box, enabling you to
save the Enrichment rule as an XML script. This option
can be used to move an Enrichment rule from one
workstation to another, provided the related TQL query is
also relocated.

Import From XML

Imports XML files that contain saved Enrichment queries
to the Enrichment Manager.

New Creates an Enrichment rule. Opens the New Enrichment
Rule wizard.

New Folder Creates a new folder.

Preview Generates a preview of the results of the selected
Enrichment rule.

Properties Opens the New Enrichment Rule/Properties wizard.

Enables you to change the description and the activation
state of the rule.

Rename Folder

Renames the folder.
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Ul Element (A-Z) Description

Save (Enabled only when a new Enrichment query is created
or when changes are made to an existing one.) Saves the
Enrichment rule to the RTSM.

Save As Displays the Save As Enrichment Rule wizard, enabling
you to define a new name and description for a query.
This option can be used for creating a new Enrichment
rule based on an existing one.

Editing Pane

This area enables you to create and define Enrichment query nodes and
relationships.

Important » When you select a folder in the Enrichment Rules

information pane, the editing pane is empty.

» When you select an Enrichment rule in the
Enrichment Rules pane, the editing pane displays the
selected rule, which consists of TQL query nodes that
are defined in the TQL query and the relationships
between them, and the Enrichment query nodes and
relationships that are created and added to the rule.

» The Enrichment Manager has two modes in which
you can work: Enrichment mode and Query mode.

The mode in which you are working determines the
options that appear in the shortcut menu. For details,
see the editing pane description below.

» You can calculate the number of instances that were
created as a result of an Enrichment rule and remove
the instances created from an Enrichment rule from
the RTSM. For details, see "Additions Count" on
page 201 and "Remove Enrichment Results" on

page 207.
Relevant tasks "Define an Enrichment Rule — Scenario" on page 523
See also For details on how to create a TQL query, see "Add Query

Nodes and Relationships to a TQL Query" on page 32.
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User interface elements are described below (unlabeled elements are shown
in angle brackets):

Ul Element (A-Z) Description

E Indicates an added Enrichment query node or
relationship.

E| Indicates a query node or relationship that has

been deleted from the RTSM.

Indicates an updated query node or relationship.

The Enrichment Manager has two modes in
which you can work: Enrichment mode and
Query mode.

Enrichment Mode | ¥
Cuery Mode
Enrichment Mode

Working in:
Query and Enrichment

mode » Query mode enables you to define regular

(non-Enrichment) relationships and query
nodes and add them to the TQL query you
defined.

» Enrichment mode enables you to define
Enrichment relationships and query nodes and
add them to the TQL query you defined.

<Main Menu> For details, see "Main Menu" on page 197.

<Query Node> A component from which TQL queries are built.

<Relationship> The entity that defines the relationship between
two query nodes.

<Shortcut menu> options | For details, see "Shortcut Menu Options" on
page 40.
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Ul Element (A-Z) Description
<Toolbar> For details, see "Toolbar Options" on page 201.
<Tooltips> Hold the cursor over a query node or relationship

to view its tooltip.
The tooltips contain the following information:

» Element name. The name of the query node.

» Cl Type. The CIT of the query node as defined
in the CI Type Manager. For details, see "CI
Type Manager" on page 475.

» Definitions of the selected query nodes and
relationships. The attribute conditions, as
described in "Query Node/Relationship
Properties Dialog Box" on page 85.

Cl Type Selector

This area displays a hierarchical tree structure of the CI Types found in the
ODB.

Important The CI Type Selector is part of Enrichment Manager,
information Impact Analysis Manager, and Trigger TQL Editor.

To create or modify a TQL query, click and drag query
nodes to the Editing pane and define the relationship
between them. Your changes are saved to the ODB. For
details, see "Add Query Nodes and Relationships to a TQL
Query" on page 32.

Note: The number of instances of each CIT in the ODB is
displayed to the right of each CIT.

Relevant tasks » "Define an Impact Rule — Workflow" on page 452
"Define an Enrichment Rule — Scenario" on page 523
"Define a TQL Query" on page 30

Yy vy

"Create a Pattern View" on page 359
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User interface elements are described below (unlabeled elements are shown
in angle brackets):

Ul Elements (A-Z) Description
& Click Add CI Type to Map to move the selected CI type
to the Editing pane.
|§| Click Refresh to refresh the CI type tree.
Q Click Search to search for the CI type entered.
B Click Expand All to expand all subtrees within the CI
type tree.
B Click Collapse All to collapse the subtrees within the CI
type tree.
<Search window> Enter the name or part of a name of a CI type for which
to search.

Shortcut Menu Options
The CI Type Selector includes the following elements (listed alphabetically)
available by right-clicking a CI Type:

Menu Item Description

Add CI Type to Map Select to add the selected CI type to the Editing pane.

Go to Cl Type Takes you directly to the selected CI type in CIT Manager.
Definition

Show CIT Instances Opens the CIT Instances window, which displays all
instances of the selected CIT. For details, see "Element
Instances Dialog Box" on page 77.
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Advanced Pane

This area displays the properties, conditions, and cardinality for the selected
query node and relationship.

Important The Advanced pane appears in the lower part of the
information window in the following managers and user interfaces:
Modeling Studio, Impact Analysis Manager, Enrichment
Manager, the Input Query Editor and Trigger Query
Editor in DFM.

A small green indicator * appears next to the tabs that
contain data.

Relevant tasks » "Define an Impact Rule — Workflow" on page 452
"Define an Enrichment Rule — Scenario" on page 523
"Define a TQL Query" on page 30

"Create a Pattern View" on page 359

"Create a Template" on page 360

YYVYVYY

"Create a Perspective" on page 362

User interface elements are described below:

Ul Elements (A-Z) Description

711 If the window is not wide enough to display all the tabs, use

the left and right arrows to move to the required tab.
= Click Show List to display a list of the available tabs for the

current module. You can select a tab from the list.

Attributes Displays the attribute conditions defined for the query node
or the relationship. For details, see "Attribute Tab" on
page 87.

Cardinality Cardinality defines how many query nodes you expect to

have at the other end of a relationship. For example, in a
relationship between a node and an IP Address, if the
cardinality is 1:3, the TQL query retrieves only those nodes
that are connected to between one and three IP Addresses.
For details, see "Cardinality Tab" on page 89.
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Ul Elements (A-Z)

Description

Data Sources

Displays the data sources set for the selected query node.

Note: This tab appears only in the Modeling Studio.

Details

Displays the following information:

» Cl Type. The CIT of the selected query node/relationship.

» Visible. A green check indicates that the selected query
node/relationship is visible in the topology map. A red
mark indicates that it is not visible.

» Include subtypes. A green check indicates that both the
selected CI and its children are displayed in the topology
map. A red mark indicates that only the selected CI
appears.

Edit

Click Edit to open the relevant dialog box for the selected
tab.

Enrichment Rules

Displays the Enrichment rule defined for the selected query
node or relationship. If the Enrichment rule is used to
update the attributes of a CI, click Edit to open the Query
Node/Relationship Definition dialog box and edit the rule if
required. For details, see "Query Node/Relationship
Definition Dialog Box" on page 544.

Note: This tab appears only in Enrichment Manager.

Impacted Query
Nodes

Indicates which query node is affected by the changes that
occur in the selected trigger query node. If required, you can
click Edit to open and modify the Affected Query Nodes
dialog box. For details, see "Impacted Query Nodes Dialog
Box" on page 466.

Note: This tab appears only in Impact Analysis Manager.

Qualifiers

Displays the qualifier conditions defined for the query node
or the relationship. For details, see "Qualifier Tab" on
page 92.

Selected Identities

Displays the element instances that are used to define what
should be included in the TQL query results. For details, see
"Identity Tab" on page 95.
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@ New Enrichment Rule/Enrichment Rule Properties/Save
As Enrichment Rule Wizard

This wizard enables you to create or modify an Enrichment rule.

To access » To create a new Enrichment rule, right-click anywhere
in the Enrichment Rules pane and click New or click
the New - button.

» To modify an existing Enrichment rule, right-click an
Enrichment rule in the Enrichment Rules pane and
select Properties.

» To create a new Enrichment rule based on an existing

query, right-click an Enrichment rule in the
Enrichment Rules pane and select Save As.

Important » When creating a new Enrichment rule, bear in mind

information that the application does not allow you to make any
changes in the TQL query that are necessary for the
rule. These changes include the following:

» Deleting, from the Enrichment TQL query, the
query nodes or relationships connected to the
Enrichment query node, causing a query node to
become unattached to any relationship.

» You cannot change the cardinality definition to 0
(not required) of a query node or relationship that is
used in an Enrichment rule. For details on
relationship cardinality, see "Query
Node/Relationship Properties Dialog Box" on
page 85.

» An Enrichment TQL query that serves as the basis for
Enrichment rules, is subject to certain validation
restrictions. For details, see "Troubleshooting and
Limitations" on page 103. If the TQL query is not valid,
you cannot save it.

Relevant tasks » "Define an Enrichment Rule — Scenario" on page 523

Wizard map The New Enrichment Rule /Enrichment Rule
Properties/Save As Enrichment Rule wizard contains:

Rule General Attributes Page > Rule Base Query Page

See also "Topology Query Language" on page 21
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¥ Rule General Attributes Page

This wizard page enables you to enter a unique name and description for the
Enrichment rule.

Important » An Enrichment TQL query that serves as the basis for
information Enrichment rules is subject to certain validation
restrictions. For details, see "Troubleshooting and
Limitations" on page 103. If the TQL query is not
valid, you cannot save it.

» For important information on the effects of making
changes to the TQL query after creating it, see "New
Enrichment Rule/Enrichment Rule Properties/Save As
Enrichment Rule Wizard" on page 539.

» By default, this wizard is set to display a Welcome
page. You can choose not to display this page by
changing the user preferences. For details, see "User
Preferences Dialog Box" on page 102.

Wizard map The New Enrichment Rule/Enrichment Rule
Properties/Save As Enrichment Rule Wizard contains:

Rule General Attributes Page > Rule Base Query Page

See also "Topology Query Language" on page 21
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User interface elements are described below:

Ul Element (A-Z)

Description

Rule Description

(Optional) Enter a description of the rule.

Rule is Active

(Optional) Select this option to activate the rule in the
system as soon as it is saved.

Default: Not selected.
Note:

» If an active Enrichment rule is deactivated (by clearing
the Rule is Active check box), all changes that occur in
the RTSM relating to the rule are deleted from the
system. When you deactivate an Enrichment rule, a
red X appears next to the Enrichment rule in the
Enrichment Rules pane.

» To reactivate the rule, right-click the rule in the
Enrichment Rules pane and select Properties. In the
General Attributes page, select Rule is Active.

Rule Name

Enter a unique name for the Enrichment rule.

The rule name cannot contain any of the following
characters:\/:"<>|%"?

Note: If the rule name is either empty, contains a name
used by another Enrichment rule, or uses invalid
characters, the Next and Finish buttons are disabled.
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¥ Rule Base Query Page

This wizard page enables you to define the properties of the TQL query on
which the Enrichment rule is based.

Important
information

» An Enrichment TQL query that serves as the basis for
Enrichment rules, is subject to certain validation
restrictions. For details, see "Troubleshooting and
Limitations" on page 103. If the TQL query is not
valid, you cannot save it.

» For important information on the effects of making
changes to the TQL query after creating it, see "New
Enrichment Rule/Enrichment Rule Properties/Save As
Enrichment Rule Wizard" on page 539.

» By default, this wizard is set to display a Completion
page after clicking Next in this page. You can choose
not to display the Completion page by changing the
user preferences. For details, see "User Preferences
Dialog Box" on page 102.

Wizard map

The New Enrichment Rule/Enrichment Rule
Properties/Save As Enrichment Rule Wizard contains:

Rule General Attributes Page > Rule Base Query Page

See also

"Topology Query Language" on page 21

User interface elements are described below:

Ul Element (A-Z)

Description

Base the Enrichment
rule on a new query

Select this check box if you want to base the Enrichment
rule on a new TQL query. The TQL results are based on
the attributes defined for the new TQL query.

Base the Enrichment
rule on an existing

query

Select this check box if you want to base the Enrichment
rule on an existing TQL query. Select the required
Enrichment TQL query from the drop-down list.

Base Query
Description

(Optional) Enter a description of the TQL query.




Chapter 13 ¢ Enrichment Manager

Ul Element (A-Z)

Description

Base Query Name

Enter a unique name for the Enrichment TQL query.

If you selected the Base the Enrichment rule on an
existing TQL option, select the Enrichment TQL query on
which you want to base the rule.

Base Query Priority

Select a priority level for the new TQL query (Low,
Medium, High, or Express). This setting determines how
often the query is rerun automatically by the system to
include updated information from the RTSM.

Save a new query
based on the current
definition

Select to save a new TQL query based on your
Enrichment rule definition.

Note: This field only appears in the Save As Enrichment
Rule wizard.
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@ Query Node/Relationship Definition Dialog Box

This dialog box displays the attributes of the selected query
node/relationship. The key attributes and the required attributes of the
selected query node appear in bold.

To access Right-click a query node or relationship when in
Enrichment mode (select Enrichment from the
Query/Enrichment drop-down at the top of the
Enrichment Manager page) and select Update
Relationship/Query Node.

Important Use an Enrichment rule to update the value of CI
information attributes in the RTSM, or to add data to attributes that
currently do not have values. You can use this option, for
example, for simultaneously adding a note to all CI
instances.

You must fill in the value of the key attributes and the
required attributes of the Enrichment query node. The
method you use to define these values determines the
number of instances created.

If you enter a dynamic value, you can create numerous

instances. For example, entering the dynamic value of a
host_key for the CIT Node or an IP address attribute for
the CIT IpAddress.

Relevant tasks "Define an Enrichment Rule - Scenario" on page 523
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are described below:

Ul Element (A-Z)

Description

Name The attribute name.
Type The field type of the selected attribute.
Value The value as defined in one of the following:

» The Value box in the Set Attributes area.

» The combination of the values in the By Attribute
boxes in the Set Attributes area.

» The Value column if you selected Simple in the Type
column in the Query Node Definition - Advanced
Attribute dialog box.

» The combination of the values in the Value column
and the column to the right of the Value column if you
selected By Attribute in the Type column in the Query
Node Definition - Advanced Attribute dialog box.

Set Attributes Area

User interface elements

are described below:

Ul Element (A-Z)

Description

(Appears only if you selected an attribute of the field type
string.) Opens the Query Node Definition - Advanced
Attribute dialog box.

Define query node and relationship attributes of the type
string using simple or complex expressions. You can also
create complex expressions using regular expression
format.

Advanced

(Appears only if you selected an attribute of the field type
string.) Displays the attribute value you defined in the
Query Node Definition - Advanced Attribute dialog box.
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Ul Element (A-Z) Description

By Attribute Define an attribute using attributes from other query

nodes in the TQL query.

» In the box to the left, select the required query node.

» In the box to the right, select the query node’s required
attribute.

The attribute definition appears in the Value column in

the Attributes area.

RegExp Group (Appears only when you select an attribute of the field
type string.) Enter the group number only if you are
adding a regular expression using regular expression
syntax. This is the part of the regular expression pattern
to focus on when creating the attribute. A set of
parentheses () constitutes a group.

Regular Expression (Appears only when you select an attribute of the field
type string.) Add a regular expression using regular
expression syntax. Enter the regular expression pattern.

Value (in the Set Define a constant value. Enter the required value in the
Attributes area) Value box or select a value from the Value list.

Note: The value definition appears in the Value column
in the Attributes area.

® Query Node Definition - Advanced Attribute Dialog Box

This dialog box enables you to define query node and relationship attributes
of the type String using simple or complex expressions. You can also create
complex expressions using regular expression format.

To access Select an attribute of the type string in the Query Node
Definition dialog box. Select Advanced and then click the
Advanced button.

Relevant tasks "Define an Enrichment Rule - Scenario" on page 523
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User interface elements are described below:

Ul Element (A-Z) Description

ES Define an attribute value using simple or complex
expressions. Creates a new entry in the Type column.
Click the new entry and select either Simple or By
Attribute. For details, see the description for the Type
column below.

% Delete an attribute value.
o Move a selected row up.
m Move a selected row down.

Advanced Value (This list is only available if you select By Attribute in the
Type column.) Click the entry inside the box and select
the required attribute.

Concatenate Use all the attribute values listed in this dialog box.

RegExp Group (This list is available only if you select By Attribute in the
Type column.) Click inside the RegExp Group column,
click the ([l button, and enter the group number
in the Value for RegExp Group dialog box that opens.
This is the part of the regular expression pattern to focus
on when creating the attribute. A set of parentheses ()
constitutes a group.

Regular Expression (This list is only available if you select By Attribute in the

Type column.) Click inside the Regular Expression
column, click the | button, and enter the regular
expression pattern in the Value for Regular Expression
dialog box that opens.
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Ul Element (A-Z)

Description

Type

Click the entry inside the Type column and select one of
the following options:

» Simple. Define a constant value using a simple
expression.

» By Attribute. Define an attribute using attributes from
other query nodes in the TQL.

Default is: Simple

Use first attribute
with value

Use the first attribute value listed in this dialog box that is
not empty.

Value

» If you select Simple in the Type column, click inside
the Value column, click the _ button, and
enter the required value in the Value for Simple dialog
box.

» If you select By Attribute in the Type column, click

inside the Value column and select the required value
from the list.
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RTSM Data Model Introduction

This chapter includes:

Concepts

» BTO Data Model (BDM) Overview on page 552
Reference

» Data Model Documents on page 553

» Upgrade Documents on page 554
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Concepts

& BTO Data Model (BDM) Overview

The BTO Data Model (BDM) enables you to manage the business functions,
services, processes, and activities of your IT Universe model.

The BDM documents are located in the following folder:

\\<Business Service Management root directory>\AppServer\
webapps\site.war\amdocs\eng\pdfs
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Reference

® Data Model Documents

BDM - Conceptual Data Model

The conceptual model presents a high level picture of the BTO Data Model
(BDM) organized in structured layers. This document is a map of the
concepts being modeled, as well as the scope of the model. This conceptual
data model provides a starting point for understanding the semantics of the
domain modeled.

Note: As this is an abstract representation of the model, the document does
not include every entity or relationship.

BDM - Data Model UMLs

This document represents the data model in a visually appealing set of UML
diagrams. Rather than a single, large, complex UML diagram of the entire
model, small diagrams with specific points of view are presented. The
purpose of the UML diagrams is to provide a pictorial representation of the
model entities and their relationships to each other.

Note: To make the UML diagrams easier to understand, some relationships
and entities may have been excluded.

BDM - Data Model HTML

This document includes all the BDM class information in HTML format.
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BDM - Business Model and Best Practices

This document covers the business part of the RTSM data model, as well as
some best practices and guidelines on how to model your business.

CMS Data Model 9.03 Documentation

This document covers all BDM classes and a subset of the CMS classes. It
includes the following information:

» class descriptions

» attribute information

> object scoping (BDM/CMYS)
» qualifier information

» hierarchy information

Note: This document can be automatically generated from the RTSM user
interface.

® Upgrade Documents

554

RTSM Class Mapping Summary

This mapping document presents a high level view of the class mappings
between versions 8.0x and 9.03, including the hierarchy changes.

RTSM Class Model Comparison

This document covers the differences between the 8.0x class model and the
9.03 data model in greater detail. The document includes the following
information:

» class and attribute mapping

» new classes and attributes



» qualifier changes

» deprecation information
» removed classes

» key attribute changes

» hierarchy changes

Chapter 14 ¢ RTSM Data Model Introduction
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Exporting the RTSM Data Model to a UML
Tool

This chapter includes:

Concepts

» Export to UML Tool — Overview on page 558

Tasks

» Export the Class Model on page 559

» Convert XML of Selected Part of Class Model on page 560
Reference

» Export Class Model to UML Wizard on page 562

» Tool Plug-in Input on page 565

Note: Currently, Altova UModel versions 2008 and 2009 are supported.
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Concepts

& Export to UML Tool - Overview

558

The Export to UML tool enables you to export selected sections of the RTSM
class model to a format compatible with UML tools, and to view the model
as a UML diagram.

The input for the tool is the RTSM class model XML file retrieved by the
JMX service UCMDB:service=Class Model Services/
exportClassModelToXml().

Note: To access the JMX console, enter the following address in your
browser: http://<server_name>:21212/jmx-console, where <server_name>
is the name of the machine on which HP Business Service Management is
installed.
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Tasks

P Export the Class Model
This task describes how to use the Export Class Model to UML tool wizard.
This task includes the following steps:
» "Prerequisites" on page 559
» "Run the UML Tool" on page 559
» "View the Exported File in Altova" on page 559

1 Prerequisites
Set up the tool by extracting the following zip file to any location:

<HP BSM root directory>:\odb\tools\ExportClassModel.zip

2 Run the UML Tool

You use the Export Class Model to UML wizard to choose the CIT and its
attributes to be exported to the UML tool.

For details on working with the Export to UML wizard, see "Export Class
Model to UML Wizard" on page 562.

3 View the Exported File in Altova
In Altova, select File > Import From XMI File.

Select the XMI file. The class model entry appears in the Model Tree
pane.

c Right-click the entry and select Show in new diagram > Content.
Click OK.
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P Convert XML of Selected Part of Class Model

560

This task describes how to use the custom plug-in to convert the XML of a
selected part of the class model to the UML tool format.

The plug-in can be either a Java class or an XSLT text file. If you use a Java
class, it must implement the ITransformToUML(ExportToUML.jar) interface;
the transformToUML() method receives an XML string as a parameter and
returns a byte array that is written to the output file.

For details on the custom plug-in input, see "Tool Plug-in Input" on
page 565.

This task includes the following steps:

» "Activate the Plug-in Using a Java Class" on page 560
> "Activate the Plug-in Using an XSLT Text File" on page 561

Activate the Plug-in Using a Java Class

Add the display name and fully-qualified class name to the config.xml file in
the ExportToUML directory, as follows:

<ConverterToUML>
<Name><display nhame></Name>
<Class><fully qualified class name></Class>
</ConverterToUML>

Continue with the procedure for exporting the class model. For details, see
"Export the Class Model" on page 559.
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Activate the Plug-in Using an XSLT Text File

In this case, XSLT from the specified file is applied to the class model XML
and is written to the output file.

Add the display name and full path of the XSLT file to the config.xml file in
the ExportToUML directory, as follows:

<ConverterToUML>
<Name><display name></Name>
<XsltFile><Full_path_of_the XSLT _file></XsltFile>
</ConverterToUML>

Continue with the procedure for exporting the class model. For details, see
"Export the Class Model" on page 559.
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Reference

@ Export Class Model to UML Wizard

This wizard enables you to choose the CIT and its attributes to be exported
to the UML tool.

To access Browse to the location where you extracted the tool.
Right-click ExportClassModel.jar in the
ExportClassModel directory. Select Open With > Java 2
Platform SE binary.

Important By default the tool opens the ClassModel.xml file in the
information ExportClassModel directory. You open other files
through the File > Open Class Model File menu.

Relevant tasks "Export the Class Model" on page 559

Wizard map The Export Class Model to UML wizard contains:

Export Class Model to UML Wizard > Select Valid Links
> Export Selected Items

See also "Tool Plug-in Input" on page 565

User interface elements are described below:

Ul Element (A-Z) Description

File Displays a list of XML files. Open the file that contains
the class model.
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Ul Element (A-Z)

Description

Select Attributes
Pane

Select the attributes to be displayed in the UML tool.

The attributes of the selected CIT are displayed in this
pane. The attributes are colored as follows:

» Attributes inherited from the parent CIT are black.
» Attributes specific to this CIT are dark blue.

Select Cl Types Pane

The CITs displayed here are retrieved from the
ClassModel.xml file.

Select the CIT and its sub nodes to be exported to the
UML tool.

Use the buttons to select or clear all subindex.

®, select Valid Links

This wizard page enables you to select links that can be used between two

CITs.
Important General information about the wizard is available in
information "Export Class Model to UML Wizard" on page 562.
Wizard map The Export Class Model to UML wizard contains:

Export Class Model to UML Wizard > Select Valid Links
> Export Selected Items

User interface elements are described below:

Ul Element (A-Z)

Description

[@]

Click to remove the filter from the list of CITs.

Filter by

Enables you to filter the list of valid links. You can filter
the list of CITs and you can sort the list by CIT or
relationship.
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®” Export Selected Items

This wizard page enables you to export the selected CITs and their attributes
to the UML tool.

Important General information about the wizard is available in
information "Export Class Model to UML Wizard" on page 562.
Wizard map The Export Class Model to UML wizard contains:

Export Class Model to UML Wizard > Select Valid Links >
Export Selected Items

User interface elements are described below:

Ul Element (A-Z) Description

Export Click to browse to the UML file, in XMI format, to which
you want to add the UCMDB CITs and their attributes.

If there are no valid links for a pair of CITs, a no valid
links message is displayed in the Select Valid Links page.
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@ Tool Plug-in Input

The input for the plug-in is an XML string (selected classes/attributes/valid
links) in the following form:

<?xml version="1.0" encoding="ISO-8859-1"?>
<Class-Model>
<Class class-name="hostresource" display-name="Host Resource"
visibility="public">
<Attribute name="isvirtual" display-name="Is Virtual" visibility="public"/>
<Attribute name="city" display-name="City" visibility="public"/>
</Class>
<Class class-name="host_node" display-name="Computer" visibility="public">
<Derived-From class-name="host"/>
</Class>
<Class class-name="vax" display-name="VAX" visibility="public">
<Attribute name="root_actualdeletionperiod" display-name="Actual Deletion
Period" visibility="public"/>
<Attribute name="data_allow_auto_discovery" display-name="Allow C| Update"
visibility="public"/>
<Derived-From class-name="host_node"/>
</Class>
<Class class-name="host" display-name="Host" visibility="public">
<Attribute name="host_iscomplete" display-name="Host Is Complete"
visibility="public"/>
<Attribute name="host_isroute" display-name="Host Is Route" visibility="public"/>
<Attribute name="host_hostname" display-name="Host Name" visibility="public"/>
<Attribute name="host_os" display-name="Host Operating System"
visibility="public"/>
</Class>
<Class class-name="unix" display-name="Unix" visibility="public">
<Derived-From class-name="host_node"/>
</Class>
<Valid-Link ID="host_member_host" display-name="Member" visibility="public">
<End1 class-name="host"/>
<End2 class-name="host"/>
</Valid-Link>
<Valid-Link ID="host_container_f_hostresource" display-name="Container link"
visibility="public">
<End1 class-name="host"/>
<End2 class-name="hostresource"/>
</Valid-Link>
</Class-Model>
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Working with Tables

This chapter includes:
Reference

» Columns User Interface on page 570

569



Chapter 16 » Working with Tables

Reference

® Columns User Interface

This section includes (in alphabetical order):
» Select Columns Dialog Box on page 570

» Sort Column Content Dialog Box on page 572

@ Select Columns Dialog Box

This dialog box enables you to choose the information you are interested in
displaying. You can hide a column or display a hidden column.

Description Click the Select Columns [[}} button. This button appears
above every table in a report.

Important The order of the columns in the list in the Visible

information Columns pane determines the order of the columns

displayed in the table. To change the order of table
columns, move them to the required position using the
up and down arrow buttons or by dragging a column to a
new location.

The following elements are included:

Ul Element (A-Z) Description

> Displays a column. Moves the selected column from the
Available Columns pane to the Visible Columns pane.

& Hides a selected column. Moves the selected column from
the Visible Columns pane to the Available Columns pane.

Displays all hidden columns. Moves all the columns from
the Available Columns pane to the Visible Columns pane.

AT
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Ul Element (A-Z)

Description

Hides all columns. Moves all the columns from the Visible

=

= Columns pane to the Available Columns pane.

e Move a selected column up in the list in the Visible
Columns pane.

i Move a selected column down in the list in the Visible

Columns pane.

Available Columns

The columns in this pane do not appear in the table.

Visible Columns

The columns in this pane are visible in the table.
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@ Sort Column Content Dialog Box

This dialog box enables you to set or change the sort order for the entries

displayed in a table.
Description Click the =t Sort Column Content button.
Important To sort a table by one column:
information Move the column name from the Available Columns to

the Sorted Columns list. Select the name and decide
whether to sort in ascending (upward triangle) or
descending (downward triangle) order by clicking the
relevant button.

To sort a table by more than one column:

Move the column names from the Available Columns to
the Sorted Columns list. For each column, decide
whether to sort in ascending or descending order.

To change the order in which columns are sorted:

In the Sorted Columns list, select an entry, and click the
Up or Down arrow to change the order. (Entries higher in
the list are sorted before entries lower in the list.) A
number is displayed in the table’s column headers.

Note: Only columns that are displayed can be sorted. For
details on how to define which columns are displayed in
the table and in which order, see "Select Columns Dialog
Box" on page 570.

The following elements are included:

Ul Element (A-Z) Description

Y Moves the selected column from the Available Columns
pane to the Sorted Columns pane. You can double-click
the selection to perform the same procedure.

Moves the selected column from the Sorted Columns
&< .
pane to the Available Columns pane.

Moves all the columns from the Available Columns pane
to the Sorted Columns pane.

AT
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Ul Element (A-Z)

Description

Moves all the columns from the Sorted Columns pane to

=

= the Available Columns pane.

¥ ft Moves the selected column up or down in the list to
increase or decrease its priority in establishing the sort
order.

BT L Enables you to sort the column content in ascending or

descending order.

In the Sorted Columns pane, select a column name and
click the ascending or descending button.

Available Columns

The columns whose content is not sorted.

Note: You can select multiple columns.

Sorted Columns

The columns whose content is sorted in either ascending
or descending order.
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Regular Expression Examples

This chapter includes:
Reference

» Examples of Regular Expressions on page 576
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Reference

@ Examples of Regular Expressions

576

Enter a regular expression to define an IP address (aa.yy.zz.mm):

In the First Field

In the Second Field

LG Enter: Enter:
Create label by aa SRR ARIARY 1
Create label by yy CLDEHCT*L] 2
Create label by zz GLIALDEHAS 2
Create label by mm (FLLAL1ALDCY 2

Enter a regular expression to create the label by the first or last letters of the

selected attribute:

In the First Field

In the Second Field

letters

To: Enter: Enter:
Create label by the first letter (B8] 1
Create label by the last letter ") 2
Create label by the first two )0 1
letters

Create label by the last two ([ 2
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